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Welcome to MicroLab Expert

Offtheshelf Software
MicroLab Expert connects to your analytical instruments to open new processing pathways for your experimental
data.
MicroLab Expert presents analytical data of various origins and evaluation results at a glance in a typical manner
for the analyst.
MicroLab Expert provides a vast number of modules to complete and simplify your tasks in analytical data
evaluation.
MicroLab Expert is embedded into your working environment to assist you in returning to the substantial parts of
your work in order to prevent fighting with all day trivia.
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Software Installation
This chapter contains following topics:
System Requirements
Installing the Software
Installation Steps
Software Protection and Licensing
Starting the Software
Uninstalling the Software
Quick introduction

System Requirements
To run the software properly on your machine, the following hardware and software requirements are recommended:

Hardware Requirements
The minimum hardware requirements are:
CPU:

Pentium IV processor or better

Memory:

Windows 7 SP1, Windows 8 or Windows
10
(64bit):
3 GB or more (4 GB recommended), when
using the Quantify/Reaction Module 4 GB are
mandatory.
The amount of available RAM will affect the
maximum possible sample count for the
Reaction Module. Please review the section
Running Reactions for details!

Available disk space:

2.5 GB or more

Graphics adapter:

Fully compliant OpenGL graphics adapter

Screen resolution:

1024x768 pixel or more

Software Requirements
The minimum software requirements are:
Operating System:

Windows 7 / Windows 8 / Windows 10

Other software:

.NET Framework 4.6
.NET Framework 3.5 SP1
C++ Redistributable Package 2010 SP1

.NET runtime environment
The software is a .NET application and needs a special runtime environment to work properly. For this
software version the .NET Framework 4.6 is required.
During installation of the software, the runtime environment will be automatically installed on your
operating system.
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Installing on Notebooks
Notebooks are very often equipped with so called mobility graphics adapter. They sometimes share the
base memory with the graphics adapter and they very often have reduced functionality and performance,
which might cause display problems in the 3D data view or the 3D top view of the application.
Please be sure to have the latest OpenGL video drivers installed on your system. You will find them on the
homepage of your Notebook supplier in the internet.

Installing the Software
To install the software, please follow the instructions below:
1. Start your computer and wait until all system relevant operations are complete.
If your computer is already started...
... please just close all programs before you start installation.

2. Logon to the MS Windows system (Optional).
3. Insert the product installation CD into your CDROM drive. If Autorun is enabled on your system, the installation
starts automatically and you can skip steps 3 and 4.
4. From the Start menu, select Run.
5. Type D:\setup (substitute the appropriate letter of your CDROM drive for D).
6. Follow the instructions on the screen.
For details, please also refer to the chapter installation steps.
.NET runtime environment
The software is a .NET application and needs a special runtime environment to work properly.
During installation of the software, the runtime environment will be automatically installed on your
operating system. This step is only required once.
Currently Microsoft .NET Framework 4.6 is mandatory for running the software!
If the desired version of the runtime environment is not available on the installation CD, please download
directly from the Microsoft® homepage:
https://www.microsoft.com/enUS/download/details.aspx?id=48137
You will be redirected by the setup automatically.

Installation Steps
After starting the Setup from your installation CDROM or local hard disc, all required components of the software will be
installed on your machine subsequently.
Remove previous installations before you start!
At first your machine is investigated for previous installations of the software. If any previous installation
is available, you will be prompted to remove it before you can continue with a new installation!
The setup is terminated automatically to let you uninstall previous copies of the software. For details on
removal of the software, please refer to the chapter "Uninstall the Software".
After investigating the system for previous software versions, some software requirements are checked on your machine.
A proper installation of the .NET framework with required version number must be installed. You will be prompted, if this
.NET framework is missing and the setup will be terminated to run the setup of the .NET framework installation first.

Installing .NET Framework
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You shall install the .NET framework either from the delivered product CDROM or from the internet as described below.
The .NET Framework is required to run the software properly on your machine.
Downloading the .NET framework
You may download the .NET Framework 4.6 from the following URL in the internet:
https://www.microsoft.com/enUS/download/details.aspx?id=48137
(You will be directed to the english page automatically. Please select your appropriate language before starting the
download.)
Product CDROM
You will find the .NET framework setup also on your product installation. The file is named NDP46KB3045557x86
x64AllOSENU.exe.
Installation
After downloading the NDP46KB3045557x86x64AllOSENU.exe program from the internet store it on your hard
disc or finding the file on your product installation CDROM.
1. From the Start menu, select the Run... command.
2. Type "Explorer" into the text field and press the Return key on your keyboard.
3. From the Microsoft Windows Explorer, find the path, where the NDP46KB3045557x86x64AllOSENU.exe file
is located either on your product CDROM or the download path.
4. Double click the NDP46KB3045557x86x64AllOSENU.exe file and .NET framework installation starts
automatically.
5. Follow the instructions of the setup.

Installing the Main Software
After successful installation of the .NET framework the setup program of the software must be restarted manually to
resume installation. Please refer to the chapter "Installing the Software" for details.
1. The installation wizard will guide you through the steps of installation.
2. Modify the settings on the wizard pages to your needs.
3. Click the Next > button to proceed.

Software Protection and Licensing
Software protection is necessary and it is Copyright protected as described in the Enduser license agreement (EULA).
However, to give users the opportunity for thorough evaluation before purchasing a trial license is available. If you have
already purchased the software or the trial period has expired, the software must be registered and activated. According
to the software protection policy, you have the following options:
60 days trial period
Directly after initial installation of the software, this or any more recent version of the software can be used for a trial
period of 60 days without limitation of functionality and without registration or activation. The trial period allows you to
inspect all available functions of the software and decide, which modules you might require for your future work.
Serial number protection
If you have purchased a legal software license and received a serial number from your software vendor in return,
registration and activation of the software is required. Please follow the instructions described in the chapter "Product
Registration" before start working with the software.

Starting the Software
Once installation is complete, you will see a software icon on your desktop and a new program group in your Start menu.
Some known file types are automatically registered to the software during initial startup. Whenever you see the software
icon with one of the known files in your Windows explorer or anywhere else in your operating system, such files can be
directly opened with a double click on them.
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The Software does not run under the Guest Account!
To be able to use this software, you need to be logged on as regular user or administrator user. Using the
software with the guest account is not supported!

To start the Software
Click the software icon on your desktop.
OR
From the Start menu, select Programs  software.
OR
From your windows explorer, Double click a file with a software icon.

Uninstalling the Software
The following components might be uninstalled from your computer in order to install a more recent version.

Uninstalling the Software
The software can be easily removed from your machine via the control panel. Please follow the instructions below to
uninstall it.
1. From the Start menu, select the Settings submenu.
2. From the Settings submenu. select the Control Panel command.
3. From the Control Panel, select the Add/Remove Programs command.
4. From all listed programs, find the software and click the Remove button.
5. Follow the instructions and all components will be uninstalled automatically.

Uninstalling additional Software
If you uninstall the software, any additional software that was also installed during the installation process will remain on
your machine. If you are absolutely sure that the additional software is no longer required by any other application,
please follow the instructions below to uninstall it:
1. From the Start menu, select the Settings submenu.
2. From the Settings submenu. select the Control Panel command.
3. From the Control Panel, select the Add/Remove Programs command.
4. Locate the additional software in the program list and click the Remove button.
5. Follow the instructions and all components will be uninstalled automatically.

Quick introduction
An analytical software package like this contains a lot of sophisticated and specific functions supporting the analyst to
accomplish his daily work. In order to tap the full potential of the software some basic understanding of work flows and
handling is required. It is recommended to take a short tour through the following basic functions of the software:

Before you start working
Installing
Registering the product
Getting Help

Basic functions
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Basic functions
Working with the application workspace
Application menus
Exchanging data with other applications

Working with spectroscopic data
Loading and saving data
Organizing data
Mathematical manipulation functions
Printing data
Exchanging data with other applications

Working with libraries
Creating and administering libraries
Searching and retrieving data and information

Working with univariate calibrations
Creating new univariate calibrations

Working with multivariate calibrations
Creating new multivariate calibrations

Working with Color analysis
Introduction to Colorimetry
Performing colorimetric analysis
Comparing colors of different spectra

Working with IR analysis
Using IR analysis to assign bands to molecules

Problems?
Reporting a bug
Contact us
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Product Registration
Software products are protected by an Authorization Scheme, which requires the Activation of a valid License or using a
dongle protection unit. The Registration and Activation Process is performed via two different Methods, depending on the
Internet Connectivity of the Computer on which your Product is installed.
A valid serial number is required!
In order to register and activate your product you must have a valid serial number. You will find it either
on the installation CDROM which comes with the delivered product or you need to purchase it. Please
contact your software vendor us to obtain a valid license and corresponding serial number.
Administrator rights are required on Windows 7 / Windows 8 / Windows 10 machines!
The restrictive file access policies on computers running Windows 7 / Windows 8 / Windows 10 do not
allow the standard user to perform the product registration/activation. To successfully register and
activate the product, the software has to be started with Administrator Privileges. Once the
registration/activation has been performed the software will run normally in the standard user
environment.

Registration and Activation Process
Registration and Activation are required each time, you install the software to a new location on a Computer or on any
license enhancements, that need to be registered and activated. In all cases, the registration form must be filled and
submitted to register and activate the software. The following registration information will be submitted:
First Name
Last Name
Company
Email address
The serial number which comes with the Product
A randomly created Machine Hash Code
Privacy Statement
Any Information provided to Agilent remains secure and private and is used only for the Purposes
specified by the Customer. Further, the Machine Hash Code used during Activation is a Combination of
Hash Values of various Computer Components and cannot be used to determine the make or model of the
Computer, nor can it be backwardcalculated to determine the raw Computer Information.

Activation and Registration via Internet
Products automatically detect, if there is a valid Internet Connection to the Licensing Server. If a stable connection can be
established, Registration information will be submitted and your product will be activated.
Disable Firewalls or AntiVirus Programs!
During registration via internet, your computer must contact the licensing server at Agilent. If any firewall
of antivirus program is running on your computer, please deactivate it for registration. Such programs
might interfere and interrupt connection to the licensing server. In this case only manual registration is
possible although the computer is properly connected to internet.

Internet Product Activation
The activation process of your Product for a computer with a valid internet connection is fairly easy. In order to activate
MicroLab Expert with the described work flow you need:

Activation Prerequisites
In order to activate your Product the following information is required:
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A valid serial number, which comes with the installation CDROM of your Product or if you purchased it online,
please contact your vendor for a valid serial number.
A Computer with internet access on which the Product is installed.
Disable Firewalls or Antivirus Programs!
During registration via internet, your computer must contact the licensing server at Agilent. If any firewall
of antivirus program is running on your computer, please deactivate it for registration. Such programs
might interfere and interrupt connection to the licensing server. In this case only manual registration is
possible although the computer is properly connected to internet.

Activation Steps
To activate your Product please execute the following steps:
1. Start the Software. On Windows 7 / Windows 8 / Windows 10 machines the software needs to be started with
Administrator Privileges!
2. Click the Next Button in the Trial Dialog

3. Enter your personal Registration Information into the form fields.
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Press the Next Button and continue filling the form.
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Press the Next Button and continue filling the form.
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Privacy Statement
Any Information provided to Agilent remains secure and private and is used only for the Purposes
specified by the Customer. Further, the Machine Hash Code used during Activation is a Combination of
Hash Values of various Computer Components and cannot be used to determine the make or model of the
Computer, nor can it be backwardcalculated to determine the raw Computer Information.

4. Press the Register Button. After clicking, the Product will automatically registered and activated at the Agilent
Licensing Server. This process usually takes only a few seconds.

5. Restart the Software to complete Activation.
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Main Software Manual
This chapter contains following topics:
Definitions
Application Workspace
Data Handling in the Software
Printing
Menus Overview
Appendix

Definitions
This chapter contains following topics:
2D Data
3D Data
Audit Trail
Axis
Discrete Data
Equidistant Data
Highlighted Object
Labels
Library
Objects
Peak Table
Projects
Properties
Resolution
Search
Search Result

2D Data
In the past as well as today mostly 2D analytical data are recorded to visualize the behaviour of two independent
parameters, although in times of modern computer technology, multidimensional data acquisition is also possible and will
be applied in many cases.
In the software we distinguish discrete data and equidistant data objects, which sometimes leads to a limitation of
applicable mathematical functions.

2D Data Example
A typical example for a 2D data object is a UV/VIS spectrum, where the absorption of a suitable material is measured
within the wavelength range of interest. The resulting spectrum is a 2D data object with the absorption on the yaxis and
the respective wavelength on the xaxis. The UV/VIS spectrum of benzene in the range from 230 to 270 nm looks as
follows:
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(Source: http://www.jcamp.org/testdata/testdata.zip)

3D Data
Recording 3D data implies, that the dependency of three independent parameters must be measured to gain a special
analytical result. Mostly these measurement cannot be directly visibly interpreted by the analyst, because it is nearly
impossible to evaluate 3dimensional space on a 2dimensional screen.
The software circumvents that inconvenient situation either by powerful mathematical methods, which extract meaningful
results automatically or by interactive 2D data extraction. The result of such an extraction will be a set of two
corresponding 2D data objects, representing that point of extraction from the 3D data object. Resulting 2D data objects
can be easily handled by the user then.

Pseudo 3D Data
Very often 3D data objects are abused as collection of multiple 2D data objects. The main target of this approach is to
keep data of an analytical experiment together in one data set.
A typical example are hyphenated methods like LCMS (Liquid Chromatography coupled with Mass Spectrometry) or TLCUV
(Thin Layer Chromatography coupled with UV/VIS spectroscopy). The latter analytical method provides a lot of 2D UV
spectra at covered distances on the thin layer plate. These 2D UV data objects are collected in one 3D data object.
The xaxis contains the covered distance of the plate, whereby the yaxis contains the measured wavelength range of
interest and the zaxis the intensity or count of a particular absorption.

3D Data Example
The following figure shows a typical pseudo 3D data object with a set of two 2D data objects extracted from the x, z
plane and the y, z plane. This is a measurement of cannabis extract on a thin layer plate:
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(Source: J&M Analytische Mess und Regeltechnik GmbH, RobertBosch Str. 83, 73431 Aalen, Germany)

Audit trail
What is an audit trail?
Following the guide lines of the Food and Drug Association (FDA), the software includes an audit trail for all objects, that
can be modified, according to the CFR 21 part 11 guide lines. An audit trail is a list of all modifications of an object. It
shows the complete history of an object from the point of creation until now and all things happened meanwhile. Every
modification will cause an entry in the audit trail of the object, containing detailed information about modification
properties, respectively. The audit trail of an object can be reviewed in the audit trail tab.

What information is logged in an audit trail?
The following information is logged:
The real name of the user, who modified the object.
The department, the user belongs to indicating his actual function in the company he works.
Date and time of modification of the object.
Modification details
This is meant to be a detailed description of parameters of the respective modification.

Which actions in the software will cause an audit trail entry?
In principle, all operations, that modify the object permanently, will cause an audit trail entry.
The following actions will be logged:
Any mathematic function applied to an object.
Importing and exporting an object.
Renaming objects

Axis
The term is applied for the axis of a graph. The horizontal axis is the xaxis, the vertical yaxis and the zaxis is a possible
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third axis used for threedimensional graphing. Each axis possesses a unit and sizing markers. Axis properties can be
customized in the preferences dialogs:
2D axis preferences
3D axis preferences

Units
In general, all known units can be used with any axis in a data set. However, in most cases the xaxis is used as data
point axis, whereas the y and/or zaxis are used as intensity axes. If any unknown unit is provided by an axis, the
arbitrary unit is applied automatically.
The following units are known to the software:
Unit

Unit

Arbitrary

Centimeter

Absorbance

Millimeter

Transmittance

Micrometer

PercentTransmittance

Nanometer

Energy

DegreeCelsius

Percent

DegreeKelvin

Logarithmic

DegreeFahrenheit

Photoacoustic

Points

Reflectance

Counts

ElectronVolt

RelativeWavenumber

Volt

GigaHertz

Millivolt

KiloHertz

Wavenumber

MegaHertz

Year

Hertz

Day

PartsPerMillion

Hour

MassUnits

Minute

Mol

Second

Millimol

Millisecond

Emission

MicroSecond

FractionNumber
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NanoSecond

Milliampere

Meter

Nanoampere

Channel

Degree

Decibel

DiodeNumber

Discrete Data
For many reasons, either because of the measurement methods or data recording techniques, data might be only
available as discrete data point objects.
For example in MS spectra, data points are only available for detected masses. Data points in such MS spectra are not
equidistant at all and it would not make sense to have them in an equidistant data object. Some of the modern recording
techniques, like diode array detectors, provide data in a nearly equidistant data sets, but there are very small deviations
in the data point distance because of the detector precision, which lets such data occur as discrete data objects as well.
In detail this means, there is no continuous spectrum with regular data point intervals at least on one axis, but only a list
of data points with random distance belonging together.

Discrete 2D Data Example
The following example shows the MS spectrum of 2Chlorophenole with discrete data points on those positions, where
masses have been detected:

(Source: http://www.jcamp.org/testdata/testdata.zip)
Tip: Click on the icon to download the file.

Equidistant data
Many modern measurement techniques provide continuous data with equidistant data points. Herein all data points have
the same distance according to at least one axis. These spectra have a minimum and a maximum value on the respective
axis and a fixed data point interval, which is also called the resolution.

Equidistant 2D Data Example
The following IR spectrum shows the equidistant 2D data object of N,N,2,4Tetramethylaniline:
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(Source: S.T.Japan Europe GmbH, Nikolausstr. 125, 51937 Cologne, Germany)

Highlighted Object
The current active data object in the analytical data view area is emphasized by an intensive foreground color or a
increased thickness.

Labels
What are object labels?
Labels are user defined object properties. The can be added to an object, modified or removed within the software to
your own demands. The typical application for a label is e.g. if you like to add a comment or experimental data to a
spectrum object. This can be any additional information like a concentration, the instrument which has been used for
measurement or just an additional description of sample preparation or a result.
Labels do have a unique identifier and they will be stored together with the object into a project file or any other file
type.
Which labels are stored in a file?
Some file types are not capable or do not support saving additional information. In this case you will be
prompted before saving, that some information might be lost when saving into the selected file type. You
may choose a different file type in this case. E.g. the JCAMP DX file format supports user defined labels.

Each label contains exactly one value. Appropriate values can be numbers, strings or any combination of both. Object
labels can be reviewed in the labels tab. Modifications are also performed there.

Library
What is a library?
A library is a collection of analytical data like spectra, molecules, text documents and related information as well as foreign
application data, which is inserted as it is. It is a mass storage device for your data which can be easily accessed and
where data is easily found.
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Library and library file type.
Some foreign file types use embedded libraries, because they have to carry a lot of different information,
which would be very complicated to put it into a single binary file. Therefore, these file types provide
libraries as data files. Theses files are different from libraries available here.

Library types
The software distinguishes multiple library types as described in the following:
Library on a database server
This library type is server based and requires an additional highend database system installed somewhere on
your system or network. Library servers like Oracle, SQLServer or Sybase are powerful and professional database
systems, often used in the industry. The software does not support these systems by default. Additional adaption
to your needs is necessary. Please contact your software provider for details and help.
Local library
This library type is based on MSAccess and will be automatically installed together with the software. It provides
default database functions for up to 2 million data sets and about 2 GB database size on your local hard disc or
network drive.
Directory as library (virtual library)
This library type just points to a predefined directory on your hard disc or network drive, where all files included in
the directory will be interpreted as contents of the virtual library. It is also possible to include subdirectories below
the defined root directory of the library.

Objects
What are objects?
All kinds of analytical data and related information as well as foreign application data in the software are organized in so
called objects. E.g. a 2D spectrum is an object. This is an organizational instance to distinguish data from different origins.
Objects possess a lot of properties shown in the properties tab. Properties cannot be modified by the user. Customizable
properties are called labels. Available object labels are displayed in the labels tab. They can be customized by the user.
All these objects are organized in the software, e.g. in projects and folders in the project explorer. Objects of a library are
available in the library explorer. In both cases, the organizational structure is visible as a tree view to the user.
Objects are also displayed in the 2D view, 3D view or molecule view of the software. Objects can be moved together with
all related information to any new location within a suitable place in the software. This can be done simply by drag & drop
operation. It is also possible to search spectra in a library by using drag & drop.

Peak table
A peak table is a collection of peaks, that have been detected in a 2D data object by the find peaks function of the
software. Peaks and related properties are listed in a table and presented in the peak table tab. Peak information will
either be displayed in the peak table or directly in the data view at the peaks. Display options for peaks can be
customized in the 2D Preferences dialog.

Peak table example
A typical peak table looks like this:

Peak table operations
By default, all operations, that might be available for tables in the software can also be applied to the peak table, except
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modification.
Copy and Paste
Working with tables
Editing of peak data is allowed.

Projects
What is a project?
A project is a collection of files, e.g. of an analytical experiment, that belong together. Related files like spectra, molecules,
documents, pictures, etc. can be added to a project by the user. They can be organized in a hierarchical structure (tree)
within folders similar to the file system on your hard disc.

Project file
A project is a single file on your hard disc, where all related documents and files are included. By default the file extension
*.project is used for such project files.

Benefits of projects
In most cases analytical data, related information and evaluation results of an experiment or investigation are spread
over numerous files located somewhere on your local hard disc. Every time the user wants to access a part of the
information, he or she starts a time consuming exploration of the hard disc to find related data.
Projects provide an optimal place to keep such data of various origins together in one file. Related data and information
can be easily accessed and you can take the whole package with you in just one file like in a briefcase.

Properties
What are object properties?
Objects possess a lot of properties describing the object. E.g. the file name or the data type of a spectrum is a property
of a spectrum object. These properties are required in the software for two reasons. The application evaluates the
properties of an object to determine which operations are allowed with this object. The user gets some additional
background information from the properties of an object, e.g. the file location on his hard disc or the data type.
Properties cannot be changed by the user, because this would change the characteristics of an object. User defined
object properties are called labels and they can be added and customized to your demands.
Properties are organized in categories (e.g. "General", "xAxis") and are shown in the properties tab of the application.
Properties can be added to the printout of an object either by activating the print properties flag in the print layout or by
inserting the corresponding placeholders into a print text field. Activating the print properties flag will print all available
object properties, whereas adding a placeholder will only print the referenced property.
Please refer to the sections "General Object Properties" and "Print Layout Placeholders" in the chapter "Printing" for
further details about the available printing options.

Resolution
The resolution is a property of equidistant data objects. As a matter of fact, in an equidistant data object, all data points
have the same distance on the xaxis. So xaxis data is well described, if the starting value, the ending value and the
distance between two adjacent data points are known. The distance between two adjacent data points is called
resolution.
How can I change the resolution?
The software offers the option to adjust the xaxis properties of an equidistant data object. Here the
resolution can be changed or data points can be shifted.

EN

20 . Main Software Manual

Search
How does searching work?
The software is capable of comparing two data objects, e.g. two spectra or molecules. Various search parameters can be
adjusted to provide optimal conditions to the search requests. These search parameters strongly depend on the objects
data type and must be carefully set up to receive a good result. For spectrum search, a lot of search algorithms are
available. During searching, a query object will be compared with all appropriate objects in one or even more libraries.
After comparison of the query object and all library objects, the best matching objects and their properties will be
returned to the user in a search result table. The search result table is displayed for a review by the user.

How does text searching work?
Any additional information to an object is stored either in the properties or labels of an object. Any word, phrase or
regular expression can be used as search query to find objects in a library. A specific search query must be defined for
this purpose. All objects matching in a library will be returned in a search result table.

Supported search functions
The following search functions are supported:
Spectrum Search
Text Search

Search result
What is a search result?
A search result contains all matching objects of a search query, either from a text search or spectrum search on a library.
By default, these search results are displayed in a search result table.
A search result is shown in the tree view of the library explorer and can be reviewed whenever necessary. It can also be
added to a project.

Application Workspace
This chapter contains following topics:
Workspace Details
Customizing the Workspace
Status bar
Toolbars
User Authentication
Select Labels Dialog

Workspace details
Workspace contents
The default application workspace shows the following items:
Menus and submenus
Analytical data views
Various data explorers
Toolbox
Toolbars
Status bar
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Customizing the workspace
To customize and store your personal application workspace, please follow the instructions below:
1. Show all desired tabs on your workspace.
2. Arrange all tabs within the workspace to fit your needs.
3. From the Workspace submenu of the Windows menu, select the Save as... command.
4. Follow the instructions in the File Dialog.

Status bar
The status bar is located on the bottom edge of the application window. It holds the values of a number of predefined
labels on the bottom left, current coordinates of the mouse pointer within the active data object in the workspace and
additional information about the current operator and the department.
The status bar looks like this:

Customizing the status bar
The following contents can be customized:
Customizing status bar labels
A selection of preferred labels of the current active object, being also shown on the labels tab, can be optionally
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displayed on the status bar for convenience. To customize the list of preferred labels, please follow the instructions
below:
1. Click the Left Mouse button on the status bar.
2. From the Select Labels dialog, check the labels you like to see.
3. Click the OK button to apply your choice.
Customizing operator and department
During the very first start of the software the user will be asked to enter the operator and department name in the User
Authentication Dialog. By default the name and location of the current operating system user will be proposed. It is
mandatory to enter a operator name and the name cannot be changed later on. These values can be reviewed in the
Options dialog. The department name can be changed later on via the options dialog.

Toolbars
The toolbars contain the shortcut icons which provide a fast way to execute common software functions. The toolbars can
be configured and reset using the Toolbars submenu in the Tools menu:

The toolbars are by default docked below the menu bar:

They may also be displayed undocked and moved freely across the workspace:

User Authentication Dialog
This dialog will be shown during the very first start of the software. The user will be prompted to enter the operator and
department name. By default the name and location of the current operating system user will be proposed. It is
mandatory to enter an operator name and the name cannot be changed later on.
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These values can be reviewed in the Options dialog. It is possible to change the department name later on via the
options dialog.

User Authentication is relevant for the Audit Trail.
When using the audit trail every modification of an object will be recorded. The operator and department
name will be saved in the audit trail. Please review the details concerning the audit trail.

Select Labels Dialog
In this dialog, the labels, shown in the status bar, the label tab or the label editor of the application, can be selected. The
dialog is invoked by leftclicking on the status bar or by rightclicking on the labels tab. The user will see the same
dialog in both cases but the labels will be configured individually for each display option. The dialog looks like this:

A list of all available labels is shown in the dialog.

Change selection of labels
To change visible labels, please follow the instructions below:
1. Check those labels you like to see in the parent dialog or the application.
2. Use the Up button or the Down button to change the order of appearance.
3. Press the OK button to confirm your choice.

Additional options:
The Clear button clears selection.
The All button selects all labels.
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The Sort button sorts the order of appearance alphabetically, either ascending or descending.
The New button adds a new label to the list and to the actual data object.

Data Handling in the Software
This chapter contains following topics:
Data Views
Data View Operations
Data explorers
Working with Data in the Workspace

Data Views
This chapter contains following topics:
2D Data View
3D Data View
3D Top View
Data Table View
Molecule View
WaterfallView

2D data view
The 2D data view might contain one or more 2D data objects of the same data type. Also equidistant and discrete data
might be mixed. It is not possible to mix 2D data objects of different data types, because their axes are usually not
compatible. Sometimes it might also be possible, that objects of the same data type could not be displayed together in
one data view, because their axes cannot be properly converted to match the current available axes.
There are no limitations towards the number of data objects being shown merged in a single data view. However, this
capability should be used with care in order to keep control over your data.

2D data view functions
The following 2D data view functions are available:
Zooming
Moving
Shifting
Surfing
Show data as table
Additional 2D data view functions will be controlled from the 2D View menu.

2D data view example
In the following figure, the UV/VIS spectra of the colors red, green, blue and yellow are merged in one 2D data view.
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Legend
Several data objects can be merged into a single data view. In this case, it is difficult to distinguish the objects just by
color or the graph shape. A legend shows a list of all spectrum names plus a color indicator in top left corner of the data
view. The legend is enabled by default, if more than one spectrum is shown in a data view. The position and size of the
legend can be adjusted to your personal requirements. The legend looks like this:
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Legend Size
To change the legend size, please follow the instructions below:
1. Click the Legend or one of the entries with the Left Mouse Button.
Tracker items appear in the corners and middle edges of the legend frame.
2. Move the mouse pointer over one of the tracker items.
3. Drag and drop the tracker item to resize the legend.
Legend Positioning
To change the legend position, please follow the instructions below:
1. Click the Legend or one of the entries with the Left Mouse Button.
Tracker items appear in the corners and middle edges of the legend frame.
2. Move the mouse pointer close to the center of the legend.
3. Drag and drop the legend item to the new position.
Legend Properties
The legend properties can be adjusted to your personal needs as well. Here the font, font size and the frame can be
configured in the 2D Preferences Dialog.

3D data view
All three dimensions of a 3D data object are shown in a cube in the 3D data view. The axes of the cube hold the
respective data dimensions. Only one 3D data object can be shown at a time.
The cube might be rotated, zoomed or moved along any of the three dimensions to provide a perfect view to your data. It
is also possible to show 2D cuts, which hold two dimensional slices of the cube along the x,zplane and y,zplane at the
current mouse pointer position. These slices are shown in separate 2D data views on top of the cube optionally. Slices
can be extracted and stored as new 2D data objects.
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Can I save my preferred 3D data view options?
The software will automatically save the last used 3D data view options. Therefore the next 3D
object will be opened with the last used display options. This way the data will always be opened
in your favorite 3D display mode.

3D data view functions
The following functions are available with 3D data objects.
Zooming
Rotating
Moving near and far
Moving
Extracting 2D cuts
3D top view
Show data as table
Additional 3D data view functions will be controlled from the 3D View menu.

3D data view example
The following figure shows a typical pseudo 3D data object with a set of two 2D data objects extracted from the x, z
plane and the y, z plane. This is a measurement of cannabis extract on a thin layer plate:

(Source: J&M Analytische Mess und Regeltechnik GmbH, RobertBosch Str. 83, 73431 Aalen, Germany)

Legend
The legend shows a color coded area on top right corner of the 3D data view. The color coding covers the full intensity
range of the 3D data object. A horizontal line inside the colored area shows the actual intensity at the mouse pointer
position.
Showing and Hiding the Legend
The legend can be enabled and disabled on demand in the 3D Preferences Dialog.
Alternatively, the legend can be enabled or disabled from the context menu, which is available when clicking the Right
Mouse Button in the 3D data view.
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3D top view
All three dimensions of a 3D data object are shown in a cube in the 3D data view. The axes of the cube hold the
respective data dimensions. The top view provides a fixed view from the positive end of the zaxis along the zaxis of the
object. Minima and maxima of the data object are color coded and can be distinguished by contour lines optionally.
The top view might be zoomed in the x,yplane to provide a perfect view to data details. It is also possible to show 2D
cuts, which hold two dimensional slices along the x,zplane and y,zplane at the current mouse pointer position. These
slices are shown in separate 2D data views on top of the top view optionally. Slices can be extracted and stored as new
2D data objects.
Can I save my preferred 3D data view options?
The software will automatically save the last used 3D data view options. Therefore the next 3D
object will be opened with the last used display options. This way the data will always be opened
in your favorite 3D display mode.

3D top view functions
The following functions are available with 3D data objects.
Zooming
Moving near and far
Moving
Extracting 2D cuts
3D data view
Show data as table
Additional 3D data view functions will be controlled from the 3D View menu.

3D top view example
The following figure shows a typical top view of a pseudo 3D data object with a set of two 2D data objects extracted from
the x, z plane and the y, z plane. This is a measurement of cannabis extract on a thin layer plate:
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(Source: J&M Analytische Mess und Regeltechnik GmbH, RobertBosch Str. 83, 73431 Aalen, Germany)

Legend
Similar to the 3D data view, a legend with color coded intensity levels can be displayed in the top right corner of the 3D
top view. Please refer to the 3D data view for details.

Data Table View
For advanced users dealing with spectral information, they like to see any 2D data as numbers too. This function is useful
to allow some calculations by hand or copy spectral data to other applications. The 2D data view can be simply toggled to
show data either as graph or in a data table. Respective commands are described in the Show Data in Table command
section.
The data table can be copied into the clipboard!
The default table functions of the software also apply to this data table. For details, please refer to the
Working with Tables section.

A default data table for a 2D data object looks like this:
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Showing current zoom region in a data table
For convenience only the active zoom region of a graph view is taken into account when toggling to the data table. In this
case, only data points of the zoomed region are shown in the data table. This allows users to extract exactly what they
need from a vast amount of numbers.
To see all available data points in a table, one must perform an Auto scale command in advance.

Showing merged 2D data in a data table
If several 2D data objects have been merged into a data view, they can be shown in a table as well. Besides the xaxis
column, for each 2D data object a separate data column is available in the table. The column header shows the name of
the data object.
Some table fields contain (null) value!
If data with different resolution or number of data points are merged, they can of course be shown
together. In the data table view, some data points might not be available for one particular 2D data
object where they are for another. In this case empty fields appear being filled with the (null) value.

Merged data looks like this:
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Copy data table to the clipboard
The contents of the data table is easily shared with other applications by copying the contents into the clipboard.
Copy single or multiple rows
1. Click into the first field of the row of interest using the Left mouse button.
2. To select multiple rows, hold down the SHIFTkey or the CTRLkey and click the rows of interest subsequently.
3. From the Edit menu, select Copy.
Alternatively, use the keyboard shorthand.
Start the target application and paste the clipboard contents.
Copy the whole data table
1. Click into the grey field in the top left corner of the data table with the Left mouse button.
2. From the Edit menu, select Copy Full Data Table.
Start the target application and paste the clipboard contents.
Some contents cannot be copied!
Some data might be copy protected, e.g. commercial spectral libraries. In order to protect the owners
copyrights some contents are not allowed to be copied.

Molecule view
A chemical structure is displayed in a separate view. It is shown as wired two dimensional model, where hetero atoms
are colored, respectively. Molecules attached to spectral data will be displayed in the Molecule tab of the software. This
way molecules and spectral data might be available at the same time on your workspace. In IR spectrum interpretation,
some additional functions are available for displaying molecules.
The molecule view looks like this:
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Customizing the Molecule View
Some preferences can be adjusted for the molecule view. Please refer to the chapter "Molecule View Functions" for
details.

3D Waterfall View
The Waterfall View is a special version of the 3D Data View. All options and commands for the general 3D Data View also
apply here. To facilitate the overview of a measurement, the Waterfall View displays the data as combination of lines
which show the contour of the 3D data object. The waterfall view can be switched between lines in xaxis or yaxis
direction. The corresponding 3DView menu command is shown below:

Can I save my preferred 3D data view options?
The software will automatically save the last used 3D data view options. Therefore the
next 3D object will be opened with the last used display options. This way the data will
always be opened in your favorite 3D display mode.

3D data view functions
Zooming
Rotating
Moving near and far
Moving
Extracting 2D cuts
3D top view
Show data as table
Additional 3D data view functions will be controlled from the 3D View menu.

3D waterfall view examples
The following pictures show an example 3D data object displayed as xaxis and yaxis waterfall view:
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Data View Operations
This chapter contains following topics:
2D Extraction
Moving
Moving 2D data
Moving 3D data in 3D view
Moving 3D data in top view
Rotating
Shifting
Surfing
Zooming

2D extraction
This function is only available for 3D data objects. The 2D cuts need to be enabled using the Show 2D cuts function of the
software. While surfing through the 3D data object, the actual 2D cuts are displayed online. The 2D cuts can be frozen
when a required 2D data objects is reached and the 2D cuts may be extracted into separate 2D data objects for further
evaluation.
This function is useful with all pseudo 3D objects which consist of a set of 2D data objects. Interesting objects might be
extracted manually.
Extracting all 2D objects automatically.
If you need to extract all 2D data objects along an axis, please use the Extract all spectra along...
command from 2DExtraction submenu in the 3DView menu. This will extract all 2D spectra along
the desired axis and merge them in a new window.
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2D extraction is described in the following:

2D extraction procedure
To extract a 2D data object from a 3D data object, please follow the instructions below:
1. Activate the 3D data view of interest.
2. Show the 2D cuts.
3. Surf or walk through the 3D data object, until you find required 2D data to be extracted.
4. Click the Left Mouse button to fix the current 2D data objects at the current mouse pointer position.
(Click the Left Mouse button again to release the 2D data objects again and continue surfing.)
5. Choose the XCut or YCut or Both Cuts command from the 2DExtraction submenu in the 3DView menu to
extract the 2D data object of interest
or
doubleclick the 2D cut with the Left Mouse button to extract it.

Manual 2D extraction procedure
To extract data manually from a 3D data object, please follow the instructions below:
1. Activate the 3D data view of interest either in 3D view or top view mode.
2. From the 3D View menu, select the 2D Extraction submenu.
3. From the 2D Extraction submenu, select the Manual command.
The 2D cuts are displayed automatically, if not already available and the Manual Extraction Dialog is shown.
4. In the Manual Extraction dialog, move to the xaxis or yaxis position for extraction.
5. Click the Extract button to extract data along the corresponding axis.

Moving
Moving is available in any 2D data view or 3D data view or even the 3D top view. Moving means, the whole object is
moved up, down, left or right keeping the current detail or zoom level. Moving an object is useful, if you have zoomed into
a region of interest and you like to follow the slope of a spectrum beyond the current visible area. In this case, you might
move the whole object to have a look on your object with the current zoom level.
Moving is nearly the same for 2D data and 3D data, but there are slight differences:
Moving 2D data
Moving 3D data in 3D view
Moving 3D data in top view

Moving 2D data
Moving 2D data is useful for viewing analytical data at the preferred detail level and move through the whole data set
without changing the detail level. To be more precise, the user moves the current view port.
Moving is performed as described in the following:

Moving with the mouse
To move the view port with the mouse, please follow the instructions below:
1. Activate the 2D data view of interest.
2. Hold down the Right Mouse button anywhere in the data view area until the

icon appears.

3. Keep the Right Mouse button held down and move the view port.
4. Release the Right Mouse button.
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The view port flips back to its original position.

Moving with mouse and keyboard
To move the view port with mouse and keyboard, please follow the instructions below:
1. Activate the 2D data view of interest.
2. Hold down the SHIFTkey until the

icon appears.

3. Keep the SHIFTkey held down and drag the active curve with the Left Mouse button held down
4. Move the mouse to move the spectrum in vertical direction.
5. Release the SHIFTkey and the Left Mouse button to fix the current area as new view port.
The view port is kept in this case. Whenever more than one spectrum object are merged in the data view, the dragged
curve remains shifted relative to the other curves.

Moving with the keyboard
To move the view port with the keyboard, please follow the instructions below:
1. Activate the 2D data view of interest.
2. Hold down the SHIFTkey until the

icon appears.

3. Keep the SHIFTkey held down and use the Up Arrow, Down Arrow, Left Arrow or Right Arrow key to move the
view port.
4. Release the SHIFTkey to fix the current area as new view port.

Moving the vertical axis with the mouse
To move the view port vertically with the mouse, please follow the instructions below:
1. Activate the 2D data view of interest.
2. Hold down the Left Mouse button anywhere over the yaxis area until the

icon appears.

3. Keep the Left Mouse button held down and move the view port up or down.
4. Release the Left Mouse button to fix the current area as new view port.

Moving the horizontal axis with the mouse
To move the view port horizontally with the mouse, please follow the instructions below:
1. Activate the 2D data view of interest.
2. Hold down the Left Mouse button anywhere over the xaxis area until the

icon appears.

3. Keep the Left Mouse button held down and move the view port left or right.
4. Release the Left Mouse button to fix the current area as new view port.

Moving 3D data in 3D view
Moving 3D data in the 3D view is similar to flying with a helicopter through the landscape of your data. Movements are
possible in all three dimensions.
If you are far away from the 3D object, moving just seems to move the whole object, but if you move closer to the surface
of your 3D object, then moving makes sense to explore the surface of the 3D data object.
Moving is performed as described in the following:

Moving near and far with mouse and keyboard
To move near and far with mouse and keyboard, please follow the instructions below:
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1. Activate the 3D data view of interest.
2. Hold down the SHIFTkey until the

icon appears.

3. Keep the SHIFTkey held down and move the mouse forwards or backwards to move near and far.
4. Release the SHIFTkey to fix the current area as new view port.

Moving near and far with mouse wheel
To move near and far with the mouse wheel, please follow the instructions below:
1. Activate the 3D data view of interest.
2. Roll the Mouse Wheel forwards or backwards to move near and far.

Moving near and far with the keyboard
To move near and far with the keyboard, please follow the instructions below:
1. Activate the 3D data view of interest.
2. Hold down the SHIFTkey until the

icon appears.

3. Keep the SHIFTkey held down and use the PageUpkey or PageDownkey to move the view port near and far.
4. Release the SHIFTkey to fix the current area as new view port.

Moving with the mouse
To move the view port with the mouse, please follow the instructions below:
1. Activate the 3D data view of interest.
2. Hold down the Right Mouse button anywhere in the data view area until the

icon appears.

3. Keep the Right Mouse button held down and move the view port.
4. Release the Right Mouse button to fix the current area as new view port.

Moving with the keyboard
To move the view port with the keyboard, please follow the instructions below:
1. Activate the 3D data view of interest.
2. Hold down the SHIFTkey until the

icon appears.

3. Keep the SHIFTkey held down and use the Up Arrow, Down Arrow, Left Arrow or Right Arrow key to move the
view port.
4. Release the SHIFTkey to fix the current area as new view port.

Moving 3D data in top view
Moving 3D data in the 3D top view is similar to looking onto a surface at a certain distance. Movements are possible in all
three dimensions.
Moving is performed as described in the following:

Moving near and far with mouse and keyboard
To move near and far with mouse and keyboard, please follow the instructions below:
1. Activate the 3D data view of interest.
2. Hold down the SHIFTkey until the

icon appears.

3. Keep the SHIFTkey held down and move the mouse forwards or backwards to move near and far.
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4. Release the SHIFTkey to fix the current area as new view port.

Moving near and far with mouse wheel
To move near and far with the mouse wheel, please follow the instructions below:
1. Activate the 3D data view of interest.
2. Roll the Mouse Wheel forwards or backwards to move near and far.

Moving near and far with the keyboard
To move near and far with the keyboard, please follow the instructions below:
1. Activate the 3D data view of interest.
2. Hold down the SHIFTkey until the

icon appears.

3. Keep the SHIFTkey held down and use the PageUpkey or PageDownkey to move the view port near and far.
4. Release the SHIFTkey to fix the current area as new view port.

Moving with the mouse
To move the view port with the mouse, please follow the instructions below:
1. Activate the 3D data view of interest.
2. Hold down the Right Mouse button anywhere in the data view area until the

icon appears.

3. Keep the Right Mouse button held down and move the view port.
4. Release the Right Mouse button to fix the current area as new view port.

Moving with the keyboard
To move the view port with the keyboard, please follow the instructions below:
1. Activate the 3D data view of interest.
2. Hold down the SHIFTkey until the

icon appears.

3. Keep the SHIFTkey held down and use the Up Arrow, Down Arrow, Left Arrow or Right Arrow key to move the
view port.
4. Release the SHIFTkey to fix the current area as new view port.

Moving the vertical axis with the mouse
To move the view port vertically with the mouse, please follow the instructions below:
1. Activate the 3D data view of interest.
2. Hold down the Left Mouse button anywhere over the yaxis area until the

icon appears.

3. Keep the Left Mouse button held down and move the view port up or down.
4. Release the Left Mouse button to fix the current area as new view port.

Moving the horizontal axis with the mouse
To move the view port horizontally with the mouse, please follow the instructions below:
1. Activate the 3D data view of interest.
2. Hold down the Left Mouse button anywhere over the xaxis area until the
3. Keep the Left Mouse button held down and move the view port left or right.
4. Release the Left Mouse button to fix the current area as new view port.
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Rotating
Rotating is only available for 3D data objects in the 3D data view and Waterfall view. In spite of the Auto Rotate function,
the 3D data objects might be freely rotated around any axis of the coordinate system and angle as described in the
following:

Rotate with mouse and keyboard
To rotate a 3D data object with mouse and keyboard, please follow the instructions below:
1. Activate the 3D data view of interest.
2. Hold down the CTRLkey and keep it pressed.
3. Additionally move the Mouse on your table as long as you need to rotate to any direction.
4. Release the CTRLkey.

Rotate with the keyboard
To rotate a 3D data object clockwise, please follow the instructions below:
1. Activate the 3D data view of interest.
2. Hold down the CTRLkey and keep it pressed.
3. Additionally press the Right Arrow or Left Arrow or Up Arrow or Down Arrowkey as long as you need to rotate.
4. Release the CTRLkey.

Shifting
Shifting is only available for multiple 2D data objects displayed merged in one 2D data view. Shifting means, a single 2D
data object is moved relative to all other 2D data objects in any direction. This function is useful, if the user needs to
prove similarity between certain spectral areas of two data objects. In this case one 2D data object is shifted relative to
another one. Permanent shifting or unshifting along the yaxis is available using the Shift Spectra function or Unshift
Spectra function of the software.
A 2D data object can also be temporarily shifted as described in the following:

Shifting a 2D data object with the mouse
To shift a 2D data object relative to other objects, please follow the instructions below:
1. Activate the 2D data view of interest.
2. Move the Mouse Pointer next to the graph of the object to be shifted.
3. With the Right Mouse button held down, move the object relative to all other objects.
4. Release the Right Mouse button to restore the original data view.

Surfing
Sometimes the user needs to walk along the graph of a 2D data object or 3D data object and wants to see discrete data
point values. The surfing function allows to walk through a data object data point by data point in any direction. The
actual data point values will be displayed in the lower right corner of the window.
Surfing is performed as follows:

Surfing on data objects with mouse and keyboard
To walk through data points of an object, please follow the instructions below:
1. Activate the data object of interest.
2. Move the Mouse Pointer close to the data point of interest.
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3. Press the Left Arrow or Right Arrow or Up Arrow or Down Arrow key to navigate to the nearest data point.
4. Keep pressing one of the Arrow keys to walk further into the direction along the graph.

Zooming
Zooming is needed to get closer to details of your analytical data. In the 2D data view or 3D data view and the 3D top
view, zooming works in the same way as described in the following:

Zooming with the mouse
To zoom with the mouse, please follow the instructions below:
1. Activate the 2D or 3D data view of interest.
2. Move the Mouse Pointer to the starting point of your preferred zoom area.
3. With the Left Mouse button held down, move the mouse to the destination position.
A dark grey rectangle is drawn indicating you new view port area.
Moving the whole zoom rectangle...
You might need to alter the starting position of the zoom rectangle again?
Moving the whole rectangle works as follows:
1. Fix the current zoom region by holding down the Left and Right Mouse button
simultaneously.
2. The zoom region is fixed then and you might move it to a new destination position.
3. Then release only the Right Mouse button to get back to the resize mode.

4. Release the Left Mouse button to apply the current selected zoom region.

Zooming on vertical axis with the mouse
To zoom a 2D data object in vertical direction only, please follow the instructions below:
1. Activate the 2D data view of interest.
2. Move the Mouse Pointer over the vertical axis.
3. Roll the Mouse Wheel forwards or backwards to zoom in or out.

Zooming on horizontal axis with the mouse
To zoom a 2D data object in horizontal direction only, please follow the instructions below:
1. Activate the 2D data view of interest.
2. Move the Mouse Pointer over the horizontal axis.
3. Roll the Mouse Wheel forwards or backwards to zoom in or out.

Data explorers
The software comes with multiple data explorers, which provide different views on your analytical data and related
information. The following data explorers are available:
Project explorer
Library explorer
Quantify explorer (Please refer to the Calibration Help Manual for details)
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Project explorer
The project explorer provides functions similar to the MSWindows explorer. It is useful to organize analytical data in so
called project files. This way spectra and molecules as well as related information and additional documentation like MS
Winword documents, spreadsheets, text documents or pictures can be collected in just one file.
Using the project explorer is optional.
The software handles files without using the project explorer as well. For a brief look on a spectrum or
molecule, there is no need to setup a project. Files can be opened and displayed in the software without
being member of a project.

Project Administration Module
The project explorer is part of the Project Administration Module of the software. If you do not have
access to the project explorer in your software, please contact your software supplier for more
information about upgrades to your software.

Project explorer contents
The following components are available:
Project tree
The project tree shows the hierarchical structure of objects located in a project file.
Project toolbar
The project toolbar contains shortcuts to common menu commands.
Context menu on entries
Each entry in the tree view provides a context menu, which is shown by clicking the Right mouse button on the
entry. The context menu is available for the project node, folders and items inside.

Open the project explorer
To activate the project explorer, please follow the instructions below:
1. From the Window menu, select the Project Explorer command.
2. The project explorer is opened at its previous location either as tab or as separate window on the application
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workspace.

Close the project explorer
To close the project explorer, please follow the instructions.
To close the project explorer, please follow the instructions below:
1. Move the mouse pointer to the

icon next to the tab flags.

2. Click on the icon to close the current active tab of the tab group.

Context Menu
For each item in the explorer tree view, a context menu is available, which shows some commands applicable to the
selected item. The context menu is available for
Project nodes
Folder nodes
Items in the project or folder
The context menu is shown by clicking the Right mouse button on the particular item.
The following commands are available:
Which commands are available?
Not all commands are available at all times. Only commands applicable to the current selected item are
available.

Close
This entry is only available with project nodes. It closes the selected project. You will be prompted to save changes
whenever changes might not have been saved before.
Show Contents
This opens all items in the current selected project or folder. This operation is limited to the current folder or project
level and does not open items recursively. If possible, all items will be opened into the same data window.
Remove Contents
This deletes all items in the current selected folder or project. This operation is limited to the current folder or
project level and does not delete items in subfolders recursively. Before removing the files you will be prompted to
confirm the operation, because it cannot be undone.
Add File(s)
This is a shorthand to the Add Files command from the project menu.
New Folder
This inserts a new folder at the current selection level. This might be either a folder on a root level of a project or a
subfolder in an existing folder. By default the folder is named "New Folder". Directly after creation you can modify
the name and press the RETURNkey to complete folder creation.
Remove Folder
This removes a folder with all subfolders and contents. You will be prompted to confirm this operation, because it
cannot be undone.
Rename
This turns the current selected item name into edit mode. To modify the name, just enter a new name and press
the RETURNkey to confirm. Press the ESCkey to abort.
Copy
This copies the current selected item into the clipboard. It is only applicable to single folders and single items.
Folders will be copied recursively with all items and subfolders.
Paste
This pastes clipboard contents to the actual position.
Expand All
Expands the complete tree for the selected project/folder. All subfolders will be expanded.
Collapse All
Collapses the complete tree of the selected project/folder.
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Show Versions
The following commands are available for calibrations only:
Review
Opens the calibration wizard and lets the user review the calibration settings.
Edit Clone Copy
Direct editing of an existing calibration is not possible. This command will clone the existing calibration and open it
in the Calibration Model Wizard for editing purposes. Please review the Edit Clone Copy of Calibration command in
the chapter commands.
Remove
Deletes the calibration from the project  please review the Remove Calibration command in the chapter commands.
Export
Exports the calibration  please review the Export Calibration command in the chapter commands.

Project toolbar
The project toolbar is only available in the project explorer. It provides shortcuts to the most common commands being
used with projects and related data.
The following toolbar icons are available:
Toolbar
icon

Action

Creating a new project

Opening a project

Closing a project

Adding data from directory

Adding files to a project

Removing an item from a project

Creates a new folder within the current project

Removes the current selected folder from the project

Project tree
Analytical data, documents of foreign applications and any additional information can be organized in projects in the
software. These projects can be compared to a briefcase, where related data is packed together in one file.
The contents of a project are shown in the project tree view of the project explorer with their original file icons and file
names. Some extra icons are available for known spectrum types and molecules.

Folder
User defined organizational instances can be added to a project in form of folders and subfolders. These folders can be
organized like folders on you hard disc. Data is located in these folders according to your personal context.

Data type icons in the project tree
The following project tree icons are available for the different data types. Icons for external application data are not
included in the following list:
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Icon

Data type

Project

Folder

Molecule

IR spectrum

UV spectrum

3D spectrum

Calibration

Expandable Items
Expandable items are displayed with a + sign in front of the icon. Project and folder items are regular expandable items,
which will show the substructure/subfolders if the user clicks on the + sign. Additionally calibration items are expandable
and will show details of the calibration:

If the Security Module is activated and the Data Versioning option is enabled, regular spectrum items will also be
expandable and will show their complete history of modification. The user may access any previous version of the object:
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Project tree operations
The project tree is capable of many operations similar to the MSWindows explorer. The following operations can be
performed:
Create a project
Create new folder
Open a project
Rename a project
Close a project
Add files to a project
Remove files from a project
Drag and drop objects

Library explorer
Libraries are physical or virtual mass storage devices, wherein you can store and search analytical data and related
information.
The library explorer is the browser of your knowledge bases and shows the data inside your libraries. You can see
registered libraries and contents at a glance.
Libraries might be either located on your hard disc with several analytical data in directories and enclosed subdirectories
or in database systems connected to the application. Such database systems will be usually installed on separate servers
and a special communication protocol and access strategy is required.
Foreign database systems
The applications is equipped with a generic database interface, which allows easy and quick adaption to
proprietary database systems like Oracle, SQLServer or Sybase. So if you need to connect to such
database systems, do not hesitate to contact us. We will find a solution to connect you to your data.

Library explorer contents
The library explorer comprises the following contents:
Library tree
The library tree holds libraries and analytical data enclosed into libraries, predefined search queries and search
results.
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Library toolbar
The library toolbar holds shortcuts to the most common commands.

Open the library explorer
To activate the library explorer, please follow the instructions below:
1. From the Window menu, select the Library Explorer command.
2. The library explorer is opened at its previous location either as tab or as separate window on the application
workspace.

Close the library explorer
To close the library explorer, please follow the instructions.
To close the library explorer, please follow the instructions below:
1. Move the mouse pointer to the

icon next to the tab flags.

2. Click on the icon to close the current active tab of the tab group.

Library toolbar
The library toolbar is only available in the library explorer. It provides shortcuts to the most common commands being
used with libraries and virtual libraries.
The following toolbar icons are available:
Toolbar
icon

Action

Create library

Open library

Close library

Open directory as library
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Spectrum search

Text search

Library tree
Libraries, search queries and search results are administered in the software and organized in library explorer. All things
related to libraries are available here for review.

Libraries in the library tree
Analytical data will be found in particular library nodes beneath the
icons are available:
Icon

libraries node in the tree. The following library tree

Description

Library

Directory used as library (virtual library)

various
icons

Depending on the data type, various icons are used to show
spectral data underneath a library.

Analytical data underneath a directory as library

Next to the icon, the title of the object or node is shown respectively.

Search queries in the library tree
Predefined search queries will be found underneath the
search query tree icons are available:
Icon

predefined search queries node in the tree. The following

Description

Spectrum search

Text search

Next to the icon, the search parameters are shown in order to provide a quick information about the search conditions.

Search results in the library tree
Search results are displayed under a
available:
Icon

search result node in the tree. The following search query tree icons are

Description

Any search result
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Next to the icon, the query object, e.g. the name of a spectrum or the expression used in a text search are shown in
order to provide a quick information about the search conditions.

Library tree operations
The library tree is capable of many operations similar to the MSWindows explorer. The following operations can be
performed:
Create a library
Open a library
Close a library
Remove data from a library
Drag and drop search results
Search results can be moved to a project in the project explorer via drag and drop operation.

Quantify explorer
The quantify explorer provides a list of all calibrations that are available in the software. It will show all calibrations from
the loaded projects in the project explorer and all manually loaded/imported calibrations. In the quantify explorer the
user may enable the autoprediction function by activating the calibration checkbox for one or more calibrations or just
evaluate the current active spectrum in the data view.
The Quantify module can only be used together with the Project Administration Module!
Calibrations require a set of spectra, which need to be organized in a project. If you do not have access
to the project or quantify explorer in your software, please contact your provider for more information
about upgrades to your software.

Quantify explorer contents
The following components are available:
Quantify list
The quantify tree shows a list of all open calibrations. It provides a checkbox for each calibration. If the checkbox is
activated, all spectra that are loaded/activated will be automatically evaluated with the selected calibration. The
evaluation result will be display in a textbox in the spectrum view if the spectral data is compatible to the
calibration, otherwise no result will be shown. Please review the command Auto Prediction in the chapter
Commands for a detailed description.
Quantify toolbar
The quantify toolbar contains shortcuts to common menu commands for calibrations.
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Open the quantify explorer
To activate the quantify explorer, please follow the instructions below:
1. From the Window menu, select the Quantify Explorer command.
2. The quantify explorer is opened at its previous location either as tab or as separate window on the application
workspace.

Close the quantify explorer
To close the quantify explorer, please follow the instructions.
To close the quantify explorer, please follow the instructions below:
1. Move the mouse pointer to the

icon next to the tab flags.

2. Click on the icon to close the current active tab of the tab group.

Quantify toolbar
The quantify toolbar is only available in the quantify explorer. It provides shortcuts to the most common commands being
used with calibrations and related data.
The following toolbar icons are available:
Toolbar
icon

Action

Review a calibration

Remove a calibration

Evaluate data using a calibration

Import calibration model

Export calibration model

Quantify list
Analytical data is analyzed in the software following chemometric approaches using univariate or multivariate methods.
Such data will be collected in so called calibrations. In order to keep related data together, calibrations can be stored
together with spectra in a project. The Quantify Explorer provides a filtered overview of the actual calibrations of open
projects in the project explorer and all loaded calibrations.
The Quantify Explorer/List merely shows a list of all calibrations. Contents of a calibration are shown in the Project
Explorer list as expandable items. Please review the section Project Tree in the chapter Data Explorers/Project Explorer
for further details. The user may select a calibration in the list for further operations with Quantify Toolbar commands. The
autoprediction feature for spectra is activated by selecting the checkboxes of the calibrations in the list:
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Please refer to the section Auto predict data using a calibration in the chapter commands for further information.

Quantify list operations
All operations in the list are performed by using the Quantify Toolbar. Please review the section Quantify Toolbar for
further information.

Working with Data in the Workspace

Available tabs and tab groups in the software
Additional information and tools as well as various data explorers are available as tabs. Suitable collections of tabs are
available as tab groups.

Related Topics
Working with tab groups

Default tab groups
By default, the following tab groups are available:
Data explorers
Toolbox

Available tabs
The following tabs are available:
Labels tab
Properties tab
Mathematics tab
Audit trail tab
Molecule tab
Peak table tab
Diagnostics tab

Working with tab groups
Multiple tabs can be grouped to a tab group. This is helpful, if tabs are often used. The active tab of a tab group can be
toggled on request.
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Related Topics
Tab arrangement
Docking a tab to the application
Showing a tab as separate window
Restoring the last docking position
Restoring the last windowed position

Creating a tab group
To create a tab group, please follow the instructions below:
1. Move the mouse pointer over the tab flag of the desired tab you want to group to another tab.
2. Hold down the left mouse button and move the mouse pointer over the desired destination tab. While you move
the mouse, a drag icon is displayed.
3. If the mouse pointer is near the header of the destination tab, the shape of a dark grey rectangle with a tab flag
shows the destination docking position.
4. Release the left mouse button.
5. A new tab group is created and the tabs will be appended to the destination tab.

Docking a tab to a tab group
To dock a tab group, please follow the instructions below:
1. Move the mouse pointer over the tab flag of the desired tab you want to group to a tab group.
2. Hold down the left mouse button and move the mouse pointer over the desired destination tab. While you move
the mouse, a drag icon is displayed.
3. If the mouse pointer is near the header of the destination tab group, the shape of a dark grey rectangle with a tab
flag shows the destination docking position.
4. Release the left mouse button.
5. The tab will be appended to the destination tab group.

Removing a tab from a tab group
To remove a tab from a tab group, please follow the instructions below:
1. Move the mouse pointer over the tab flag of the desired tab you want to remove from a tab group.
2. Hold down the left mouse button and move the mouse pointer to any destination. While you move the mouse, a
drag icon is displayed.
3. Release the left mouse button.
4. The tab will be removed from the tab group and is now shown at the new destination.
Removing a tab by closing the tab
A tab can also be removed from a tab group by closing the tab.

Changing the tab order
To change the tab order, the desired tab must be moved within a tab group to a new destination. Please follow the
instructions below to perform this operation:
1. Move the mouse pointer over the tab flag of the desired tab you want to move within a tab group.
2. Hold down the left mouse button and move the mouse pointer to any destination along the tab flags.
3. While you move the mouse, a drag icon is displayed.
4. Whenever a suitable destination position for the tab is reached, the shape of a dark grey rectangle with a tab flag
is displayed.
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5. Release the left mouse button to apply the destination position.

Data explorers
Data explorers provide an optimal overview over user data and allows you to organize and access your data as known
from the MSWindows explorer. These data explorers are collected in a tab group, which is shown in the top right corner
of the application by default.
The software provides the following data explorers:
Project explorer
Library explorer
Quantify Explorer

Toolbox
A toolbox is a collection of tabs that have been combined to a tab group. The toolbox comprises the following tabs:
Labels tab
Properties tab
Mathematics tab
Audit trail tab
Molecule tab
Peak table tab

Tabs

Audit trail tab
The audit trail tab shows the audit trail of the current active object in a table. This is very important for people working in
regulated environments following the FDA or GXP guidelines. The audit trail is compliant to CFR 21 part 11 regulations.
All of the following objects may have an audit trail:
2D data object
3D data object
Molecules
Project in the project explorer
Audit Trail entries cannot be modified!
Audit trail entries are created automatically by the software and they cannot be modified or removed by
the user.

Audit trail tab example
The following figure shows the audit trail of a 2D data object, that has been manipulated by several mathematical
functions:
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Labels tab
The labels tab holds all available labels of the current active object. The user might edit any field of the table to modify
the label name or the label value. New labels can also be created. Changes will be finally applied, if the object is stored
next time. Additionally the user can customize the labels tab to only show certain labels.

Labels tab example
In the following figure, a typical labels tab is shown from a 2D data object:

Labels tab description
Labels are presented in a table view as shown in the figure above.
Each label has a name, which is displayed in the "N ame" column of the table on the left. Corresponding values are shown
in the "Value" column of the table on the right. If multiple values are available for one label, they are displayed as comma
separated list.

Modification of Labels
The value of a label can be modified just by clicking with the Left Mouse button into the desired field of the table. A new
value can be entered or the current value can be edited.

Creating new labels
New labels can be created just by clicking with the Left Mouse button into the empty row at the bottom end of the table.
The row will be initialized with the [Null] name and value. It can be modified by the user. After finishing modifications, a
new empty row appears.
Customizing the labels tab
The user can customize the labels tab to only show selected labels. Some data objects might contain a large amount of
attached labels and displaying all of them would make it difficult to find the necessary information. By clicking into the
labels tab with the Right Mouse button the Select Labels Dialog will be shown. The dialog enables the user to select the
labels that will be shown in the tab, to change the order of appearance and to add new labels. Please follow the above
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link to find out more about the Select Labels Dialog.

Mathematics tab
The mathematics tab holds the parameters of the current selected mathematical function. A list of all applicable
mathematical functions is available in the drop down box on top of the tab.
Some of the mathematical functions are not available!
In the drop down list, only applicable mathematical functions for the current active object are shown in
alphabetical order.

Mathematics tab example
In the following figure, a mathematics tab with the normalization function selected is shown. The user may adjust the
normalization parameters and press the Calculate button to apply the function:

Molecule tab
The molecule tab contains one molecule linked to the current active object in the application workspace. In most cases, a
spectrum of a compound and a respective molecule must be shown together at a glance. The spectrum is shown in the
application workspace and the related molecule is shown in the molecule tab then.
Otherwise it remains empty.
Molecule as main object!
If the molecule itself is the main item of interest, it will be shown in the main application workspace and
not within the molecule tab.

Molecule tab example
The following figure shows a molecule representation of N,NDimethylAcetamide linked to the corresponding spectrum on
the main workspace:
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Peak table tab
The result of a find peaks operation in the software is a peak table. It contains a collection of peaks and related
properties. The peak table tab is used to present the peaks to the user. Visibility of peak table columns can be
customized.

Peak table tab example
The peak table looks like this:

See also
Working with tabs

Properties tab
The properties tab contains detailed information about the current active object in the application workspace. This data
cannot be changed by the user, because it contains elementary property information, like the file name.
The contents of this tab strongly depend on the current active object and its data format or object type. Properties are
presented in a table with particular categories, which can be expanded or collapsed on request.

Properties tab example
In the figure below, e.g. the properties of an IR spectrum of N,NDimethylAcetamide are displayed:

EN

56 . Main Software Manual

Properties tab description
The spectrum comprises some general information like the file name and the file location as well as the displayed name of
the object, which might be different from the file name.
Furthermore it contains two spectral axes with related properties given in separate categories.
By selection of a row within the properties table, a related help description is shown on the bottom end of the table.
The user is free to toggle the property view from a section wise view to an alphabetical view and vice versa using the
buttons in the top left corner of the tab.

Tab operations

Working with tabs
Any analytical data, related information, data explorers and toolbox items are available on so called tabs, which have a
lot of properties making arrangement of visible items very convenient to the user.

Related Topics
Available tabs in the software
Tab arrangement
Tabs can be dragged and dropped from their original position to a new user defined position within the application
workspace area.
Tab display options
Tab keyboard and mouse controls

Tab properties
Particular text, graphical information, data explorers or toolbox items are displayed in an area on the application
workspace, being surrounded by a border. On one edge (mostly on top or bottom) next to the border, there is a flag with
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a meaningful description of the contents of the area. Mostly this is the name or subject of the object, information or tool
box item currently displayed in there.
Example:

In the figure above, two tabs are available. The active tab is highlighted, indicated by the darkgrey background and bold
font style of the flag caption.
The highlighted tab contains the IR spectrum of 1Methyl2Pyrrolidinone. The IR spectrum is shown within the tab area
including spectral axes. The name of the spectrum is displayed as flag caption.
There is a second tab in the back, which holds another spectrum of N,NDiEthylAcetamide.
The flags provide a quick overview of currently available information and let the user easily find and activate the topic of
interest.

Tab arrangement
Tabs are attached to one of the edges of the parent application by default. They can be docked to one of the four edges
of the application. Docked tabs can also be torn off the parent's edges. In this case, they will be shown as separate
window.

Docking a tab to the parent window
To dock a tab to a new position within the parent application, please follow the instructions below:
1. Move the mouse pointer over the tab flag of the desired tab you want to move.
2. Hold down the left mouse button and move the mouse pointer to new the desired new position. While you move
the mouse, a drag icon is displayed.
3. If the mouse pointer is near a new possible docking position, a dark grey rectangle shows the destination docking
position. Possible docking positions are
Left edge
Right edge
Bottom edge
Top edge
4. Release the left mouse button and the tabs will be arranged anew instantly.
Restoring the original tab location during movement
If the mouse pointer resides over the center position of the current view, the dark grey rectangle
surrounds the whole view. In this case the current view will be restored.

Showing a tab as separate window
To show a docked tab as separate window, please follow the instructions below:
1. Move the mouse pointer over the tab flag of the desired tab you want to move.
2. Hold down the left mouse button and move the mouse pointer away from the current location until a grey rectangle

EN

58 . Main Software Manual
is displayed.
3. Release the left mouse button and the tab will be displayed as separate window.

Restoring last docked position of a tab
This option is only available, if a tab is displayed as separate window!
To restore the last docked position of the tab, please follow the instructions below:
1. Move the mouse pointer over the window header.
2. Double click on the header to restore the last used docking position

Restoring last windowed position of a tab
This option is only available, if a tab is displayed as docked tab!
To restore the last windowed position of the tab, please follow the instructions below:
1. Move the mouse pointer over the tab header.
2. Double click on the header to restore the last used window position

Tab display options
The following tab display options are available in the software:

Showing and hiding tabs
The software tabs can be shown or hidden on user demand. By default a predefined set of tabs is shown. They appear
docked to the edges of the parent application.
Show a tab
To show the desired tab, please follow the instructions below:
1. Select the Windows menu. It holds all available tabs in the software.
2. Click on the menu entry of the desired tab.
3. The tab will be opened on its last recognized position.
Hide a tab / close a tab
Tabs cannot be hidden, but they can be closed like windows. To close a tab, please follow the instructions below:
1. Click on the tab to be closed to activate it.
2. Now click on the

icon on the upper right corner of the tab to close it.

Autohide functionality for docked tabs
All tabs docked to the parent application support the autohide function. Tabs, which are actually not in use, will be
collapsed automatically in order to maximize the visible client area to other topics of interest.
The autohide function for tabs can be activated and deactivated as described in the following:
Activate the autohide function for a tab
1. Click on the tab to be collapsed to activate it.
2. Now click on the

icon on the upper right corner of the tab to activate it.

3. The tab will be automatically collapsed, if the mouse pointer moves away from it. Just a tab label remains visible to
the user.
Deactivate the autohide function for a tab
1. Move the mouse pointer next to the tab label.
2. The tab is expanded to its default extend.

EN

Main Software Manual . 59

3. Now click on the

icon on the upper right corner of the tab to deactivate the autohide function.

4. The tab is now show at its previous position again.

Tab keyboard and shortcut controls
Tab control by keyboard
Default keyboard shortcuts to control tabs are given in the following:
Keyboard shortcut

Action

CTRLTAB

Toggles to the next open tab in the current focus.

SHIFTCTRLTAB

Toggles to the previous open tab in the current focus.

CTRLF4

Closes the current active tab.

Tab Control by mouse Control
In the right or left corner next to the tab flags, there are some icons for controlling tabs as described in the following.

Toggle to the next open tab
To toggle to the next open tab of a tab group, please follow the instructions below:
1. Move the mouse pointer to the

icon next to the tab flags.

2. Click on the icon to toggle to the next open tab of the tab group.

Toggles to the previous open tab
To toggle to the previous open tab of a tab group, please follow the instructions below:
1. Move the mouse pointer to the

icon next to the tab flags.

2. Click on the icon to toggle to the previous open tab of the tab group.

Close the current active tab
To close the current open tab, please follow the instructions below:
1. Move the mouse pointer to the

icon next to the tab flags.

2. Click on the icon to close the current active tab of the tab group.

Sharing Data with other Applications

Copy and paste options
There are many possibilities to copy and paste items or objects in the software for many reasons. In general, the object
or item to be copied or pasted, will be transferred via the MSWindows clipboard. The object source may be the software
itself or a foreign application containing data of interest. The copied object or item will be available as different data types
in the clipboard, when copied from the software, so the user may select, which data type he will paste in a foreign
application. In most foreign applications, the Paste Special command is available, where the user can decide, how to
paste an object or item.
The following section gives an overview of objects and items, that can be copied and pasted.
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How to copy and paste?
Copy
Paste

What can be copied?
Copy object as internal object
Sometimes a user needs a copy of an object for a manipulation purposes without modifying the original object.
The object will be copied from the software and pasted back into the software again. In this case, the object already
exists with the same name.
An object copy, named 'Copy of...' will be created to avoid conflicts. This is a convention taken over from MSWindows
explorer.
Copy object as image
If the user copies an object into the clipboard, he may choose from the Paste Special function of a foreign application,
how to insert the object.
The object can be inserted as image in a predefined resolution and size. The image properties can be customized in the
Options dialog.
Copy object as text in JCAMPDX format
If the user copies an object into the clipboard, he may choose from the Paste Special function of a foreign application,
how to insert the object.
The object can be inserted as ASCII text in the JCAMPDX file type.
Copy selected text
Selected text can be copied into the clipboard as plain text or rich text as commonly used in other applications. The text
can be taken from any place in the software, where text, cells of a table, labels, names or properties can be edited.
Copy selected table
The contents of a whole table can be copied as tab separated text into the clipboard. After selection of the table, all
entries will be copied. For details, please refer to the chapter about working with tables.
Copy reports
If any reports are created in the software, e.g. a search report, they can be copied into the clipboard as well. This way
results can be transferred to foreign applications easily.

What can be pasted to the software?
Paste text
Text can be pasted from the clipboard into any editable field, e.g. into text fields, cells of a table, labels, names or
properties.
Analytical data in known file types
If an application is capable of transferring its native data format into the clipboard, it can be pasted as object into the
software without using a file. The file type must be known to the software to run this operation.

Drag and drop objects (general)
It is very easy to transfer objects within the software or from outside the software into this software using the drag &
drop functionality. The user can easily see, if the desired drag & drop operation is valid or not from the mouse pointer.
The following drag & drop operations are supported in the software:
Project explorer
1. Moving an object from one to another folder within the same or a different project.
2. Moving an object from one project to another.
3. Adding an object from the data view to a project.
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4. Adding a file from outside the application into a project.
5. Adding an object of the project into a data view to join data with already opened items.
6. Moving search results from the library explorer into a project.
Library explorer
1. Inserting an object into a library.
2. Searching an object in a library.
3. Searching an object using a predefined search.
Data views
1. Open an object in a data view from inside or outside the software.
2. Adding an object to a data view containing data of the same data type.
3. Moving data from a data view into another one.
4. Moving data into a project.
5. Adding data to a library.
6. Searching data in a library.

Move objects with drag & drop
To move an object with drag & drop, please follow the instructions below:
1. Move the mouse pointer over the object you like to move.
2. Hold down the left mouse button.
3. Move the mouse pointer to the destination with the left mouse button held down.
4. Release the left mouse button to complete the operation.

Working with tables
Tables are often used in the software to show data in a suitable manner to the user. E.g. the search results or the
properties and labels as well as all the preferences dialogs are shown in tables.
Whenever a table is shown in the software, one or more of the following options are available. The table must be visible
to the user, when performing the following operations:

Select a cell in the table
To select a cell in a table, please follow the instruction below:
1. With the Left mouse button click on the cell you would like to select.
Only selection of rows is possible!
In some tables, it is only possible to select complete columns or rows. In this case, selection and editing
of single cells is not possible.

Select the table
To select the table, please follow the instruction below:
1. With the Left mouse button click on one of the column headers.
2. The table is sorted by this column and it is automatically selected.

Edit a cell in the table
To edit the contents of a cell in a table, please follow the instructions below:
1. With the Left mouse button click on the cell you would like to edit.
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2. The cell is entered for editing automatically and contents are highlighted.
3. Enter a new value.
4. Press the RETURN key.

Sort table by column
To sort a table in ascending or descending order of values in a column, please follow the instructions below:
1. With the Left mouse button click on the header of the column you would like to sort.
2. The column is sorted ascending.
3. Click again to sort the column descending.
Tip: The sort status of the column is shown on the right side of the column header. An Arrow down symbol indicates,
the column is sorted descending and an arrow up symbol indicates, the column is sorted ascending.

Copy selection into clipboard
To copy the selection into the clipboard, please follow the instructions below:
1. With the Left mouse button click on the item you would like to copy.
2. Use either the keyboard shortcut for copying or from the Edit menu, select the Copy command.

Copy the table into the clipboard
To copy the whole table into the clipboard, please follow the instructions below:
1. With the Left mouse button click on a Column Header.
2. From the Edit menu, select the Copy Full... command.

Paste from clipboard into cell
To paste contents from the clipboard into a cell, please follow the instructions below:
1. Go to the application or location containing the text you would like to transfer.
2. Select the text you would like to transfer.
3. Copy the text into the clipboard.
4. Switch to the destination software.
5. Edit the cell you would like to change.
6. Paste the contents into the cell, either using the keyboard shortcut or from the Edit menu, select the Paste
command.

Add new rows in a table
To add new rows in a table, please follow the instructions below:
1. Click with the Left mouse button into the empty row at the bottom end of the table.
2. The row will be filled with default values (null).
3. Edit each cell to your requirements.
Why is the command not available with some tables?
In some tables, it is not possible to add new entries rows because data must not be changed.

Remove rows from a table
To remove rows from a table, please follow the instructions below:
1. Click with the Left mouse button into the row you would like to remove.
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2. Press the DEL key.

Printing
This chapter contains following topics:
Print layout templates
Basic print layout
General object print layout properties
Print layout placeholders
Print Layouts Templates

Print layout templates
The software is capable of printing objects and related information like labels, properties, an audit trail etc. to your
default printer using predefined print layout templates. Print layout just means, that components, e.g. the spectrum plot,
properties, labels and all related information on the object you like to print, are arranged on a piece of paper in a
predefined manner.
A basic print layout defines the overall look of the final report. Herein header and footer information as well as some body
settings can be adjusted. The final report body is filled with object specific details, which might be further customized in
the general object properties and some object type dependent properties (see below). For various object types,
separate print layout properties are available:
2D spectrum print layout properties
3D spectrum print layout properties
Molecule print layout properties
Search report layout properties
Colorimetrics result print layout properties
Calibration report layout properties
Calibration Evaluation report layout properties
Instrument Validation report layout properties
Spectrum Analysis report layout properties
Signal to noise report layout properties
IR/RAMAN Interpretation result layout properties
The Print Layout dialog combines all customizable options for available object types into a print layout template,
accordingly. It offers a set of print layout templates with a preconfigured settings for various objects, which might be
customized by the user.

Basic print layout
Each print layout contains a set of basic layout options, defining a header, footer, body and logo. These basic print layout
components are available in all print layout templates. The contents will be printed on all pages of the final output. Body
contents might span over multiple pages. The body is surrounded by header and footer, whereby the header and footer
are the same on each page and need to be customized just once.

Print layout header
A predefined area on top of the piece of paper is preserved for the header and information enclosed. The following
settings are available in the header:
Print header
This option toggles printing the header on or off.
Yes
A header with information adjusted below will be printed.
No
A header will not be printed and the preserved area is added to the print layout body.
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Print header line
This option toggles printing a horizontal line as separator on the bottom of the header on or off. A horizontal line is
a visual separator of header and body contents.
Yes
a horizontal line is printed to separate the header from the body text.
No
no separator is printed.
Text left
A free text can be entered here, which need to be displayed aligned left in the header. The text is meant to be a
simple ASCII text and the font as well as the font size or color cannot be changed. The text might include print
layout placeholders, e.g. for the current date or time.
Text center
A free text can be entered here, which need to be displayed centered vertically in the header. The text is meant to
be a simple ASCII text and the font as well as the font size or color cannot be changed. The text might include print
layout placeholders, e.g. for the current date or time.
Text right
A free text can be entered here, which need to be displayed aligned right in the header. The text is meant to be a
simple ASCII text and the font as well as the font size or color cannot be changed. The text might include print
layout placeholders, e.g. for the current date or time.

Print layout logo
A company logo or any other image might be printed in the top right corner of the piece of paper. The logo is
automatically included into the print layout header. The following settings for a logo can be adjusted:
Print logo
This option toggles printing the logo on or off.
Yes
the logo will be printed and the preserved area is added to the print layout header.
No
no logo is printed
Logo (file)
The full path and file name to the logo or image must be entered here. You can also navigate to a path and choose
a file by clicking on the
icon at the right side of the text field. A File Open dialog is opened, where you may select
an appropriate image file.
Logo text
A free text can be entered as rich text. By clicking into the text field and then on the
icon, a Rich Text Editor
dialog is opened, where you might enter a text, which is displayed next to the logo. The text might include print
layout placeholders, e.g. for the current date or time.

Print layout footer
A predefined area at the bottom of the piece of paper is preserved for the footer and information enclosed. The following
settings are available in the footer:
Print footer
This option toggles printing the footer on or off.
Yes
a footer is printed with all adjusted information
No
the footer will not be printed and the preserved area is added to the print layout body.
Print footer line
This option toggles printing a horizontal line as separator on the bottom of the footer on or off. The horizontal line
is a visual separator of footer and body contents.
Yes
a horizontal line is printed to separate the footer from the body.
No
no separator is printed.
Text left
A free text can be entered here, which need to be displayed aligned left in the footer. The text is meant to be a
simple ASCII text and the font as well as the font size or color cannot be changed. The text might include print

EN

Main Software Manual . 65
layout placeholders, e.g. for the current date or time.
Text center
A free text can be entered here, which need to be displayed centered vertically in the footer. The text is meant to
be a simple ASCII text and the font as well as the font size or color cannot be changed. The text might include print
layout placeholders, e.g. for the current date or time.
Text right
A free text can be entered here, which need to be displayed aligned right in the footer. The text is meant to be a
simple ASCII text and the font as well as the font size or color cannot be changed. The text might include print
layout placeholders, e.g. for the current date or time.

Spectral image
All data like spectra and plots are printed as images. Their size and print resolution can be adjusted to meet the best
print quality required. The following parameters can be adjusted:
Image height percentage
This parameter controls the height of the image within the body of the printed page. The height must be given in percent
of the whole body/page height. The current zoom region will be rendered into an image of the given size.
Image width percentage
This parameter controls the width of the image within the body of the printed page. The width must be given in percent of
the whole body/page width. The current zoom region will be rendered into an image of the given size.
The spectrum does not fit into the page and multiple empty pages are created!
In case the printer resolution is lower than the resolution of the image given by the height and width
parameter, the spectrum image will be scaled to fit the page automatically. In this case, some empty
pages might be produced by the printer automatically.
To overcome this problem, please adjust the spectrum height and spectrum width parameters to match
the printer resolution.
Keep aspect ratio
The aspect ratio ensures the image will either be stretched to match the given height and width or not. The following
parameter settings are available:
Yes
The original aspect ratio is kept. The image is scaled to match the specified height. The width is recalculated
automatically from the original ratio of height and width. Thus the Image width parameter is ignored in this case.
No
The image is scaled to the specified height and width without keeping the original image aspect ratio. This means,
the image might be streched either in horizontal or vertical direction or both.
Image resolution
This parameter controls the final resolution of the image in dpi units (dots per inch). The monitor screen resolution is
typically 72 dpi, whereas the default printer resolution is typically 150 dpi up to 1200 dpi.
Be careful with high resolution!
The image resolution must be carefully chosen. The print preview or printing process will slow down
significantly the higher the resolution is chosen. Secondly the request for memory is very high, too.
Therefore high resolutions should only be used with very powerful computers and corresponding
printers. Otherwise resolutions up to 300 dpi will be sufficient.
Horizontal alignment
The horizontal alignment controls the final horizontal position of the image in the page body. The following alignments are
available:
Center
The image is horizontally centered in the page.
Left
The image is aligned left.
Right
The image is aligned right.
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Signature
This option toggles printing of a signature line at the bottom of the report. It contains the operator name, the department
(both options can be during installation or via the optionsdialog) and a blank line for the handwritten signature. Future
version will additionally offer the option of printing a digital or electronic signature.
Yes
A signature line will be added at the bottom of the layout, holding the operator name, department and a blank line
for signing.
No
The signature will be omitted from the layout.

Print layout body
A predefined area in the center of the piece of paper is preserved for the body and information enclosed. This area is
preserved for the specific objects and related information available in the software, which need to be printed.
Thus, these additional components that need to be adjusted for printing as well. The basic print layout components are
combined with one of the following objects to a final print layout template.
2D data objects
3D data objects
Molecule objects
Search result object
Colorimetric report object
Chemometric report object
Signal to Noise Report
IR Interpretation Result

General object print layout properties
Whenever one or more objects need to be printed, related information might be printed as well. The general object
properties are used to adjust print options for related object properties.
The following parameters can be adjusted for objects:

Audit trail print layout property
This flag toggles printing of the audit trail on or off when an object is printed.
Yes
the audit trail of an object is included as separate block into the print layout body. For each available object that is
printed, a separate block is added.
No
the audit trail is not printed.

Labels print layout property
This flag toggles printing of Labels on or off when an object is printed.
Yes
labels related to an object are included as separate block into the print layout body. For each available object that
is printed, a separate block is added.
No
no labels are printed.

Properties print layout property
This flag toggles printing of Properties on or off when an object is printed.
Yes
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properties related to an object are included as separate block into the print layout body. For each available object
that is printed, a separate block is added.
No
no properties are printed.

Peak table print layout property
This flag toggles printing of peak table on or off when an object is printed.
Yes
a peak table related to an object are included as separate block into the print layout body. For each available
object that is printed, a separate block is added.
No
no peak table is printed.

Print multiple objects sorted
This flag is only used, when multiple objects will be printed. In this case it toggles sorted printing of objects and related
information on or off.
Yes
the object and the whole set of related information are printed at once, before the next object and its related
information are applied.
No
all objects are printed together, followed by the properties sorted by the property type. The information are
included as separate blocks into the print layout body. For each available item that is printed, a separate block is
added.
What happens if one of the general object properties is missing?
Notwithstanding the flag status, the missing property is ignored for printing.

Print layout placeholders
In all ASCII text fields or in the rich text editor dialog, placeholders can be used that represent particular information
being updated with actual values on generation of the final printout. E.g. the current date and time can be entered using
a placeholder.
Why do I see different placeholders in special context?
Placeholders are filtered according to the current context. Only applicable placeholders are shown. To get an
overview of the currently available placeholders simply open the context menu by rightclicking into the
editor text field. A list of all available placeholders will be shown. Placeholders can be directly selected from the
context menu by leftclicking.

Placeholder syntax
Placeholders must be entered using the following syntax:
1. Enter a smaller than symbol (<) to indicate the starting of a placeholder.
2. Enter the name of the placeholder
3. Enter a greater than symbol (>) to indicate the end of a placeholder.

Placeholder syntax example
<PLACEHOLDER_NAME>

Fixed placeholders
A list of all available placeholders in the software is given in the following:
<Date> placeholder
Inserts the current date string according to the regional settings of the operating system.
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<DateTime> placeholder
Inserts a long date and time according to the regional settings of the operating system.
<Department> placeholder
Inserts the name of the department. The department can be customized in the Options dialog.
<Objectname> placeholder
Inserts the name of object to be printed.
<Operator> placeholder
Inserts the current operator using the software. The operator can be customized in the Options dialog.
<Page> placeholder
Inserts the current page number in the report.
<Page {0} of {1}> placeholder
Inserts the current page number into the variable {0} and the total number of pages of a report into the variable {1} in
the report.
<Projectname> placeholder
Inserts the name of the current project.
<Time> placeholder
Inserts the current time string according to the regional settings of the operating system.
<Unique Identifier> placeholder
Inserts a unique identifier number.

Labels as placeholders
For all analytical data objects like 2D and 3D data objects as well as molecules, labels attached to the object can be
addressed using a placeholder named like the label.
Example:
<LABEL_NAME>
For easy access to all available labels of an object simply rightclick into the text field. A popup window will show all
labels and by selecting a label with a leftclick the corresponding label name and placeholder will be automatically copied
to the text field.

Object properties placeholders
When printing spectrum objects, all available object properties can be added to the printout by activating the Print
Properties flag. Single properties can be easily printed by using placeholders. Simply add a placeholder with the exact
object property name to the desired text field. The available object properties for a certain object are listed in the
properties tab of the software. Since the object properties are organized in categories, the general syntax for adding a
property placeholder looks like this:
<CATEGORY.NAME>
Example: Available properties are for example the name of the object which resides in the category "General" and the x
Axis resolution which resides in the category "XAxis". The corresponding placeholders look like this:
<GENERAL.NAME> will print the object name.
<XAXIS.AXIS RESOLUTION> will print the resolution of the objects xAxis.

Search quality placeholder
A special placeholder is available when printing the results of a spectrum search. All objects of the search result will have
an additional label which holds the search quality:
<SEARCHQUALITY>
Adding this placeholder to one of the printout text fields will print the search quality value of the corresponding object.

EN

Main Software Manual . 69

What happens, if the label does not exist for the current printed object?
In this case, the label remains empty and the report is printed without filling the label.

Print Layouts Templates

Spectrum print layout template
In addition to the basic print layout properties and general object properties, some individual properties can be adjusted
for 2D data objects, that need to be printed.

Spectrum print layout properties
The following specific 2D data object print layout properties can be customized:
Print spectrum
This flag toggles printing one or more spectrum objects on or off.
Yes
One or more spectrum objects are printed according to their current visible view port of the 2D data view. The size
of the bitmap to be printed, can be adjusted in the Image parameters.
No
no spectrum is printed.
Spectrum caption
A free ASCII text might be printed as caption on top of the spectrum output, e.g. the title of the spectrum might be shown
here. The user is free to enter a text including print layout placeholders.
Yes
a spectrum caption is printed.
No
a spectrum caption is not printed.
Spectrum underline
A free ASCII text might be printed as underline on the bottom of the spectrum output, e.g. a remark or some additional
measurement parameters according to the spectrum might be shown here. The user is free to enter a text including print
layout placeholders.
Yes
a spectrum underline is printed.
No
a spectrum underline is not printed.
Legend
The legend showing the spectrum names and color indicators can be printed for the spectra in the current data view.
Yes
a legend is printed.
No
a legend is not printed.

3D spectrum print layout
Notwithstanding the basic print layout properties and general object properties, some individual properties can be
adjusted for 3D data objects, that need to be printed.

Spectrum print layout properties
The following specific 3D data object print layout properties can be customized:
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Print 3D spectrum
This flag toggles printing one or more spectrum objects on or off.
Yes
a 3D spectrum object is printed according to their current visible view port of the 3D data view. The size of the
image to be printed, can be adjusted in the Image parameters.
No
no 3D spectrum is printed.
3D spectrum caption
A free ASCII text might be printed as caption on top of the 3D spectrum output, e.g. the title of the 3D spectrum might be
shown here. The user is free to enter a text including print layout placeholders.
Yes
a 3D spectrum caption is printed.
No
a 3D spectrum caption is not printed.
3D spectrum underline
A free ASCII text might be printed as underline on the bottom of the 3D spectrum output, e.g. a remark or some
additional measurement parameters according to the 3D spectrum might be shown here. The user is free to enter a text
including print layout placeholders.
Yes
a 3D spectrum underline is printed.
No
a 3D spectrum underline is not printed.
Legend
The color coded area showing the intensity range can be printed as a legend together with the 3D data object.
Yes
a legend is printed.
No
a legend is not printed.

Colorimetric result print layout
Notwithstanding the basic print layout properties and general object properties, some individual properties can be
adjusted for a colorimetric result , that need to be printed. The report consists of diagrams and a text report.

Print colorimetric diagrams
The following colorimetric diagram print layout settings can be adjusted:
Print diagrams as displayed
This flag toggles printing the all available diagrams as displayed on or off.
Yes
all available diagrams will be printed in one block. They will be aligned automatically to fill the space of the block.
No
only selected diagrams will be printed. They will be aligned automatically to fill the space of the block.
Printing all diagrams as displayed!
If this flag is set true, the flags for individual printing of single diagrams can not be altered. Please set
this flag to false to perform modifications.
Print color gamut
This flag toggles printing the CIE color gamut on or off.
Yes
the CIE color gamut is printed together with the other activated diagrams in one block.
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No
the CIE color gamut is not printed.
Print L*a*b* diagram
This flag toggles printing the L*a*b* diagram on or off.
Yes
the L*a*b* diagram is printed together with the other activated diagrams in one block.
No
the L*a*b* diagram is not printed.
Print Hunter L*a*b* diagram
This flag toggles printing the Hunter L*a*b* diagram on or off.
Yes
the Hunter L*a*b* diagram is printed together with the other activated diagrams in one block.
No
the Hunter L*a*b* diagram is not printed.
Print L*u*v* diagram
This flag toggles printing the L*u*v* diagram on or off.
Yes
the L*u*v* diagram is printed together with the other activated diagrams in one block.
No
the L*u*v* diagram is not printed.

Print colorimetric result
The colorimetric result is a text report containing the results of the colorimetric analysis.
The following colorimetric result print layout settings can be adjusted:
Print colorimetric report
This flag toggles printing the text of the colorimetric report on or off.
Yes
the results of the colorimetric analysis or color comparison are available as text and will be printed.
No
no text results are printed.
Print spectra
This flag toggles printing one or more spectrum objects that have been analyzed on or off.
Yes
One or more spectrum objects are printed according to their Spectrum print layout properties settings.
No
no spectrum is printed.

Calibration Evaluation/Calibration report print layout
In addition to the basic print layout properties and general object properties, some individual properties can be adjusted
for a chemometric result that needs to be printed. The report consists of diagrams and a text report.

Chemometric results
The following chemometric result properties can be adjusted for printing:
Print Result Plots
This parameter controls printing for any result plots provided by the calibration method. Printing those plots can be
enabled or disabled here.
Yes
all available plots will be printed.
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No
none of the plots is printed.

Chemometric report
The following chemometric report properties can be adjusted for printing:
Print Result Reports
This parameter controls printing for any result report provided by the calibration method. Printing those reports can be
enabled or disabled here.
Yes
all available reports will be printed.
No
none of the reports is printed.
Print Table Borders
This parameter controls printing of table borders for any tables in result reports provided by the calibration method.
Yes
all available tables will be printed with borders around the cells.
No
no borders are printed.

Molecule print layout
Notwithstanding the basic print layout properties and general object properties, some individual properties can be
adjusted for molecules, that need to be printed.

Molecule print layout properties
The following molecule print layout properties are available:
Print molecule
This flag toggles printing one or more molecule objects on or off.
Yes
One or more molecule objects are printed according to their current visible view port of the 2D data view. The size
of the image to be printed, can be adjusted in the image parameters.
No
no molecule is printed.
Molecule caption
A free ASCII text might be printed as caption on top of the molecule output, e.g. the title of the molecule might be shown
here. The user is free to enter a text including print layout placeholders.
Yes
a molecule caption is printed.
No
a molecule caption is not printed.
Molecule underline
A free ASCII text might be printed as underline on the bottom of the molecule output, e.g. a remark or some additional
measurement parameters according to the molecule might be shown here. The user is free to enter a text including print
layout placeholders.
Yes
a molecule underline is printed.
No
a molecule underline is not printed.

Search result print layout
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In addition to the basic print layout properties and general object properties, some individual properties can be adjusted
for search result objects, that need to be printed.

Search result print layout properties
The following print layout properties for search results can be adjusted:
Print search result table
This flag toggles printing the search result table on or off.
Yes
the search result table including the library origin, hit quality and customized labels are printed in a result table.
The table is a separate block, which might cover multiple pages of the final report.
No
a search result table is not printed.
Print search parameter
This flag toggles printing the search parameters on or off.
Yes
the

search parameter are printed as separate block, which might cover multiple pages in the final report.

No
search parameters are not printed.
Print objects
This flag toggles printing one or more objects of the search results on or off. The query object will always be printed.
Yes
all selected search result objects and the query object are printed according to their current visible view port of the
2D data view. The size of the image to be printed, can be adjusted in the image parameters.
No
no objects are printed.
Search Quality
The search quality value for an individual search result can be printed by adding the Search Quality Placeholder to one of
the available ASCIIText fields in the layout. Please refer to the section "Print Layout Placeholders" for further information.

Menus Overview
The software provides a lot of options, manipulation tools and commonly used commands organized in menus and sub
menus.

Menus
Available menus and their commands are listed in the following. Please follow the links to see details:
File menu
Edit menu
Project menu
2D View menu
3D View menu
Library menu
IR Interpretation menu
Mathematics menu
Quantify menu
Scripting menu
Security menu
Tools menu
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Window menu
Help menu

Context sensitive menus
The software contains a lot of specific menus with related commands. Not all available menus are displayed all the time.
Only those menus are shown, which can be applied to the current active data object. This might be confusing the first
time a user works with the application, but the reduced set of menus provide the optimal working environment in the
actual context.
Available Menus
Depending on your license, some of the menus and commands might be missing, although required by the
current active object. To get more information how to obtain an update or upgrade of the software, please
contact our support service.

File menu
The file menu contains all required commands to handle files in the software. This means loading, saving or exporting,
and printing. Furthermore some more general commands are available to control printing.

File menu commands

The File menu provides the following commands:s
Open a file
Save a file
Save a s
Load Method
Save Method as
Save all
Send Data by Email
Page setup
Print layout
Print preview
Print
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Recent files
Exit

File Open dialog
The File Open dialog lets the user specify the drive, directory, and the name of a file to open. The following illustration
shows a typical explorerstyle File Open dialog box. The dialog may appear different on your computer, the actual
appearance depends on the operating system you are using.
An additional PreviewFunction may be activated in the submenu Options in the menu Tools. A preview of the selected
file will then be shown in the lower part of the dialog for quick evaluation purposes.

Opening a file
Any file types known to the software can be directly opened and their contents will be displayed after the file has been
opened successfully.
What happens to unknown file formats?
Files with an unknown file format cannot be displayed with the software, but such files can be added to
a project. If such a file is registered to any other application installed on your computer, you can open it
with the original application from your project .

Related Topics
Troubleshooting on opening files
Projects

File open menu command
To open a file via the application menus, please follow the instructions below:
1. From the File menu, select the Open command.
2. A File Open dialog is displayed.
3. Navigate to the file location on your hard disc or network neighborhood.
4. Select one or more files you like to open.
5. If the option FileOpenPreview is enabled in the Options Dialog, the selected file will be shown as preview.
6. Click the Open button.

File Open Keyboard Shortcut
Please refer to the list of keyboard shortcuts for details.

File Open Command Line Control
The application can be controlled from the command line. Please refer to the section "Command Line Control" for details.

File Save dialog
The File Save dialog lets the user specify the drive, directory, and the name of a file to open. The following illustration
shows a typical explorerstyle File Save dialog box:
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Save
Items that have been created in the software, e.g. a report or an object that has been modified, can be saved. Not yet
saved objects have an asterisk symbol (*) next to their name. After saving, the symbol vanishes.
What about saving a project and contents of a project?
Projects and file enclosed will not be saved using this command. On modification of projects and contents
inside, the whole project will be saved automatically.

The following saving strategies are supported in the software:

Save menu command
To save an object using the menu command, please follow the instructions below:
1. Activate the object, you like to save.
2. From the File menu, select the Save command.
Tip: If the object was created anew, a File Save dialog is opened, where you can choose a file name and a file
location. Otherwise the file is stored without user interaction.

Save keyboard shortcut
To save an object using the keyboard shortcut, please follow the instructions below:
1. Activate the object, you like to save.
2. Enter the key combination listed in the keyboard shortcuts.
Tip: If the object was created anew, a File Save dialog is opened, where you can choose a file name and a file
location. Otherwise the file is stored without user interaction.

Save as
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This command can be applied to an opened item in the software. E.g. a project, a file located in a project or a report can
be stored under a new name. Furthermore, files and reports can be exported into various file formats.
The operation is applied to the current selected item.

Save as menu command
To save the current active item as a file in a desired file format, please follow the instructions below:
1. Activate the item you want to save by clicking with the Left mouse button on it.
2. From the File menu, select the Save as... command.
3. A File Save dialog is displayed.
4. Navigate to the destination file location on your hard disc or network neighborhood.
5. Enter a valid file name.
6. From the File Types drop down box, select an appropriate file type.
7. Click the Save button.

Save as keyboard shortcut
None.

Save all
During working the user often modifies objects, changes to other objects and might forget, that he has changed some
objects previously. To make sure everything is saved before continuing to work, the user applies the save all command.
The user will be subsequently prompted to save all modified objects in the software. He is free to export the objects or
save them under a new name as well.
Saving all modified objects is performed as described in the following:

Save all menu command
To save all modified objects using a menu command, please follow the instructions below:
From the File menu, select the Save All... command.
Why is the Save all command inactive sometimes?
The Save All... command is only active in the menu, if any modified objects are available in the software.

Save all keyboard shortcut
To save all objects using the keyboard shortcut, please follow the instructions below:
1. Enter the key combination listed in the keyboard shortcuts.

Page setup dialog
Some default paper settings for printing your analytical data can be adjusted in this dialog. According to your printer
capabilities and to your own requirements for the output, you might adjust the paper size, margins and orientation. It is
also possible to adjust the default printer here.
The dialog looks like this:
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Page setup dialog contents
Paper settings
Paper size
To adjust the size of your paper in your printer, please select a suitable paper size from the Size drop down combo
box.
Just click on the
icon to expand the list.
Paper source
To adjust the tray in your printer, where the configured paper is found, please select a tray from the Source drop
down combo box.
Just click on the
icon to expand the list.
Paper orientation
Two orientations are available. Changes will be shown in the preview on top of the dialog.
Portrait orientation
Landscape orientation
Paper margins
Paper margins can be entered for each edge, separately. The default unit might change in different languages according
to your regional settings of the operating system.
You might enter margins for the following edges of your paper:
Left
Right
Upper
Lower
Default printer adjustment
The software always prints to the default printer in your operating system.

Print layout dialog
In this dialog, available print layout templates can be customized. The dialog looks like this:
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Selecting a print layout template
On the left side of the dialog, a list with all print layout templates available in the software is displayed.
Click on one of the print layout template icons to select it. The properties are updated automatically and will be displayed
on the right.
When selecting the Print Preview command, the corresponding Print Layout Dialog will be
automatically opened to enable instant adjustments to the print parameters!

Modifying a print layout template
To modify the properties of a print layout template, please follow the instructions below:
1. Click the desired print layout template icon in the list on the left of the dialog.
2. Modify the basic print layout properties
3. Modify the object specific print layout properties:
2D Spectrum print layout
3D spectrum print layout
Calibration report print layout
Colorimetrics result print layout
Calibration Evaluation/Calibration report print layout
Molecule print layout
RTF report print layout
Search result print layout
IR Interpretation report print layout
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Must I save changes?
No, any changes will be tracked and saved automatically when you leave the dialog.

Saving a print layout template
Usually there is no need to explicitly save a template since all changes to the print layout templates will automatically be
saved when the dialog is closed. If the user needs to use multiple different layouts he can save these by using the Save
as button.

Loading a print layout template
To load a user defined print layout template, please click on the

button and select a saved template.

Resetting a print layout template
If the user is not satisfied with the changes he can revert back to the default print layout template. Clicking on the Reset
button will reset all parameters to the default values.

Previewing a print layout template
If a corresponding data object is opened in the data view when invoking the print layout dialog, the Print Preview
button will be activated for the specific report type. Therefore the user can directly preview the changes in the Print
Preview Dialog. For example: If the print layout dialog is invoked while a 2D spectrum is opened in the data view, the
Print Preview button for the 2D spectrum layout template will be enabled. By clicking the button the user can preview
the 2D spectrum print layout in the preview dialog window.

Leaving the dialog
To leave the dialog, press the ESCkey or click on the

icon in the top right corner.

Print layout
There are many different data types available in the software, which need their own representation and specific tools on
the screen. Therefore, different print layouts must be also available for all these data types. A set of predefined print
layouts is always available, which can be customized to your demands.
For configuration of a print layout, choose one of the following options:

Print layout menu command
To modify a print layout using a menu command, please follow the instructions below:
1. From the File menu, select the Print Layout command.
2. The Print Layout dialog is opened.
3. Customize the print layout in the dialog.
4. Press the ESC key to leave the dialog. Modifications will be stored automatically.

Print layout keyboard shortcut
None.

Print preview dialog
The print preview presents the final print layout for the current active object before printing. From this preview the user
can see, how items are arranged on paper when printed out. Arrangement and customization of objects can be done in
the print layout. Current print parameter settings can be easily changed via the parameter window, which is opened
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together with the print preview dialog.
If the Print Parameter window is not opened automatically, this option needs to be activated in the
Options Dialog!

The print preview looks like this:

The corresponding print parameter dialog will be opened simultaneously and the user is able adjust and update
parameters instantly:
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Print preview
The print preview shows what the final printout on a piece of paper will look like. The print preview is shown for the
current active object in the software using a predefined print layout.
The print preview is shown as described in the following:

Print preview menu command
To show the print preview using a menu command, please follow the instructions below:
1. Activate the object you would like to see a print preview of by clicking with the Left mouse button.
2. From the File menu, select the Print Preview command.

Print preview keyboard shortcut
To show the print preview using a keyboard shortcut, please follow the instructions below:
1. Activate the object you would like to see a print preview

of by clicking with the Left mouse button.

2. Press the key combination listed in the keyboard shortcuts to print.

Print dialog
Before printing your analytical data, you may configure an appropriate print layout to get a suitable result on a piece of
paper. Finally you can print the result on your default printer or on another printer you might select from the print dialog
shown below:
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Print dialog contents
Printer settings
Changing the current printer is identical to the procedure for changing the default printer permanently. If you change the
printer here, the default printer will be only changed for this application.
Printed area
Adjust here, which pages you like to print. The user may only print a certain number of all available pages in the range.
The following options are available:
It is only possible to print all pages right now.
Number of copies and sorting
Adjust the number of copies you like to print in the spin box. Click the
copies.

icon to increase or decrease the number of

Enable the Sort checkbox if you like to sort pages as displayed in the dialog.

Print
If you would like to print the current active object, you may configure a suitable print layout first. This will help you to
arrange items on a piece of paper conveniently. Then configure a default printer for the application or use the default
printer of the operating system to print your active object. Then simply print the current active object by using one of the
following commands:

Print menu command
To print the current active object using the print menu command, please follow the instructions below:
1. Activate the object in the software you like to print with a Left mouse button click.
2. From the File menu, select the Print command.
3. The Print dialog is opened.
4. Adjust the printer settings in the dialog
5. Press the OK button to print.

Print keyboard shortcut
To print the current active object using the keyboard shortcut, please follow the instructions below:
1. Activate the object in the software you would like to print with a Left mouse button click.
2. Press the key combination listed in the keyboard shortcuts to print.
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Recent items
This submenu includes a number of recently opened files or projects or mathematical operation for your maximum
convenience.
If the user needs to reopen a file which has just been in use a short time ago, he can select this file directly from the
recent files submenu without time consuming navigation to its original location. The same applies to projects and
mathematical functions.
The list of recently used files, projects or mathematical functions will be updated automatically. Older items will be
removed after a certain time automatically. The number of recognized files, projects or mathematical functions can be
configured in the Options dialog.

Recent files menu command
To open a recently used file using a menu command, please follow the instructions below:
1. From the File menu, select the Recent Files submenu.
2. From the Recent Files submenu, select the file name of the file you like to open.

Recent projects menu command
To open a recently used project using a menu command, please follow the instructions below:
1. From the Project menu, select the Recent Projects submenu.
2. From the Recent Projects submenu, select the project file name of the project you like to open.

Recent mathematics menu command
To open a recently used mathematical function using a menu command, please follow the instructions below:
1. From the Mathematics menu, select the Recent Mathematics submenu.
2. From the Recent Mathematics submenu, select the file name of the file you like to open.

Exit
Closes the application. The current working environment is stored, so that you can continue working on next startup at
the same point.
What about modified files when closing the application?
The user is prompted for not yet saved files. He can either save them or discard changes.

Exiting the application is performed as described in the following:

Exit menu command
To exit the application using a menu command, please follow the instructions below:
1. From the File menu, select the Exit command.

Exit keyboard shortcut
To exit the application using a keyboard shortcut, please follow the instructions below:
1. Press the key combination listed in the keyboard shortcuts.

Edit menu
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The edit menu holds various commands for editing the current active object in the workspace. This can be a spectrum, a
molecule or just a text in a table or the table itself. Labels are also editable in the software. The edit menu contains
commands to copy and paste items to or from another application. Furthermore you might control an objects
modifications. You will be able to undo and redo operations.

Edit menu contents

The Edit menu provides the following commands:
Undo last operation
Redo last operation
Cut
Copy
Copies just the selected items into the clipboard.
Copy Full...
This copy option applies to all tables or property grids in the software. The user might copy not only particular cells
in a table, but the whole table or grid. In the example above, the whole search result grid is copied.
Paste
Remove
Removing files from a library or project...
Removal of objects from a library is available from the Library menu.
Removal of objects from a project is available from the Project menu.
These commands are separated, because the library module and the project administration module are not
available in all software packages. Please contact your software provider for details.

Undo
Sometimes the last operation applied to an object does not lead to the intended result. In this case, the user has the
opportunity to recover the object in its state before the last operation was applied.
Does the Undo command effect the audit trail of the object?
Yes it does. When undoing the last operation, the software restores the previous object state from an
internal cache. This means, the audit trail does not contain the operation, that has been undone.

The last operation can be undone as described in the following:

Undo menu command
To undo the last operation using a menu command, please follow the instructions below:
1. From the Edit menu, select the Undo command.
2. The previous state is restored.

Undo keyboard shortcut
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To undo the last operation using a keyboard shortcut, please follow the instructions below:
1. Press the key combination listed in the keyboard shortcuts.

Redo
Sometimes the undo operation applied to an object needs to be canceled. In this case, the user has the opportunity to
redo the last operation without adjusting all parameters again.
Does the Redo command effect the audit trail of the object?
Yes it does. When redoing the last operation, the software restores an operation and also the audit trail
entry.

The last operation can be reapplied as described in the following:

Redo menu command
To redo the last operation using a menu command, please follow the instructions below:
1. From the Edit menu, select the Redo command.
2. The previous state is restored.

Redo keyboard shortcut
To redo the last operation using a keyboard shortcut, please follow the instructions below:
1. Press the key combination listed in the keyboard shortcuts.

Copy
Objects, text, tables and other items of the software can be copied into the clipboard. For details, please refer to the
copy and paste opportunities available in the software.
Copy operation can be performed as described in the following:

Copy menu command
To copy an object or item into the clipboard using a menu command, please follow the instructions below:
1. Select the object or item you would like to copy.
2. From the Edit menu, select the Copy command.

Copy keyboard shortcut
To copy an object or item into the clipboard using a keyboard shortcut, please follow the instructions below:
1. Select the object or item you would like to copy.
2. Press the key combination listed in the keyboard shortcuts.

Paste
Objects, text and other items of the software or foreign applications can be pasted from the clipboard into the software.
For details, please refer to the copy and paste opportunities available in the software.
Paste operation can be performed as described in the following:

Paste menu command
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To paste an object or item from the clipboard using a menu command, please follow the instructions below:
1. Select the destination for the paste operation.
2. From the Edit menu, select the Paste command.

Paste keyboard shortcut
To paste an object or item from the clipboard using a keyboard shortcut, please follow the instructions below:
1. Select the destination for the paste operation.
2. Press the key combination listed in the keyboard shortcuts.

Project menu
This menu contains all applicable commands for projects. Creation and modification of a project is controlled here.

Project menu commands

Available Project menu commands are listed in the following:
New project
Open project
Close project
Add file to a project
Remove file from a project
Add data from folder
Remove data from folder
Add/Remove active object to a project
In the example shown above, an object called '4CHLORO2NITROPHENOL' would be removed from a project called
'DemoProject'.
The add or remove command toggles automatically according to the active object and active project.
Add all Objects in Window to Project
Sign Project (only available with activated security policy and data access control)
Protect Project / Unprotect Project
Recent projects

Create a Project
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Projects are displayed in the project explorer. A new project can be created as described in the following:

Create Project Menu Command
To create a new project using the menu command, please follow the instructions below:
1. From the Project menu, select the New command.
2. A File Save dialog is displayed.
3. Navigate to the destination file location on your hard disc or network neighborhood.
4. Enter a valid project file name.
5. Click the Save button.

Create Project Keyboard Shortcut
Please refer to the list of keyboard shortcuts for details.

Create Project Toolbar Ccommand
1. Open or activate the project explorer.
2. From the project explorer toolbar, select the

icon.

3. A File Save dialog is displayed.
4. Navigate to the destination file location on your hard disc or network neighborhood.
5. Enter a valid project file name.
6. Click the Save button.

Create Project Command Line Control
The application can be controlled from the command line. Please refer to the section "Command Line Control" for details.

Open a Project
Project files can be opened as described in the following:

Open Project Menu Command
To open a project file via the application menu, please follow the instructions below:
1. From the Project menu, select the Open command.
2. A File Open dialog is displayed.
3. Navigate to the project file location on your hard disc or network neighborhood.
4. Select the project file you would like to open.
5. Click the Open button.

Open Project Keyboard Shortcut
Please refer to the list of keyboard shortcuts for details.

Open Project Toolbar Command
1. Open or activate the project explorer.
2. From the project explorer toolbar, select the
3. A File Open dialog is displayed.
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4. Navigate to the project file location on your hard disc or network neighborhood.
5. Select the project file you would like to open.
6. Click the Open button.

Open Project Command Line Control
The application can be controlled from the command line. Please refer to the section "Command Line Control" for details.

Close a Project
If projects are no longer in work for the user, they can be closed to free the space in the project explorer for more
important projects. To close a project, please follow the instructions described below:

Close project menu command
To close a project file via the application menu, please follow the instructions below:
1. Open or activate the project explorer.
2. Select a project node in the tree of the project explorer.
3. From the Project menu, select the Close command.

Close project keyboard shortcut
None.

Close project context menu command
To close a project using the context menu on a selected project node, please follow the instructions below:
1. Open or activate the project explorer.
2. Select a project node in the project explorer tree.
3. Click the Right mouse button.
4. From the context menu, select the Close command.

Close project toolbar command
1. Open or activate the project explorer.
2. From the project explorer toolbar, select the

icon.

3. The project is closed automatically.

Add Files to a Project
The user is free to add any file into a project. These might be files, which can be directly opened and visualized with the
software or files, which can only be opened with external applications. All files can be collected and stored together and
organized in your projects.
Adding a file multiple times.
Filenames are unique within a project. Therefore, a file can only be added once into a project. It is not
possible to add multiple instances in e.g. different folders of a project.

Add Files Menu Command
To add files to a project or folder via the application menu, please follow the instructions below:
1. Select a project node or folder in the tree of the project explorer.
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2. From the Project menu, select the Add File(s)... command.
3. A File Open dialog is displayed.
4. Navigate to the file location on your hard disc or network neighborhood.
5. Select one or more files you would like to add to the current project or folder.
6. Click the Open button.

Add Files Keyboard Shortcut
None.

Add files Context Menu Command
To add files to a project or folder using the context menu on a selected project node, please follow the instructions
below:
1. Select a project node or folder node in the project explorer tree.
2. Click the Right mouse button.
3. From the context menu, select the Add File(s)... command.

Add Files Toolbar Command
1. Select a project node or folder node in the project explorer tree.
2. From the project explorer toolbar, select the

icon.

3. A File Open dialog is displayed.
4. Continue as described above.

Add Files Command Line Control
The application can be controlled from the command line. Please refer to the section "Command Line Control" for details.

Insert item into Project
The current active item or object can be inserted into a project via the following pathways:

Add object menu command
To add an object into a project using the menu command, please follow the instructions below:
1. Open the project explorer and expand the destination project.
2. Activate the object you would like to add into a project.
3. Select the destination project node in the project tree of the project explorer.
4. From the Project menu, select the Add 'Object' command.
Tip: Make sure that the object does not already exist in the project before you execute this operation.

Add object via drag and drop
To add an object into a project using the drag & drop function, please follow the instructions below:
1. Open the project explorer and expand the destination project.
2. Activate the object you would like to add into a project.
3. Move the mouse pointer next to the object you would like to add to a project.
4. Hold the Left mouse button down.
5. Move the mouse pointer over the destination project node in the tree view of the project explorer.
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6. Release the Left mouse button.

Remove an item from a Project
Items like folders and files in projects can be easily removed if they are no longer required. Removal of files or folders
from projects means permanent deletion of the file or folder.
In different contexts of the application, various items can be removed as well, either permanently or just from the current
view.
Projects will not be removed, but closed.
Closing projects does not mean deletion of the project file on your hard disc. The original project file is
kept, but the project is removed from the view in your project explorer.

Removal of items is described in the following:

Remove from project menu command
To remove an existing file or folder using the menu, please follow the instructions below:
1. Select the file or folder you want to remove.
2. From the Project menu, select the Remove 'object name' command.
3. You will be prompted to confirm deletion.
4. In the dialog box, press the Yes button to confirm deletion or No button to abort.

Remove from project keyboard shortcut
1. Select the item you want to remove.
2. Press the key combination listed in the keyboard shortcuts.
3. You will be prompted to confirm deletion.
4. In the dialog box, press the YES button to confirm deletion or NO button to abort.

Remove from project context menu command
To remove an existing file or folder using the context menu on a project node, please follow the instructions below:
1. Select the file or folder you want to remove.
2. Click the Right mouse button.
3. From the context menu, select the Remove command.
4. You will be prompted to confirm deletion.
5. In the dialog box, press the YES button to confirm deletion or NO button to abort.

Remove from project toolbar command
1. Select the file or folder you want to remove.
2. From the project explorer toolbar, select the

icon.

3. You will be prompted to confirm deletion.
4. In the dialog box, press the YES button to confirm deletion or NO button to abort.

Add data from directory to Project
Any analytical data can be directly inserted into a project from a source directory using this command. The file type can be
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specified. All data enclosed in the source directory and optionally all subdirectories will be inserted into the project then
in a kind of batch import process.

Add data from directory menu command
To import data from a directory into a project via the application menus, please follow the instructions below:
1. From the Project menu, select the Add Data from Directory command.
2. The Import Data from Directory into Project dialog is displayed.
3. Fill in the required fields of the dialog.
4. Click the Import button.

Add data from directory keyboard shortcut
None.

Add data from directory toolbar command
1. Select a project node or folder node in the project explorer tree.
2. From the project explorer toolbar, select the

icon.

3. The Import Data from Directory into Project dialog is displayed.
4. Fill in the required fields of the dialog.
5. Click the Import button.

Import data from directory
Any analytical data can be directly inserted into a library from a source directory using this command. The file type and the
destination library can be specified. All data enclosed in the source directory will then be inserted into the library with a
batch import process.

Import data from directory menu command
To import data from a directory into a library via the application menus, please follow the instructions below:
1. From the Library menu, select the Import Data from Directory command.
2. A Directory Import into Library dialog is displayed.
3. Fill in required fields of the dialog.
4. Click the Import button.

Import data from directory keyboard shortcut
To import data from a directory into a library via a keyboard shortcut, please follow the instructions below:
1. Press the key combination listed in the keyboard shortcuts.
2. A Directory Import into Library dialog is displayed.
3. Fill in required fields of the dialog.
4. Click the Import button.

Add all Objects in Window to Project
If the user needs to insert all visible objects located in the current active data view at once into a particular project, all
objects will be added to the current selected folder within the current selected project in the project explorer using this
command.
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Adding just the active object
It is also possible to add just the active object. Please refer to the 'Add an item to a project' command.

Add all objects to project menu command
To add all visible objects to a project or folder via the application menu, please follow the instructions below:
1. Select a project node or folder in the tree of the project explorer.
2. From the Project menu, select the Add all Objects in Window to Project command.

What happens, if no project was selected?
In this case, a File Save dialog is shown, which allows you to store all data into a new project.

Add all objects to project keyboard shortcut
none.

Protect Project
The command "Protect Project" applies a password protection to the selected project. Once the protection is applied, the
project contents can only be viewed and opened if the correct password is entered. The password protection may also be
removed again by selecting the command "Unprotect Project".
Protected projects are marked with a special symbol:
When protecting a project the user will be asked for the protection password:

Protect project menu command
To protect a project with a password, please follow the instructions below:
1. Select the project to be protected.
2. From the Project menu, select the Protect Project command.
3. Enter the password in the password dialog.
4. Apply the protection by clicking on the OK button.

Protect object keyboard shortcut
None.

Recent items
This submenu includes a number of recently opened files or projects or mathematical operation for your maximum
convenience.
If the user needs to reopen a file which has just been in use a short time ago, he can select this file directly from the
recent files submenu without time consuming navigation to its original location. The same applies to projects and
mathematical functions.
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The list of recently used files, projects or mathematical functions will be updated automatically. Older items will be
removed after a certain time automatically. The number of recognized files, projects or mathematical functions can be
configured in the Options dialog.

Recent files menu command
To open a recently used file using a menu command, please follow the instructions below:
1. From the File menu, select the Recent Files submenu.
2. From the Recent Files submenu, select the file name of the file you would like to open.

Recent projects menu command
To open a recently used project using a menu command, please follow the instructions below:
1. From the Project menu, select the Recent Projects submenu.
2. From the Recent Projects submenu, select the project file name of the project you would like to open.

Recent mathematics menu command
To open a recently used mathematical function using a menu command, please follow the instructions below:
1. From the Mathematics menu, select the Recent Mathematics submenu.
2. From the Recent Mathematics submenu, select the file name of the file you would like to open.

2D view menu
The 2D view menu holds various commands to adjust the visible view port of a 2D data view. Commands are specifically
designed to zoom, scale, shift and scroll analytical 2D data to fit the user requirements for printing or further evaluation.
If multiple 2D data objects are merged in one view, single objects can be shifted against each other.
Why is the menu missing sometimes?
The 2D view menu is only available if the current active object is a 2D data object.

2D view menu contents
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The 2D View menu provides the following commands:
Auto Scale
Auto Scale X
Auto Scale Y
Auto Scale Active
Auto Scale X Active
Auto Scale Y Active
Auto Scale to Y Values
Reverse xAxis Orientation
Shift Spectra
Unshift Spectra
Reset shift
Sticky View
Clear View
Merge Views
Split View
Show Data in Table
Show Favorite Area
Preferences...
Set Visible Area
Create 3D Data
Create Annotation
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Quick access to 2D preferences!
The 2D Preferences dialog is also available via the context menu on a data view. Just click the Right
Mouse button over a 2D data view to enter the context menu and select the Preferences... command.

Auto scale
The auto scale function resets the current view port and rescales all objects enclosed in a way, that all data points and
the graphs of all objects are visible again. Whenever the user wants to return to see the full data object at a glance, e.g.
after he has zoomed into a particular data objects area to see details, he might apply this function.
The auto scale function is applied to all available data objects in the current active data view. So the view port is re
scaled to show all data objects completely. If you just like to rescale the view port to fit the current active object, please
use the auto scale active function.
This function is used for 2D data objects and 3D data objects. The auto scale function is applied as follows:

Auto scale menu command
To apply the auto scale function using the menu command, please follow the instructions below:
1. Activate the data view of interest, that needs to be auto scaled.
2. From the 2D View menu or 3D View menu, select the Auto Scale command.

Auto scale keyboard shortcut
To apply the auto scale function using the keyboard shortcut, please follow the instructions below:
1. Activate the data view of interest, that needs to be auto scaled.
2. Press the combination of keys listed in the keyboard shortcuts.

Auto scale on double click action
To auto scale an object using a double click action in the data view area, please follow the instructions below:
1. Activate the data view on your workspace.
2. Double click with the Left Mouse button anywhere into the data view area to apply the auto scale function.

Auto scale X
The auto scale X function resets the current view port along the xaxis and rescales all objects enclosed in a way, that
the maximum xaxis range of all objects enclosed is visible again. All other axes remain unchanged. Whenever the user
wants to see the full data range along the xaxis of all objects, e.g. after he has zoomed into a particular data objects
area to see details, he might apply this function.
The auto scale X function is applied to all available data objects in the current active data view. So the view port is re
scaled to show the complete xaxis of all data objects. If you just like to rescale the view port to fit the current active
object, please use the auto scale X active function.
This function is used with 2D data objects and 3D data objects.
The auto scale X function is applied as follows:

Auto scale X menu command
To apply the auto scale X function using the menu command, please follow the instructions below:
1. Activate the data view of interest, that needs to be auto scaled.
2. From the 2D View menu or 3D View menu, select the Auto Scale X command.

Auto scale X keyboard shortcut
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None.

Auto scale Y
The auto scale Y function resets the current view port along the yaxis and rescales all objects enclosed in a way, that
the maximum yaxis range of all objects enclosed is visible again. All other axes remain unchanged. Whenever the user
wants to see the full data range along the yaxis of all objects, e.g. after he has zoomed into a particular data objects
area to see details, he might apply this function.
The auto scale Y function is applied to all available data objects in the current active data view. So the view port is re
scaled to show the complete yaxis of all data objects. If you just like to rescale the view port to fit the current active
object, please use the auto scale Y active function.
This function is used with 2D data objects and 3D data objects.
The auto scale Y function is applied as follows:

Auto scale Y menu command
To apply the auto scale Y function using the menu command, please follow the instructions below:
1. Activate the data view of interest, that needs to be auto scaled.
2. From the 2D View menu or 3D View menu, select the Auto Scale Y command.

Auto scale Y keyboard shortcut
None.

Auto scale active
The auto scale active function resets the view port and rescales the current active objects in a way, that all data points
and the graph of the current active object are visible again. Whenever the user wants to return to see the full data of the
current active object at a glance, e.g. after he has zoomed into a particular data objects area to see details, he might
apply this function.
All other objects, which might be also available in the current data view, are ignored for rescaling. If you like to rescale
the view port to fit all objects again, please use the auto scale function.
This function is used for 2D data objects and 3D data objects.
The auto scale active function is applied as follows:

Auto scale active menu command
To apply the auto scale active function using the menu command, please follow the instructions below:
1. Activate the data object of interest, that needs to be auto scaled.
2. From the 2D View menu or 3D View menu, select the Auto Scale Active command.

Auto scale active keyboard shortcut
None.

Auto scale X active
The auto scale X active function resets the view port of the current active object along the xaxis and rescales just the
active object in a way, that the maximum xaxis range is visible again. All other axes remain unchanged. Whenever the
user wants to see the full data range along the xaxis of the current active object, e.g. after he has zoomed into a
particular data objects area to see details, he might apply this function.
All other objects, which might be also available in the current data view, are ignored for rescaling. If you like to rescale
the view port to fit all objects again, please use the auto scale X function.
This function is used with 2D data objects and 3D data objects.
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The auto scale X active function is applied as follows:

Auto scale X active menu command
To apply the auto scale X active function using the menu command, please follow the instructions below:
1. Activate the data object of interest, that needs to be auto scaled.
2. From the 2D View menu or 3D View menu, select the Auto Scale X Active command.

Auto scale X active keyboard shortcut
None.

Auto scale Y active
The auto scale Y active function resets the view port of the current active object along the yaxis and rescales just the
active object in a way, that the maximum yaxis range is visible again. All other axes remain unchanged. Whenever the
user wants to see the full data range along the yaxis of the current active object, e.g. after he has zoomed into a
particular data objects area to see details, he might apply this function.
All other objects, which might be also available in the current data view, are ignored for rescaling. If you like to rescale
the view port to fit all objects again, please use the auto scale Y function.
This function is used with 2D data objects and 3D data objects.
The auto scale Y active function is applied as follows:

Auto scale Y active menu command
To apply the auto scale Y active function using the menu command, please follow the instructions below:
1. Activate the data object of interest, that needs to be auto scaled.
2. From the 2D View menu or 3D View menu, select the Auto Scale Y Active command.

Auto scale Y active keyboard shortcut
None.

Auto scale to Y values
The auto scale to Y values option toggles the data display behavior of the 2D data view. It maximizes the displayed yaxis
data range of every spectrum in the current active data view regardless of the intensities of other spectra in the active
data view. All other axes remain unchanged. This useful to adjust the displayed yaxis data range for spectra with
different ydata maximum, so that the ydata ranges of all spectra cover the full display area. The following two pictures
show an example of the auto scale to Y values option:
Two spectra are merged into a data view. The blue spectrum has a ydata maximum of about 1, the red spectrum has a
ydata maximum of about 2. The auto scale to Y values option is turned off and therefore the blue ydata range covers
only half of the display area.
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The same data view with the the auto scale to Y values option turned on. The blue ydata range is adapted to the red y
data range.

The auto scale to Y values option affects all available data objects in the current active data view. The yaxis shows the
data range of the active spectrum.
This function is used with 2D data objects.
The auto scale to Y values option is activated or deactivated as follows:

Auto scale to Y values menu command
To activate or deactivate the auto scale to Y values option, please follow the instructions below:
1. Activate the data view of interest, that needs to be auto scaled.
2. From the 2D View menu select the Auto Scale to Y values command.
3. The status of the Auto scale to Y values option is shown by check mark in front of the menu command.

Auto scale Y keyboard shortcut
None.
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Reverse XAxis Orientation
The Reverse XAxis Orientation command simply toggles the displayed xaxis direction. It switches the xaxis of the
displayed spectrum from increasing xvalues to decreasing values or vice versa. This useful to quickly switch the spectrum
orientation which is preset for certain spectra types. The destination orientation is indicated as part of the menu
command (left to right or right to left).
The Reverse XAxis Orientation command is applied as follows:

Reverse XAxis Orientation menu command
To reverse the xaxis orientation of a displayed spectrum, please follow the instructions below:
1. Activate the data view of interest.
2. From the 2D View menu select the Reverse XAxis Orientation command.

Reverse XAxis Orientation keyboard shortcut
To reverse the xaxis orientation of a displayed spectrum using the keyboard shortcut, please follow the instructions
below:
1. Activate the data view of interest.
2. Press the key combination listed in the keyboard shortcuts.

Shift spectra
Sometimes 2D data objects are very similar to each other, or the user opened the same data twice in a single data view.
In this case, the shift spectra function is useful to separate 2D data objects that might be overlaid in a 2D data view.
Available objects in a 2D data view are shifted against each other to separate overlaying data. This function is only
available, if multiple 2D data objects are merged in one data view. It can be applied multiple times in order to increase
the distance.
Shifting spectra is performed as follows:

Shift spectra menu command
To shift spectra using the menu command, please follow the instructions below:
1. Merge two or more 2D data objects in one data view.
2. From the 2D View menu, select the Shift Spectra command.

Shift spectra keyboard shortcut
To shift spectra using the keyboard shortcut, please follow the instructions below:
1. Merge two or more 2D data objects in one data view.
2. Press the key combination listed in the keyboard shortcuts.

Unshift spectra
Sometimes 2D data objects are very similar to each other, or the user opened the same data twice in a single data view.
In this case, the shift spectra function might have been applied to separate overlaying 2D data objects. You can see it
from the yaxis legend, if data is shifted. In this case, neither numbers nor a unit are shown on the yaxis. This function is
only available, if multiple 2D data objects are merged in one data view and if they have been previously shifted.
Unshifting can be applied multiple times in order to decrease the distance until the original proportions are reached.
Unshifting spectra is performed as follows:

Unshift spectra menu command
To unshift spectra using the menu command, please follow the instructions below:
1. Activate the 2D data view with shifted spectra inside.
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2. From the 2D View menu, select the Unshift Spectra command.

Unshift spectra keyboard shortcut
To unshift spectra using the keyboard shortcut, please follow the instructions below:
1. Activate the 2D data view with shifted spectra inside.
2. Press the key combination listed in the keyboard shortcuts.

Reset shift
The reset shift command is used to undo any spectra shifting that was done by the functions Shift spectra or Unshift
spectra. Any shifting that has affected multiple merged Objects will be completely reset. This way larger shifts can be
undone in one step and the original position of merged spectra will be restored.
The reset shift command is performed as follows:

Reset shift menu command
To reset the shift of merged spectra using the menu command, please follow the instructions below:
1. Activate the 2D data view with shifted spectra inside.
2. From the 2D View menu, select the Reset shift command.

Reset shift keyboard shortcut
None.

Sticky view
The sticky view option toggles the data display behavior of the 2D data views. If this option is activated, all new 2D data
objects of the same data type will be automatically opened in one data view. New data object will be merged
automatically into an already existing data view, if a suitable view is available. This option does not effect already open
data objects.
Tip: This option is useful, if you are interested in viewing a whole series of data in one data view, where data might
be available in multiple files on your hard disc. Just activate this option and open all files at once.

The sticky view option is activated or deactivated as follows:

Sticky view menu command
To activate or deactivate the sticky view option using the menu command, please follow the instructions below:
1. From the 2D View menu, select the Sticky View command.

Sticky view keyboard shortcut
None.

Clear view
This command is only available if multiple 2D data objects are merged in one data view. One of the 2D data objects is
always meant to be the active object. If this command is applied, all 2D data objects, except the current active object are
closed.
The clear view command is performed as follows:

Clear view menu command
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To clear the data view using the menu command, please follow the instructions below:
1. Activate the 2D data object you like to keep open.
2. From the 2D View menu, select the Clear View command.

Clear view keyboard shortcut
None.

Merge views
The merge views function joins all 2D data objects of the same data type which are currently opened in a window or tab
on the workspace. The current active 2D data object is meant to be the reference object and remaining objects of the
same data type will be transformed to fit the current object.
Undo merging is very easy!
To separate all merged data objects again, just use the Split View command from the 2D View menu.
If you just like to close a single data object, activate it in the data view and press the DELkey to close
it.
If you just like to see a single object in a separate window again, drag it out of the current data view
and drop it on the tab flag area on top of the data views.

Merging views is performed as follows:

Merge views menu command
To merge views using the menu command, please follow the instructions below:
1. Activate the 2D data object, that is meant to be the reference for merging.
2. From the 2D View menu, select the Merge Views command.

Merge views keyboard shortcut
To merge views using keyboard shortcut, please follow the instructions below:
1. Activate the 2D data object, that is meant to be the reference for merging.
2. Press the combination of keys listed in the keyboard shortcuts.

Split views
Previously merged data objects might need to be displayed in separate data views again. In this case, the split views
function removes all 2D data objects from the current active 2D data view and reopens them in single tabs on the
workspace each.
Removing single data objects is very easy!
If you just like to close a single data object located in the current active data view, activate it and press
the DELkey to close it.
If you just like to see a single object in a separate window again, drag it out of the current data view
and drop it on the tab flag area on top of the data views. It will be opened in a separate tab.

Splitting views is performed as follows:

Split views menu command
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To split views using the menu command, please follow the instructions below:
1. Activate the 2D data view with multiple data objects inside.
2. From the 2D View menu, select the Split View command.

Split views keyboard shortcut
None.

Show data in table / Show data as graph
The show data in table function toggles the current 2D data view between displaying data in a table and a graph view.
When displaying data in a table, all values of the xaxis are listed in the first column. Intensities are listed in subsequent
columns for each 2D data object.
Table data can be copied into the clipboard!
The whole data table or selected rows can be copied to the clipboard for use in other applications. For
details, please refer to the Copy command section.

This function applies to 2D data objects. It can be activated or deactivated as follows:

Show data in table menu command
To toggle the show favorite area function using the menu command, please follow the instructions below:
1. Activate the data view of interest.
2. From the 2D View menu, select the Show data in Table / Show data as Graph command.

Show data in table keyboard shortcut
None.

Show data in table on context menu
To toggle the show data in table function for a data view using the context menu in the data view area, please follow the
instructions below:
1. Activate the data view on your workspace.
2. Click with the Right Mouse button anywhere into the data view area.
3. From the context menu, select the Show data in Table / Show data as Graph command.

Show favorite area
The show favorite area function resets the current view port and changes to a predefined region which has been
configured by the user previously. This might be a particular zoom region of interest containing a special signal which
needs to be observed. For each data type a separate favorite region can be defined.
How to change favorite area settings?
The favorite area settings can be customized in the 2D Preferences dialog. Please refer to this section for
details.

This function applies to 2D data objects. It can be activated or deactivated as follows:

Show favorite area menu command
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To toggle the show favorite area function using the menu command, please follow the instructions below:
1. Activate the data view of interest.
2. From the 2D View menu, select the Show favorite Area command.

Show favorite area keyboard shortcut
None.

Show favorite area on context menu
To toggle the show favorite area function for an object using the context menu in the data view area, please follow the
instructions below:
1. Activate the data view on your workspace.
2. Click with the Right Mouse button anywhere into the data view area.
3. From the context menu, select the Show favorite Area command.

2D Preferences Dialog
The 2D data view has a lot of properties, which may be customized by the user in order to adapt the data presentation to
his own requirements. Axis settings, coloring of objects, border settings and background color, etc. can be adjusted here.
It may be useful to customize the cursor or zoom function.
For each data type, separate view settings are applied!
For user convenience, each data type provides individual display settings. The software will recognize
them automatically.

The preferences dialog looks like this:
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Loading 2D preferences
To load previously saved 2D preferences, please click on the

button and select a saved preference file.

Saving 2D preferences
To save your personal 2D preferences, please click on the Save as button. Usually there is no need to explicitly save the
preferences since all changes will automatically be saved when the dialog is closed. But if the user needs to often use
different preferences he can save these by using the Save as button and specifying a configuration name.

Resetting 2D preferences
If the user is not satisfied with the changes he can revert back to the default 2D preferences. Clicking on the Reset
button will reset all parameters to the default values.

Selecting a customizable property
On the left side of the dialog, a list with all customizable properties is available.
Click on one of the properties to select it. Adjustable parameters are updated automatically and will be displayed on the
right.

Coordinate system options
These options control the look and feel of the axis coordinate system in the software. Coloring, backgrounds and grid
settings can be adjusted for the 2D data view. The property section of the preferences dialog looks like this:
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Label Color
The label color controls the font color of the axes legend. Click on the color field to change the color.
Data Area Color
This option controls the background color of the data view. Click on the color field to change the color.
Axis Area Background
This option controls the background color of the axis coordinate system. Click on the color field to change the color.
Grid Color
This option controls the color of the grid shown in the back of the data view. Click on the color field to change the color.
Label Font
This option controls the font style of the axis legend. The font, font size, and font style can be adjusted here. Expand the
Label Font node to adjust particular font settings.
Grid Dash On
This parameter controls the size of visible grid dashes shown with the grid color.
Grid Dash Off
This parameter controls the size of transparent dashes shown with the grid color.
Grid Pen Width
This parameter controls the pen width used for drawing the dashed grid lines.
Show Grid
Enables or disables the grid.
Text
This option controls the font style of additional text in the coordinate system. The font, font size, and font style can be
adjusted here. Expand the Additional Text Font node to adjust particular font settings.
Major Tick Steps XAxis
This parameter defines the number of tickmarks for each major axis step on the xaxis.
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Minor Tick Steps XAxis
This parameter defines the number of tickmarks that divide each major step on the xaxis.
Show compressed XAxis
This parameter only applies to IR spectra. In most cases, IR data is shown in wave number units on the XAxis. In order
to compensate the nonlinear axis and emphasize lower wave numbers, the region above the Compression Position will
be shown compressed.
Compression Ratio
This parameter defines the compression factor.
Compression Position
This parameter defines the position on the Xaxis, where compression starts. By default this is around 2000 1/cm.
Major Tick Steps YAxis
This parameter defines the number of tickmarks for each major axis step on the yaxis.
Minor Tick Steps YAxis
This parameter defines the number of tickmarks that divide each major step on the yaxis.
YAxis Label Alignment
The orientation of the unit label on the YAxis can be toggled in order to save space. The unit label can be shown in
horizontal or vertical orientation.
Show Logarithmic Axis
The YAxis can be shown a logarithmic axis in order to visualize logarithmic data as linear data. This parameter toggles
data display.

Zooming
This section provides parameters for zooming in 2D data. By default the user can draw a rectangle for zooming into a
particular region of data.

Current Area Selection
This parameter controls which zoom mode is applied. By default the rectangle zoom is used, which allows zooming in both
axis directions at once. For some applications it might be useful to keep the yaxis direction and only zoom in xaxis
direction.
Rectangle
Zoom in x and ydirection
Horizontal
Zoom in xdirection only
Color
This parameter sets the background color of the zoom area while zooming.

Cursor
This section controls the mouse pointer layout and coloring. Furthermore the behavior of the mouse pointer can be
changed.
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Color
This parameter controls the color of the mouse pointer.
Width
This parameter control the line width of the cross hair lines drawing around the mouse pointer.
Spacing
This parameter controls the distance of the cross hair lines from the center of the mouse pointer.
Show Data Position
This parameter controls the tool tip help function. The tool tip help shows the actual cursor position in x and yvalues.
Yes
The tool tip is shown
No
The tool tip is invisible
Current Cursor
Various cursor modes are available controlling the behavior of the mouse pointer. The following modes are available:
Cross
Shows an x,y cursor with four orthogonal cross hair lines indicating the position of the mouse pointer within the
data view. The mouse pointer can be moved to any position within the data view without limitation.
Line
Shows an x,y cursor with two vertical cross hair lines indicating the position of the mouse pointer within the data
view. The mouse pointer can be moved to any position within the data view without limitation.
Surfing
Shows an x,y cursor with four orthogonal cross hair lines indicating the position of the mouse pointer within the
data view. The mouse pointer is forced to the graph of the active data object. When moved to a new position
within the data view the center of the mouse pointer sticks to the graph slope.
Arrow
Shows an x,y arrow cursor indicating the position of the mouse pointer within the data view. The mouse pointer
can be moved to any position within the data view without limitation.

Favorite display area settings
The favorite display area controls the actual visible data view. By default all data objects are auto scaled on opening to
show the full spectral range. If the show favorite area function is enabled, only the preferred region which has been
previously defined by the user is applied as default visible data view instead.
The display properties for the favorite area can be modified on the right of the dialog:
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Current view boundaries
These parameters show the coordinates of the current visible area of the 2D data view. Minimum and maximum data view
coordinates for x and y of the actual data view are shown read only. To apply those coordinates as favorite display area,
please follow the instructions below:
1. While the 2D Preferences dialog is open, zoom to your favorite area in the 2D data view.
2. Set the flag Apply Current Area As Favorite Area true in order to apply these coordinates as new favorite view
settings. The data view and parameters in the category below are updated accordingly.
Favorite view boundaries
These parameters show the actual favorite area coordinates. The favorite display area can be modified manually by
changing the Minimum X, Maximum X, Minimum Y and Maximum Y coordinates. Additionally, the favorite display area
can be applied as default view for new data objects.
1. Modify the Minimum X, Maximum X, Minimum Y and Maximum Y coordinates to your favorite view coordinates.
2. Set the Enable Favorite View Area flag to Yes to enable your favorite display area.
All open 2D data views containing data of this data type will be updated and new data views are opened
automatically with your favorite display area.

Peak marker options
Peak markers are used to show peaks within the data view area. Display options for such peak markers can be adjusted
here. For each data type, separate display options will be stored. When opening the preferences dialog, the preferences
for the actual data type can be customized. The following peak marker properties are available:

Show Details
Peak information are available either as peak table or as peak markers. The user can decide whether to see the peak
table, peak markers or both. This flag controls the display option:
Peak Table and Peak Markers (Show Both)
Shows peak table and peak markers
Peak Markers
Shows peak markers only.
Peak Table
Shows the Peak Table only
Show Value
Displayed information on the peak marker can be customized. Either the xaxis value, the yaxis value or both can be
shown on a peak marker within the data view.
xaxis value
Shows the xaxis value of a peak
yaxis value
Shows the yaxis value of a peak.
x and yaxis values
Shows the xaxis value and the yaxis value of a peak.
Show Marker on top of peak
Peak markers in a data view can be aligned to the top of the data view area or directly shown next to the peak.
Yes
Peak markers are shown directly next to the peak.
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No
Peak markers are shown aligned on top of the data view.
Show start end markers
This flag indicates, whether start and end tick marks are visible in the data view.
Yes
Start and end tick marks are visible.
No
Start and end tick marks are hidden.
Fill peak
For some data types it might be useful to see the area underneath the graph slope and the baseline filled. This flag
controls, whether the peak area underneath a peak is filled or not.
Yes
Enables peak filling.
No
Disables peak filling.
Peak marker font
The font and font size for peak markers shown within the data view area can be customized here.
Marker tail color
Each peak marker possesses a connecting line between the value and the corresponding peak. This line is called tail and
the color can be customized here.
Displayed Decimals for XValues
This option controls the number of decimals shown for the xaxis value shown on a peak marker. This number might be
different from the default number of decimals available for data.
Displayed Decimals for YValues
This option controls the number of decimals shown for the yaxis value shown on a peak marker. This number might be
different from the default number of decimals available for data.
Calculation decimals
This option controls the number of decimals that are shown for the peak evaluation values in the peak table.

Show Legend
In the 2D data view the legend shows a list of all data objects within the current active data view. The active object is
highlighted automatically in the legend.
In the 3D data view the legend shows a color coded area reflecting the actual intensity range of the 3D data object.
The user can activate an object by clicking the name in legend with the Left mouse button.
The following parameters can be adjusted for legend display:

Style
The legend style has the following options:
Auto
The legend is shown automatically, whenever 2 or more data objects are visible in the current data view. If only
one object is shown, the legend is invisible.
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Always
The legend is always shown.
Never
The legend is never shown.
Text Color
This option configures the text color of the legend entries.
Text Font
This option configures the font, font size, font style, etc. parameters for the legend.
Has Background
This option configures, whether a background color is applied to the legend or the background remains transparent.
Yes
The color given by the Background Color parameter is applied as background color for the legend.
No
A transparent background color is used for the legend area.
Background Color
This option configures the background color of the legend. So if you like to color it, select a suitable color here.
Has Frame
This option configures, whether the legend is shown with or without border.
Yes
The legend is surrounded by a border.
No
The legend is shown without border.
Frame Color
This option configures the frame color of the legend. So if you like to color it, select a suitable color here.

Visible Data Options
The visible data options control the appearance of 2D data objects in the current data view. General coloring, line style
and special settings for 2D data can be adjusted here. For each data type, separate display options will be stored. These
options are applied to all visible items in the data view. Actual color settings will be overridden on any changes. A list of
visible items is also given below the Visible Data Options node for individual adjustments of each object.

Coloring Policy
When 2D data objects first enter the software, they will receive a curve color, line style, etc. The object will keep this style
until it will be changed by the user. Several coloring policies are available to automate coloring and line style assignment
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for incoming data. The following policies are available:
Automatic (see screenshot above)
The automatic coloring alternates the color for new incoming objects according to a predefined list of colors as
shown in the lower part of the screen shot.
Example: The first data object is bluecolored, the second is redcolored and so on.
Monochrome
The monochrome coloring defines exactly one color, which is applied to all objects.
By Name
Data receives a curve color depending on predefined conditions. The user is free to define conditions from any text
information provided by the data, e.g. the file name or any label.
Example: The color condition given below applies the blue color to all data objects containing a label called "TITLE"
with a value "ref" somewhere in the name. The asterisk (*) symbol is used as wildcard. Naming is not case
sensitive.

Fill Spectrum Area
This option configures, whether the area underneath the curve is filled with the curve color or not.
Yes
The area underneath the data curve is filled.
No
The area underneath the data curve is not filled.
Line Style
This option configures the line style of the curve. The following line style options are available:
Solid
Dash
Dot
Dash Dot
Dash Dot Dot
Line Width
This option configures the line width in pixels. By default 1 pixel is used.
Show Data Point Markers on Zoom
Whenever the user zooms into a spectral area in a way that the distance between two adjacent data points is large
enough to show data point markers, they can be shown automatically.
Yes
Data point markers will be shown automatically during zooming.
No
No data point markers will be shown.
Example:
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Show Spectrum Points as Lines
Instead of a data curve, each data point can also be visualized as vertical line to zero. This option is applied by default for
mass spectra.
Yes
Data points will be shown as vertical lines to zero.
No
Data points will be shown as curve.
Example:

Spectrum xAxis Orientation
This option controls the orientation of the xaxis. Available options are:
RightToLeft
Standard orientation  xaxis values increase from right to left
LeftToRight
Inverse orientation  xaxis values increase from left to right

Set Visible Area
The set visible area command is used to quickly set the visible xaxis and yaxis range. The range needs to be manually
entered in the range input dialog. The command is located in the 2DViewMenu:
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The set visible area command only affects the current 2Dobject! If you want to open multiple objects in the
same visible range, please use the Show Favorite Area command.

The range input dialog will be opened specifically for the chosen axis and looks like this:

To quickly access the range input dialog just doubleclick with the left mouse button into the lower/higher
part of the desired axis or use the right mouse button to access the 2DView context menu!

The following picture depicts the axisareas which are sensitive to the doubleclick range input:

Set visible area menu command
To set the visible area manually using the menu command, please follow the instructions below:
1. Activate the desired 2D data view.

EN

Main Software Manual . 115

2. From the 2D View menu, select the Set Visible Area menu and choose the axis from the submenu
or
use the Rightmouse button to access the 2DView context menu.
3. Enter the desired display range in to the Range Input Dialog.
4. Press the ReturnKey or click the OKButton or CancelButton.

Set visible area doubleclick access
To set the visible area via doubleclick, please follow the instructions below:
1. Activate the desired 2D data view.
2. Doubleclick with the Leftmouse button on high/low area of the appropiate axis  see picture above.
3. Enter the desired display range in to the Range Input Dialog.
4. Press the ReturnKey or click the OKButton or CancelButton.

Set visible area keyboard shortcut
None.

Create 3D Data
This function combines multiple 2D data objects into a threedimensional data object. Please refer to the Create 3D data
dialog for a detailed description of the create 3D data function. To create 3D data from 2D data objects, please follow the
instructions below:
1. Open all 2D data objects that you want to combine.
2. Merge all 2D data objects into a single data view by using the Merge Views command from the 2D View menu.
Alternately all required 2D data files can be organized in a project and opened by using the project explorer
context menu command Show contents.
3. Execute the Create 3D data command:

Create 3D data menu command
To create a new 3D data object, please follow the instructions below:
1. Activate the data view with merged 2D data objects.
2. From the 2D View menu select the Create 3D Data command.
3. The Create 3D data dialog will be opened. Choose the appropriate method and select the corresponding unit.
4. Press the Ok button.
5. The created 3D data object will be opened in a new data view .

Create 3D data keyboard shortcut
None.

Create 3D Data Dialog
Multiple 2D data objects can be used to create a threedimensional data object. This can be very useful to display multiple
spectra, for example from a sequential measurement, in one 3D data object and thus provides a simple overview of the
whole data set.
Since the data for the additional third dimension usually is not contained in the originating 2D data objects, the 3D data
creation dialog offers a range of options to combine the individual 2D data objects. These options vary from simple
incremental combination to using numerical data from attached labels to create the 3D object. The following options for
combining 2D data objects are available:
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User Defined
Incrementally combines the 2D data objects. The user can choose the order in which the objects are combined and
the increment interval.
Creation Date
Incrementally combines the 2D data objects by their date and time of creation.
Label
Combines the 2D data objects incrementally according to the numerical values that are stored in an attached label.
Only one label can be selected.

Prerequisites
Prerequisites for creating a 3D data objects from 2D data objects:
All 2D data objects need to be opened and merged into a single data view.
This can be achieved by either manually opening the individual 2D spectra and merging them into one data view or
by organizing all required 2D data files in a project and opening them by using the project explorer context menu
command Show contents.
The label of all objects needs to contain the numerical data.
If the method "label" is used to create a 3D object, all 2D data objects need to have the desired label attached and
this label of every 2D data object needs to contain a numerical value. Verify and check or edit the attached labels
by using the label editor.
Open the Create 3D Data Dialog by selecting the command Create 3D data from the 2D View menu. The dialog looks
like this:

Create 3D data dialog contents
The dialog consist of two main fields. The 3D Creation method selection and a parameter selection. Besides the unit
selection drop down box, the parameter section is only important for the user defined method.
3D Creation methods

User Defined
All 2D data objects will be shown in the parameter text box. To combine all objects with user defined parameters, please
follow the instructions below:
1. Adjust the order of your data in the 3D object.
If the displayed sequence does not match the order in which you want to combine the data objects, you can move
individual data objects by selecting them with the Left mouse button and using the Up and Down buttons.
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2. Enter a axis start value for the zaxis.
This will be the zdata value for the first 2D data object and the first value of the zaxis.
3. Enter an increment.
This increment specifies the zdata interval between two successive 2D data objects.
4. Enter the desired target unit for the 3rd dimension.
The drop down box offers all available units in the software. This unit will label the new zaxis data.
5. Click on the OK button to create the new 3D data object.
A separate data view with the new 3D data object will be opened.
Example:
A 3D data object created with the user defined method and the parameters shown in the above picture will have a zaxis
ranging from 0 to 4, with the first 2D data object located on the zvalue 0. The following 2D data objects will be
incrementally located on the zpoints 1,2,3, with the last object located on zvalue 4.

Creation Date
The creation date of all 2D data objects will be show in the parameter text box. All objects will be sorted automatically
according to their creation date. The oldest object will be displayed first and youngest object last. The zaxis will be
automatically labeled with the corresponding creation dates. The oldest object will be the first zaxis data object, the
youngest object the last. The options axis start, increment and unit are not used in the date based creation methods.

Label
The parameter text box will display all labels that are attached to the 2D data objects. The user needs to select a single
label that has to contain numerical values. The 3D data object will be created incrementally according to the numerical
values stored in the selected label. Essentially this method is the same as the date based methods. Instead of using a
label containing a date, the 3D data is created by use of numerical value stored in the selected arbitrary label. The
options axis start and increment are not used in the label based creation method.
Parameters of Creation

Objectlist
Depending on the selected method the text box will display variable information:
User defined
Shows a list of all 2D objects that are used to create the 3D object. The order of the 2D objects can be changed by
using the Up and Down buttons. The 3D object will be created according to the sequence of 2D objects shown in
the list.
Creation date
Shows a list of creation dates of all 2D objects. The objects will be sorted ascending according to their date and
time of creation. Thus the oldest object will be in first position and it will the first 2D object in the newly created 3D
data object.
Label
Shows a list of all labels attached to the 2D data objects. You can only select one label. The numerical data stored
in this label will be used to create the 3D object. The Up and Down buttons are not used in this method.

Axis start
The parameter axis start defines the first data point of the zAxis. This parameter will only be used with the user defined
method and additionally forms the zdata value of the first 2D data object.

Increment
The parameter increment defines the interval between two consecutive 2D data objects. This parameter can only be
modified when selecting the user defined method. All other methods automatically calculate the increment.

Unit
The parameter unit defines the desired unit that is used to label the zaxis. The drop down box shows all units that are
available in the software. If no explicit unit is needed, the value "arbitrary" is to be chosen.

Create Annotation
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118 . Main Software Manual

The "Create Annotation" command creates an annotation in the data view. This is useful to add user comments to a
spectrum or part of a spectrum. An annotation consists of rectangular callout box which may be customized to the users
preferences. The following picture shows examples of different annotations:

Annotations are independent and each annotation has its own preference. Size, color, font and the anchor position can
be customized. Annotations can be printed, saved (saving only applies to the *.panorama data format) and hidden from
the dataview.
Tips for working with annotations:
Use the Hide Annotations/Show Annotations commands in the 2DView context menu to toggle
the visibility of all annotations in the spectrum view.
Use the Print Annotations option in the 2Dspectrum section of the Print Layout to control printing
of the annotations.
Open the Annotation context menu by Right clicking on an annotation. The context menu enables
the user to edit the annotation text, to delete the annotation, or to individually control the
annotation properties.

Create annotation menu command
To create an annotation via the menu command, please follow the instructions below:
1. Select the command Create Annotation in the 2DView. A default annotation will be created in the dataview.
2. Resize the rectangular box by moving the small square tracker items by clicking and dragging with the Left Mouse
Button.
3. Move the anchor by clicking and dragging the small circular tracker item with the Left Mouse Button.
4. Move the whole annotation by clicking and dragging with the Left Mouse Button.
5. Double click the callout box with the Left Mouse Button to edit/enter the annotation text. Alternatively click the
box with the Right Mouse Button and select Edit from the context menu.
6. Edit the annotation properties by calling the preferences context menu. Click the box with the Right Mouse Button
and choose Preferences.

Create annotation context menu command
To create an annotation via the 2Dview context menu, please follow the instructions below:
1. Right click anywhere in the data view to open the 2DView context menu.
2. Select the command Create Annotation.
3. Proceed with steps 26 shown above to customize the annotation.

Create annotation keyboard shortcut
Not available.

3D view menu
The 3D view menu holds various commands to adjust the visible view port of a 3D data view. Commands are specifically
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designed to zoom, scale, shift, rotate and scroll analytical 3D data to fit the user requirements for printing or further
evaluation.
Why is the menu missing sometimes?
The 3D view menu is only available if the current active object is a 3D data object.

3D view menu contents

The 3D View menu provides the following commands:
Top View
3D View
Waterfall View
2D Data Overlay
Auto Scale
Auto Scale X
Auto Scale Y
Auto Scale Z
Auto Rotate
Show 2D Cuts
2D Extraction
Reset View
Preferences...
Quick access to 3D preferences!
The 3D Preferences dialog is also available via the context menu on a data view. Just click the Right
Mouse button over a 3D data view to enter the context menu and select the Preferences... command.

3D top view
The 3D top view provides a fixed view from the positive side along the zaxis down to the x,yplane of a 3D data object.
Heights are color coded, respectively to show maxima and minima. Contour lines are available optionally. All functions
available in the default 3D View are also available here.
Switching to the top view is performed as follows:
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Top view menu command
To switch to the 3D top view using the menu command, please follow the instructions below:
1. Activate the desired 3D data view.
2. From the 3D View menu, select the Top View command.

Top view keyboard shortcut
None.

3D Waterfall View
The waterfall view provides an alternative display of the 3D data object. The contour of the 3D data object is displayed by
parallel lines, either in xaxis or yaxis direction. All functions available in the default 3D View are also available here.
Switching to the waterfall view is performed as follows:

Waterfall view menu command
To switch to the waterfall view using the menu command, please follow the instructions below:
1. Activate the desired 3D data view.
2. From the 3D View menu, select the Waterfall View command and choose the desired line direction from the
submenu.

Waterfall view keyboard shortcut
None.

Auto scale
The auto scale function resets the current view port and rescales all objects enclosed in a way, that all data points and
the graphs of all objects are visible again. Whenever the user wants to return to see the full data object at a glance, e.g.
after he has zoomed into a particular data objects area to see details, he might apply this function.
The auto scale function is applied to all available data objects in the current active data view. So the view port is re
scaled to show all data objects completely. If you just like to rescale the view port to fit the current active object, please
use the auto scale active function.
This function is used for 2D data objects and 3D data objects. The auto scale function is applied as follows:

Auto scale menu command
To apply the auto scale function using the menu command, please follow the instructions below:
1. Activate the data view of interest, that needs to be auto scaled.
2. From the 2D View menu or 3D View menu, select the Auto Scale command.

Auto scale keyboard shortcut
To apply the auto scale function using the keyboard shortcut, please follow the instructions below:
1. Activate the data view of interest, that needs to be auto scaled.
2. Press the combination of keys listed in the keyboard shortcuts.

Auto scale on double click action
To auto scale an object using a double click action in the data view area, please follow the instructions below:
1. Activate the data view on your workspace.
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2. Double click with the Left Mouse button anywhere into the data view area to apply the auto scale function.

Auto scale X
The auto scale X function resets the current view port along the xaxis and rescales all objects enclosed in a way, that
the maximum xaxis range of all objects enclosed is visible again. All other axes remain unchanged. Whenever the user
wants to see the full data range along the xaxis of all objects, e.g. after he has zoomed into a particular data objects
area to see details, he might apply this function.
The auto scale X function is applied to all available data objects in the current active data view. So the view port is re
scaled to show the complete xaxis of all data objects. If you just like to rescale the view port to fit the current active
object, please use the auto scale X active function.
This function is used with 2D data objects and 3D data objects.
The auto scale X function is applied as follows:

Auto scale X menu command
To apply the auto scale X function using the menu command, please follow the instructions below:
1. Activate the data view of interest, that needs to be auto scaled.
2. From the 2D View menu or 3D View menu, select the Auto Scale X command.

Auto scale X keyboard shortcut
None.

Auto scale Y
The auto scale Y function resets the current view port along the yaxis and rescales all objects enclosed in a way, that
the maximum yaxis range of all objects enclosed is visible again. All other axes remain unchanged. Whenever the user
wants to see the full data range along the yaxis of all objects, e.g. after he has zoomed into a particular data objects
area to see details, he might apply this function.
The auto scale Y function is applied to all available data objects in the current active data view. So the view port is re
scaled to show the complete yaxis of all data objects. If you just like to rescale the view port to fit the current active
object, please use the auto scale Y active function.
This function is used with 2D data objects and 3D data objects.
The auto scale Y function is applied as follows:

Auto scale Y menu command
To apply the auto scale Y function using the menu command, please follow the instructions below:
1. Activate the data view of interest, that needs to be auto scaled.
2. From the 2D View menu or 3D View menu, select the Auto Scale Y command.

Auto scale Y keyboard shortcut
None.

Auto scale Z
The auto scale Z function resets the current view port along the zaxis and rescales all objects enclosed in a way, that
the maximum zaxis range of all objects enclosed is visible again. All other axes remain unchanged. Whenever the user
wants to see the full data range along the zaxis of all objects, e.g. after he has zoomed into a particular data objects
area to see details, he might apply this function.
The auto scale Z function is applied to all available data objects in the current active data view. So the view port is re
scaled to show the complete zaxis of all data objects.
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This function is only used with 3D data objects. The auto scale Z function is applied as follows:

Auto scale Z menu command
To apply the auto scale Z function using the menu command, please follow the instructions below:
1. Activate the data view of interest, that needs to be auto scaled.
2. From the 3D View menu, select the Auto Scale Z command.

Auto scale Z keyboard shortcut
None.

Auto rotate
The auto rotate function is often used in demonstration of the software to see 3D data objects from all sides. Rotation is
carried out around an imaginary vertical perpendicular axis through the current 3D data object orientation on the
workspace.
Auto rotation might be started and stopped using this command. If you need to freely rotate the 3D object, please use
the Rotate function of the software.
Starting or stopping auto rotation of a 3D data object is performed as follows:

Auto rotate menu command
To start or stop rotation of a 3D data object using the menu command, please follow the instructions below:
1. Activate the desired 3D data view.
2. From the 3D View menu, select the Auto Rotate command.

Auto rotate keyboard shortcut
To start or stop rotation of a 3D data object using the keyboard shortcut, please follow the instructions below:
1. Activate the desired 3D data view.
2. Press the key combination listed in the keyboard shortcuts.

Increasing and decreasing rotation speed
To increase or decrease the rotation speed, please follow the instructions below:
1. Start the Auto Rotate function of the software as described above.
2. Press the Up Arrowkey or Down Arrowkey to increase or decrease rotation speed.

Invert rotation direction
To invert the rotation direction, please follow the instructions below:
1. Start the Auto Rotate function of the software as described above.
2. Press the Left Arrowkey or Right Arrowkey to invert rotation direction.

2D data overlay
When working with 3D data, users have the option to choose a 3D view or a top view. It is also possible to choose a side
view along the xaxis or yaxis of your data.
Applying the 2D data overlay command, all 2D data objects of the 3D object are merged into a new tab window (lower
view):
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Extract all 2D spectra of a 3D data object at once!
Besides the overlay functionality, this command has an additional effect. All 2D data of a 3D data object
is merged into a new tab window. Thus they have been extracted all at once from the 3D object.

2D data overlay is performed as follows:

2D data overlay menu command
To show the 2D data overlay view using the menu command, please follow the instructions below:
1. Activate the desired 3D data view.
2. From the 3D View menu, select the 2D data overlay submenu.
3. From the 2D data overlay submenu, select the XAxis or YAxis command.
Data will be opened in a new 2D data view tab window.

2D data overlay keyboard shortcut
None.
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Show 2D cuts
This function shows or hides 2D data views for 2D cuts of a 3D data object. While moving with the mouse pointer through
the three dimensional cube of the 3D data object, the x,zplane and the y,zplane at the current mouse pointer position
are shown as 2D data objects in separate data views on top of the 3D object.
2D data extraction
2D cuts are used for 2D data object extraction from a 3D data object.

Toggling the show 2D cut function is performed as follows:

Show 2D cuts menu command
To toggle show 2D cut option using the menu command, please follow the instructions below:
1. Activate the desired 3D data view.
2. From the 3D View menu, select the Show 2D Cuts command.

Show 2D cuts keyboard shortcut
None.

Manual extraction dialog
Manual data extraction is applicable to all 3D data objects. Particular x,zplanes or y,zplanes can be extracted at a user
defined position. While moving through the 3D data object data point by data point, the position for extraction can be
exactly determined.
The dialog looks like this:
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Dialog functions
The dialog is shown on top of the application and will be available until it is closed by the user by clicking on the
button. In addition the 2DCuts display will automatically be opened when starting the manual extraction dialog.
Extraction by manual selection of a data point
1. Enter the required data point position manually into the text fields for the xaxis or yaxis, respectively.
2. The 2Dcut display shows the spectrum that will be extracted.
3. Click the Extract button.
The extracted data point object will be opened in a new tab window on your workspace.
Which data point is used for extraction?
After entering a value into one of the text fields and clicking the Extract button, the data point closest to
the entered value is automatically used for extraction.
Extraction by scrolling through the 3D data object
1. Move the slider of the scroll bar or click the
Text field values are updated automatically.

or

button to navigate to the position for extraction.

2. The 2Dcut display shows the spectrum that will be extracted.
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3. Click the respective Extract button.
In the 3D data view, the semitransparent planes indicate the current extraction position.

3D preferences dialog
The 3D data view has a lot of properties, which may be customized by the user in order to adapt data presentation to his
own requirements. Coloring of objects, rendering settings and background color, etc. can be adjusted here. It might be
useful to customize the cursor or zoom function. Many functions are similar to those in the 2D Preferences Dialog.
Therefore only a few are described below.
The preferences dialog looks like this:

Loading 3D preferences
To load previously saved 3D preferences, please click on the

button and select a saved preference file.

Saving 3D preferences
To save your personal 3D preferences, please click on the Save as button. Usually there is no need to explicitly save the
preferences since all changes will automatically be saved when the dialog is closed. But if the user needs to often use
different preferences he can save these by using the Save as button and specifying a configuration name.

Resetting 3D preferences
If the user is not satisfied with the changes he can revert back to the default 3D preferences. Clicking on the Reset
button will reset all parameters to the default values.

Selecting a customizable property
On the left side of the dialog, a list with all customizable properties is available.
Click on one of the properties to select it. Adjustable parameters are updated automatically and will be displayed on the
right.
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Library menu
The library menu contains all commands around data importing, searching, search result and configuration of libraries.
For a more detailed introduction to working with libraries and searching from the scientific point of view, please refer
to the "Library and Search" tutorial.
Why is the library menu missing?
The library module is an extra module, which needs a valid license. Maybe your license does not grant
access to this functionality. Please contact your software provider for more information.

Library menu commands

The Library menu contains the following commands:
Search Spectrum
Search Text
Show Library Contents
New Library
Open Library
Close Library
Open Directory as Library
Import Data from Directory
Insert 'Object' into Library
Remove 'Object' from 'Library'
Search Residual Spectrum
Overlay Spectra
This command overlays search results and the query object in order to allow direct comparison similar to the Merge
Views command from the 2D View menu.
Apply Filter to Search Results

Spectrum search...
Any 2D spectra can be searched in libraries registered to the software. All available libraries are listed in the library
explorer. From the data type nodes under a library node you can see how many spectra of the respective data type are
available in each library. One or more suitable libraries can be searched at the same time. Different search algorithms and
definition of spectral regions for searching provide optimal search conditions for the particular topic of interest. Finally, the
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search query can be stored and reused later on with the same or a different spectrum. After searching, matching objects
from the libraries will be collected in a search result table, which is shown to the user.

Quick introduction to searching spectra
Follow the instructions to search a spectrum in the software.
1. Open or activate the library explorer.
2. Open or create a new local library.
3. If just you created a new library, please import some data before you proceed.
4. Open a file with a spectrum you would like to search on a library.
5. Search the spectrum on a library.

Related Topics
Searching spectra by drag & drop on library or search query
Searching files by drag & drop from outside the software
How to search spectra
Tip: Click on the hyper links to learn more about the topics.

Search text
For the full text search on one ore more libraries, some parameters can be adjusted or even an expression can be build
to search a text or text fragment on all labels and properties stored in the libraries together with analytical data. The
search query is similar to known search engines from the internet. Just enter a word or fragment you like to search for.
You are free to use wildcards as well.

Search text menu command
To create a new text search query using the menu command, please follow the instructions below:
1. From the Library menu, select the Search Text command.
2. A Library Search Text dialog is displayed.
3. Fill in the desired fields of the dialog.
4. To save the current search query for later use, please press the Save button.
5. Click the Search button.

Search text keyboard shortcut
1. Press the combination of keys listed in the keyboard shortcuts .
2. A Library Search Text dialog is displayed.
3. Fill in the desired fields of the dialog.
4. Click the Search button.

Search text toolbar command
To create a new text search query using the toolbar shortcut of the library explorer, please follow the instructions below:
1. Open or activate the library explorer.
2. From the library explorer toolbar, select the

icon.

3. A Library Search Text dialog is displayed.
4. Fill in the desired fields of the dialog.
5. To save the current search query for later use, please press the Save button.

EN

Main Software Manual . 129
6. Click the Search button.

Search text dialog
Libraries and their contents can be searched for words, text fragments or regular expressions similar to search engines
known from the internet. This is a useful tool to find required analytical data in a vast number of objects of a library
quickly. You can configure a search query to your personal demands and save it for another search on your libraries later
on. The search result is displayed in a search result table, which can be configured as well.
The dialog looks like this:

Search text dialog contents
The following settings can be adjusted in a search query.
Simple text search query
1. Enter a valid search phrase
A search phrase might consist of one or more words separated by spaces. The following wildcards are allowed:
?  This wildcard is a placeholder for exactly one character.
*  This wildcard is a placeholder for none, one or more characters or even one or more words.
Example:
You are looking for an object containing "benzene" anywhere in the title:
Search phrase: *benzene*
You are looking for an object starting with "benzene" in the title:
Search phrase: benzene*
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You are looking exactly for "benzene" as title:
Search phrase: benzene
You are looking for a substituted "Hydroxybenzoic acid", but you do not know the position of the hydroxyl
group:
Search phrase: *Hydroxybenzoic acid
Case sensitivity of search phrases.
Search phrases are not case sensitive, so there will be no difference whether you type the search
phrase in upper case or lower case characters.

2. Select a recently used search phrase
Recently used search phrases are recognized by the software. Please click on the
a list of most recently used search phrases.

icon of the combo box to show

Reset
Clicking the reset button will delete the current search phrase.
Show active spectrum in search result
Activating this option will display the currently active spectrum in the search result dialog. This makes a direct visual
comparison of the spectrum to the search results very easy. The search result dialog will be similar to the result dialog of
the regular spectrum search. Therefore the user will be able to use the function Search Residual Spectrum in conjunction
with the text search. Please refer to the tutorial How to search spectra for a detailed description of the search options.
Searched labels
By default, text information of objects is stored in user defined labels, properties or any other format in a library. They are
used to carry additional information, which might be searched and displayed in the search result table. Here, searching
can be limited to a set of user defined labels, which might increase search speed in large libraries. By default, all labels
are applied for searching.
Destination library
A list of all registered libraries in the software is displayed here. The user needs to select those libraries, that will be
applied for the text search.
Tip: If you do not exactly know, if a library contains relevant spectra, select all libraries first and then refine your
search query in a second run.
Search result configuration
If the search was successful, the search result table may display additional information about resulting library objects.
Additional information is carried in object properties or object labels, that have been previously uploaded together with
library data.
The user can configure the labels and properties here, being displayed in columns of the search result table. These
additional information will be retrieved together with the search results and can be reviewed by the user.

Show library contents
The show library contents function displays all spectra of the selected library in a search result window. This is useful to
get a quick overview of the library contents. As in the regular search result window, single as well as multiple spectra can
be selected and can be displayed separately or overlayed.
All contents of a library can be displayed as follows:

Show library contents menu command
To display the contents of a library using the menu command, please follow the instructions below:
1. Select the desired library to display.
2. From the 2D View menu, select the Show library contents command.
3. The software will perform a generic search and display all contents of the library.
4. Select a single or multiple spectra from the result list to display and compare.
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Show library contents keyboard shortcut
None.

Show library contents context menu
To display the contents of a library using the context menu in Library Explorer, please follow the instructions below:
1. Select the desired library to display.
2. Click with the Right Mouse button on the library entry in the Library Explorer.
3. From the context menu, select the Show library contents command.

Create library
Libraries are displayed in the library explorer. Different library types are distinguished. Creation of a library is only
available for local libraries.
A new library can be created as described in the following:

Create library menu command
To create a new library using the menu command, please follow the instructions below:
1. From the Library menu, select the New... command.
2. A New Library Settings dialog is displayed.
3. Fill in the desired fields of the dialog.
4. Click the Create button.

Create library keyboard shortcut
1. Press the combination of keys listed in the keyboard shortcuts .
2. A New Library Settings dialog is displayed.
3. Fill in the desired fields of the dialog.
4. Click the Create button.

Create library toolbar command
1. Open or activate the library explorer.
2. From the project explorer toolbar, select the

icon.

3. A New Library Settings dialog is displayed.
4. Fill in the desired fields of the dialog.
5. Click the Create button.

Open a libary
Libraries can be opened as described in the following:

Open library menu command
To open a library via the application menu, please follow the instructions below:
1. From the Library menu, select the Open... command.
2. A File Open dialog is displayed.
3. Navigate to the library location on your hard disc or network neighborhood.
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4. Select the library you like to open.
5. Click the Open button.

Open library keyboard shortcut
Please refer to the list of keyboard shortcuts for details.

Open library toolbar command
1. Open or activate the library explorer.
2. From the library explorer toolbar, select the

icon.

3. A File Open dialog is displayed.
4. Navigate to the library location on your hard disc or network neighborhood.
5. Select the library you like to open.
6. Click the Open button.

Open a directory as library
Directories on your local hard disc or on the network can be utilized as libraries in the software.
A user defined directory on your system will be set up as root directory for the virtual library. Only the root directory or
the root and all directories below will be interpreted as library by the software. Library contents can be organized with
the library explorer of the software.
What are the advantages of using the file system as library?
You do not need to import data into a library before you can start searching.
You are always uptodate, if data will be added, removed or modified in the file system by anyone.
There is no need for further database administration or other maintenance.
You can share data with other users.
Access control to confidential data is covered by the user rights granted by the operating system. There
is no need for further user administration.
The location of your original data will remain unchanged on your system. So you or an administrator are
free to organize directory structures outside the software without interferences.

Open directory as library menu command
To open a directory as library via the application menu, please follow the instructions below:
1. From the Library menu, select the Open Directory as Library command.
2. A Path Selection dialog is displayed.
3. Navigate to the directory location on your hard disc or network.
4. Select the directory you would like to open as a library.
5. Click the OK button.

Open directory as library keyboard shortcut
None.

Open directory as library toolbar command
1. Open or activate the library explorer.
2. From the library explorer toolbar, select the
3. A Path Selection dialog is displayed.
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4. Navigate to the directory location on your hard disc or network neighborhood.
5. Select the directory you would like to open as a library.
6. Click the OK button.

Directory import into library dialog
For data import into a library, some parameters must be adjusted. The source directory and the data type as well as the
destination library must be specified in order to setup a batch import. After successful parameter configuration all
specified data will be imported from the source directory into a give library one by one. Finally, an import protocol is
displayed, which holds the import statistics.
The dialog looks like this:

Directory import into library dialog contents
Source directory
1. Enter a source directory
Here the source directory location containing analytical data to be imported into a library, must be specified. You
can either enter the path to the source directory directly into the text field, or you can choose a path from your
local hard disc or network neighbourhood using the

icon right from the text field.

2. Adjust the file mask
Here, the file mask of one file type or all file types can be entered in the following scheme:
*.file extension for a particular file type or *.* for all known file types.
3. Include subdirectories
Data will be imported from a whole directory branch including all subdirectories underneath a given source
directory, if this flag is enabled.
Destination library
Select one of the libraries form the list, which is meant to be the destination library for imported data.
Why are not all libraries shown here?
This selection just allows physical libraries, but no virtual libraries. Therefore directories, which will be
used as libraries are not listed here.

Close a library
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If libraries are no longer needed by the user, they can be closed to free the space in the library explorer for more
important libraries. To close a library, please follow the instructions described below:

Close library menu command
To close a library via the application menu, please follow the instructions below:
1. Open or activate the library explorer.
2. Select a library node in the tree of the library explorer.
3. From the Library menu, select the Close command.

Close library keyboard shortcut
None.

Close library context menu command
To close a library using the context menu on a selected library node, please follow the instructions below:
1. Open or activate the library explorer.
2. Select a library node in the library explorer tree.
3. Click the Right mouse button.
4. From the context menu, select the Close Library command.

Close library toolbar command
1. Open or activate the library explorer.
2. From the library explorer toolbar, select the

icon.

3. The library is closed automatically.

Import data from directory
Any analytical data can be directly inserted into a library from a source directory using this command. The file type and the
destination library can be specified. All data enclosed in the source directory will then be inserted into the library with a
batch import process.

Import data from directory menu command
To import data from a directory into a library via the application menus, please follow the instructions below:
1. From the Library menu, select the Import Data from Directory command.
2. A Directory Import into Library dialog is displayed.
3. Fill in required fields of the dialog.
4. Click the Import button.

Import data from directory keyboard shortcut
To import data from a directory into a library via a keyboard shortcut, please follow the instructions below:
1. Press the key combination listed in the keyboard shortcuts.
2. A Directory Import into Library dialog is displayed.
3. Fill in required fields of the dialog.
4. Click the Import button.

Insert object into library
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Analytical data and files can be inserted into a library from the library explorer. The object to be inserted, must be
currently opened and activated in the software.
Inserting items is described in the following:

Insert object into a library menu command
To insert an object into a library using the menu, please follow the instructions below:
1. Open or activate the object you like to insert into a library.
2. From the Library menu, select the Insert 'object name' into Library command.
3. A Select Library dialog is opened.
4. In the dialog box, select the destination library from the list of all available libraries.
5. Press the OK button to proceed or the Cancel button to abort.

Insert object into a library keyboard shortcut
To insert an object into a library using a keyboard shortcut, please follow the instructions below:
1. Open or activate the object you like to insert into a library.
2. Press the key combination listed in the keyboard shortcuts.
3. A Select Library dialog is opened.
4. In the dialog box, select the destination library from the list of all available libraries.
5. Press the OK button to proceed or the Cancel button to abort.

Select library dialog
The dialog holds a list of all available libraries registered to the software. If only one library is currently open this dialog
will be omitted. Virtual libraries are not available here.
The dialog looks like this:

Select library dialog contents
A list of all registered libraries is given for selection.
1. Select one of the libraries in the list.
2. Press the OK button.
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Remove an item from library
Analytical data and files stored in a library or search results can be easily removed from the library explorer, if they are no
longer required. Removal of files or search results or search queries from the library explorer means permanent deletion
of the selected object.
Copyright protection of commercial libraries.
Some commercial libraries might be copyright protected. In this case items cannot be modified or
removed from this library.

Removing data from a library.
The item to be deleted must be opened before it can be deleted from the library. This is a protection
mechanism to prevent unintentional deletion.

Removal of items is described in the following:

Remove data from library menu command
To remove an existing item from a library using the menu, please follow the instructions below:
1. Double click with the left mouse button to open the selected item.
2. Select the item you want to remove.
3. From the Library menu, select the Remove 'object name' command.
4. You will be prompted to confirm deletion.
5. In the dialog box, press the YES button to confirm deletion or NO button to abort.

Remove data from library keyboard shortcut
To remove an existing item from a library using a keyboard shortcut, please follow the instructions below:
1. Double click with the left mouse button to open the selected item.
2. Select the item you want to remove.
3. Press the key combination listed in the keyboard shortcuts.
4. You will be prompted to confirm deletion.
5. In the dialog box, press the YES button to confirm deletion or NO button to abort.

Remove data from library context menu command
To remove an existing item from a library using a context menu command, please follow the instructions below:
1. Double click with the left mouse button to open the selected item.
2. Select the item you want to remove.
3. Click the Right mouse button.
4. From the context menu, select the Remove command.
5. You will be prompted to confirm deletion.
6. In the dialog box, press the YES button to confirm deletion or NO button to abort.

Search residual spectrum
This command is used to perform an additional search with the residual spectrum of a previous search. The residual
spectrum is created by subtracting the search spectrum and the result spectrum of a search. Please refer to the tutorial
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How to search spectra for details on the search function.
The Search Residual Command is only available if there is an active result of a previous search.

Search residual spectrum menu command
To create a new residual spectrum search query using the menu command, please follow the instructions below:
1. Select the search result window from a previous search.
2. From the Library menu, select the Search Residual Spectrum command.
3. A Search Residual Spectrum dialog is displayed showing the overlayed search and result spectrum and the
resulting residual spectrum.
4. Adjust the Reference Factor to prepare the residual spectrum for the search.
5. Click the Search button.
6. The residual spectrum search result is displayed in a new search result window.

Search residual spectrum keyboard shortcut
Not available.

Overlay Spectra
This command is used to overlay the search spectrum and the result spectrum of library search result. The search and the
result spectrum will be merged from two separate windows into one window. The Overlay Spectra command is similar to
the Merge Views command, but can only be used on an active library search result window. Please refer to the tutorial
How to search spectra for details on the overlay function.

Overlay spectra menu command
To overlay the search and result spectrum, please follow the instructions below:
1. Select the search result window.
2. From the Library menu, select the Overlay Spectra command.
3. The search and result spectrum are displayed overlayed in a single spectrumview.
4. To undo the overlay, simply select the Overlay Spectra command again.

Overlay spectra keyboard shortcut
Not available.

Apply Filter to Search Result
This command is used to narrow down the search result list of a library search result. A filter string will be applied to the
spectrum names of the search result and only the matching entries will be displayed. Please refer to the tutorial How to
search spectra for details on the overlay function.
Removing/undoing the filter.
The applied filter is removed/undone by simply calling the command a second time and entering an
empty filter string.

Apply Filter to Search Result menu command
To apply a filter string to the library search result, please follow the instructions below:
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1. Select the search result window.
2. From the Library menu, select the Apply Filter to Search Result command.
3. Enter the filter string into the Apply Filter dialog. Use wildcards ( * ) to match partial names.
4. Click on the OK button.
5. The filtered search result list is displayed.

Apply Filter to Search Result keyboard shortcut
Not available.

IR/RAMAN Interpretation Menu
The IR/RAMAN Interpretation menu contains all available commands for automatic and interactive IR and RAMAN spectrum
interpretation. A general overview and an introduction is given in the "IR/RAMAN Analysis Overview" section.
Why is the IR/RAMAN Interpretation menu missing?
The IR interpretation and RAMAN interpretation are extra modules, which needs a valid license. Maybe your
license does not grant access to this functionality. Please contact your software provider for more information.

IR/RAMAN Interpretation menu commands

The IR/RAMAN Interpretation menu holds the following commands:
The menu name toggles from IR Interpretation to RAMAN Interpretation according to the actual analysis mode.
Analyze Spectrum
Validate Spectrum and Molecule
Toggle to ... Interpretation
Toggles current interpretation mode either to
IR interpretation
RAMAN interpretation
Browse Functional Groups at specific Wavelength
Show Rule Designer
Show Functional Group Definition
This command opens the actual selected functional group in the rule designer.
Load Rule Database
Preferences...

EN

Main Software Manual . 139
Remove selected Functional Group
Highlight all assigned Functional Groups
Show Identified Peaks
How to add interpretation results to a project?
After performing any analysis, results can be stored in your project for review later on. Please refer to the
chapter "Add/Remove active Object to a Project" for details.

Analyze spectrum
IR and RAMAN spectrum interpretation allows automatic and interactive analysis for popular IR or RAMAN bands in a single
spectrum based on predefined interpretation rules. A list of identified peaks and corresponding functional groups are
returned as a result of the analysis.
Before you start IR and RAMAN spectrum Interpretation...
Please make sure to load an IR/RAMAN interpretation rule database. (By default a rule database is
available already)
Expert users, please configure Preferences properly, before you start analyzing spectra.

Analyzing an IR or RAMAN Spectrum

Toggle to the right analysis mode before analyzing a spectrum!
Before analyzing a spectrum, please toggle the analysis mode to the one you want. The rule database is
loaded for the actual analysis mode accordingly!
To toggle the analysis mode, choose the Toggle to ... menu command in the IR/RAMAN Interpretation
Menu.

To analyze a spectrum, please follow the steps below:
1. Open an IR or RAMAN spectrum from a file or project.
2. From the IR/RAMAN Interpretation menu, select the Analyze Spectrum command.
3. The spectrum is analyzed automatically and results are presented in a new tab window as described below.

Presentation of Spectrum Analysis Results
The example shows the result of an IRSpectrum interpretation. For RAMANspectra similar results are obtained with the
same features.
After starting spectrum analysis successfully, the results will be displayed in the Spectrum Analysis Result dialog:
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The analyzed spectrum is displayed in the spectrum view on top of the dialog. For details about the spectrum view
functionality, please refer to the chapter "Spectrum View Functions". Matching functional groups are listed in a table on
the bottom. It shows identified functional groups including related information from the rule database:
Quality Value
Name of the Functional Group
Name of the corresponding Chemical Sub Class
Name of the corresponding Chemical Class
For current selected functional group, the subset of passed interpretation rules is shown in the upper left table. Failed
interpretation rules are shown in the upper right table. Each functional group possesses a corresponding molecular
representation. It is shown inside the spectrum view. For details about the molecule view functions, please refer to the
chapter "Molecule and Functional Group View".

Highlighting Vibrations
You may highlight corresponding spectral region of a vibration by selecting an entry in the pass or fail table.
1. Click the Left Mouse button on an entry in the pass or fail table to select a vibration.
Selection looks like this:
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The horizontal bar on top of the spectrum is an additional indicator for the spectral width of the interpretation rule.

Show Identified Peaks
IR and RAMAN interpretation strongly depends on peak detection, which is done prior to analysis. In order to see the
identified peaks you may activate peak markers in the spectrum view of the spectrum analysis result. When activated, the
peak position is indicated by a vertical red line.
For details please refer to the chapter "Peaks" in section "Data View Enhancements".
How do I control identified peaks?
Sometimes it might be necessary to modify peak detection parameters, because automatic peak
detection does not produce satisfactory results. You have the following options to take influence on peak
detection:
Open the Preferences dialog and change "peak detection" settings there. Please refer to the
section "Preferences" for details.
Before you analyze a spectrum, perform manual peak detection using the Find Peaks function in
the Mathematics menu of the software.
Analysis only considers your personal set of detected peaks then.
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You may also like to review all identified peaks. They can be colorized in the spectrum to reveal not yet analyzed areas.
Please refer to the chapter "Highlight all assigned Functional Groups" for details.

Sorting Matching Functional Groups
You may sort matching functional groups table by a preferred column:
Just click with the Left mouse button onto the caption of the desired column. The table will be sorted in ascending
alphabetical order.
A second click with the Left mouse button onto the same column caption will sort the column descending.

Modifying Interpretation Results
After automatic interpretation has been completed, results can be modified and updated manually by the user because of
the following or other reasons:
Some of the peaks in your spectrum may not be identified by automatic spectrum interpretation.
Others have been identified, but from your point of view, assignment is not correct.
Deleting Functional Groups from Interpretation Results
Functional groups that have been added to the list by mistake can be removed as follows:
1. Click the Functional Group to be deleted with the Left mouse button in the table.
2. Press the DELkey on your keyboard
3. Alternatively, Select the Remove Selected Functional Group command from the IR/RAMAN Interpretation menu.
The functional group is removed without further notification.
Adding Functional Groups to Interpretation Result
You may add functional groups for a peak in your spectrum by selecting a suitable one from the rule database. The
Functional Group Browser will help you to identify suitable functional groups and lets you add them to the current
interpretation result. Please follow the steps below:
1. Move the mouse pointer close to the peak of interest in the spectrum area.
2. Click the Right mouse button inside the spectrum view to popup a context menu.
3. From the context menu, select the menu entry Show all Functional Groups at...
The Functional Group Browser opens and shows a list of best matching functional groups at the selected peak
position.
How to use the Functional Group Browser?
Please refer to the chapter "Functional Group Browser" for details on navigation inside the browser.

4. Select a functional group from the list in the Functional Group Browser.
5. Click the Add Functional Group to Result button to add current selected one.
6. Move the black vertical line to other frequencies / Peaks of interest.
7. Repeat steps 4  6 until all required peaks have been assigned.
8. Click the Close button to return to your initial interpretation result.

Show Functional Group Definition
It might be important for improving the rule database to easily review a functional group definition. The actual selected
functional group can be reviewed in the Rule Designer using the AltF12 keys shorthand or alternatively use the
following menu command:
1. Select a functional group from the list in the spectrum analysis result.
2. From the IR/RAMAN Interpretation menu, select Show Functional Group Definition.
Both methods open the Rule Designer window to show the actual functional group. Here you may review related
functional groups or modify rule definitions to optimize the rule database.
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Share Results with other Applications
Contents of any table in the interpretation result can be copied to the clipboard and pasted in other applications.
Please refer to the chapter "Copy and Paste Opportunities" in the section "Using the Software" for details.

Saving Interpretation Results
Interpretation results can be saved to file or into a project to be reloaded for review later on.
To learn more about saving objects in the software, please refer to the chapter "Save" or "Save as" in the section
"Commands".
To learn more about adding objects to a project, please refer to the chapter "Add all Objects in the Window to Project" in
the section "Commands".

Printing Interpretation Results
Results can be printed using a predefined Interpretation Result Print Layout. Contents of the printout can be customized
there.
Please refer to the chapter "Interpretation Result Print Layout" in the section "Printing" for details.

Validate Spectrum and Molecule
In most cases spectrum interpretation will only be the first step on the path to identify the analyzed substances.
Furthermore identified functional groups from spectrum interpretation need to be assigned to a molecule to finally
complete analysis results of a sample from the research point of view. The software assists you in matching a spectrum
with a molecule and vice versa.
All you need is a molecule and a spectrum either as files or combined in a project that can be loaded by the software. The
following validation approaches are available:
Starting with a spectrum you like to match a molecule.
Starting with a molecule you like to match a spectrum.
Having a spectrum with a linked molecule, you like to confirm both are matching well.

Matching a Spectrum with a Molecule
Starting with a spectrum, validation will work as described in the following:
1. Open an IR or RAMAN spectrum from a file or project.
2. From the IR/RAMAN Interpretation menu, select the Validate Spectrum and Molecule command.
3. In the file dialog that opens automatically, select a file containing a molecule.
4. Click the Open button.
Spectrum and molecule are now analyzed automatically and results will be presented in a new tab window as described
below.
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The analyzed spectrum and molecule are shown together in the spectrum view on top of the result. In the tables below,
matching functional groups as well as passed and failed interpretation rules of the active functional group are listed. For a
detailed description on the functions of the view, please refer to the chapter "Spectrum View Functions".
Selection of a functional group in the bottom table will highlight corresponding peaks in the spectrum and will also
emphasize corresponding fragments in the molecule.
Validation status is shown in the matching functional group table. In the Validated column, you see the matching result:
Both
The functional group was identified in the spectrum and in the molecule. This means perfect matching.
Molecule
The functional group was only identified in the molecule but not in the spectrum.
Spectrum
The functional group was only identified in the spectrum but not in the molecule.
If matching will not provide expected results, you may start a new validation with another molecule. You may also
investigate peaks by browsing suitable functional groups for the peak.
Please refer to the chapter "Browsing IR Frequencies and Proposal of Functional Groups" for details.

Matching a Molecule with a Spectrum
Starting with a molecule, validation will work as described in the following:
1. Open a molecule from a file or project.
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2. From the IR/RAMAN Interpretation menu, select the Validate Spectrum and Molecule command.
3. In the file dialog that opens automatically, select a file containing an IR or RAMAN spectrum.
4. Click the Open button.
Results will be provided automatically as described above.

Matching a Spectrum with a linked Molecule
If a molecule is linked to the current spectrum, validation can be started without loading a molecule. Results will be
calculated and provided as described above.
How to link a molecule to a spectrum?
Please refer to the chapter "Link Objects" in the section "Commands" for details.

Toogle to ... Interpretation

The software supports both analysis techniques, but only one at a time. The actual interpretation mode is indicated by
the interpretation menu name. Possible menu names are:
IR Interpretation
The software is now in IR interpretation mode. The corresponding IR rule database is applied for analysis.
RAMAN Interpretation
The software is now in RAMAN interpretation mode. The corresponding RAMAN rule database is applied for analysis.
Both modes provide the same interpretation software features. However, core spectrum analysis and of course the
applicable rule database are different for IR and RAMAN interpretation accordingly. The mode can be easily toggled using
the Toggle to ... menu command in the IR/RAMAN Interpreation menu.
Can I run RAMAN interpretation with an IR spectrum and vice versa?
Yes!
The software does not check the actual spectrum type before doing an analysis for different reasons:
In many other and mainly older software packages and also software packages from instrument
vendors, IR spectra and RAMAN spectra are not well distinguished. If you import such spectrum into this
software the identified spectrum type might be IR although it is a RAMAN spectrum. If the software would
be that strict to deny RAMAN interpretation for IR spectra, you would never be able to analyze legacy
spectra.
Spectra are preprocessed before doing an analysis in order to take into account the different spectrum
shapes for IR and RAMAN. Preprocessing is different for both spectrum types. You may want to use both
preprocessing types with IR or RAMAN spectra. It is possible to do that using the correct mode.

Functional Group Browser
The functional group browser provides direct analysis of a particular frequency in your IR or RAMAN spectrum. A list of best
matching functional group will be derived from all available functional group definitions and shown.
The functional group browser is available
for improving interpretation results after performing spectrum analysis.
You may add functional groups to your current interpretation result, because the automatic routine may have
missed some required functional groups.
for a quick overview of suggested functional groups at a particular frequency in your spectrum. In this case the
browser is used like an online electronic functional group catalog.
Functional Group Browser Window
A new window is opened, which looks like this:
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The analyzed spectrum is shown in the upper part of the browser. In the tables below, suggested functional groups as
well as passed and failed interpretation rules of the active functional group are listed. For a detailed description on the
spectrum view functions, please refer to the chapter "Spectrum View Functions".
Selecting the Investigation Frequency
Additionally, a black vertical line marks the investigated frequency in the spectrum. The line can be moved with drag and
drop to the frequency you are interested in. The list of suggested functional groups will be updated accordingly. The list is
sorted by quality to provide the best match on top of the list.

Open the Functional Group Browser
The functional group browser can be started from the IR/RAMAN Interpretation menu, whenever an IR or RAMAN spectrum
is activated in the data view.
1. Open an IR or RAMAN spectrum in a tab window.
2. From the IR/RAMAN Interpretation menu, click the Browse Functional Groups at specific Wavelength command.

Show all Functional Groups at...
In the IR or RAMAN interpretation result view, the functional group browser is available from the context menu in the
spectrum view.
1. Move the mouse pointer close to the peak of interest in the spectrum area of the result.
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2. Click the Right mouse button inside the spectrum view to popup the context menu.
3. From the context menu, select the menu entry Show Functional Groups at...
Add Functional Group to Interpretation Result
After selecting a frequency suggested functional groups are listed in the matching functional groups table as described
above. To add one or more functional groups to the spectrum interpretation result, please follow the steps below:
1. Click the functional group in the matching functional groups table you like to add.
2. Click the Add Functional Group to Result button.
The functional group will be transferred to the interpretation result automatically. The browser window remains open for
further frequency investigation.

Rule Designer
Functional groups of chemical compounds cause one or more related peaks at known positions in an IR or RAMAN
spectrum. In research the analyst takes measured spectra and tries to find prominent bands. Assignments need to be
matched to suggested or known molecules. For a detailed introduction, please also refer to the chapter "IR/RAMAN
Analysis Overview".
The main target of the rule designer is defining interpretation rules and organize them in a spectroscopic manner.
Interpretation rules represent the encoded knowledge of an experienced spectroscopist.
In the rule designer, interpretation rules can be created, modified, deleted, copied and pasted and administered. The
dialog looks like this:

Interpretation Rule Tree
The interpretation rule tree view (in the left part of the figure above) shows the organizational structure of rules within
the interpretation rule database. Rules can be organized following a particular hierarchy:
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Chemical Class
The chemical class is an organizational instance, which collects all characteristic properties of a group of substances, e.g.
alcohols or aromatic hydroxy compounds.
Chemical SubClass
The chemical subclass is an organizational instance like the chemical class itself. In some cases, the chemical class is too
general and needs to be split into several subclasses, e.g. the chemical class aromatic hydroxy compound is divided into
the subclasses Aromatic Alcohol and Phenol.
Functional Group
Each chemical class or subclass contains a number of functional groups corresponding to a fragment in a molecule. These
functional groups in a molecule are responsible for a collection of characteristic bands in a spectrum.
Interpretation Rule
Each IR or RAMAN band is represented by an interpretation rule. It is the smallest available unit in the interpretation rule
database. Properties of a band have been computerized into several parameters describing the band shape and
characteristics.

Navigation in the Rule Data Base Tree
The following operations are available in the tree view on the left of the dialog:
Expanding and collapsing Tree Nodes
Nodes in the tree can be expanded and collapsed by clicking with the Left mouse button on the
respectively.

icon or

icon

Selection of Tree Nodes
Selection of a functional group node automatically updates the interpretation rules table and the molecule view
accordingly.
If a chemical class or subclass is selected, the views and tables are cleared.
Multiple Selection of Tree Nodes
By holding down the CTRLkey and selecting several nodes in the tree, more than one node can be selected. This
feature is useful on copying and pasting several functional groups.
Adding a new Functional Group, Chemical Class or SubClass
A new item (chemical class, subclass or functional group) can be easily inserted into the tree.
1. Just select the node, where the new item must be inserted.
2. Press the INSkey to insert the next lower level item below the selected node.
3. Type a name for the new item into the highlighted new node and press the RETURNkey to finish.
Removing Tree Nodes
An item can be easily removed.
1. Select the node of the item, which has to be removed.
2. Press the DELkey.
3. Confirm the message by clicking the Yes button.
Renaming Tree Nodes
An item can be renamed as described in the following:
1. Select the node of the item, which has to be renamed.
2. Press the F2key.
3. Type a new name for the item into the highlighted node and press the RETURNkey to finish.
4. To cancel this operation, press the ESCkey.
Copy and Paste Operation for Functional Groups
Functional groups in the tree can be copied and pasted to another item, e.g. chemical class or subclass.
1. Select the one or more functional group nodes, which has to be copied.
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2. Press the CTRLCkeys to copy it into the clipboard.
3. Select a destination chemical class node or subclass node in the tree.
4. Press the CTRLVkeys to paste the functional groups.

Interpretation Rules Table
Each functional group is characterized by a set of interpretation rules being listed in the table on bottom right of the
dialog. They possess the following properties:
Vibration Name
This is meant to be a user defined name for the IR band describing the vibration type, e.g. OH stretch or OH bend.
Start Wave Number
This is the starting wave number of the interval, where the experienced analyst would expect the band in a spectrum.
Values need to be entered in 1/cm units.
Stop Wave Number
This is the ending wave number of the interval, where the experienced analyst would expect the band in a spectrum.
Values need to be entered in 1/cm units.

The range will be used in spectrum interpretation...
The spectral range of an IR and RAMAN band defined by start and end wave number is used in band
recognition during spectrum interpretation. Some manual fine tuning might be done in the Preferences. If
the range is not clearly defined, an overall deviation should be defined there before starting a spectrum
interpretation.
Threshold
The threshold describes the expected intensity of an IR or RAMAN band. The intensity is given in the categories listed
below relative to all peaks in the analyzed spectrum. The following categories are available:
Very weak
Weak
Medium
Strong
Very strong
Variable
Variable means, the intensity strongly depends on the chemical environment and spans from very strong to very
weak.
This parameter will be used in spectrum analysis...
The threshold is used in IR and RAMAN band recognition during spectrum analysis. Some fine tuning of
the categories is done in the Preferences. The threshold values for those categories should be adjusted
properly, before starting a manual spectrum interpretation.
Priority
The priority of a band describes the relative importance of the IR band. Sometimes bands are very weak or will be rarely
observed because of the chemical environment or other experimental conditions. By experience of the analyst the
importance of an IR band must be estimated applying the following categories:
Very low (green colored)
Low (green colored)
Medium (green colored)
High (green colored)
Very high (green colored)
Excluded (red colored)
This option has an extra meaning, which overrides the interpretation of other rules in the functional group, if the
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condition is met. It allows to exclude a particular IR band from a functional group
Example:
If a carboxylic acid is analyzed, strong signal at approximately 1690 1/cm is available for the carbonyl group
and a strong signal is available at approximately 3500 1/cm for the OHgroup. In the definition of an alcohol
functional group, the analyst would never expect a carbonyl band, although he would expect a OHband.
Therefore in definition of the alcohol functional group, the carbonyl band should be excluded. In this case,
the functional group would be ignored in analysis.
Mandatory (yellow colored)
This option has inverse meaning to excluded. It overrides interpretation of other rules in the functional group, if
the condition is met. It allows to include a particular spectral region as mandatory in a functional group. At least
one peak must be available in this region to match the condition.
Example:
Regarding the example from above, if a strong signal at approximately 1690 1/cm for the carboxylic acid group is
missing, this would never be a carbonyl group, although other bands might match the settings in the functional
group definition. In this case, the functional group should be ignored in analysis.
Coloring of Spectral Regions
The bands are color encoded according to their priority to allow quick identification:
Green Color
All expected bands are green colored. The degree of transparency indicates the priority. Opaque bands possess
high priority. The more transparent they get, the less is their priority.
Yellow Color
All mandatory bands are yellow colored.
Red Color
All excluded bands are red colored.

Molecule Fragment View
On top of the dialog, the actual functional group is presented as molecule fragment. The molecule is shown in a molecule
view. Please refer to the chapter "Molecule View Functions" section for details.
Add or replace a Molecule in Functional Group
One or more molecule fragments can be added to a particular functional group. They need to be drawn with any
commercial structure editor in advance and provided as *.mol file to the software. The following methods are available to
add a molecule to a functional group:
Drag and drop a *.mol file from windows explorer to the spectrum view on top of the dialog.
Add a Molecule command
1. From the Rules menu, select the Add Molecule command.
2. In the file dialog, select a *.mol file.
3. Click the Open button to add the molecule.
How to develop molecules which can be used in Functional Groups.
In the rule designer functional group molecules need a special Shape, because the algorithm used for
Validating spectrum and molecule will analyze provided molecule itself for available functional groups.
Here the molecules of each functional group definition will be matched with the molecule provided in
validation. This matching algorithm requires special definitions for generic groups and super atoms.
Please refer to the chapter "Designing Molecules for a Functional Group" for details.

Spectrum View with Interpretation Rule Placeholders
The spectrum view shows the position of interpretation rules within the visible spectral range as colored rectangles. The
color encodes the priority of a particular spectral region.
Please refer to the chapter "spectrum view functions" for details.
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Show the position of chemical classification rules on a sample spectrum...
For some applications, it is required to see the position of chemical classification rules of a functional
group directly on an underlying spectrum. For this purpose, a spectrum file (*.spc) can be directly
dragged and dropped as layer onto the spectrum view from MSWindows explorer.

Modification of Functional Groups
A basic set of interpretation rules and corresponding hierarchy is provided with the installation of the software. You may
modify, add or remove functional groups and molecules yourself to improve and adapt the rule database to your personal
requirements. For this purpose, the following options are available:
Changes will directly change all interpretation results!
Modification of the rule database will take direct effect on your interpretation results. Please be careful
when modifying interpretation rules.

Changes will be stored automatically!
Changes will be stored, if the rule designer is closed. You will be prompted to confirm saving
modifications.
Adding a new Interpretation Rule to a Functional Group
1. A new interpretation rule can be added by clicking with the Left mouse button into the empty row (next to the
asterisk symbol) of the chemical classification rule table on the bottom right of the:

2. A new row is inserted automatically and all values are defined as (Null):

3. Enter valid values into each column now or select from the drop down boxes if applicable.
4. After leaving the current row with RETURNkey or by clicking with the Left mouse button, the interpretation rule is
updated.
Modifying a Interpretation Rule of a Functional Group
1. A interpretation rule can be modified by clicking with the Left mouse button into the desired field to be changed
in the interpretation rule table.
2. Enter new valid values for the field or select from the drop down boxes if applicable.

EN

152 . Main Software Manual
3. Leave the current field with the RETURNkey or by clicking with the Left mouse button into another field. The
interpretation rule is updated automatically.
Deleting a Interpretation Rule from a Functional Group
1. With your mouse point to the dark blue area in front of a row within the interpretation rule table.
2. Click the Left mouse button to select the row in the table.
3. Press the DELkey to delete the row.
4. Confirm the warning message with the Yes button.

Show Functional Group Definition
It might be important for improving the rule database to easily review a functional group definition. The actual selected
functional group can be reviewed in the Rule Designer using the AltF12 keys shorthand or alternatively use the
following menu command:
1. Select a functional group from the list in the spectrum analysis result.
2. From the IR/RAMAN Interpretation menu, select Show Functional Group Definition.
Both methods open the Rule Designer window to show the actual functional group. Here you may review related
functional groups or modify rule definitions to optimize the rule database.

Loading IR/RAMAN Interpretation Rule Database
Before performing any IR or RAMAN interpretation, a proper set of interpretation rules need to be defined or an existing
rule database needs to be loaded. The default rule database for IR and RAMAN comprise a lot of predefined interpretation
rules, which might be customized by the user on demand. Initially the default rule databases installed together with the
software are loaded by default. Loading a different rule database is performed as follows:
Toggle to the right analysis mode before loading a rule database!
Before loading a rule database, please toggle the analysis mode to the one you want. The rule database
is loaded for the actual analysis mode accordingly!
To toggle the analysis mode, choose the Toggle to ... menu command in the IR/RAMAN Interpretation
Menu.

Loading a Rule Database in the main Application
In the main application a rule data base is loaded as described in the following:
1. From the IR/RAMAN Interpretation menu, select the Load Rule Database command.
2. In the File dialog, navigate to the file location of your rule database and select a *.rules file.
3. Click the Open button to load it.
A default set of Rules is installed together with the software!
Default interpretation rule databases are provided together with the software for IR and RAMAN,
respectively. They will be installed automatically and it is called "IRRules.rules" and "RAMANRules.rules"
accordingly. The files are located in a subdirectory called "Rules" in your software installation directory.

Loading a Rule Database in the Rule Designer
In the rule designer a rule database is loaded as described in the following:
Why is the Rule Designer missing in my software?
The rule designer is an optional module of the software. You will require a valid license to have this
function available. Please contact your software vendor for detailed information and a quotation.
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1. From the File menu, select the Open... command.
2. In the File dialog, navigate to the file location of your rule database and select a *.rules file.
3. Click the Open button to load it.

Preferences
For IR or RAMAN spectrum interpretation or Validation of spectrum and molecule some parameters might be set to take
influence on analysis results. However, in most cases automatic selection of parameters will provide good results,
because the automatic parameter detection will analyze each spectrum and adjust settings especially for the current
spectrum. Of course all parameters can also be adjusted manually.
Parameters are stored in the Interpretation Rule Database!
Any parameters adjusted in this dialog will be stored together with the interpretation rules in the
database. Thus modification of those parameters will modify the rule database. You will be prompted to
save or discard changes, if you leave the application or switch to another rule database.
This also means, you may have different parameters for IR and RAMAN interpretation depending on the
actual analysis mode.

Opening Interpretation Parameter Dialog
To open the interpretation parameter settings dialog , select the Preferences... command from the IR/RAMAN
Interpretation menu. The dialog looks like this:

It provides parameters for the following items:

Peak Detection
For spectrum interpretation peaks need to be identified in advance. The parameters in this section are identical to those
of the Find Peaks function in the "Mathematics" section of the software. Only identified peaks will be considered in the
interpretation process.
Automatic
If the automatic peak detection is enabled, various algorithms will find a suitable set of peaks for spectrum
interpretation. Otherwise you may adjust the parameters below for peak detection.
Perform AutoBaseline Correction
If enabled, the baseline of the spectrum is automatically corrected to obtain more precise peak detection results.
No particular parameters can be set here.
Peak Height
This parameter controls the minimum absolute or relative peak height. Only signals with intensities beyond this
value will be identified as peaks.
Use Absolute Peak Height
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This parameter controls the peak height detection mechanism, which is one of the following:
Absolute Peak Height (checked)
The absolute peak height is determined from zero to the maximum peak intensity.
Relative Peak Height (unchecked)
The relative peak height is determined from the imaginary baseline of the peak to the maximum peak
intensity.
Peak Width
This parameter controls the minimum peak width. Only signals with at least this minimum peak width denoted in
wavenumber units will be identified.
An existing peak table overrides peak detection ...
If you are not satisfied with results derived from automatic peak detection or peak detection with height
and width parameter, you can provide your own list of peaks for analysis. In this case, please find peaks
yourself using the "Find Peaks" function from mathematics section before starting IR/Raman
Interpretation.
An existing peak table overrides peak detection of the interpretation algorithm. In this case the existing
peak table is considered for analysis.

Band Detection Tolerance
Interpretation rules represent the expected positions of bands in a spectrum. However because of physical or solvent
effects sometimes bands are shifted and will not appear at original position. This might cause incorrect identification in
some cases. If signal shifting is observed in the spectrum, you can correct for it by setting a particular deviation in
wavenumber units. Bands will then be identified in their original expected range and also in an interval around.
Deviation
This parameter controls the size of the tolerance interval for each IR or RAMAN band.

Intensity Threshold
The strength of a signal in the spectrum strongly depends on chemical environment and physical properties of the
substance. In interpretation rules, expected signal strengths are stored being compared now to the current sample
spectrum signal intensities. With intensity threshold settings below the analyst encodes the strength of signals in the
analyzed spectrum from his personal feeling using the following categories:
Very weak
Weak
Medium
Strong
Very strong
The numbers behind these qualitative intensity categories represent the expected intensity ranges in absorbance units
where very weak, weak, medium, strong and very strong signals are expected. Peaks appearing within one of the
categories will be identified accordingly. Intensity values of these categories span from 0 to 1.5 absorbance units.
Categories are allowed to overlap.
Normalization of the spectrum.
The intensity of the highest detected signal in the measured spectrum is automatically scaled to 1.5
absorbance units. The lowest intensity (usually the base line) in the spectrum is set to 0. All intensities in
between will be scaled accordingly. This procedure is called normalization.

By default and as long as the Automatic checkbox is enabled, these intensity categories will be determined automatically
by some algorithms in the software.

Interactive Parameter Settings
Step by step optimization of parameters and improvement of results is also possible and you can see the result changing
directly without repeating all steps of the analysis.
1. Adjust parameters for spectrum interpretation in the dialog.
2. Click the Apply button for recalculation and update of interpretation results.
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Remove selected Funtional Group

After automatic interpretation has been completed, results can be modified and updated manually by the user because of
the following or other reasons:
Some of the peaks in your spectrum may not be identified by automatic spectrum interpretation.
Others have been identified, but from your point of view, assignment is not correct.
Deleting Functional Groups from Interpretation Results
Functional groups that have been added to the list by mistake can be removed as follows:
1. Click the Functional Group to be deleted with the Left mouse button in the table.
2. Press the DELkey on your keyboard
3. Alternatively, Select the Remove Selected Functional Group command from the IR/RAMAN Interpretation menu.
The functional group is removed without further notification.
Adding Functional Groups to Interpretation Result
You may add functional groups for a peak in your spectrum by selecting a suitable one from the rule database. The
Functional Group Browser will help you to identify suitable functional groups and lets you add them to the current
interpretation result. Please follow the steps below:
1. Move the mouse pointer close to the peak of interest in the spectrum area.
2. Click the Right mouse button inside the spectrum view to popup a context menu.
3. From the context menu, select the menu entry Show all Functional Groups at...
The Functional Group Browser opens and shows a list of best matching functional groups at the selected peak
position.
How to use the Functional Group Browser?
Please refer to the chapter "Functional Group Browser" for details on navigation inside the browser.

4. Select a functional group from the list in the Functional Group Browser.
5. Click the Add Functional Group to Result button to add current selected one.
6. Move the black vertical line to other frequencies / Peaks of interest.
7. Repeat steps 4  6 until all required peaks have been assigned.
8. Click the Close button to return to your initial interpretation result.

Highlight all assigned Functional Groups
The command "Highlight all assigned Functional Groups" provides a quick way of visualizing all vibrations in the current
spectrum that are already assigned to functional groups in the interpretation result. This enables the user to quickly
reveal all assigned and yet unassigned vibrations for further optimization or additional manual interpretation.
The selection of this command toggles highlighting on or off. All identified functional groups are colored blue as shown in
the following figure:
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The transparency level of blue colored vibrations indicate, which bands belong to the current selected functional group.
Vibrations of the current selected functional group are marked dark blue. Others are light blue. On selection of a different
functional group, colors of the current selected group return to original coloring and others keep their blue shape.

Enabling and Disabling Highlighting all identified Functional Groups
To enable or disable highlighting all identified functional groups the following options are available:
Why is the command disabled?
This command is only available, if a valid spectrum interpretation result or spectrum versus molecule
validation result is active!

The function is toggled on subsequent use.
Menu Command
1. In the IR/RAMAN Interpretation menu, select Highlight all assigned Functional Groups.
Context Menu Command
1. In the spectrum view of the IR spectrum interpretation result, click the Right mouse button.
2. A context menu is shown. From the context menu, select Highlight all assigned Functional Groups.
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Show Identified Peaks

IR and RAMAN interpretation strongly depends on peak detection, which is done prior to analysis. In order to see the
identified peaks you may activate peak markers in the spectrum view of the spectrum analysis result. When activated, the
peak position is indicated by a vertical red line.
For details please refer to the chapter "Peaks" in section "Data View Enhancements".
How do I control identified peaks?
Sometimes it might be necessary to modify peak detection parameters, because automatic peak
detection does not produce satisfactory results. You have the following options to take influence on peak
detection:
Open the Preferences dialog and change "peak detection" settings there. Please refer to the
section "Preferences" for details.
Before you analyze a spectrum, perform manual peak detection using the Find Peaks function in
the Mathematics menu of the software.
Analysis only considers your personal set of detected peaks then.

You may also like to review all identified peaks. They can be colorized in the spectrum to reveal not yet analyzed areas.
Please refer to the chapter "Highlight all assigned Functional Groups" for details.

Mathematics menu
The mathematics menu provides all available mathematics operations that can be performed with an object.

Mathematics menu contents
In the Mathematics menu, the following operations are available:
Convert xAxis Unit
Convert yAxis Unit
Interpolation
Crop Data
Cut xaxis
Zapping
Smoothing
Baseline correction
Multiplicative Scatter Correction
Detrending
Normalize
Normalize Spectrum
Offset Correction
Peak Picking
Peak Evaluation
Exponential and Logarithmic Calculation
Derivative Calculation
Arithmetic Calculation
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Spectrum Arithmetics
ATR correction
Advanced ATR correction
Deconvolution
Standard Normal Variate Correction
Noise Statistics
Manipulate Data Points
Kramers Kronig
Recent Mathematics
Curve Fit
Why are some menu entries missing?
Some commands, e.g. Colorimetric analysis, belong to optional modules requiring a special software
license. Please contact us for more detailed information.

Mathematics overview
Very often, analytical data must be transformed, units must be converted or data must be scaled to meet the user
requirements or for comparison with other data. All these required manipulation operations will be provided by the
mathematics module of the software. Mathematical methods can be applied to analytical data subsequently to yield the
results, the user likes to see.
Thus basic mathematical methods of the software are used to manipulate spectral data either temporarily or
permanently. All manipulations will be logged in the audit trail of the manipulated object for CFR 21 part 11 compliance.
This way, changes can be tracked easily. Some of the mathematical methods are data type dependent and others are
available with all data types.
In case the selected operation is not valid for the current data type, the user will be prompted.
In general, equidistant and discrete data objects will be distinguished. This is necessary since not all operations can be
carried out with discrete objects. A typical example for a discrete object is a mass spectrum, which contains a lot of non
equidistant data points. For example the Adjust xAxis method will not work with such data.

Applicable mathematical functions.
Some of the mathematical functions can only be applied to a particular data type. In this case, the
mathematical function is missing or disabled.

Convert Xaxis unit
The command convert Xaxis unit changes the xaxis unit of IR, NIR, RAMAN or UV/VIS spectra or even corresponding 3D
data objects. Conversion to wave number, millimeter, micrometer and nanometer is possible.
Converting the Xaxis unit is performed as follows:

Convert Xaxis unit menu command
To convert the xaxis unit to a different unit using the menu command, please follow the instructions below:
1. Activate the 2D View or 3D View area.
2. From the Mathematics menu, select the Convert Xaxis unit command.
3. In the Mathematics Tab, select the preferred destination unit via the Unit To dropdown box.
4. Press the Calculate button.

Convert Xaxis unit keyboard shortcut
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None.

Convert XAxis unit details
The convert XAxis Unit command recalculates the xaxis values of IR, NIR, RAMAN or UV/VIS spectra and corresponding
3D data and converts the values into one of the following units:
Wave number
Millimeter
Micrometer
Nanometer
By subsequent application of the command, the units will be toggled.

Convert Yaxis unit
The command convert Yaxis unit changes the unit of the intensity axis of IR, NIR, RAMAN or UV/VIS spectra or even
corresponding 3D data objects. Conversion to Absorbance, Transmittance, %Transmittance, Kubelka Munk and
Reflectance is possible. This operation is limited to those spectrum types.
The following picture shows the mathematics tab with selected convert Yaxis unit function:

Converting Energy Spectra using a Reference spectrum.
Sometimes spectra are kept in the raw intensity unit provided by the spectrometer. Typically this is Energy units or
Counts. Such spectra are useful in order to save the raw spectrometer output and being independent of the
spectrometer response characteristics. They can be converted to transmittance or absorbance spectra with an actual
reference spectrum of the current spectrometer in use at any later time when required. This way spectra become
comparable throughout multiple spectrometers.
All you need is the raw spectrum you like to convert and the reference spectrum of the spectrometer.
NOTE: Both spectra need to have the same unit on the xaxis and Energy units or Counts on the yaxis! In case you have
Arbitrary units on the yaxis, please perform a preliminary conversion to Energy units as described above. This will simply
rename the yaxis unit but does not change data.
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Converting the Yaxis unit is performed as follows:

Convert Yaxis unit menu command
To convert the intensity axis unit to a different unit using the menu command, please follow the instructions below:
1. Activate the 2D View or 3D View area.
2. From the Mathematics menu, select the Convert Yaxis unit command.
3. In the Mathematics Tab, select the preferred destination unit via the Unit To value.
4. If applicable select a suitable reference spectrum.
5. Press the Calculate button.

Convert Yaxis unit keyboard shortcut
None.

Convert YAxis unit details
The convert YAxis command recalculates the intensity values of IR, NIR, RAMAN or UV/VIS spectra and corresponding 3D
data and converts the values into one of the following units:
Absorbance units
Transmittance units
%Transmittance units
Kubelka Munk
Reflectance units
Popular unit with NIR spectra.
Energy
Counts
Spectra with raw intensity units (e.g. energy or counts) may also be converted to transmittance or absorbance if a
corresponding reference spectrum is available. The convert YAxis command offers an option to load a reference spectrum
if the source spectrum is in a suitable format. Please review the section convert Yaxis unit in the chapter commands for
further information.
By subsequent application of the command, the units will be toggled.

Absorbance
Absorption is a process in which incident radiated energy is retained without reflection or transmission on passing
through a medium.
Absorbance values can be easily converted into transmittance, percent transmittance or reflectance values using the
following equations:
Absorbance / transmittance conversion

Absorbance / reflectance conversion
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Absorbance / % transmittance conversion

Legend:
A

Absorbance value

T

Transmittance value

%T

Percent transmittance value

R

Reflectance value

Transmittance
The ratio of transmitted energy to the amount of incident energy is called transmittance. Transmittance was formerly
called transmission. Transmittance values can be easily derived from the formulas given above.

Percent transmittance
For some applications in optics it might be useful to see transmittance values as percent transmittance values. All
intensities will be scaled to fit an interval between 0 and 100 percent transmittance.

Kubelka Munk
Mostly used with diffuse reflectance spectra. KubelkaMunk units are calculated from the KubelkaMunk equation.

Reflectance
The ratio of reflected energy to the amount of incident energy is called reflectance.

Interpolate
The xaxis properties of equidistant and discrete 2D data objects can be changed by this function. Interpolate may also
be used to convert discrete data to equidistant data. It offers three manipulation operations at once:
The resolution of a spectrum can be changed.
Data points can be shifted on the xaxis.
Cut a spectrum.
Cutting spectra is done easily!
Besides the interpolation function, the Cut XAxis operation can be used to cut spectra conveniently. Please
review the "Cut XAxis" command section for details.

Interpolate menu command
To interpolate 2D data object, please follow the instructions below:
1. Activate the spectrum you like to change.
2. From the Mathematics menu, select the Interpolate command.
3. Adjust the parameters in the Mathematics tab. By default the last used settings are recognized by the software.
Click the Reset button to retrieve the parameters of the current active object (Optional).
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In the XAxis Properties category, enter a new Resolution value into the text field. When converting
discrete objects an average resolution will be proposed. Change this to the desired resolution.
4. Press the Calculate button.

Shift xaxis data points
To shift whole spectrum to the left or right, please follow the instructions below:
1. Activate the spectrum you like to change.
2. From the Mathematics menu, select the Interpolate command.
3. Adjust the parameters in the Mathematics tab. By default the last used settings are recognized by the software.
Click the Reset button to retrieve the parameters of the current active object (Optional).
In the XAxis Properties category, enter a new Minimum value into the text field.
In the XAxis Properties category, enter a new Maximum value into the text field.
4. Press the Calculate button.

Cut spectrum
To cut a spectrum, please follow the instructions below:
1. Activate the spectrum you like to change.
2. From the Mathematics menu, select the Interpolate command.
3. Adjust the parameters in the Mathematics tab. By default the last used settings are recognized by the software.
Click the Reset button to retrieve the parameters of the current active object (Optional).
In the XAxis Properties category, enter a new Minimum value within the range of the current spectral
region into the text field.
In the XAxis Properties category, enter a new Maximum value within the range of the current spectral
region into the text field.
4. Press the Calculate button.

Interpolation details
The interpolation is available for equidistant and discrete data. Interpolation may be used to convert discrete data into
equidistant data. It comprises three different functions at once:
The resolution of a spectrum can be changed.
Data points can be shifted on the xaxis.
Cut a spectrum.

Change resolution
The data point density or resolution of an equidistant 2D data object can be modified. This is sometimes useful to smooth
data or reduce the resolution for a zerofilling.
According to a new user defined resolution, data points will be adjusted on the xaxis. The new resolution can be higher
or lower than the old one. Depending on the new resolution settings, the number of data points is increased or
decreased accordingly.
The intensities Ii at each data point i is then interpolated using a polynomial fit function Pi with a user defined degree M
similar to the SavitzkyGolay algorithm. A polynomial degree M between zero to three and a window of five data points
are used for computation of 0th order, linear, squared and cubic interpolation. The interpolation polynomial looks like this:

Legend:
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Pi

Polynomial fit function

M

polynomial degree

ai

polynomial coefficients

Ii

Intensity at the ith data point

What does a polynomial degree zero mean?
0 th order interpolation means, that missing data point intensities will be filled up with the same intensity
value of data points nearby.

Change Resolution Example
By changing the resolution, the data point density of a 2D data object can be increased or decreased. In the following
example the data point density will be decreased by half.
The data points of the 2D data object are displayed as vertical lines for a better visualization:

After changing the resolution, the 2D data object looks like this:
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Shift xaxis data points
Sometimes, it is required, that the spectral region is slightly shifted, e.g. to match the data points of another spectrum.
Within the limits of two times the resolution of the spectrum, the starting point and ending point of a data object can be
shifted. New data point positions and related intensities are interpolated as described for the change resolution function.
How far can data points be shifted from their origin?
Data point shifting is only possible within the limit of two times the resolution of the 2D data object.

Shift xaxis data points example
The xaxis of the 2D data object is shifted by 0.5 units (to the left). The data points of the 2D data object are displayed
as vertical lines for a better visualization:
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After shifting, the spectrum looks like this:
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Cut spectrum
Sometimes, the user is only interested in a particular spectral region. Exceeding data points can be removed just by
cutting the spectrum on the left or right side of the xaxis. The interpolation function lets the user choose new borders for
the spectrum.
Cutting can also be done using the Cut XAxis command. For details please refer to the chapter "Commands".
How can I set new borders of a spectrum?
Enter a new starting value and / or new ending value within the current spectrum borders in the
interpolation function and the spectrum will be cut according to the new borders.

Crop Data
Cropping data is used in case users want to reduce the number of data points in spectral data by just removing every
second data point. Remaining data points will be kept unchanged. In case reduction of the number of data points with
interpolation is required, please use the Interpolate feature.

Stretch xAxis
The Stretch xAxis command performs a correction for frequency scale shifts and stretches in IRspectra using spectral
interpolation with a convolution filter.
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Stretch xAxis is performed as follows:

Stretch xAxis menu command
To stretch the xaxis using the menu command, please follow the instructions below:
1. Activate the 2D data object you like to correct.
2. From the Mathematics menu, select the Stretch xAxis command.
3. In the Mathematics tab, enter the desired parameters for xShift, stretch correction and frequency.
4. Click the Calculate button.

Stretch xAxis keyboard shortcut
None.

Stretch xAxis details
This function implements the correction for frequency scale shifts and stretches in IRspectra. Constant offset corrections
(xaxis shifts) and stretches at specified frequencies are possible. The correction is performed by spectral interpolation
with a convolution filter.
The Stretch xAxis command is available in the Mathematics menu.

Stretch xAxis parameters
The following parameters can be adjusted:
XAxis shift
Specifies the constant offset correction for the xaxis. The axis will be shifted by the entered value.
Stretch correction
Specifies the stretch correction that will be applied at the selected stretch frequency.
Stretch frequency
Specifies the desired stretch frequency.

Cut Xaxis
Some experimental data might contain important information only in a particular spectral region. For this purpose the
region of interest can be selected and remaining, worthless data points can be cut off. This will cause permanent loss of
data points which have been cut off!

How to cut off data?
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Cutting spectral data can be applied to one or more data objects of a particular data type at once. Depending on the
selected spectral region, data will be cut on the left, right or both sides.
1. Open one or more data objects to be cut.
2. Merge them into one data view.
3. Zoom into the region of interest.
Why zooming?
The actual zoomed spectral region is applied for cutting. All data points outside the visible zoom region
are cut off.

4. From the Mathematics menu, select the Cut XAxis command
or
Activate the Mathematics tab on bottom right of the application window and Select the Cut XAxis operation from
the drop down box.
5. Click the Calculate button.

Zapping
Zapping replaces a user defined number of data points in a 2D data object or 3D data objects by values of a linear
function. The user can adjust the starting and ending point of data replacement either graphically or by entering discrete
data point values.
Zapping is performed as follows:
Apply zapping operation to multiple data objects at the same time.
If you merge multiple spectra in one data view, zapping will be applied to all objects in the current view.

Zapping menu command
To zap a 2D or 3D data object using the menu command, please follow the instructions below:
1. Activate the 2D or 3D data object on your workspace.
2. From the Mathematics menu, select the Zapping command.
3. A default Tracker Tool is displayed within the spectrum view. (Only for 2D data)
4. Adjust the zapping parameters either from the mathematics tab or graphically.
Manual zapping adjustment
1. Enter a starting point for zapping into the Mininimum text field.
2. Enter an ending point for zapping into the Maximum text field.
Graphical zapping adjustment
1. Hold down the Left Mouse button somewhere within the Tracker Tool and move it to the preferred
zapping destination.
2. Release the Left Mouse button.
3. Hold down the Left Mouse button over one of the selection rectangles
move it to modify the Tracker Tool size.
4. Release the Left Mouse button.

Zapping keyboard shortcut
None.

Zapping on double click action
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To zap a 2D data object using a double click action, please follow the instructions below:
1. Activate the spectrum object on your workspace.
2. From the Mathematics menu, select the Zapping command.
3. A default Tracker Tool is displayed within the spectrum view.
4. Adjust the zapping parameters graphically.
5. Double click anywhere on the Tracker Tool to apply zapping.

Zapping details
The zapping function allows the user to identify a region of data points in a 2D data object or 3D data object and replace
them with a straight line connecting the starting data point with the ending data point at the extremes. In case of 3D
data, the specified region is replaced by a plain surface.
While it can be used for many things, this data editing tool is especially useful for wiping out interferences and spikes,
before e.g. searching data on a library.

Zapping parameters
The following parameters can be adjusted for zapping:
Applied Axis
This parameter is only available with 3D data objects. It denotes the zapping axis. Either the xaxis or yaxis can be
selected for zapping.
What is the maximum zapping region?
The zapping region must not exceed the borders of the current active spectrum. It is not possible to
enlarge the zapping region beyond the range of the xaxis of the current active 2D data object.
Minimum
Holds the starting value of the region in the dimension to be zapped.
Maximum
Holds the ending value of the region in the dimension to be zapped.

Smoothing
Smoothing is very often used with noisy spectra to emphasize relevant information and to wipe out background noise.
The SavitzkyGolay algorithm is applied to smooth data.
Smoothing is performed as follows:

Smoothing menu command
To apply smoothing using the menu command, please follow the instructions below:
1. Activate the 2D or 3D data view with objects to be transformed.
2. From the Mathematics menu, select the Smoothing command.
3. In the Mathematics tab, adjust smoothing parameters.
Adjust the Polynomial Order of the smoothing fit function.
Adjust the number of data point taken into account for the Smoothing Window.
4. Press the Calculate button.

Smoothing keyboard shortcut
None.
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Smoothing details
The SavitzkyGolay function is mostly used as lowpass filter to render visible the relative widths and heights of spectral
lines in noisy data without major loss of intensity. This procedure is called smoothing. Each data point of a 2D or 3D data
object will be evaluated under consideration of a number of neighboring data points and the overall resulting slope of the
data. The algorithm can also be used to calculate derivatives.

SavitzkyGolay smoothing algorithm
Each data point value fi of the 2D or 3D data object is therefore replaced by a linear combination gi of itself and some
number of neighboring data points,

Where n L is the number of data points used relative to the left of a ith data point and n R the number of points used to
the right. In the software n L and n R are equivalent to compute gi as the weighted average of data points around the ith
data point. The weighting factor cn for each data point i is derived from a polynomial least squares fit using a polynomial
of the degree M. The polynomial is defined as

Required polynomials for the least squares fit for each data point of a 2D or 3D data object can be easily obtained using a
previously designed matrix to produce required linear combinations of the polynomials. The matrix AT looks like this:

The weighting factors or SavitzkyGolay coefficients cn for each data point will be derived from the vectors aj in terms of
the vectors fi of the matrix Aij with the specific forms

and

where f is replaced by the unit vector en if the coefficient cn is the component a0 . cn is then calculated as:

For smoothing purposes only the coefficients a0 are interesting, because they represent the smoothed data point
intensity values.

SavitzkyGolay smoothing example
A somewhat noisy UV/VIS spectrum is smoothed using a 2nd order polynomial and a window of nine data points.
The original UV/VIS spectrum looks like this:
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(Source: J&M Analytische Mess und Regeltechnik GmbH, RobertBosch Str. 83, 73431 Aalen, Germany)
After applying the smoothing function, the UV/VIS spectrum looks like this:

Smoothing parameters
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The following smoothing parameters can be adjusted:
Polynomial Order
This value indicates the order of the polynomial fit function applied for smoothing of 2D or 3D data objects. A positive
integer value (greater than 0) must be entered into this text field.
1 = first order
2 = second order
...
n = nth order.
Smoothing window
An odd number of data points around each smoothed data point of the spectrum will be taken into account for calculation
of the smoothing polynomial. For details, please refer to the SavtizkyGolay documentation. The number of data points
can be selected from the drop down combo box by clicking the
icon at the right side of the parameter field.
Tip: With increasing polynomial order the number of window points must be increased accordingly. If the number of
window points is too small, a math error message is displayed on calculation.

References
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Bromba, M.U.A., and Ziegler, H. 1981, Analytical Chemistry, vol. 53, pp. 1583â1586.

Derivative
A derivative might be calculated from any 2D or 3D data objects, either equidistant or discrete.
A derivative operation is performed as follows:

Derivative menu command
To calculate the derivative using the menu command, please follow the instructions below:
1. Activate the desired 2D or 3D data object you want to work with.
2. From the Mathematics menu, select the Derivative command.
3. Adjust the derivative order
4. Adjust the derivative algorithm and related parameters.
5. Press the Calculate button.

Derivative keyboard shortcut
None.

Derivative details
Derivative calculation can be carried out with all 2D and 3D data objects, regardless if they contain equidistant or discrete
data points. The order of the derivative is variable and can be adjusted by the user. The algorithm used for calculation of
the derivative might also be adjusted.
For the derivative calculation, two different algorithms are available in the software:
Differential Quotient Derivative Algorithm
SavitzkyGolay Derivative Algorithm
The derivative workflow is described in more detail here:
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Derivatives Workflow
Examples:
Differential Quotient Derivative Example
SavitzkyGolay Derivative Example
See also
Open file
Mathematics Tab
SavitzkyGolay Smoothing Algorithm
Undo Function
Audit Trail

Differential Quotient Derivative Algorithm
The derivative for each data point of the 2D data object is calculated from the average differential quotients of two
adjacent data points to the data point of interest. This procedure is applied to all data points of the 2D data object. It is
assumed, that data points are available in ascending order regarding to the xaxis of the 2D data object.
The derivative is calculated from both sides of a data point P2 as follows:
There are two adjacent data points P1(x1;y1) and P3 (x3;y3) next to the data point P2 (x2;y2).

The differential quotients must be calculated to obtain the slopes S21 between points P2 and P1 and S32 between the
data points P3 and P2 as follows:

and

The derivative D2 of data point P2 is calculated as average of the slopes S21 and S32:

Caution when applying this algorithm to discrete 2D data objects!
The distance between data points is neglected, which might have relevant effects when the derivative is
applied to discrete 2D data objects.

Differential Quotient Derivative Example
The following x,y data set shows a sine function:
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(Source: LabCognition, Analytical Software GmbH & Co. KG, Leyendeckerstr. 33, 50825 Cologne, Germany)
The derivative calculation using the differential quotient algorithm returns a cosine function as expected:

(Source: LabCognition, Analytical Software GmbH & Co. KG, Leyendeckerstr. 33, 50825 Cologne, Germany)
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SavitzkyGolay Derivative
The higher order coefficients a1 to aM of the SavitzkyGolay smoothing algorithm are used for computation of numerical
derivatives of 2D data objects. The derivative for each data point of the 2D data object is derived from the convolution gi.
It has to be multiplied by m! to obtain the mth order derivative coefficients.

Tip: For derivative calculations the order M of the polynomials should be equal or greater than 4.

SavitzkyGolay Derivative Example
The following x,y data set shows a sine function:

(Source: LabCognition, Analytical Software GmbH & Co. KG, Leyendeckerstr. 33, 50825 Cologne, Germany)
The derivative calculation using the SavitzkyGolay derviative algorithm returns a cosine function as expected:
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Derivative Parameters
The following derivative parameters can be adjusted:
Derivative order
This value indicates the order of the derivative function applied to the current 2D data object. An integer value greater
than 0 must be entered into this text field.
1 = first order
2 = second order
...
n = nth order.
Smoothing window
The smoothing window parameter is only used with the SavitzkyGolay derivative algorithm. An odd number of data
points around each data point of the spectrum will be taken into account for the derivative calculation. For details, please
refer to the SavtizkyGolay documentation. The number of data points can be selected from the drop down combo box by
clicking the
icon at the right side of the parameter field.
Tip: With increasing derivative order the number of window points must be increased accordingly. If the number of
window points is too small, a math error message is displayed on calculation.
Use SavitzkyGolay algorithm
This is a flag indicating, whether the differential quotient algorithm (default) or the SavitzkyGolay algorithm is used for
derivative calculation. The flag might be toggled by clicking the
icon at the right side of the parameter field and
selecting a new value from the list.
No
Differential quotient algorithm
Yes
SavitzkyGolay algorithm

References
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Baseline correction
The baseline correction algorithm allows automatic correction of drifted baselines using a polynomial fit function and
automatic peak detection. For peak detection purposes, some additional parameters must be adjusted.
Baseline correction is only available for 2D data objects.

Various baseline correction algorithms are available. Please review the Baseline Correction section in the chapter
"Mathematics" for details.

To perform a baseline correction, please follow the instructions below:

Baseline correction menu command
To perform a baseline correction using the menu command, please follow the instructions below:
1. Activate the spectrum, you like to correct.
2. From the Mathematics menu, select the Baseline Correction command.
3. Adjust the baseline parameters in the Mathematics tab.
4. Move the baseline knots indicated by red squares to match your needs (Optional).
5. Add new baseline knots (Optional).
6. Remove those baseline knots not needed (Optional).
7. Press the Calculate button.

Baseline correction keyboard shortcut
None.
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Adding baseline knots
Adding baseline knots is only possible when using the polyline algorithm. To add a baseline knot, follow the instructions
below:
1. Move the mouse pointer to the destination in the data view where to add a new baseline knot.
2. Hold down the CTRLkey and click the Left mouse button to add a baseline knot.

Removing baseline knots
To remove baseline knots follow the instructions below:
1. Move the mouse pointer to the baseline knot to be removed.
2. Click the Left mouse button to activate the baseline knot.
3. Press the DELkey to remove it.

Baseline correction
A perfect curve shape of analytical 2D data objects include a constant base level value, where no signals are observed.
This base level is called the baseline of a 2D data object. Because of changes in experimental conditions during
measurement, temperature influences or any other interference, the baseline sometimes drifts away from its original
base level. In this case, the baseline of a 2D data object might be corrected after a measurement has been completed
using the baseline correction function of the software. It might be applied, whenever consecutive operations are required
like ATR correction or finding peaks.

How does baseline correction work?
Several baseline algorithms are available as described in the following:
Polyline algorithm
Horizontal algorithm
Peak detection algorithm
Linear least squares regression algorithm
Two point algorithm
Spline algorithm
To select one of the algorithms, choose the entry from the algorithm drop down box in the Mathematics tab. Each
algorithm provides a set of individual parameters, which can be adjusted after selection.

Polyline algorithm
This algorithm shows a linear baseline drawn directly between first and last data point of the current visible part of the
2D data object in the data view. The end points of the line possess baseline knots (red squares) which can be moved to
adjust bias and slope of the line:
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Additional knots can be added optionally to get a polygonal line for correction. Please review the Baseline Correction
section in the chapter "Commands" to learn how to add and remove baseline knots. After adding some baseline knots,
correction can be carried out.

The polyline algorithm offers an additional autodetect option. Choosing this option will modify the polyline so that the
baseline knots of the resulting corrected spectra will lie on the xaxis:
Autodetect selected: All spectra will be corrected so that the selected baseline knots will lie on the xaxis with an y
value of 0.
Autodetect unselected: The selected polyline will used "as is" to correct the spectra. The resulting baseline may not
coincide exactly with the xaxis.
The corrected data object looks like this:
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After correction a new baseline will be proposed automatically for subsequent correction.
Which region is considered for baseline correction?
Baseline correction is only performed on the area covered by the line! Data points outside the area remain
unchanged.

Horizontal algorithm
The baseline will be corrected by using a horizontal line. In principle this algorithm works like an offset correction. The
entered value will be subtracted from the entire spectrum, thus shifting it up or down for a certain amount. Therefore this
algorithm is especially useful for correcting spectra with a constant offset. The correction value can either be entered by
moving the horizontal line directly in the spectrum or by entering a numerical value into the parameter "absolute height".
By clicking the Reset button the horizontal line and the parameter "absolute height" will automatically be set to the
minimum intensity present in the spectrum. You can use this algorithm to correct positive or negative offsets.

Peak detection algorithm
A polygonal fit function will be determined automatically, which follows the slope of the graph of the 2D data object by
neglecting detected peaks. Significant changes in the bias indicate the starting and ending point of a peak signal. These
regions will be excluded from baseline detection automatically. The user might assist the automatic peak detection
algorithm by adjusting the following parameters:
Group adjacent peaks
This parameter indicates, whether adjacent or overlapping peaks will be interpreted as a single peak or multiple peaks. If
the flag is set true, such overlapping peaks will be ignored and identified as one peak. The baseline of the following
spectrum excerpt is shown in the figure below (red line):
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If the parameter is set false, at least one data point between the end of the first peak and the starting point of the next
peak will be interpreted as a base line point. In this case, the same baseline correction detects multiple peaks within the
displayed area from above. The baseline follows the red line in this case:

The resulting spectrum looks like this:
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Minimum Peak Height
This parameter controls the peak detection concerning the minimum peak height. It is a threshold value relative from the
imaginary base line along the graph slope, that must be overridden to identify a peak. The minimum relative peak height
is given in fractions of yaxis units.
Minimum Peak Width
This parameter controls the peak detection concerning the minimum peak width. A minimum expected peak width is
adjusted here. This value might alter depending on the data type. The minimum estimated peak width is given in fractions
of xaxis units.

Linear least squares regression algorithm
This baseline correction algorithm facilitates the Standard Normal Variate correction. Besides the noise and background
correction the overall graph slope can be detrended. A polynomial fit function is applied for detrending.
Detrend
Detrending can be included into the baseline correction or not. The following parameter settings are available:
None
No detrending is performed.
Polynomial Fit
A polynomial fit function is applied for detrending.

Two point algorithm
The baseline will be corrected by a line defined by two points. These endpoints can be automatically calculated from a
predefined region in the spectrum. This is useful for sets of spectra which exhibit slight shifts. Several methods calculating
the start and end point are available. The selection for the two point baseline correction looks like this:
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The endpoint preselection is done by moving the red selection rectangles to the desired position. The width of the
selection rectangle can be adjusted by the grey tracker boxes and defines the region of points from which the actual
endpoint will be calculated by one of the following methods. The actual calculated endpoints are shown as red vertical
lines with red boxes inside the selection rectangles.
Single
Two distinct points are directly selected as endpoints. The point are show as red vertical lines without selection areas in
the spectrum. This is similar to the simple line algorithm.
Average
The endpoints are calculated as the average of the group of points that are defined by the selection rectangle.
Minimum
The endpoints are calculated as the minimum of the group of points that are defined by the selection rectangle.
Maximum
The endpoints are calculated as the maximum of the group of points that are defined by the selection rectangle.
None
No endpoint selection algorithm is used.
Alternatively the numerical values can be entered directly using the parameter sets Startx, EndX or Start Minimum, Start
Maximum, End Minimum and End Maximum:
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The twopoint algorithm is also part of the baseline correction used in the command thickness correction. Please refer to
the chapter thickness correction for a detailed description of the selection methods.

Spline Algorithm
The spline algorithm works similar to the Polyline algorithm except for the handling of the baseline knots. When using the
spline algorithm, each baseline knot will have additional spline controls to help adjusting the line shape. By moving the
spline controls the user is able to accurately adapt the baseline shape to the spectrum. The following picture shows an
example of an intermediate baseline knot with two spline controls:

Multiplicative Scatter Correction
The Multiplicative Scatter Correction corrects spectra for spectral noise and background effects which cause baseline
shifting and tilting.
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For details on the algorithm, please refer to the Multiplicative Scatter Correction section in the chapter "Mathematics".
The mathematics tab for the Multiplicative Scatter Correction looks like this:

The calculation may be performed using the full spectral range or multiple distinct ranges. Check the FullRangeCheckbox
to use the full spectral range. Uncheck the checkbox and add new ranges with the New Rangebutton to use distinct
ranges. Ranges can be edited by selecting them and entering numerical values and can be deleted by using the Delete
Rangebutton. Editing/deleting is also possible directly in the dataview. Select a range by leftclicking and move/edit it
by dragging and using the tracker tool. Pushing the Delkey will delete a selected range.
To perform a Multiplicative Scatter Correction, please follow the instructions below:

Multiplicative scatter correction menu command
To perform the operation using the menu command, please follow the steps below:
1. Open the desired 2D data objects to be corrected.
2. Merge them into one data view.
3. From the Mathematics menu, select the Multiplicative Scatter Correction command.
4. Adjust the ranges for the calculation.
5. In the Mathematics tab, click the Calculate button.

Multiplicative scatter correction keyboard shortcut
None.

Multiplicative Scatter Correction details
The multiplicative scatter correction has been proposed as method in NIR spectroscopy to correct signals for noise. Light
scattering or change in path length for each sample is estimated relative to that of an ideal sample. In principle this
estimation should be done on a part of the spectrum which does not contain chemical information, i.e. influenced only by
the light scattering. However the regions in the spectrum that hold no chemical information often contain the spectral
background where the signal to noise ratio may be poor. In practice the whole spectrum is sometimes used. This can be
done provided that chemical differences between the samples are small. Each spectrum is then corrected so that all
samples appear to have the same scatter level as the ideal.
For details on how to perform a multiplicative scatter correction, please review the "Commands" chapter.
Standard Normal Variate Correction is another method for noise reduction!
Please review the chapter "Standard Normal variate Correction" for details.
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Multiplicative Scatter Correction Algorithm
As an estimate of the ideal sample, we can use for instance the average of the calibration set. Multiplicative scatter
correction performs best if an offset correction is carried out first. For each sample:

where
xi: the ith spectrum of the collection used for calculation.
a, b: For each sample, a and b are estimated by ordinary leastsquares regression of spectrum xi versus
yAverage over the available wavelengths j.
Each value xij of the corrected spectrum xij (MSC) is calculated as:

where
xij: the intensity of the ith spectrum and jth wavelength of the collection used for calculation.

Detrending
In addition to baseline correction and standard normal variate correction, the detrending algorithm allows automatic
correction of drifted baselines and removes offset and tilting from spectra. The general graph slope will be detrended
using a polynomial fit function.

To perform a detrending, please follow the instructions below:

Detrending menu command
To perform a detrending using the menu command, please follow the instructions below:
1. Activate the spectrum, you like to correct.
2. From the Mathematics menu, select the detrending command.
3. Adjust the Fitting Polynom Order in the Mathematics tab.
4. Press the Calculate button.

Detrending keyboard shortcut
None.
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Detrending details
The detrending function is used to remove offset and tilting from spectra. The general graph slope will be detrended.
The detrending function offers polynomal fitting functions up to the fourth order:

Normalization
Normalization scales the intensities of a discrete or equidistant 2D or 3D data object to fit a user defined interval.
Normalization is performed as follows:

Normalization menu command
To normalize a 2D or 3D data object using the menu command, please follow the instructions below:
1. Activate the 2D or 3D data view with desired objects to be transformed.
2. From the Mathematics menu, select the Normalization command.
3. Adjust the normalization parameters.
Adjust the Minimum parameter to define a new lower boundary of the intensity interval.
Adjust the Maximum parameter to define the new upper boundary of the intensity interval.
Toggle the Normalize Minimum flag to keep the spectral offset or not.
4. Press the Calculate button.

Normalization keyboard shortcut
None.

Normalization details
Normalize is used to scale the intensity values of a 2D or 3D data object within user defined limits. Usually this function is
useful for visual comparison of two or more 2D data objects. It is also required as preprocessing function for many other
mathematical functions even in chemometric analysis or colorimetric analysis. Data might be normalized to an absolute
user defined intensity interval or the current yoffset is kept. The latter is called relative normalization.

How does normalize work?
All intensities of the 2D or 3D data object will be corrected using a scaling factor f to fit data to the user defined borders
of the new intensity interval. The scaling factor f will be derived from the current global minimum Imin and maximum Imax
Intensities and the new user defined minimum Iâmin and maximum Iâmax intensities of the 2D data object as follows:
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Each intensity Ii of the 2D or 3D data object is then recalculated to fit the new interval using a linear transformation:

Normalize parameters
The following normalize parameters might be adjusted:
Minimum Y
The Minimum Y parameter is only used, if the Normalize Minimum flag is set true. It holds the new lower bound of the
intensity interval. After normalization, the lowest intensity within the 2D or 3D data object is scaled to the Minimum Y
value.
Maximum Y
The Maximum Y parameter is always applied. It holds the new upper bound of the intensity interval. After normalization,
the highest intensity within the 2D or 3D data object is scaled to the Maximum Y value.
Normalize minimum
Two types of normalizations can be applied:
Absolute normalization
Data is scaled within the user defined interval between Minimum Y and Maximum Y values. After normalization,
the lowest intensity value in the 2D or 3D data object is equal to the Minimum Y value and the highest observed
intensity value is equal to Maximum Y.
Relative normalization
This procedure considers the current yoffset of the 2D or 3D data object that will be kept. Data is scaled between
a user defined interval starting with the lowest available intensity in the spectrum and ending with Maximum Y
value. The Minimum Y value is ignored in this case.

Normalize Spectrum
Correction of spectral intensities according to reference material peaks in spectral data is widely used as normalization
approach. The Normalize Spectrum feature allows correction according to a particular intensity as well as correction by
peak area. In normalization all spectrum intensities are divided by the selected peak intensity or area. In addition the
peak intensity or area can be either absolute to 0.0 or baseline corrected according to a twopoint baseline definition.
Thickness Correction
This type of operation is also used as an integrated part of Thickness Correction.

Normalization
The same normalization methods are available as described in Thickness Correction.

Use Baseline
This flag indicates whether the absolute peak intensity or absolute peak area are used for calculation. Absolute means,
no baseline is used to correct the height or peak area.
True
The intensity/peak is corrected using the twopoint baseline.
(Example: By Peak calculation with baseline)
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False
The absolute intensity/peak area down to 0.0 are considered for calculation.
(Example: By Peak calculation without baseline)

Baseline Parameters
The baseline parameters described in twopoint baseline correction are applied here.

Offset Correction
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The Offset Correction is a special normalization to a user defined position on the xaxis. All data objects in the current
data view will be scaled to match a user defined position in the current active object.
Use the Offset Correction command from the Mathematics menu or select the Offset Correction operation directly from
the Mathematics tab to perform this operation. The following options will be displayed in the Mathematics Tab:

Offset Correction algorithm options
The following algorithms are available for performing an offset correction:
ShiftToOffset  All objects in the current data view will be shifted to the current intensity at the selected xaxis
position of the active data object. Consequently, the intensities of all other objects will be increased/decreased by
intensity difference at the selected position.
ScaleToOffset  All objects in the current data view will be scaled to the current intensity at the selected xaxis
position of the active data object. Consequently the active object will remain unchanged and the intensities of all
other objects will be multiplied by the factor ActiveSpectrumIntensity[x] / OtherSpectrumIntensity[x].

Offset Correction example
Take the following set of spectra as an example:

Selecting the offset correction function shows a vertical line indicating the position on the xaxis, where correction takes
place. After performing a ShiftToOffset calculation, all spectra will be shifted to match the intensity of the active spectrum
at the given position. The user may also enter a destination intensity value to which the spectra will be matched. The
result looks like this:
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Offset Correction procedure
To perform a correction, please follow the steps below:
1. Open one or more data objects to be normalized.
2. Merge those data objects into one data view.
3. From the Mathematics menu, select the Offset Correction command.
Numeric offset correction
In the Mathematics tab, do the following parameter adjustments:
1. Select the desired offset correction algorithm.
2. Set the XValue to the desired normalization position on the xaxis.
The data view will be updated automatically!
The vertical line will be shifted to the new position automatically.

2. Set the YValue to the desired intensity or do not modify this parameter if you like to keep current intensity
(Optional).
3. Click the Calculate button.
Graphical offset correction
In the data view, do the following:
1. Select the desired offset correction algorithm.
2. Move the mouse pointer close to the vertical line.
3. Hold down the Left Mouse button
4. Move the vertical line to a new destination.
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5. Release the Left Mouse button.
Parameters will be updated automatically!
Parameters in the Mathematics tab will be updated automatically according to the new xaxis position.

5. Set the YValue to the desired intensity or do not modify this parameter if you like to keep current intensity
(Optional).
6. Click the Calculate button.

Peak Picking
The Peak Picking algorithm automatically detects peaks in any 2D data objects. Resulting peaks will be shown in a peak
table on the peak table tab. Peaks are also colored in the data view to show the peak areas.
Finding peaks is performed as follows:

Peak Picking menu command
To find peaks using the menu command, please follow the instructions below:
1. Activate the 2D data object you would like to find peaks in.
2. From the Mathematics menu, select the Peak Picking command.
3. (Optional) Enable Auto Detect and enter your desired amount of peaks. Proceed to step 7.
4. In the Mathematics tab, adjust the find peaks parameters.
5. Alternatively, move the horizontal threshold line to a new position (Optional).
The line can be easily moved by a fixed distance using the Arrow Up and Arrow Down buttons in the mathematics
tab.
What is the horizontal line good for?
The horizontal line indicates the threshold for peak detection. The minimum required intensity with
respect to the data baseline is shown. The line can be moved by drag and drop:
1. Move the mouse pointer close to the horizontal threshold line.
2. Push and hold the Left mouse button.
3. Move the mouse upwards or downwards. The line follows the movement.
4. Release the Left mouse button.

6. The peak picking results will be automatically update when modifying the horizontal threshold line.
7. If you manually edited the parameters or enabled auto detect click the Calculate button to update the results.

Peak Picking keyboard shortcut
None.

Peak Picking parameters
The following parameters can be adjusted:
Group adjacent peaks
Please refer to the Baseline Correction parameters for details.
Minimum peak height
Please refer to the Baseline Correction parameters for details.
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Minimum peak width
Please refer to the Baseline Correction parameters for details.

Peak Picking details
The Peak Picking function of the software automatically detects peak maxima or minima in a 2D data object. Either
discrete or equidistant data objects can be used. Peaks can also be added and removed manually.
In automatic peak detection, only peaks with a user defined minimum intensity relative to the data baseline and a
minimum average peak width will be considered. These parameters must be adjusted properly by the user before
automatic calculation is applied.
From the first derivative of the data object, maxima will be detected using the SavitzkyGolay derivative function.
Shoulders and/or overlapping of adjacent peaks might be also analyzed using the second derivative of the data object.
Some parameters can be adjusted by the user to optimize peak finding conditions.
When using manual peak finding, the user may freely define new peaks at any data position. After adding a new peak its
start, end and maximum position can be modified.
Resulting peak information will be shown either in a peak table or as peak markers directly in the data view or both.
Display options can be customized in the 2D Preferences dialog. The peak table is shown on a separate tab below the
data view. It will be displayed on demand.

Peak table
The peak table holds several columns with information regarding position of a peak within a 2D data object. Available
columns strongly depend on the data type.

Usually, the following columns are available in a peak table:
Number
Each peak in the collection possesses a unique, concurrent number starting from the lowest xaxis value to the highest x
axis value.
Begin
This value indicates the starting point of a peak in xaxis units.
Max
This value indicates the position of the peak maximum/minimum in xaxis units.
End
This value indicates the ending point of a peak in xaxis units.
Width
This value indicates the difference between ending point and starting point in xaxis units.
Height
This value indicates the relative intensity at the peak maximum in yaxis units. The relative intensity at the peak maximum
will be calculated as difference between the absolute intensity and the baseline intensity at the maximum.
Absolute Height
This value indicates the absolute intensity at the peak maximum in yaxis units. The absolute intensity at the peak
maximum will be calculated as difference between the absolute intensity and zero.
Peak Area
This value indicates the peak area between the graph and the baseline, lasting from the starting point to the ending
point of a peak.
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Center of Gravity
This value shows the Center of Gravity of the peak.

Peak table display options
Visibility of peak table columns and order of appearance can be customized. Whenever a peak table is shown in the peak
table tab customization is carried out as described in the following:
Results from Peak Evaluation are also visible here!
If any peak evaluation methods are defined for the current data type, the results are available in
additional peak table columns. These columns can be shown or hidden here. Please refer to the "Peak
Evaluation" section for details.

1. Click the Right mouse button on the peak table area.
2. From the dialog, select preferred columns to be displayed.
3. Change their order of appearance according to you needs.

4. Click the OK button to apply settings

Peak Markers
Besides the peak table, peak markers are shown in the data view area on top of the corresponding peak. Each peak
marker consists of start, end and maximum/minimum tick marks as well as a peak label. The peak label shows the actual
position either on the xaxis, yaxis or both. Peak markers can be customized in the 2D Preferences dialog.
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Find peaks automatically
The following excerpt from the N,N,2,4TetraMethylAniline IR spectrum is submitted to peak picking in the following. The
spectrum excerpt looks like this:
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Minimum peak height adjustment
The minimum peak height must be adjusted properly to give positive peak finding results. If the value is too large, smaller
peaks will not be detected anymore. It should be adjusted close to the noise level of the spectrum to gain optimal
results.
The noise level including some minor baseline drifts up and down is estimated to be 0.02 yaxis units. So the minimum
peak height parameter should be set to this value.
How to get the optimum peak height level?
Start with 0 as minimum peak height and minimum peak width. Then increase the minimum peak height
value in small yaxis fractions to get all the peaks you like to see or even some more.
Minimum peak width adjustment
The peak width must be properly adjusted. If it is set too small, all kinds of noise or spikes will be detected and false
peak results will be produced. If the value is set too large, narrow peaks might be missed and will be kicked out of the
peak list. So an average peak with for the current data type should be entered here.
How to get the optimum peak width level?
Start with the previously adjusted minimum peak height level and enter the width of the broadest peak
in your spectrum. Adjust this value as minimum peak width. Then decrease the value in small xaxis
fractions to slowly increase the amount of detected peaks to get as many peaks as you like to see.
Finding peaks without adjacent peak grouping
This option is used to separate preselected peaks (see parameter adjustment above) that might overlap to just one
peak.
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Peak finding without adjacent peak grouping is shown in the following figure:
The following parameter settings are applied:
Group adjacent Peaks = No
Minimum Peak Height = 0.02
Minimum Peak Width = 0

All the center peaks are strongly overlapping, but the peak grouping is deactivated for finding peaks. In this case, the
baseline strongly follows the graph slope. It moves up to the small peak in the middle and down again. The large peak in
the middle is split into a total of three peaks.
Peak picking with adjacent peak grouping
In contrast to the figure above, the following figure shows the same peak detection with adjacent peak grouping.
The following parameter settings are applied:
Group adjacent Peaks = Yes
Minimum Peak Height = 0.02
Minimum Peak Width = 0
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The baseline does not strongly follow the graph slope in this case. Adjacent or overlapping peaks, which do not return to
the overall spectrum baseline level, will be cut off by a vertical line. Area and peak height calculation will be adapted to
the baseline accordingly.

Add peaks manually
In addition to the automatic peak finding methods, peaks can be added manually. Please follow the instructions below to
add a peak:
1. Move the mouse pointer close and underneath the position of the graph where you like to add a peak.
2. Hold down the CTRLkey and click the Left mouse button to add a new peak.
3. Use the red tracker boxes to adjust the bounds of the manually added peak.

Edit peaks manually
Peaks can be edited manually either by modification of start, end or maximum values within the peak table or graphically.
Modification of peaks is possible as long as the Peak find tool is activated in the mathematics tab.
Modifying peaks in the peak table
Modification of a peak within a peak table is done as described in the following:
1. Browse the peak table or just click the peak to be modified in the data view with the Left mouse button.
2. Click the Left mouse button to enter the field you like to change.
3. Enter a new valid value.
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Why is the entered value not valid?
The new entered value for start and end of a peak must be chosen in that way, that the peak area
underneath the peak is not parted by the graph. In other words, the baseline of the peak must not
cross the graph. The value will be adjusted automatically to the nearest valid data point to your actually
selected position.
Secondly, the position of the maximum/minimum must be within the limits of start and end peak marker.

4. Press the Returnkey to apply changes.
Graphical modification of peaks
As long as the peak find tool is activated in the mathematics tab, each peak shows tracker icons (red squares) at start,
end and maximum/minimum position of a peak. Modification of the peak is performed as described in the following:
1. Move the mouse pointer close to a tracker icon.
2. Press and hold the Left mouse button.
3. Move the mouse along the graph slope to the new destination position.
4. Release the Left mouse button.
Why is my selection not applied?
The new start or end position of a peak must be chosen in that way, that the peak area underneath the
peak is not parted by the graph. In other words, the baseline of the peak must not cross the graph. The
position will be adjusted automatically to the nearest valid data point to your actually selected position.
Secondly, the position of the maximum/minimum must be within the limits of start and end peak marker.

Removing peaks
Single peaks or the whole peak table can be removed from the current data object.
Removing a peak table
1. In the mathematics tab, select the Find Peaks operation.
2. Press the Clear Table button.
Remove a single peak
1. Select the peak to be removed either in the data view or the peak table by clicking with the Left mouse button
onto it.
2. Press the DELkey to remove it.

Peak Evaluation
Peak Evaluation is applied to show additional user defined calculation results together with the peak table of a data
object. Calculation results are derived from any peak data of a spectrum. Please refer to the "Peak Evaluation" section in
the chapter "Mathematics" for details.
Peak Evaluation is configured as follows:

Peak Evaluation Menu Command
To add new peak evaluations or edit existing peak evaluation methods using the menu command, please follow the
instructions below:
1. Activate the 2D data view with desired objects to be evaluated.
2. From the Mathematics menu, select the Peak Evaluation command.
3. In the Peak evaluation dialog, click the Add button to add a new evaluation method.
Alternatively, select an existing evaluation method from the list on the left.
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4. Modify the formula by clicking the

button.

5. Click the OK button.

Peak Evaluation Keyboard Shortcut
None.

Peak Evaluation details
Peak evaluation provides optional user defined calculations on available peak data of a data object. Any calculation
results based on peak data can be added to your spectral data. Calculation results will be presented as additional
columns in the peak table. Whenever the user uses the Find Peaks operation to create a peak table for the data object,
additional calculation results are calculated as well and presented in the peak table.
The Peak Evaluation command is available in the Mathematics menu.
Peak Evaluations are data type dependent!
Peak evaluation methods are useful for particular data types. Therefore, several peak evaluation methods
can be stored by data type. Only those of the active data type will be applied to your data.

Add or Edit Peak Evaluation
To add new peak evaluation methods or edit existing evaluation methods, please follow the steps described below. If
you want to edit an existing evaluation method, select it from the list and continue with step 5 of the description below:
1. From the Mathematics menu, select the Peak Evaluation command.
The Peak Evaluation dialog opens and shows existing evaluation methods.
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2. Click the Add button to add a new peak evaluation method.
A dialog opens, where you must enter a new name for the peak evaluation method:

3. Enter a meaningful name for your peak evaluation method.
4. Click the OK button to create the new peak evaluation method.
The new peak evaluation method will be transferred into the main dialog:

5. Click into the empty field beside the label Formula in the Evaluation Parameters.
6. Enter a user defined formula or click the

button to open the formula editor.

7. In the formula editor, enter the particular evaluation formula. You might refer to any peak data and other spectral
information in your calculations. Please refer to the "Peak Evaluation Formula Editor" section in the chapter
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"Dialogs" for details.
8. Click the OK button to save current peak evaluation methods and close the dialog.

Remove Peak Evaluation
1. From the Mathematics menu, select the Peak Evaluation command.
The Peak Evaluation dialog opens and shows existing evaluation methods.

2. In the list of peak evaluations on the left, select the evaluation method you like to delete.
3. Click the Remove button.
4. Click the OK button to save current peak evaluation methods and close the dialog.

Show and Hide Peak Evaluation Results
Peak evaluation results are calculated automatically, whenever a peak table is created using the Find Peaks command.
Results are shown in additional columns of the peak table. To show or hide these columns, please change the peak table
column settings.
For details on this, please refer to the "Peak Table Display Options" section.

Peak Evaluation Example
A very simple example is the calculation of the extinction values of peaks in a UV spectrum. This can be done automatically
with peak evaluation on creation of a peak table.
1. Add a peak evaluation formula as described above using the following formula for calculation of the extinction:
log ( Intensity[ x ] / #Peak.Height )
where
x: wavelength of your background Intensity
2. Then select the Find Peaks command in the mathematics menu.
3. Adjust the peak parameters in the Mathematics Tab.
4. Click the Calculate button.
The new peak table shows peak data and an additional column with extinction results:
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Peak Evaluation Formula Editor
The peak evaluation formula editor allows you to enter an individual formula for calculating a peak evaluation result. All
intensity values, peak heights or peak areas might be addressed in a custom formula for calculation. Furthermore it is
possible to use additional information stored in custom labels attached to data objects in use.
The formula editor looks like this:

Enter any formula using simple arithmetic operations into the text field. If you are not sure about the syntax, please use
the short hand buttons underneath the text field or the context menu available on Right Mouse button click for
assistance:
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Context menu
To open the context menu, holding all functions listed below, please follow the instructions below:
1. Move the mouse pointer to the position in the text field, where you like to insert a parameter, operator,
mathematical function or label.
2. Click the Right Mouse button to open the context menu.
3. From any submenu, select the desired command.

Formula parameters
The following values, variables, mathematical functions and operators are allowed to create a formula:
Values
Positive or negative numeric values
Variables
Labels
You may use any available label containing numerical values for calculation purposes. Clicking the Label button
opens a dropdown list with all available labels to choose from.
Intensity
Intensity values at a defined position on the xaxis of the current spectrum. This value is independent of the
evaluated peaks. Clicking the Intensity button opens an input mask for the xaxis position of the intensity.
Tags
Tags hold typical peak information which can be used for calculation. A list of all tags is available by clicking the
Tags button or via the context menu:

Mathematical functions
Default mathematical functions from a pocket calculator like sin(x), cos(x), tan(x), sqrt(x), sqr(x), etc. are available in the
context menu of the editor.
Operators
A list of operators is given as buttons below the formula text field. They are also available in a context menu.
Any basic mathematical operators are allowed to add, subtract, multiply or divide values. For assistance, please
click one of the operator buttons.
Mathematical terms can be put in parentheses to control the order of calculation.
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Exponential and logarithmic calculation
The exponential or logarithmic functions available in the software allow manipulation of intensities of discrete or
equidistant 2D data objects. This might be useful to determine exponential or logarithmic dependencies in recorded data,
which might be transformed into a linear function before further processing is applied.

An exponential or logarithmic function is applied as follows:

Exponential and logarithmic menu command
To apply an exponential or logarithmic function using the menu command, please follow the instructions below:
1. Activate the desired 2D data view containing objects to be transformed.
2. From the Mathematics menu, select the Exponential and Logarithmic command.
3. From the Mathematics tab, click on the

icon to show available operations.

4. From the list, select the desired Operation.
5. Press the Calculate button.

Exponential and logarithmic keyboard shortcut
None.

Exponential and logarithmic calculation details
There are various exponential and logarithmic functions available for manipulation of 2D and 3D data objects. All functions
can be applied to equidistant or discrete 2D or 3D data objects.
The following functions are available:
Exponential Multiplication
Power 10 Multiplication
Logarithm Multiplication
Logarithm 10 Multiplication

Exponential Multiplication
Each data point intensity Ii will be recalculated using an exponential function with an Euler base as follows:
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Power 10 Multiplication
Each data point intensity Ii will be recalculated using an exponential function with a base of 10 as follows:

Logarithm Multiplication
Each data point intensity Ii will be recalculated using a natural logarithm function as follows:

Logarithm 10 Multiplication
Each data point intensity Ii will be recalculated using a logarithm with the base of 10 function as follows:

Arithmetic calculation
Sometimes, it might be useful to manipulate data by general mathematical operations like adding, subtracting, multiplying
or dividing by a constant value to adapt data to a similar object. For this purpose several arithmetic functions can be
used. By default all objects in the current dataview will be processed. If only the selected active object needs to be
processed, the user must activate the option ApplyOnActiveSpectrumOnly.

Arithmetic calculation menu command
To perform an arithmetic calculation using a constant value, please follow the instructions below:
1. Activate the 2D or 3D data object you like to modify.
2. From the Mathematics menu, select the Arithmetic Calculations submenu.
3. From the Arithmetic Calculations submenu, select the desired arithmetic function.
4. To process only the active object in a multiobject dataview, activate the ApplyOnActiveSpectrumOnly option.
5. In the Mathematics tab, enter a constant value into the Value field.
6. Press the Calculate button.

Arithmetic calculation keyboard shortcut
None.

Arithmetic calculation details
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This function provides seven arithmetic operations which may be applied to 2D and 3D data objects.
Arithmetic operations with constants:
Adding a constant value
Subtracting a constant value
Multiplying with a constant value
Dividing by a constant value
Value potentiated with Intensity
Intensity potentiated with value
Square  raise to the power of two
Square Root  calculates the radical
The arithmetic operations will be performed on the whole data object range and will be applied to all objects of a merged
dataview. To apply the arithmetic operation only to the active object of multiobject dataview, please activate the option
ApplyOnActiveSpectrumOnly in the Mathematics tab.

Adding a value to a data object
A constant value is added to all intensities of the data object.

Subtracting a value from a data object
A constant value is subtracted from all intensities of the data object.

Multiplying a data object with a value
All intensities of the data object will be multiplied with a constant value.

Dividing a data object by a value
All intensities of the data object will be divided by a constant value.

Potentiate a constant value with a data object
A constant value will be potentiated by the intensities of the data object ( c^I ).

Potentiate a data object with a constant value
All intensities of the data object will be raised to the power of a constant value ( I^c ).

Square a data object
All intensities of the data object will be squared

Calculate the square root of a data object
The square root of all intensities of the data object will be calculated.

Spectrum arithmetics
The spectrum arithmetic functions provide basic arithmetic operations for two or more 2D data objects. The spectra can
be added, subtracted, multiplied, divided or exponentiated. Please review the section Spectrum Arithmetics in the chapter
Mathematics for a detailed description.
Spectrum arithmetics are performed as follows:

EN

208 . Main Software Manual

At least two spectra must be located in the same data view to run this operation! If more than two
spectra are merged into a data view when executing spectrum arithmetics, the operation will be
applied to all merged spectra except the selected reference spectrum.

The reference spectrum is the spectrum that is active/selected when the spectrum arithmetics
command is executed. It is the spectrum that will be added to/substracted from the other spectra 
or the other spectra will be multiplied with/divided by.
Switching of the reference spectrum is simply done by selecting a different spectrum before the
calculation is executed.

Spectrum arithmetics menu command
To apply spectrum arithmetics using the menu command, please follow the instructions below:
1. Merge two or more spectra in one data view.
2. Select/activate the reference spectrum in the dataview.
3. From the Mathematics menu, select the Spectrum Arithmetics submenu.
4. From the Spectrum Arithmetics submenu, select the desired function
5. In the Mathematics Tab, adjust the parameters.
6. Press the Calculate button.

Spectrum arithmetics keyboard shortcut
none.

Spectrum arithmetics parameters
The spectrum arithmetics parameter will be adjusted in the mathematics tab as follows:

Select the arithmetic function from the drop down box by clicking in the Operation field.
Adjust the Scaling Factor by entering numerical values or using the slider. The default scaling factor is 1 and for normal
arithmetic operation this should stay untouched. Adjusting the factor is only necessary if the reference spectrum needs to
be scaled before the arithmetic operation is carried out.
Enable or disable the Full Range checkbox, if you like to apply the arithmetic function just to a spectral region or the
whole spectrum area.
Full Range unchecked
A spectral region can be adjusted either manually or graphically.
Manual region selection:
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Enter the desired region boundaries into the fields Minimum and Maximum
Graphical region selection:
Move the gray selection area (tracker tool) to the desired position. The size of the selection area can be
adjusted by dragging the adjustment boxes.
Full Range checked
The full spectral range is used for the calculation.

Spectrum arithmetics on double click action
To apply a spectrum arithmetics using a double click action, please follow the instructions below:
1. Merge two spectra in one data view.
2. From the Mathematics menu, select the Spectrum Arithmetics submenu.
3. From the Spectrum Arithmetics submenu, select the desired operation.
4. Uncheck the Full Range checkbox.
5. A default Tracker Tool is displayed within the spectrum view.
6. Adjust the spectral region for spectrum arithmetics graphically.
7. Double click anywhere on the Tracker Tool to apply the spectrum arithmetics.

Spectrum arithmetics details
This function provides the basic arithmetic operations being applicable, if at least two 2D data objects are merged into a
data view. These spectra can undergo the following arithmetic operations:
Adding two spectra
Subtracting two spectra
Multiplying two spectra
Dividing two spectra
Power spectra
The spectrum arithmetics submenu also contains links to the functions Average spectra and Thickness Correction which
may be applied to two or more spectra merged into a 2D data view.
Arithmetic operations can be performed either on the whole spectral range or just on a selected region. In all cases the
result will be a new 2D data object. The reference spectrum is the spectrum that will stay untouched. It is the spectrum
that will be added to/subtracted from the other spectra  or the other spectra will be multiplied with/divided by.
How can I identify the reference spectrum?
The current active object is considered as the reference spectrum. Switching of the reference spectrum is
possible by simply selecting a different spectrum before the calculation is carried out.

What happens to the spectrum outside the selected region?
The current active object is meant to be the reference spectrum. Data points outside the selected
spectral region will simply be copied into the new data object from the reference spectrum.

Arithmetic operations will be applied to the selected spectral regions of multiple 2D data objects. The 2D data sets must
be equidistant and must have the same resolution to run this operations. Exceeding data points will be copied from the
reference spectrum by default.
For convenience, the spectrum arithmetics parameters can be adjusted interactively in the mathematics tab while the
results are displayed in the dataview. The mathematics tab for the spectrum arithmetics function looks like this:
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Spectrum Arithmetics Parameters
The following parameters are available for spectrum arithmetics:
Operation
The following mathematic operations are available:

Addition  Adding two Spectra
The intensity values of both data objects are summed for each data point in the selected spectral
region. Exceeding data points will be just copied from the current active spectrum. The intensities of
the reference object are scaled by the scaling factor in advance.
Substraction  Subtracting two Spectra
The intensities of the inactive 2D data object are subtracted by the intensities of the current active 2D
data object (reference spectrum) in the selected spectral region. Exceeding data points will be just
copied from the current active spectrum. The intensities of the reference object are scaled by the
scaling factor in advance.
Multiplication  Multiplying two spectra
The intensity values of both data objects are multiplied for each data point in the selected spectral
region. Exceeding data points will be just copied from the current active spectrum. The intensities of
the reference object are scaled by the scaling factor in advance.
Division  Dividing two spectra
The intensity values of the current inactive 2D data set are divided by the intensities of the active 2D
data object (reference spectrum) for each data point in the selected spectral region. Exceeding data
points will be just copied from the current active spectrum. The intensities of the reference object are
scaled by the scaling factor in advance.

Division by zero is not allowed!

Power spectra
The intensity values of the current inactive 2D data set are raised to the power of the intensity of the
active data object (reference spectrum), e.g. I^A. Exceeding data points will be just copied from the
reference spectrum.
Potentiation
This is the inverse of the power operation. The intensity values of the current active 2D data set are raised to the
power of the intensity of the inactive data object (reference spectrum), e.g. A^I.
Zero negative values
This parameter controls whether all negative values in the result data object of arithmetic calculation will be set to zero
automatically or not. This can be useful when searching residual spectra in libraries. The following settings are available:
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Checked
Enables autozero function for negative values in the defined spectral range of the resulting data object.
Unchecked
Disables the autozero function.
Scaling Factor
The scaling factor is used to scale the reference spectrum with a scalar value before the arithmetic calculation is carried
out. All intensities in the specified spectral region are multiplied by the scaling factor before arithmetic calculation. The
value is set to 1 by default. For normal spectrum arithmetic operations it should stay untouched.
If an adjustment of the scaling factor is necessary, it can be done by simply entering a numerical value or by using the
slider. In both cases the preview spectrum will be adjusted to show the result.
Full Range
This parameter controls whether only the selected spectral region is applied or the whole spectral range. The following
settings are available:
Unchecked
Only the specified part of the spectral range is applied. It is defined by Minimum and Maximum values as well as
indicated by the light grey graphical section in the graph view.
Checked
The maximum applicable spectral range of both objects is applied.
Minimum
This parameter denotes the lower boundary (on the xaxis) taken into account for the arithmetic calculation. It may be
adjusted by entering a numerical value or graphically by adjusting the selection area in the data view.
Maximum
This parameter denotes the upper boundary (on the xaxis) taken into account for the arithmetic calculation. It may be
adjusted by entering a numerical value or graphically by adjusting the selection area in the data view.

Interactive Operation
The spectrum arithmetics are interactive, changes made to the parameters will directly be show in a preview window:
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The upper part of the window shows the dataview with the merged original spectra being used for calculation. The
red spectrum is the active (highlighted) spectrum and therefore the reference spectrum. In the lower spectrum
view the calculation result preview spectrum is shown.
You can switch the active spectrum by selecting another spectrum in the legend or by clicking the
curve directly!

Any changes to the calculation parameters will be directly reflected in the preview spectrum. Click the Calculate button in
the mathematics tab to run the calculation. All spectra in the upper dataview except the reference spectrum will be
replaced by the resulting spectra.

Average Spectra
The average spectra function calculates the mean from a series of two or more spectra. It also provides an option to
calculate the standard deviation.
The average spectra calculation is performed as follows:

Average Spectra Menu Command
To calculate the average spectrum of two or more 2D data objects using the menu command, please follow the
instructions below:
1. Open two or more 2D spectra.
2. Merge them into a single data view.
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3. Alternatively, activate the 2D data view with desired objects to be used in calculation.
4. From the Mathematics menu, select the Average Spectra command.
5. Adjust the parameters.
Specify to create a new window with the results or put them into the same window as the data source.
Specify, whether you like to calculate a standard deviation spectrum as well or not.
6. Press the Calculate button.

Average Spectra Keyboard Shortcut
None.

Average Spectra details
Calculation of an average spectrum from a set of multiple 2D data objects is useful in many cases. This function is often
applied in quantitative or qualitative analysis of spectra series. It might be also a convenient feature, when multiple
spectra are displayed in one data view, to get a quick overview by just displaying the average spectrum instead. For
other users, it is also interesting to see some statistic information like the mean deviation of a spectra series. The mean
deviation spectrum is also calculated on averaging.
Similar mathematical operations are available to calculate two spectra. Detailed information is provided in the section
"Spectrum Arithmetics".

Average spectra parameters
The following parameters can be adjusted in the average spectra function:
Create new window
This flag toggles creation of a new window for the calculation result on or off.
Yes
The average spectrum and the mean deviation spectrum are displayed in a new window.
No
The average spectrum and the mean deviation spectrum are added to the current window.
Calculate deviation
This flag toggles calculation of the mean deviation spectrum on or off.
Yes
The mean deviation spectrum is calculated.
No
The mean deviation spectrum is not calculated.

Thickness Correction
The thickness correction algorithm removes pathlength variations from spectra. The user needs to select a peak and a
baseline. The algorithm offers various methods, please review the chapter thickness correction in the mathematics
section for details.
The general thickness correction workflow consists of selecting the thickness band baseline and the actual thickness
band. The thickness band baseline line will then be corrected by a twopoint baseline algorithm with the selected
parameters and the thickness correction will be performed. Selecting the parameters is performed as follows:

Thickness correction menu command
To apply thickness correction using the menu command, please follow the instructions below:
1. Activate the 2D data object you like to correct.
2. From the Mathematics menu, select the Thickness correction command from the Spectrum Arithmetics submenu.
3. In the Mathematics tab, select the parameters for thickness band baseline and the thickness band by entering
numerical values.
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4. Alternatively, adjust parameters by using the vertical selection lines or rectangle areas in the spectrum view.
What are different selection tools good for?
Distinct vertical lines select single points in the spectrum to define peaks or the borders of peak areas.
Colored rectangles define a range of points from which the actual anchor point will be calculated by the
selected method (average, minimum, maximum). Please review details in the chapter thickness correction
in the mathematics section.

5. Click the Calculate button.

Thickness correction keyboard shortcut
None.

Thickness correction parameters
Please review the chapter thickness correction in the mathematics section for a full description of all parameters.
Parameters for selecting the thickness band:

Normalization
By Intensity
The user needs to select a single peak intensity for normalization.
By Spectrum Area
The whole spectrum area is used for normalization.
By Peak Area
A peak area is used for normalization. The peak area can be selected by different methods analog to the twopoint
algorithm selection methods.

Peak area calculation method
The user needs to select the appropriate method for the peak area calculation. Options are:
Trapezoid
Algebraic sum
Absolute sum

Parameters for the thickness band baseline correction using the twopoint algorithm:
Method
Please refer to the thickness correction chapter for details. Options are:
Single
Average
Maximum
Minimum

StartX, EndX
StartX and EndX define the upper and lower limit of a peak area.

Start Minimum, Start Maximum
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Defines a region of points for the lower limit from which the actual anchor point will be calculated by the above selected
method.

End Minimum, End Maximum
Defines a region of points for the upper limit from which the actual anchor point will be calculated by the above selected
method.

Thickness Correction details
Thickness Correction (Thickness pathlength correction) is used to remove a pathlength variation from a given set of
spectra. To successfully perform a thickness correction a baseline needs to be drawn under a peak and the peak will be
integrated over this baseline. The whole spectrum will be divided by the resulting area. As a prerequisite all samples will
have to feature an isolated band which does not vary in concentration. Normalizing the full spectrum to this band will
effectively remove the pathlength variation. This method is sometimes referred to as "internal standard".
The Thickness correction command employs a twopoint baseline correction for the thickness band baseline and
subsequently calculates the thickness correction with the selected thickness band. The command offers a variety of
options to define baseline limits and the actual thickness band. In particular these are:

Baseline selection methods (equivalent to Peak area selection)
These particular ranges are always defined by a lower and upper limit. The lower and upper limit may in turn be defined
by different methods. Therefore these selection methods always show two selectors. For the method "single" these
selectors are two discrete vertical lines. For all other methods these selectors are two rectangle selection areas. The
different method are described in detail in the following:
Single
Both limits (StartX, EndX) are defined by a single numerical value. This value may be entered graphically by moving the
vertical lines by grabbing the red boxes with the mouse or by directly entering numerical values into the fields StartX and
EndX.
Average
Both limits will be calculated by the average of a certain area. These areas may be entered graphically or by directly
entering numerical values into the fields Start Minimum, Start Maximum, End Minimum and End Maximum. Graphically
the area position can be defined by moving the position of the colored selection rectangles with the mouse. The area range
can be adjusted by dragging the gray tracker boxes next to the rectangles. The actual lower limit is then calculated as
the average of all points in the lower limit area and actual upper limit is calculated as the average of all points in the
upper limit area. These values are shown as red boxes in the corresponding area rectangle.
Maximum
Both limits will be calculated by the maximum of a certain area. These areas may be entered graphically or by directly
entering numerical values into the fields Start Minimum, Start Maximum, End Minimum and End Maximum. Graphically
the area position can be defined by moving the position of the colored selection rectangles with the mouse. The area range
can be adjusted by dragging the gray tracker boxes next to the rectangles. The actual lower limit is then calculated as
the maximum of all points in the lower limit area and actual upper limit is calculated as the maximum of all points in the
upper limit area. These values are shown as red boxes in the corresponding area rectangle.
Minimum
Both limits will be calculated by the minimum of a certain area. These areas may be entered graphically or by directly
entering numerical values into the fields Start Minimum, Start Maximum, End Minimum and End Maximum. Graphically
the area position can be defined by moving the position of the colored selection rectangles with the mouse. The area range
can be adjusted by dragging the gray tracker boxes next to the rectangles. The actual lower limit is then calculated as
the minimum of all points in the lower limit area and actual upper limit is calculated as the minimum of all points in the
upper limit area. These values are shown as red boxes in the corresponding area rectangle.
The following pictures show a few examples of the different methods:
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This example shows a Thickness Correction with normalization by intensity and baseline selection with the method
"average". The intensity can be selected by moving the red vertical line by dragging it with the red square. The baseline
limits are selected by moving the position of the blue rectangles. The limit areas (width of the rectangles) are increased or
decreased by using the gray tracker boxes of the selected rectangle.
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This example shows a Thickness Correction with normalization by "peak area" and method "single". Therefore the actual
peak area for normalization is selected by the two vertical red lines. Again the blue rectangles define the baseline limits.
The actual limits calculated by averaging all points inside the rectangle are shown by the red squares inside the
rectangles.

Thickness correction algorithm
Normalization
The following normalization methods are available:
By Intensity
The thickness band will be selected by intensity. The user selects the desired peak by either graphically moving the red
vertical line or by directly entering a numerical xvalue.
By Spectrum Area
The whole spectrum area is used for normalization. The user additionally needs to select an integration method for the
peak area calculation. Available options are trapezoid, algebraic sum and absolute sum.
By Peak Area
The thickness band is defined by a peak area. The peak area (thickness band) selection is available via four different
methods and is identical to the baseline selection method described above. Essentially the user will have four selection
rectangles to graphically select the baseline area (two blue rectangles) and the peak area (two red rectangles). The
pictures below shows an example.
Again the user additionally needs to select an integration method for the peak area calculation. Available options are
trapezoid, algebraic sum and absolute sum.
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Peak Area Calculation
If a peak area is selected for normalization, an additional calculation method needs to be chosen. The options are:
Trapezoid
This method calculates the peak area as half of the sum of all intensities multiplied by the data point distance
(resolution) accordingly
Algebraic Sum
This method considers the area under a peak. It is calculated as the sum of all intensities multiplied by the data
point distance (resolution) accordingly
Absolute Sum
This method calculates the peak area as the sum of all intensities within peak range

ATR correction
The ATR correction is only used with IR spectra, that have been recorded with a ATR accessory. In this case, data points
must be corrected for a relative shift introduced by the instrument configuration.
Perform a base line correction first.
The results of an ATR correction strongly depend on a good base line of the spectrum. So please perform
a baseline correction first to obtain good results.

An ATR correction is performed as follows:

ATR correction menu command
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To perform an ATR correction using the menu command, please follow the instructions below:
1. Activate the spectrum, you like to correct.
2. From the Mathematics menu, select the ATR Correction command.
3. Enter a reference wave number into the Reference Wave Number field.
4. Press the Calculate button.

ATR correction keyboard shortcut
None.

Advanced ATR correction menu command
To perform an advanced ATR correction using the menu command, please follow the instructions below:
1. Activate the spectrum you'd like to correct.
2. Choose Advanced ATR Correction from the Mathematics menu.
3. Enter the refractive indexes of the sample and the crystal.
4. Enter the incident angle of the measurement.
5. Either enter values for the absorption coeffizient and the electric field of the evanescent wave or calculate a

machine constant used for further ATR corrections by performing a calculation on a spectrum with a reference. To
recalculate the constant, give a new reference spectrum.
6. Press the Calculate button.

Advanced ATR correction keyboard shortcuts
None.

ATR correction details
What is ATR?
ATR is the abbreviation for a spectroscopic technique called attenuated total reflection (ATR). In this technique, the IR
beam of an IR spectrometer is guided in an IR transparent crystal by total reflection. Due to quantum mechanical
properties of the IR light, the electromagnetic field may extend beyond the crystal surface for about one micron as a so
called evanescent field. By applying sample directly onto the surface of the crystal, it is sensed by this evanescent wave
and contributes to the absorption of the IR beam.

Why must an IR spectrum be corrected?
An IR spectrum of a sample recorded with an ATR spectrometer is not identical to a transmission spectrum recorded with
default IR spectrometer. The ATR technique introduces relative shifts in band intensity and absolute shifts in the
frequency. The relative intensity shift is well described and can be easily corrected, whereby the absolute shift in
frequency domain is more difficult to correct. Therefore the frequency shift is often neglected. The ATR algorithm in the
software only corrects the relative shifts.

ATR correction algorithm
Relative ATR shifts will be corrected according to the penetration depth of the IR beam of the spectrometer.
The penetration depth is proportional to the wavelength. Under measurement conditions, the penetration depth strongly
depends on the instrument configuration, but as a first approximation it is assumed to be equal to a single wavelength.
A quantitative description of the penetration depth Dp is given in the following equation:
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Legend:
Dp

penetration depth

n

wave number

nc

refractive index of the crystal

ns

refractive index of the sample

a

corrected angle of incidence

The penetration depth must be calculated for each data point of a spectrum. In practice, the intensities Ii of each data
point will be recalculated instead according to the estimated relative shift using the following equation:

Legend:
Icor

corrected intensity of a data point

Ii

original intensity of a data point

ni

wave number of a data point

ns

reference wave number

Perform a base line correction first.
The results of an ATR correction strongly depend on a good base line of the spectrum. So please perform
a baseline correction first to obtain good results.

What is ATR?
ATR is the abbreviation for a spectroscopic technique called attenuated total reflection (ATR). In this technique, the IR
beam of an IR spectrometer is guided in an IR transparent crystal by total reflection. Due to quantum mechanical
properties of the IR light, the electromagnetic field may extend beyond the crystal surface for about one micron as a so
called evanescent field. By applying sample directly onto the surface of the crystal, it is sensed by this evanescent wave
and contributes to the absorption of the IR beam.

Why must an IR spectrum be corrected?
An IR spectrum of a sample recorded with an ATR spectrometer is not identical to a transmission spectrum recorded with
default IR spectrometer. The ATR technique introduces relative shifts in band intensity and absolute shifts in the
frequency. The relative intensity shift is well described and can be easily corrected, whereby the absolute shift in
frequency domain is more difficult to correct. Therefore the frequency shift is often neglected. The ATR algorithm in the
software only corrects the relative shifts.

EN

Main Software Manual . 221
ATR correction algorithm
Relative ATR shifts will be corrected according to the penetration depth of the IR beam of the spectrometer.
The penetration depth is proportional to the wavelength. Under measurement conditions, the penetration depth strongly
depends on the instrument configuration, but as a first approximation it is assumed to be equal to a single wavelength.
A quantitative description of the penetration depth dp is given in the following equation:

Legende:
dp

Penetration Depth

ÿ

Wavelength

n2

Refractive index of the crystal

n1

Refractive index of the sample

ÿ

Incident Angle

The penetration depth has to be calculated for every point of the spectrum. The incident angle is limited because
of the danger of a total internal reflection. For further calculation the penetration depth is needed to calculate the

intensity.
Legende:
A

corrected datapoint intensity

n2

Refractive index of the crystal

n1

Refractive index of the sample

ÿ
Incident Angle

E0

Electric field of the evanescent
wave

ÿ
Absorption coefficient
In case E0 and Alpha are unknown, a calculation with a reference spectrum can be performed.

Perform a base line correction first.
The results of an ATR correction strongly depend on a good base line of the spectrum. So please perform
abaseline correction first to obtain good results.

References:
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Simon Nunn, Ph.D., Koichi Nishikida, Thermo Electron Scientific Instruments LLC, Madison, WI, USA, "Advanced ATR
Correction Algorithm"
The full article is also available online at: Thermo  Advanced ATR Correction Algorithm

Fourier Transform
The function Fourier Transform implements a Fast Fourier Transformation algorithm (FFT) to convert interferograms into
NIR or MIR spectra. Interferograms that are acquired by the spectrometer instrument can be transformed to regular IR
spectra using this function.
The Fourier Transform command is available in the Mathematics menu.

Fourier Transform parameters
The following parameters can be adjusted:
Spectrum Type
Specifies the type of spectrum the interferogram corresponds to. Available options are:
NIR  Interferogram corresponds to a NIRspectrum
MIR  Interferogram corresponds to a MIRspectrum
Interferogram Type
Specifies the type of interferogram to be processed. Available options are:
Single  Interferogram is of type single
Double  Interferogram is of type double
Spectral Range
Sets the spectral range for the resulting spectra.

Standard normal variate correction
The standard normal variate correction corrects spectra for spectral noise and background effects which cause baseline
shifting and tilting.
For details on the algorithm, please refer to the Standard normal variate correction section in the chapter "Mathematics".
To perform a standard normal variate correction, please follow the instructions below:

Standard normal variate correction menu command
To perform the operation using the menu command, please follow the steps below:
1. Open desired 2D data objects to be corrected.
2. Merge them into one data view.
3. From the Mathematics menu, select the Standard Normal Variate Correction command.
4. In the Mathematics tab, click the Calculate button.

Standard normal variate correction keyboard shortcut
None.

Standard normal variate correction details
This mathematics operation was originally invented to reduce spectral noise and eliminate background effects of NIR
data. From NIR technique nonspecific scattering of radiation at the surface of particles, variable spectral path length
through the sample and chemical composition of the sample typically cause baseline shifting or tilting. The influence is
larger at longer wavelengths. Such multiplicative interference of scatter and particle size can be eliminated or minimized
by applying a standard normal variate correction.
Please review the Standard Normal Variate Correction command in the Mathematics menu section for details on how to

EN

Main Software Manual . 223
Please review the Standard Normal Variate Correction command in the Mathematics menu section for details on how to
perform this operation.
In addition to the standard normal variate correction very often a detrending is applied in order to remove offset and
tilting more thoroughly. Both operations can be applied at once using the Linear least squares Baseline Correction of the
software.
Multiplicative Scatter Correction is another method for noise reduction!
Please review the chapter "Multiplicative Scatter Correction" for details.

Standard normal variate correction algorithm
Standard normal variate algorithm is designed to work on individual sample spectra. The transformation centres each
spectrum and then scales it by its own standard deviation:

where
i = spectrum counter
j = absorbance value counter of ith spectrum
Aij (SNV) = Corrected absorbance value
Aij = measured absorbance value
xi = is the mean absorbance value of the uncorrected ith spectrum
SDev = Standard deviation of the absorbance values of ith spectrum
Spectra treated in this manner have always zero mean value and a variance equal to one and are thus independent of
original absorbance values.

Standard normal variate correction example
This operation is usually applied to multiple data objects. In the following example some NIR spectra of cow milk are
shown in one data view:
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After completion of the standard normal variate correction, spectra look like this:

Noise Statistics
The Noise Statistics can be calculated for one or more 2D data objects being merged in the same data view. The user may
select a spectral range of interest for calculation of the Signal/Noise ratio and additional statistical values. The following
statistical values are calculated:
Mean
Mean intensity value
Dpp
Peaktopeak deviation
SNRpp
Peaktopeak Signal to Noise ratio
Dst
Standard Deviation among all intensities
SNRRMS
Root mean square error of signal to noise ratio
For details on the algorithm, please refer to the "Noise Statistics" section in the chapter "Mathematics".

Noise Statistics Menu Command
To perform the operation using the menu command, please follow the steps below:
1. Open one or more desired 2D data objects to be evaluated.
2. Merge them into one data view.
3. From the Mathematics menu, select the Noise Statistics command.
4. In the Mathematics tab, set the parameter Use Full Range
Yes
The full spectral range is used for the calculation.
No
Only a part of the spectral range, which is limited by the Minimum and Maximum parameters is used for the
calculation.
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Enter Minimum and Maximum value in order to define a spectral range for noise calculation.
Alternatively, move the highlighted plane inside the spectrum view to modify the spectral range to be
considered for calculation
5. Click the Calculate button.
A new dialog window is opened, which contains a result report with all noise statistics:

6. Click the Print button to show a print preview of calculated results (Optional).
7. Click the Save button to save a rich text file with results (Optional).
8. Click the Close button to close the dialog.

Noise Statistics Keyboard Shortcut
None.

Noise Statistics details
The Noise Statistics calculates the Signal/Noise ratio and some other statistic values of one or more data objects
available in the current data view. The Signal/Noise ratio can be calculated for a particular spectral region or the whole
data range.
The Noise Statistics command is available in the Mathematics menu.

Noise Calculation Algorithms
Some characteristic values are calculated for the noise statistics result:
Mean Value
The mean value M calculates the mean of all intensities Si in a user defined spectral range of interest. The following
equation is applied:

Where
M: Mean intensity value
N: Number of data points in range
Si: Intensity values
Peaktopeak Deviation
The peaktopeak deviation is calculated from a linear least squares fit among a spectral windows. Calculation considers
the baseline respectively. The following equation is used:
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Where
Dpp: Peaktopeak deviation (baseline corrected)
(FcenterFwing .. Fcenter+Fwing): Specifies start and end point of the range of interest
Yi: Linear function determined from a linear least squares fit among data points.
Si: Intensity values
Standard Deviation
The standard deviation for baselinecorrected data is calculated from the following equation:

Where
Dst: Standard deviation
N: Number of data points in range
Si: Intensity values
Yi: Linear function determined from a linear least squares fit among data points.
Signal to Noise Ratio PeaktoPeak
The signal to noise ratio peaktopeak is calculated using the following equation:

Where
SNRpp: Peaktopeak Signal to Noise Ratio
M: Mean intensity value
Dpp: Peaktopeak deviation (baseline corrected)
Signal to Noise Ratio Root Mean Square Error
The root mean square error (RMS) for the signal to noise ratio is calculated using the following equation:

Where
SNRRMS: Signal to Noise Ratio Root Mean Square Error
M: Mean intensity value
Dst: Standard deviation

Manipulate Data Points
The command Manipulate Data Points enables quick editing of spectral data. Single data points can be quickly changed by
entering numerical data.
Manipulate Data Points is performed as follows:

Manipulate Data Points menu command
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To manipulate a single data point using the menu command, please follow the instructions below:
1. Activate the 2D View or 3D View area.
2. From the Mathematics menu, select the Manipulate Data Points command.
3. In the Mathematics Tab enter the corresponding xvalues and yvalues.

Alternatively the desired xaxis value can be visually selected by moving the red slider in the spectrum view:

The red square depicts the actual yvalue. It can be edited by entering a numerical value in the mathematics tab.
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Manipulate Data Points details
The Manipulate Data Points function provides an easy way to edit the spectral data. It enables the user to manipulate
single data points of a spectrum by entering numerical values. Xaxis values can be selected visually.

Kramers Kronig Transformation
The Kramers Kronig transformation can be applied to reflectance date and will produce an absorbance spectrum and a
refractive index spectrum. The user may choose from the math dialog which spectrum is produced as a result.
A Kramers Kronig transformation is performed as follows:

Kramers Kronig menu command
To perform a Kramers Kronig transformation using the menu command, please follow the instructions below:
1. Open the reflectance data you would to transform.
2. From the Mathematics menu, select the Kramers Kronig command.
3. Adjust all necessary parameters in the MathTab and choose the result spectrum type.
4. Press the Calculate button.

Kramers Kronig keyboard shortcut
None.

Kramers Kronig Transformation details
The Kramers Kronig Transformation is used for obtaining absorbance and refractive index information from reflectance
data. Measuring a reflectance spectrum from an optically dense material will yield a complex spectrum with two
components  the absorbance spectrum and the refractive index spectrum. The Kramers Kronig transformation will extract
these components from the complex reflectance spectrum.
The Kramers Kronig transformation assumes reflectance angles near zero. The output of the transformation strongly
depends on the measurement quality, artefacts in the low wavelength region need to be eliminated properly or the
transformation will yield inadequate results.
Because of the material constants  which are required for the calculation but are unknown to the software  the
spectrum has to be extrapolated to zero wavelengths. Consequently it is necessary, depending on the available
equipment and IRSpectrometer, to measure as close as possible to the lowest available wavelength. This will decrease
the influence of the extrapolation on the Kramers Kronig transformation.

Kramers Kronig Options
The dialog for the Kramers Kronig transformation looks like this:

The following options are available for the transformation:
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Method
Specifies the calculation method for the Kramers Kronig transformation:
FFT
Uses FastFourierTransformation for the calculation
MacLaurin
Uses MacLaurins formula for the calculation
Material Conductivity
Specifies the material constant. The default setting is 25 which represents a conductive material. The material constant
has influence on the algorithm used for extrapolation and may be used to adapt the calculation to the experimental
conditions.
Normalize Data
Controls the automatic normalization of the resulting spectra:
Yes
The resulting spectra will be automatically normalized between 0 and 2.
No
The resulting spectra will not be normalized.
Create Refractive Index Spectrum
Controls the type of result spectrum for the transformation:
True
A refractive index spectrum will be created and displayed as result.
False
An absorbance spectrum will be created and displayed as result.

Kramers Kronig Algorithm
The refractive index part (real part) is calculated by the following equation:

The extinction part (imaginary part) is calculated by the following equation:

The phase shift angle of the sample for a given wavenumber is calculated as:

Legend:
n

wave number

R

Reflectance spectrum

q

phase shift angle

Curve Fit
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Curve fitting of spectroscopic data is a powerful technique that can be used to facilitate data analysis and interpretation.
Especially peak analysis of overlapping peaks can be done in case the real peak area needs to be determined. A set of
ideal peaks is fit to match the overall shape of the real spectrum as shown in the following:

The command Curve Fitting is applied to one 2D spectral data object and is a tool to model peaks as a sum of individual
spectral contributions.

The User adds the required number peaks first, e.g. repeated times pressing the Plus button, either for a desired area or
the whole spectrum. A peak added by mistake can be simply removed with the Minus button. As a special feature, each
peak can be fitted using its own Response Curve Shape.
With the sufficient number of peaks the estimation is initiated pressing the Auto Fit button, applying one of the
LevenbergMarquardt algorithm for optimization.
In a final step, a fitted spectrum of estimated peaks will be created and derived information like peak area, etc. is
calculated too.
Clicking the Reset button erases all selections.
Pressing then Calculate button creates a peak table based on actual estimation status and shows the peak areas
accordingly.
A curve fit is performed as follows:

Curve Fit menu command
To perform a curve fit using the menu command, please follow the instructions below:
1. Activate the 2D data object you would like to fit.
2. From the Mathematics menu, select the Curve Fit command.
3. Click Plus button to add a new peak to the list of estimated peaks.
4. Adjust all necessary parameters in the Mathematics tab.
5. Repeat from step 3 until the optimal number of peaks is defined.
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6. Press the Auto Fit button.
7. Clicking the Calculate button creates a new peak table with detailed peak information of the estimated peaks.
Note: in some cases it is recommended to perform a baseline correction before applying the curve fit.

Curve Fit keyboard shortcut
None.

Curve Fit Details
Curve Fit is applied to a single 2D spectral data object. The user may fit peaks with desired shape to match the overall
shape of overlapping peaks in the original spectrum. In a calculation step the peak area of the ideal peaks is calculated
showing the potential real area of overlapping peaks. The User can manually set ideal peaks and can configure their
shapes utilizing Lorentzian, Gaussian or Voigt profiles. Optionally the software calculates the optimal full width half
maximum value which might bet fit with the evaluation algorithm. Dependent on the spectrum habit, applying a baseline
correction is needed too.
By setting the desired values for the curve, a fitted spectrum of a special peak will be created. This can be done multiple
times, preferably for a spectrum range with overlapping signals or the whole spectrum.
After setting all favored peaks the sum of all individual peaks can be displayed to see the resulting overlay compared to
the original spectral data object.
The estimated peaks of the curves are shown in a peak table. Of the idealized spectrum, the values of the peak area can
be used for further calculations. The peak table shows the idealized peaks and their values, not the actual of the
spectrum used for fitting.
Hint
Calculation does not change the original data object!

Curve Fit parameters
The following options Auto Fit Algorithm is used:
LevenbergMarquardt
The LevenbergMarquardt algorithm is a wellknown numerical optimizing algorithm being used to optimize the
width and height of a set of peaks to match the shape of a curve as good as possible. Basically it tries to minimize
the error between the spectral original area and the “artificial” area resulting from the different peaks.
An optimal full width at half maximum (FWHM) value is calculated for each peak by setting the Use estimated FWHM flag.
In case this flag is set, FWHM starting values for all peaks are identical. Manual adaption is possible.
Several baseline options are available and need to be adapted manually dependent on the overall spectrum baseline
shape.
Result and residual curve are calculated too and can be displayed in overlay mode together with the raw data and the
estimated peaks.

Peak parameters
Each estimated peak can be optimized interactively by changing the individual parameters.

The following options are available for manipulation:
Full Width Half Maximum
Sets the width / shape of the peak. A new value can be entered manually or changed interactively pressing the
vertical marker
in the <value> field.
Maximum X Position
Sets the peak position of the peak. A new value can be entered manually or graphically pressing the vertical
marker

in the <value> field.
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Maximum Y Value
Sets the peak height. A new value can be entered manually or changed interactively pressing the vertical marker
in the <value> field.
The parameter Response Curve Shape can be adapted manually too. The different options are available from a list box.
Each algorithm affects the shape of the curve slightly different:
Gauss
The formula of the Gaussian normal distribution function is given below:

CauchyLorentz
The formula of the CauchyLorentz normal distribution function is given below:

Voigt
The Voigt profile is a linear combination of Gauss and CauchyLorentz.
In order to optimize the look and feel it is possible to define a color scheme for an estimated trace too.

Deconvolution
The deconvolution is applied to 2D spectral data and produces a new spectrum having peaks better resolved. Based on
numerical operations these spectra can be used for further analysis. For more details please review the section
Deconvolution Details
A deconvolution is performed as follows:

Deconvolution menu command
To perform a deconvolution using the menu command, please follow the instructions below:
1. Open Data you would like to deconvolve.
2. From the Mathematics menu, select the Deconvolution command.
3. Adjust all necessary parameters in the MathematicsTab.
4. Set up additional result spectra you'd like to see in the Optional category of the MathematicsTab.
5. Press the Calculate button.

Deconvolution keyboard shortcut
None.

Deconvolution Details
Deconvolution is applied to one or more 2D spectral data objects and will produce a new spectrum having peaks better
resolved accordingly. The algorithm is used to separate overlapping peaks from each other in order to yield a better peak
baseline and hence allow more reliable peak area calculation. The peak shape of each peak is assumed to be some ideal
peak shape of a Gauss, CauchyLorentz or linear combination of both functions. Based on numerical operations the peak
shapes are automatically fit throughout all available peaks in the spectrum.

Spectrum before deconvolution
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Deconvolution Options
The dialog for the Deconvolution looks like this:

The following options are available for the transformation:
Algorithm
Specifies the numeric calculation algorithm for the deconvolution being well described in literature:
Gold
RichardLucy
Response
The response curve sets the ideal peak shape function used for peak fitting. This can be one of the following functions:
Gauss
The formula of the Gaussian normal distribution function is given below:

CauchyLorentz
The formula of the CauchyLorentz normal distribution function is given below:

Voigt
The Voigt profile is a linear combination of Gauss and CauchyLorentz.
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Iterations
Controls how many iterations the algorithm shall do. The higher the combination of Iterations and Repetitions (see
below) the better the result.
Iterations and repetitions
Be careful setting up these parameters, because calculation time increases with increasing number of iterations
and repetitions.

Repetitions
Controls how many repetitions the algorithm shall do. Repetitions multiplied with Iterations shall not exceed 10000.
Otherwise
calculation may take too long and the result won't be better.
Boost
Sets whether the result spectrum shall be boosted. 1 = 100% no change. Values less than 1 result in lowering, higher
than 1 in boosting.
Manual
This parameter controls the algorithm's auto or manual detection of the average full width at half maximum value of
available peaks. The shape of the response curve is adjusted to match the average peak's full width half maximum value.
Checked: Activate manual selection of the Full Width Half Maximum value used for the response curve calculation.
Unchecked: A Full Width Half Maximum value will be automatically calculated based on the loaded spectrum.
Maximum number of Peaks
Defines how many Peaks should be taken for preview, descending from the strongest.
Calculate Convolution Residual
Calculates a residual spectrum by subtracting the deconvolved result spectrum and the original spectrum.
Calculate Peak Response
Calculates a simulated spectrum as an overlay of ideal peaks based on the actual full width half maximum value.
No peaks : No Spectrum shown
Spectrum: Show the Peak Response as one Spectrum
Individual: Show the Peak Response as multiple Spectra based on every Peak for itself
Calculate Peak Residual
Calculates a residual spectrum by subtracting the simulated peak spectrum and the original spectrum.

References
"Advanced Spectra Processing" Miroslav Morhac, Institute of Physics, Slovak Academy of Sciences, Dubravska cesta 9, 842
29 Bratislava, Slovakia, Digital Signal Processing 13 (2003) 144–171.

Quantify menu
This menu contains all applicable commands for quantitative and qualitative analysis using chemometric methods.
Creation and modification of univariate and multivariate calibrations is controlled here. Evaluation or automatic evaluation
of the current active spectrum can be performed.

Quantify menu commands
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Available Quantify menu commands are listed in the following:
New Calibration
Review Calibration
Remove Calibration
Evaluate  Evaluates the active spectrum with all available calibrations.
Evaluate with...  allows the selection of a specific calibration for evaluation.
Export Calibration Model
Load Calibration Model

Review calibration
The user can select a calibration for review from the submenu of the Review Calibration command. The selected
calibration will be opened in the Calibration Model Wizard to show all relevant calibration parameters. The calibration will
be opened in readonly mode solely for review purposes. To edit a calibration the user needs to select the command Edit
Clone Copy from the context menu of the Project Explorer.

Review calibration menu command
To review a calibration model via the application menu, please follow the instructions below:
1. In the Quantify menu, select the Review submenu.
2. A list with all available calibrations will be expanded.
3. Selected the calibration you want to review.
4. The Calibration Model Wizard will be opened in readonly mode with the selected calibration.

Review calibration context menu command
To review a calibration model via the Project Explorer context menu, please follow the instructions below:
1. Open or activate the Project Explorer.
2. Select the calibration model in the Project Explorer tree.
3. Click the Right mouse button.
4. From the context menu, select the Review command.

Review calibration toolbar command
To review a calibration via a toolbar command in the quantify explorer, please follow the instructions below:
1. Open or activate the quantify explorer.
2. Select the calibration you like to edit.
3. From the quantify explorer toolbar, select the

icon.

4. The Calibration Model Wizard will be opened with the selected calibration.
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Review calibration keyboard shortcut
None.

Remove a calibration
A list of all currently available calibrations is shown in the quantify explorer. The Calibration Model Wizard shows the
current calibration settings and can be used for revision or modification. There are three options to remove a calibration:
The menu command in the Quantify menu, the context menu in the Project Explorer and the toolbar command in the
Quantify Explorer.
The Remove Calibration commands behave slightly different!
Using the Remove Calibration command in the quantify explorer toolbar will only remove the calibration
from the quantify explorer list. The calibration will not be removed from the project. Using the main menu
or context menu command will remove the selected calibration completely, it will be removed from
quantify explorer and deleted from the project!

Remove calibration menu command
To remove a calibration model via the application menu, please follow the instructions below:
1. From the Quantify menu, select the Remove... command
2. A submenu with the list of all calibrations in the Quantify Explorer will open.
3. Select a calibration in the submenu to delete it.

Remove calibration context menu command
To remove a calibration model via the Project Explorer context menu, please follow the instructions below:
1. Open or activate the Project Explorer.
2. Select the calibration model in the Project Explorer tree.
3. Click the Right mouse button.
4. From the context menu, select the Remove command.

Remove calibration toolbar command
To remove a calibration model via the Quantify Explorer toolbar, please follow the instructions below:
1. Open or activate the Quantify Explorer.
2. Select the calibration model in the Quantify Explorer list.
3. Click the Remove Calibration toolbar icon

.

Remove calibration keyboard shortcut
None.

Evaluate
After creating a calibration model for a particular qualitative or quantitative analysis, derived calibration models need to
be applied to samples in routine analysis. Evaluation of the current active spectrum/spectra is performed using this
command. A report with the prediction results of the current samples will be shown.
In contrast to the Evaluate with... command, this procedure produces prediction results for all available calibrations of all
open projects in the software. Please refer to the chapter "Prediction of unknown Samples" for details.

Evaluate menu command
To evaluate a spectrum/spectra with an existing qualitative or quantitative calibration using a menu command, please
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follow the instructions below:
1. Open one or more spectra you like to evaluate from a file or project.
2. Merge them into one data view (optional).
3. From the Quantify menu, select the Evaluate command.
4. An evaluation report is displayed in a separate window.
Sharing the report...
It is possible to copy the report or a particular part of the report into the clipboard by pressing CTRLC
keys.

Evaluate quantify toolbar command
To evaluate a spectrum with a calibration model via the Quantify Explorer toolbar, please follow the instructions below:
1. Open or activate the Quantify Explorer.
2. Select the calibration model in the Quantify Explorer list.
3. Click the Evaluate toolbar icon

.

Evaluate keyboard shortcut
None.

Evaluate Command Line Control
The application can be controlled from the command line. Please refer to the section "Command Line Control" for details.

Evaluate with...
After creating calibration models for a particular qualitative or quantitative data analysis derived calibration models need
to be applied to samples in routine analysis. Furthermore, calibration methods combining several calibration models can
be used for routine analysis as well.
Evaluation of the current active spectrum/spectra is performed using a command from the Evaluate with... submenu. The
Evaluate with... submenu holds all available calibration models. Selecting one of the submenu entries will evaluate the
current spectrum with the calibration. A report will be shown holding prediction results on the current samples. Please
refer to the chapter "Prediction of unknown Samples" for details.
In contrast to the Evaluate command, this command only considers a single calibration for producing a prediction result.

Evaluate with... menu command
To evaluate a spectrum/spectra with an existing qualitative or quantitative calibration using a menu command, please
follow the instructions below:
1. Open one or more spectra you like to evaluate from a file or project.
2. Merge them into one data view (optional).
3. From the Quantify menu, select the Evaluate with... submenu.
4. Choose the desired calibration from the list.
5. An evaluation report is displayed in a separate window.
Sharing the report...
It is possible to copy the report or a particular part of the report into the clipboard by pressing CTRLC
keys.

Evaluate with... keyboard shortcut
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None.

Evaluate with... Command Line Control
The application can be controlled from the command line. Please refer to the section "Command Line Control" for details.

Auto predict data using a calibration
After creating a calibration model for a particular qualitative or quantitative analysis, the derived calibration model can be
automatically applied to samples in routine analysis. Every time a suitable spectrum is opened, a brief result of the
automatic prediction is shown in the upper part of the spectrum view. The autoprediction can be toggled on or off by
checking or unchecking the a calibration in the Quantify Explorer list. Autoprediction is also possible with multiple
calibrations. Simply select the desired calibrations in the quantify list:

Please also review the section Prediction of unknown samples in the chapter Chemometric Analysis for further
information.

Auto predict using the Quantify Explorer
To start or stop autoprediction of a spectrum with an existing qualitative or quantitative calibration, please follow the
instructions below:
1. In the Quantify Explorer, select the calibration for prediction and activate the checkbox.
2. Open the spectrum that needs to be predicted. If the spectrum is compatible with the calibration, the Prediction
Result will be displayed in the spectrum view:

3. As long as the checkbox is activated all spectra that are opened will automatically be predicted.

Auto predict keyboard shortcut
None.

Auto predict toolbar command
None.

Load/Import Calibration Model
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The Load Calibration Model command allows the user to load calibration methods that were previously created and saved
with the software. The load command will open a File Open Dialog for the calibration model file. Models can be loaded
from the specific calibration file format ( *.calibration ) or directly from a Project file. If the calibration has been protected
by a password, the user will be prompted to enter the password.

Load Calibration Model menu command
Please follow the instructions to load calibration models by menu command:
1. Select the command Load Calibration Model in the Quantify menu.
2. A File Open Dialog will be shown.
3. Select the desired calibration model or project file.
4. Click the Open Button.
5. Enter the password for the calibration (optional).
6. The loaded calibration model will be shown in the Quantify Explorer.

Load Calibration Model toolbar command
To load a calibration model via the Quantify Explorer toolbar, please follow the instructions below:
1. Open or activate the Quantify Explorer.
2. Click the Load Calibration toolbar icon

.

3. Proceed as described above.

Load Calibration Model keyboard shortcut
None.

Export Calibration Model
The export calibration model command allows the user to exchange calibration methods that were created in the
software. The exported model will be saved in a separate file. The export command will show the Export Calibration
Dialog and allows the user to enter a password (optional) and will open a File Save Dialog for the calibration model file.
Models can be saved in the specific calibration file format.

Export Calibration Model menu command
Please follow the instructions to export calibration models by menu command:
1. Select the desired calibration method in the Quantify Explorer. The menu command will be disabled if no calibration
is selected.
2. Select the command Export Calibration Model in the Quantify menu.
3. The Export Calibration Dialog will be opened. The user may enter a password to encrypt the calibration and may
exclude the advanced statistics from the export.
4. A File Save Dialog will be shown.
5. Enter the name and select the path for the destination file.
6. Click the SaveButton.

Export Calibration Model toolbar command
Please follow the instructions to export calibration models by Quantify Explorer toolbar command:
1. Select the desired calibration model in the Quantify Explorer.
2. Click the Export Calibration toolbar icon

.

3. Proceed as described above.
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Export Calibration Model keyboard shortcut
None.

Tools menu
The tools menu holds various commands according to general functions and customization of the software.

Tools menu contents

The Tools menu provides the following commands:
Options
Label Editor
Sign Object (only available with activated security policy and data access control)
Change Password
Lock Application
Application Lockout Settings
Toolbars

Options dialog
Some common application settings may be adjusted in this dialog. The dialog looks like this:
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Application settings
The following application settings can be adjusted:
Audit Trail settings:
Operator settings
The full name of the operator is available here. The user will be asked to enter the operator name in the User
Authentication Dialog during the very first start of the software. By default the name of the current operating system user
is proposed. The operator name is mandatory and can be reviewed in the options dialog but cannot be changed after the
initial input.
Audit trail entries will include the operator!
All audit trail entries include the operator and the department. Please provide correct entries!
Department settings
The name of the department is available here. The user will be asked to enter the department name in the User
Authentication Dialog during the very first start of the software. This can be any company name or name of a division or
department in a company. This value should also reflect the function or position of the user. Unlike the operator name,
the department name can be changed later on in the options dialog.
Audit trail entries will include the department!
All audit trail entries include the operator and the department. Please provide correct entries!

Copy settings:
Copy as bitmap settings
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This option controls, whether all analytical data objects, e.g. 2D data, 3D data and molecules are copied as bitmap into
the clipboard or not. Regardless of this setting, data is always copied as text into the clipboard. The bitmap resolution can
be customized as well. This might be relevant for a required output resolution.
Yes
Analytical data is copied as bitmap in a predefined size into the clipboard to be shared with other applications.
No
nothing is copied.
Use Bitmap resolution settings
This option controls, whether the current screen resolution or a custom size is used for copying an object as bitmap into
the clipboard.
Yes
A custom bitmap size is used to copy an object into the clipboard. The bitmap resolution is predefined.
No
The current screen resolution is used for copying the object into the clipboard.
Bitmap resolution settings
A custom bitmap resolution can be adjusted for copying objects into the clipboard as bitmap. The image of an object is
rendered to fit the custom bitmap resolution automatically.
Copy as CSV settings
This option controls, whether analytical data, i.e. spectral data is copied as separator separated list into the clipboard.
The TABkey is applied as separator.
Yes
analytical data is copied as formatted text using a TABseparator into the clipboard.
No
no formatted text using a TABseparator is copied.
Tip: This option should be set true, if you like to copy data to foreign applications like MSExcel.
Copy as text settings
This option controls, whether analytical data, i.e. spectral data is copied as unformatted ASCII text into the clipboard.
Yes
analytical data is copied as unformatted text into the clipboard.
No
no unformatted text is copied.

Language settings:
Current language settings
This flag toggles the current application language. The initial default language is the native operating system language. It
will be detected automatically on first startup of the application. The user might switch the language later on here. To
toggle the application language, click the
icon at the right side of the property field and select the desired language
from the drop down list.
Tip: The application needs to be restarted to apply the new language completely!

MRU settings:
MRU file list size settings
A custom number shorthands to the last opened files is recognized by the software. This list is called most recently used
file list (MRU). This option controls the number of recognized entries in the most recently used files (MRU) submenu in the
File menu.
To modify this value, please enter a new positive integer value into the property field.
MRU project list size settings
A custom number shorthands to the last opened projects is recognized by the software. This list is called most recently
used projects list (MRU). This option controls the number of recognized entries in the most recently used projects (MRU)
submenu in the Project menu.
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To modify this value, please enter a new positive integer value into the property field.
MRU mathematics list size settings
A custom number shorthands to the last used mathematical functions is recognized by the software. This list is called
most recently used mathematics list (MRU). This option controls the number of recognized entries in the most recently
used mathematical functions including parameter settings (MRU) submenu in the Mathematics menu.
To modify this value, please enter a new positive integer value into the property field.
Preview settings:
File Open Preview
This option controls wether a preview of the selected file in the File Open Dialog is shown.
Yes
any file selected in the File Open Dialog will be shown as preview in the lower part of the dialog.
No
no preview is shown.
Project Password Protection
This option controls the automatic password encryption of new projects.
Checked
New projects are automatically protected by the default password.
Unchecked
Projects are not password protected.
Mathematics Settings:
Ignore Lambert Beer
This option controls wether Lambert Beers Law is followed strictly for all mathematical operations.
Yes
Mathematical operations will be processed without previous unit conversions.
No (default)
Data will be converted to absorbance units for mathematical operations and will be converted back to the original
unit after processing.
Scientific Notation for Numbers
Defines the thresholds for switching the number display to scientific notation.
Bigger than
Numbers bigger than this value will be displayed in scientific notation.
Smaller than
Numbers smaller than this value will be displayed in scientific notation.
Print Settings
Controls the display of the parameters dialog during print preview.
Yes
The parameters dialog will be displayed together with the print preview.
No
Parameters dialog is not shown.

Label Editor
The software supports text information stored in labels together with data objects. These labels hold important
information, e.g. concentrations used in calibration or sample information. The label editor is used for modification of such
information stored in labels for multiple 2D data objects at once.
Simply open all 2D data objects you like to modify and merge them into one data view. Then open the label editor. It
looks like this:
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Contents
The actual active data object is shown in the data view on top of the editor. The table below holds a list of all objects and
corresponding labels. Data objects are listed in rows and corresponding labels are shown in columns. Selection will be
updated automatically when entering a field for editing.
Paste values from the clipboard!
After adjusting the display options to your requirements, multiple values or ranges can be pasted from
the clipboard into the label editor.

Change label display options
To modify displayed labels, please follow the instructions below:
1. Click the Display Options button to show the Select Labels dialog.
2. From the list of labels, check those you like to see in the table above.
3. Click the OK button to return.

Adding new labels
To add a new label to all the 2D data objects, please follow the instructions below:
1. Click the New Label button.
The following dialog is shown:
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2. Enter the name of the label to be added.
3. Click the OK button.
The new label will be automatically shown in the table now.

Removing labels
To remove one or more labels from the list of all available labels, the column must be visible in the table. Please refer to
the Change label display options sections for details.
To remove a label permanently from all visible data objects, please follow the instructions below:
1. Click the Delete Label button.

2. In the Displayed Labels dialog, check all labels to be removed.
3. Click the Delete button.
4. Confirm or discard deletion.

Copy and Paste Clipboard Data
The table in the dialog can be used in a similar manner than MSExcel tables regarding copy and paste support. Thus
information can be exchanged between two applications using the clipboard. There are several Copy and Paste
Opportunities for Tables. These operations are further described in the chapters "Tables" and "Copy and Paste
Opportunities".
Context Menu
A context menu is enrolled whenever the Right Mouse button is pressed over the label editor table. It shows the
following commands:
Copy
Paste
Select All

Lock Application
The command "Lock Application" is used to prevent unauthorized personnel from using the application. The application
will be locked with a simple screen to enter the unlock password and cannot be used otherwise.
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Locking the application.
The command "Lock Application" is only available if the lockout settings (e.g. automatic lockout interval and
password) have been previously configured using the command Application Lockout Settings in the Tools
menu.
The application may also be locked automatically after a defined time interval. Please refer to details in the
chapter "Application Lockout settings".

Lock application menu command
To lock the application, please follow the instructions below:
1. If applicable, configure the Application Lockout Settings in the Tools menu.
2. Select the command Lock Application in the Tools menu to lock the application.
3. The software will be locked and only show a simple screen with a textbox to enter the unlock password.
4. To unlock the software again, simply enter the unlock password and click the Unlock button.

Lock application keyboard shortcut
Not available.

Application Lockout Settings
The Application Lockout Settings control the details for automatically locking the application after a defined time interval.
The automated lockout can be activated/deactivated using this dialog and the timeout interval in minutes can be defined.
Depending on the active security settings, the user needs to enter his personal account password or the password that
was defined in this dialog to unlock the application again. The application may also be locked manually using the
command Lock Application from the Tools menu.
The dialog looks like this:

Application Lockout Settings Dialog contents
Enable Automated Application Lockout
Activate this checkbox to enable the automated lockout. The application will be locked after being idle for the defined
time. The user needs to unlock the application to continue working.
Lock Application after [minutes]
Specifies the time the application needs to be idle before going in to lockmode. The time has to be entered in minutes.
Unlock Password
This option will only be available if the global security settings are disabled. If global security is enabled, the user needs
to unlock the application with his personal account password. Without global security a unlock password can be defined
here.

Window menu
EN
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The window menu contains several commands to control the contents of your application workspace. Tab or window
arrangement can be customized and stored as custom workspace here. Missing tabs can be reopened again.

Window menu contents

The following Window menu commands are available:
Close
Close All
Tabbed Arrangement
Horizontal Arrangement
Vertical Arrangement
Workspace submenu
Open
Save as...
Reset workspace
Reset Application Settings
Hide All Toolboxes
Auto Hide All Toolboxes
The following commands just activate the particular tab on the application workspace. If the tab is not available at the
moment, it will be opened.
Project Explorer
Library Explorer
Quantify Explorer
Labels
Configure Visible Labels
Properties
Mathematics
Audit Trail
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Molecule
Peak Table

Close window
The close window command closes the current active window or tab. All data objects enclosed, will be closed. If any data
object has been modified, the user is prompted to save data before closing the tab.
Closing a window is performed as follows:

Close window menu command
To close a window using the menu command, please follow the instructions below:
1. Activate the tab or window you would like to close.
2. From the Window menu, select the Close command.

Close window keyboard shortcut
To close a window using the keyboard shortcut, please follow the instructions below:
1. Activate the tab or window you would like to close.
2. Press the key combination listed in the keyboard shortcuts.

Close all
The close all windows command closes all open windows or tabs. All data objects enclosed in those windows, will be
closed. If any data object has been modified, the user is prompted to save data before closing the respective tab.
Closing all window is performed as follows:

Close all window menu command
To close all open windows using the menu command, please follow the instructions below:
1. From the Window menu, select the Close All command.

Close all window keyboard shortcut
To close all open windows using the keyboard shortcut, please follow the instructions below:
1. Press the key combination listed in the keyboard shortcuts.

Tabbed arrangement
This is the default windows arrangement in the main application workspace. Each data object or a set of merged objects
are shown in single tab windows. Tabs containing data can be also arranged horizontally or vertically.
If you'd like to learn more about tabs, please look at the Working with Tabs section.
Arranging tab windows in the default way is performed as follows:

Tabbed Arrangement Menu Command
To arrange tabs in separate windows using the menu command, please follow the instructions below:
1. Open desired files either from your hard disc or from a project.
2. From the Window menu, select the Tabbed Arrangement command.

Tabbed Arrangement Keyboard Shortcut

EN

Main Software Manual . 249

None.

Horizontal arrangement
Sometimes, it might be required to see more than one data object at a glance, even if the objects do have a different
data type. In this case multiple tabs need to be arranged to show your data at maximum possible size on your
workspace. Tabs containing data can be arranged horizontally or vertically.
If you'd like to learn more about tabs, please look at the Working with Tabs section.
Arranging tabs horizontally is performed as follows:

Horizontal arrangement menu command
To arrange tabs horizontally using the menu command, please follow the instructions below:
1. Open desired files either from your hard disc or from a project.
2. From the Window menu, select the Horizontal Arrangement command.

Horizontal arrangement keyboard shortcut
None.

Vertical arrangement
Sometimes, it might be required to see more than one data object at a glance, even if the objects do have a different
data type. In this case multiple tabs need to be arranged to show your data at maximum possible size on your
workspace. Tabs containing data can be arranged horizontally or vertically.
If you'd like to learn more about tabs, please follow this link.
Arranging tabs vertically is performed as follows:

Vertical arrangement menu command
To arrange tabs vertically using the menu command, please follow the instructions below:
1. Open desired files either from your hard disc or from a project.
2. From the Window menu, select the Vertical Arrangement command.

Vertical arrangement keyboard shortcut
None.

Workspace
This chapter contains following topics:
Open a workspace
Save a workspace
Reset workspace
Reset Application Settings
Hide all toolboxes
Auto hide all toolboxes

Open a workspace
You might previously have saved your favorite workspace settings to disc in order to transfer it to another computer. The
settings can be restored on another computer using this function.
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Last used settings will be recognized!
You do not need to save your workspace settings every time when leaving the application. Your last
used settings will be automatically restored on the next application startup.

Opening a workspace is performed as follows:

Open a workspace menu command
To open a workspace using the menu command, please follow the instructions below:
1. From the Window menu, select the Workspace submenu.
2. From the Workspace submenu, select the Open... command.
3. A File Open dialog is opened.
4. In the dialog, select an appropriate file name an press the Open button.

Open a workspace keyboard shortcut
None.

Save a workspace
The current window and tab position might be your default application settings. You might save these settings to disc in
order to transfer it to another computer.
Last used settings will be recognized!
You do not need to save your workspace settings all the time when leaving the application. Your last
used settings will be recognized on next application startup, automatically.

Saving a workspace is performed as follows:

Save a workspace menu command
To save a workspace using the menu command, please follow the instructions below:
1. From the Window menu, select the Workspace submenu.
2. From the Workspace submenu, select the Save as... command.
3. A File Save dialog is opened.
4. In the dialog, select an appropriate file name an press the Save button.

Save a workspace keyboard shortcut
None.

Reset workspace
To reset the workspace and restore the default configuration of the application, this function is used. All tabs and tab
positions will be restored automatically.
To reset the workspace, please follow the instructions below:

Reset workspace menu command
To reset the workspace using the menu command, please follow the instructions below:
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1. From the Window menu, select the Workspace submenu.
2. From the Workspace submenu, select the Reset command.

Reset workspace keyboard shortcut
None.

Reset Application Settings
This command resets all application settings and returns the software to the default factory settings. This is equivalent to
command line switch /CLEANSETTINGS. Please refer to the section Command Line Control in the chapter Using the
Software for details on command line control.
To reset the application settings, please follow the instructions below:

Reset Application Settings menu command
To reset the application settings using the menu command, please follow the instructions below:
1. From the Window menu, select the Workspace submenu.
2. From the Workspace submenu, select the Reset Application Settings command.

Reset Application Settings keyboard shortcut
None.

Reset Application Settings command line switch
To reset the application settings using a command line switch, please follow the instructions:
1. Open a command line window to the application directory.
2. At the command prompt enter: software.exe /cleansettings. (The name of the main executable file differs. Replace
it with the actual executable file name).
3. Start the software.

Hide all toolboxes
Hiding tabs is useful to provide the maximum required space on your workspace for analytical data of current interest. If
you do not need a tab and related contents at the moment, you might hide it permanently.
Restoring default tab conditions with just a click...
If you want to restore the default tab position, click the Reset command from the Workspace submenu.

Show a specific tab again...
If you want to show a specific tab again, click the respective tab name from the Window menu.

Hiding all tabs is performed as follows:

Hide all toolboxes menu command
To hide all toolboxes using the menu command, please follow the instructions below:
1. From the Window menu, select the Workspace submenu
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2. From the Workspace submenu, select the Hide all Toolboxes command.

Hide all toolboxes keyboard shortcut
None.

Auto hide all toolboxes
The auto hide function for tabs is useful to provide the maximum required space on your workspace for analytical data of
current interest. If you do not need a tab and related contents at the moment, but you need it sometimes, it can be
automatically hidden. If you move near to the tab flag it is resized to show the contents automatically again.
Restoring default tab conditions with just a click...
If you want to restore the default tab position, click the Reset command from the Workspace submenu.

Enabling or disabling the auto hide function for tabs is performed as follows:

Auto hide all toolboxes menu command
To auto hide all toolboxes using the menu command, please follow the instructions below:
1. From the Window menu, select the Workspace submenu
2. From the Workspace submenu, select the Auto Hide all Toolboxes command.

Auto hide all toolboxes keyboard shortcut
None.

Help menu
The help menu provides detailed information about the software, troubleshooting and technical support.

Help menu contents

The Help menu contains the following commands:
Contents
Opens this help document.
Register License
Whenever you need to register the software during the trial period for the first time or later on for an upgrade, you
must do registration here.
About

About Dialog
The dialog contains some general and support information about your product, which might help us in case of
troubleshooting. Additionally, your product serial number and the license status are located here.
In case you have a Demo version or Trial version installed, you will find the expiration date here.
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The About dialog looks like this:

Appendix
This chapter contains following topics:
File types and data types
Keyboard shortcuts
Link Objects
Troubleshooting and frequently asked questions
Command Line Control
Getting Help
End User License Agreement
Corporate Headquarters
Technical Support

File types and data types
This chapter contains following topics:
Supported file types
ASCII text file type
Calibration file type
LabCognition file type
LabCognition library file type
Project file type
Data types

Supported file types
The application is capable to import analytical data from various file types. This is very important, because most of the
foreign applications use their own proprietary formats to store analytical data. The list of available import filters will be
subsequently enhanced to your convenience.
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The software supports file types as well as various library types. So far, the following formats are supported:

Supported file formats
File type name

File extension

Additional information

Agilent method files

*.a2m

Methods define instrument collection
parameters and data analysis within the
MicroLab Expert software

Agilent result files

*.a2r

Results obtained by quantitative or qualitative
data analysis or library searching in MicroLab
Expert software

LabCognition files

*.panorama

For detailed information about the
LabCognition file type, please refer to the
LabCognition file type section

LabCognition project files

*.project

For detailed information about the
LabCognition project file type, please refer to
the project file type section

JCAMP DX files

*.dx, *.jdx

www.jcamp.org

JCAMP CS files

*.cs

www.jcamp.org

ASCII Text files

*.txt, *.csv

For detailed information about supported text
file import formats, please refer to the ASCII
Text file type section

ACD ChemSketch files

*.sk2

www.acdlabs.com

Galactic files

*.spc

www.galactic.com

MDL Mol files

*.mol

www.mdl.com

Spectacle16 files

*.irs, *.uvd,
*.chr, *.ms,
*.tim, *.fl

www.creonlabcontrol.com

Perkin Elmer files

*.sp, *.asc

www.perkinelmer.com

Nicolet Omnic files

*.spa

www.nicolet.com

LabPower Junior files

*.scn

www.secomam.com

Camspec files

*.1aa

www.camspec.co.uk

Shimadzu files

*.spc,

www.shimadzu.com

Horiba files

*.mdw

www.horiba.com

Supported library formats
The following libraries are file based. They consist of one or more files containing all necessary information.
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File type name

File extension

Additional information

Agilent library

*.a2l

MicroLab Expert library file format

LabCognition library files

*.library

For detailed information about the
LabCognition library file type, please refer to
the LabCognition library file type section

Galactic library

*.idx

www.thermo.com

Nicolet library

*.lbd

www.nicolet.com

ASCII text file type
The ASCII text file format can be easily reproduced by the user. It is a line oriented file type, where complete lines are
interpreted as one statement or information.
This file type can be used to import user defined x,y data into the software. A 2D data set is created from imported data
automatically. It is very important to put the blocks into the ASCII file in the given order of appearance. Otherwise, the file
will not be imported properly.
A format description is given in the following:

Units of the XAxis and YAxis (optional)
By default arbitrary units are applied to both data axes of the 2D data set, if no particular unit is provided in the ASCII
file. If you require special units on the X and Yaxis, you might provide them as TAB separated pair in front of the data
block. The software will detect the data type automatically from the given units.
The following notation is used:
xaxis unit

yaxis unit

For details about available units within the software, please refer to the definition of Axis section of the manual.

Number formatting (optional)
With some locales the decimal delimiter used in numbers causes problems, because the decimal symbol is not unique
around the world (Example: in Germany "," is used, anywhere else "."). If this parameter is omitted, the decimal symbol of
your current regional settings of the operating system is applied by default when reading data from a text file. Otherwise
the following notation is used:
DecimalSymbol

one character as decimal symbol

Example:
For Germany, the following settings are used:
DecimalSymbol

,

Data block (mandatory)
Data might consist of equidistant or discrete data points. It must be given as separated point list, where each data point
is written in a separate line. xvalue and yvalue are separated by the TAB separator. Each line ends with a carriage
return line feed (CrLf) character.
The following line notation is used:
xValue

yValue

Data type identification block (optional)
After the data block an optional identification block can be added. Herein the data type can be adjusted. The data type is
meant to be a sequence of one or more words in a single line. The data type can be omitted, if units are given in front of
the data block. In this case, the data type is determined automatically.
Data type
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For details about available data types in the software, please refer to the Data Types section of the manual.

Labels block (optional)
Any kind of additional labels can be added in subsequent lines optionally. The order of appearance of labels as well as
the upper or lower case writing does not matter. These label lines must be constructed as follows:
LabelIdentifier=LabelValue
Example:
TITLE=This is a demonstration data set showing a straight line
OWNER=LabCognition
DATE=2004/06/05
Tip: The label TITLE will be interpreted as name for the data set. Whenever the object is shown in the software, the
Value of TITLE will be the displayed name of the object.

Where do I see the labels in the software?
After the ASCII file has been imported properly, the labels can be reviewed in the labels tab. You are free
to modify them or add new labels to your data set. Please review the Labels Tab section for details.

Calibration file type
This is an internal file type, where all kinds of calibration data and related information used in calibration will be
organized. Such data is stored in one binary file to keep all required information together.
The file extension *.calibration is used for those files.
Stored information are the following:
Calibration name.
Calibration dependencies.
Folders in a calibration.
All spectra included into a calibration.
All validation spectra included into a calibration.
Graphical results of the calibration process.
Reports created during calibration process.

LabCognition file type
This is an internal file type, where all kinds of data and related information coming into the software and can be stored in
one binary file. This is an internal data type including all features and results of evaluations performed within the
software.
Why using LabCognition files?
Most file types do not support evaluation results and they would be lost if data is returned to its original
file type after evaluation.

Stored information are the following:
original or manipulated analytical data
Audit trail with modifications
evaluation reports, e.g. colorimetric results

EN

Main Software Manual . 257

LabCognition library file type
The LabCognition library is a MSAccess based database file containing all required information about analytical data,
related properties and labels.

Project file type
This is an internal file type, where all kinds of data and related information coming into the software and organized in a
project can be stored in one binary file. Stored information are the following:
Project name
Project dependencies
Folders in a project
All files included into a project

Data types
Depending on the topic of interest, various analytical methods are available to measure physical properties. Thus,
analytical data from various origins must be evaluated and manipulated in the software according to the very special
requirements of respective data. Usually data are measured with analytical instruments in a laboratory. Each analytical
method needs its own set of mathematical functions and typical evaluation workflow. In most cases various data formats
are used to transport these highly specific data from one to another application.
The following data types are available and the list will be subsequently enhanced:

2D data types
The following data types are supported and will be subsequently enhanced:
Data type name

Additional information

IR Spectrum

infrared spectroscopy data or near infrared spectroscopy data

UV Spectrum

ultra violet and visible spectroscopy data

Fluorescence Spectrum

Fluorescence data

Raman Spectrum

RAMAN infrared spectroscopy data

NMR Spectrum

nuclear magnetic resonance data

MASS Spectrum

mass spectrometry data

XRay Spectrum

XRay spectroscopic data

Liquid Chromatogram

Chromatogram data

HPLC Chromatogram

High pressure chromatographic data

Gas Chromatogram

Gas chromatographic data

Chromatogram

any chromatogram data
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<none>

user defined x,y data of any type

3D data types and pseudo 3D data types
The following 3D and pseudo 3D (hyphenated) methods are available:
Data type name

Additional information

3D IR data

infrared spectroscopy data

3D Flurescence data

Fluorescence spectroscopy

3D UV/VIS data

ultra violet and visible spectroscopy data

Related Topics
2D Data
Equidistant Data
Discrete Data
3D Data

Keyboard shortcuts
The most frequent commands in the software are accessible via keyboard shortcuts. A list of all available keyboard
shortcuts is shown below.
Keyboard shortcuts in other languages and customization.
Keyboard shortcut customization or language dependent settings are not available so far. Please
contact your software provider for recent updates.
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Keyboard shortcut

Action

CTRLTAB

Toggles to the next open tab in the current focus

CTRLSHIFTTAB

Toggles to the previous open tab in the current
focus

CTRLF4

Closes the current active tab

CTRLDEL

Closes all open tabs

ALTF4

Closes the application

CTRLO

Opens a file

CTRLS

Save current active item

CTRLSHIFTO

Open a project
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CTRLSHIFTN

Creates a project

CTRLR

Start or stop auto rotation of a 3D data object

CTRLSHIFTS

Saves all items

CTRLSHIFTL

Create a library

CTRLL

Open a library

CTRLSHIFTD

Import data from directory

CTRLSHIFTI

Insert object into library

CTRLF

Search Text

CTRLC

Copy selection to clipboard

CTRLV

Paste from the clipboard into selection

CTRLX

Cuts the current active object

CTRLSHIFTZ

Reverse xAxis Orientation

CTRLSHIFTQ

Shift spectra in a 2D data view

CRTLSHIFTW

Unshift spectra in a 2D data view

CRTLSHIFTM

Merge 2D data views

CRTLSHIFTU

Split 2D data views

CRTLSHIFTA

Autoscale 2Dobject

CRTLSHIFTK

Sticky View

CTRLP

Print the current active object

CTRLSHIFTP

Show the print preview
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CTRLZ

Undo last operation

CTRLY

Redo last operation

F1

Opens help context of the active menu entry/dialog

F2

Renames the current selected item

DEL

Deletes an item

CTRLD

Start recording a script or stop the current recording

CTRLG

Run recorded script

CTRLSHIFTE

Start the script editor

CTRL3

Display 3Dobject in regular 3Dview

CTRLT

Display 3Dobject in top view

CTRLSHIFT1

Display 3Dobject in xaxis Waterfall view

CTRLSHIFT2

Display 3Dobject in yaxis Waterfall view

CTRLA

Autoscale 3Dobject

CTRL7

Autoscale 3Dobject xaxis

CTRL8

Autoscale 3Dobject yaxis

CTRL9

Autoscale 3Dobject zaxis

CTRLSHIFTV

Reset 3Dview

CTRLSHIFTB

3Dview Preferences

ALTF12

Shows the functional group definition of the
selected group

ESC

Cancel the current operation or leave a dialog
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Link Objects
Some data recorded from samples like spectra and molecules belong together. Whenever the spectrum or the molecule is
displayed in the software, related data should be displayed together. For this purpose, objects can be linked to each
other. After linking, all linked objects will be displayed together, if one of the linked objects is opened.
Which items can be linked in the software?
Currently, molecules can be linked to spectra only.

Link Objects with Drag and Drop
To link objects with drag and drop, please follow the steps below.
1. Open a spectrum in a tab window.
2. Drag a molecule object from a Project, any other open tab window or directly from windows explorer onto the
spectrum.
Both will be linked automatically.
A molecule linked to a spectrum is displayed in the molecule tab. Please refer to the "Molecule Tab" in the section "Tabs"
for details.

Troubleshooting and frequently asked questions
In the following, the most frequently asked questions are listed.

Troubleshooting topics
Why are some of my menus missing sometimes?
Possible reasons for missing menus are:
Context Sensitive Menus
Menus are context sensitive. Particular menus are only visible, if the active data object supports the functions listed in the
menu.
License
Maybe your current product license does not allow you to use these features. Please contact your provider to purchase a
suitable update or upgrade.
File open failed. I cannot open data from a file!
Corrupted file?
Maybe the file you would like to import, is corrupted or the dialect is not supported by the software. Please contact your
software provider for help.
We are not perfect!
Maybe the import filter is erroneous and must be revised. Please enter a new bug with a detailed description of how to
reproduce the error into our support system. Attach the file and screenshots, if required. We will resolve the problem as
soon as possible.
Thank you for your support in advance.

Frequently asked questions topics
General application settings
How can I create my favorite working environment?
Please refer to the Customizing a Workspace section for details.
How can I select a printer?
The software will use the default printer set up in Windows.
What are tabs?
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Please refer to the Working with Tabs section for details.
Which tabs are available in the software?
Please refer to the Available Tabs and Tab Groups section for details.
How can I arrange tabs on the workspace?
Please refer to the Tab Arrangement section for details.
How can I show or hide tabs?
Please refer to the Tab Display Options section for details.

2D data view
I want to see my full spectrum. How do I restore the displayed area?
Auto scale using a menu command
Use the Auto Scale command from the 2D View menu.
Auto Scale shortcut
Just Double Click with the Left Mouse button into the data view.
How can I remove a spectrum from a 2D view?
Remove using a keyboard command
1. Activate the spectrum you'd like to remove.
2. Press the DEL key.
Remove using drag & drop
1. Move the mouse pointer next to the spectrum slope.
2. Hold the Left mouse button down.
3. Move the mouse to an empty space on top of the 2D view, where all the tab flags are located.
4. Releases the Left mouse button.
Why are my units on the yaxis gone?
Available data objects have been shifted to separate overlaying data. Please unshift your data to restore appropriate
display ratio.
How can I define the current view port manually?
Manual view port configuration is available from the 2D preferences dialog.
1. Activate the data view of interest.
2. From the 2D View menu, select the Preferences... command.
3. In the 2D Preferences dialog, select the Displayed Area item.
4. Enter your custom view port ranges into the property fields.
How can I change the color of a spectrum?
Manual color settings for 2D data objects are available from the 2D preferences dialog.
Manual view port configuration is available from the 2D preferences dialog.
1. Activate the data view of interest.
2. From the 2D View menu, select the Preferences... command.
3. In the 2D Preferences dialog, select the Displayed Area item.
4. Enter your custom view port ranges into the property fields.

3D data view
I want to see my full 3D spectrum. How do I restore the displayed area?
Auto scale using a menu command
Use the Auto Scale command from the 3D View menu.
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Auto Scale shortcut
Just Double Click with the Left Mouse button into the data view.
How can I enable or disable contour lines?
Manual property settings for 3D data objects are available from the 3D preferences dialog.
1. Activate the data view with the object of interest.
2. From the 3D View menu, select the Preferences... command.
3. In the 3D Preferences dialog, select the Rendering item.
4. Toggle the Contour Lines Enabled property field on the right.
Can I print a 3D object in black & white?
Manual property settings for 3D data objects are available from the 3D preferences dialog.
1. Activate the data view with the object of interest.
2. From the 3D View menu, select the Preferences... command.
3. In the 3D Preferences dialog, select the Color Mapping item.
4. Toggle the Scale property field on the right to White Tones or Grey.
How can I extract 2D data from a 3D object?
Please refer to the 2D Extraction section for details.

Library
What is a library?
Please refer to the Library section in the Definitions section for details.
How can I review library properties?
Library properties display:
1. Activate the library explorer tab on your workspace.
2. Expand the libraries node in the tree view.
3. Select the desired node showing the 'library name' in the tree view.
4. Activate the properties tab on your workspace and you will see the library properties.
How can I add files into a library?
Adding just one object
If you just like to insert the current active object on your workspace into a library, click here.
Adding the contents of a whole directory
If you like to insert multiple files of a special file type into a library in a kind of batch process, please refer to the Import
Data from Directory section
What is a search result?
Please refer to the Search Result section in the Definitions section for details.
How do I search on a search result?
It is possible to refine your search by just searching on an already existing search result.
In the search query dialog, please select a search result as library to limit your search request to the results of a previous
search request.
The other way to perform a refined search is to drag & drop an object, e.g. a spectrum, onto a search result node in the
library explorer.

Working tools and data sharing
Can I use copy & paste?
Please refer to the Copy and Paste Opportunities section for details.
Can I use Drag & Drop?
Please refer to the Drag & Drop Objects section for details.

EN

264 . Main Software Manual

Which objects or items can be copied and pasted?
Please refer to the Drag & Drop Objects section for details.
What keyboard shortcuts are available?
Please refer to the Keyboard Shortcuts section for details.
What is copied into the clipboard?
Selected information is copied into the clipboard in multiple formats (if supported).
E.g. a spectrum is copied as bitmap and as x,y data table into the clipboard.

Command Line Control
The software can be controlled by other Windows applications via command line commands. Several options are available
to open files or run predictions with calibration models automatically on startup of the application. Typically, these
commands are applied via a DOS prompt as described in the following:
1. From the Windows Start menu, choose the Run... command.
2. In the dialog type cmd and press the RETURNkey.
This opens a DOS prompt window.
3. In the DOS prompt window navigate to the installation directory of the software using shell commands like cd\.
4. Type the software executable name plus the command line switch you like to apply.
The general syntax for a command line is the following:
software.exe [FILES] [SWITCHES]
The general syntax for SWITCHES is the following:
software.exe /SWITCH:[VALUE]
Several SWITCHES can be combined by separating them with a white space character.

Command Line Options
Several command line options are available as described in the following:
Command Line Help
Type the software executable name plus the command line switch /? to get an information on all command line options:
software.exe /?
Open Files
The FILES parameter allows you to provide a list of file names being opened by the software on startup. The list may
include valid file wildcards like * and ?. File names need to be separated by a white space character.
Example:
software.exe file1.spc *.dx
This opens the file named "file1.spc" plus all files with extension "dx" in the application directory.
Loading or Creating a Project
A project can be loaded or created using the following SWITCH:
/project
If the denoted project name cannot be found, a new project is created with the given name.
Example:
software.exe /project:MyProject.project
This loads or creates a project named"MyProject".
Creating Folders in a Project
New folders in an open project can be created using the following SWITCH:
/folder
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This command can only be used together with the /project SWITCH.
Example:
software.exe /project:MyProject.project /folder:MyFolder
This command creates a folder named "Myfolder" in the project "MyProject".
Adding Data to a Project or Folder
Files can be added to a folder or project by combining the /project and the /folder switch as follows:
software.exe file1.spc /project:MyProject.project /folder:MyFolder
This command adds the file "file1.spc" to the folder named "Myfolder" in the project "MyProject". If the folder or project
does not exist, they will be created automatically.
Predicting unknown Samples
The software can be used as an external prediction tool for unknown samples, e.g in online analysis. The software is run
with an unknown spectrum file and a project containing calibrations to be evaluated. The prediction result which is a
number or text is returned to the standard output device. It can be redirected easily into a file.
The following SWITCHES are supported in this section:
/PredictProject
Denotes the project name, where calibrations are stored. This must be the exact name. If the name contains white
spaces, the name needs to be put into quotation marks.
/CalibrationModel
Denotes the calibration model name. This must be the exact name. If the name contains white spaces, the name
needs to be put into quotation marks.
/NoMessageBox
Runs the prediction tool silent.
Examples:
software.exe file1.spc /PredictProject:MyProject.project /CalibrationModel:MyPLS1
This command runs a prediction on "file1.spc" with calibration "MyPLS1" from project "MyProject". The result is returned to
the standard output device and a message box is shown with the result.
software.exe file1.spc /PredictProject:MyProject.project /CalibrationModel:MyPLS1 /NoMessageBox
This command runs a prediction on "file1.spc" with calibration "MyPLS1" from project "MyProject". The result is returned to
the standard output device. The application is run in silent mode. No message boxes are shown.
software.exe file1.spc /PredictProject:MyProject.project /CalibrationModel:MyPLS1 /NoMessageBox >
MyResult.txt
This command runs a prediction on "file1.spc" with calibration "MyPLS1" from project "MyProject". The result is returned to
the file "MyResult.txt". The application is run in silent mode. No message boxes are shown.

Low Level Command Line Controls
The following command line controls are for experts only.
Clean User Settings
Sometimes users want to restore factory default settings for the application parameters. This can be easily achieved
using the following SWITCH:
/cleansettings
software.exe /cleansettings
Resetting the application settings may also be achieved by using the command Reset Application Settings in the
Workspace Submenu of the Window menu.
Delete Files On Exit
All files being loaded on startup of the application can be automatically removed from your hard disc when the application
is closed.
The following SWITCH is supported:
/DeleteFilesOnExit
This switch is used in case the application is used as a data viewer. Temporary data provided by other applications needs
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to be opened with the software, but they might be of no use anymore after closing the software.
software.exe file1.spc /DeleteFilesOnExit
This command opens the file "file1.spc" on startup of the application. After closing the application, the file is permanently
removed from the hard disc.

Getting Help
There are various ways to get Help in the software:
Online application Help
From the Help menu, select Contents.
Manuals and Tutorials
From the Help menu, select Manuals and Tutorials.
A submenu will open which hosts a selection of PDFfiles that contain certain help topics and tutorials. Select the
appropriate PDFFile and it will automatically be opened.
Help on the Web
The link above takes you to the support section of our Web site where you can learn about the support options
available to you.
Technical Support
The link above takes you to our technical support information.

Accessing the help
To find out more about how do something in the software, access the online Help using any of the following methods.

To use the Contents, Index, or Search:
From the Help menu, select Contents & Index. Use the buttons and links to navigate.

To get Help on a window or dialog:
On any dialog, click the Help button.
OR
Press F1 for help on any program window or dialog.
OR
Rightclick and select Help.

Finding information in the help
You can find information in the help in several ways.

Help menu command
1. From the Help menu, click Contents.
2. If the lefthand pane isn't visible, click the Contents, Index, or Search buttons.
3. In the Help window, do the following:
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To:

Contents

View the table of contents for the online Help. Click each
book to display pages that link to topics, and click each page
to display the corresponding topic in the right pane.
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Index

Search for specific words or phrases or select from a list of
index keywords. Click the keyword to display the
corresponding topic in the right pane.

Search

Locate words or phrases within the content of your topics.
Type the word or phrase in the text field, press ENTER, and
select the topic you want from the list of topics.

Glossary

Display a list of words, short phrases, and their definitions
related to MyProduct. When you select a term from the Term
list, its corresponding definition is displayed in Definition.

Moving around in the help
Use the following types of navigation in the Help to move around and display information:
Hyperlinks are clickable items such as text (typically underlined and displayed in a different color) that perform an
action, such as displaying another topic or a Web page.
When you click a Related Topics or See Also button, a popup menu opens that displays a list of topics you can go
to. These topics are relevant to what you are currently reading in the right pane. Click a topic in the popup menu to
open it in the right pane.
When you click a dropdown hotspot, more information is displayed below the hotspot. You only need to click the
hotspots you want to read. To hide the text, click the hotspot again.
When you click an expanding hotspot, more information is displayed immediately to the right of the hotspot. You
only need to click the hotspots you want to read. To hide the text, click the hotspot again.
When you click the Previous or Next buttons, you can read through a series of topics that are arranged in a
particular order. This allows you to learn about a subject in an easytofollow sequence.

Printing the Help
While using the software's online help, you can print topics and information right from the browser window.

To print a help topic:
1. Rightclick in the right pane and select Print. The Print dialog opens.
2. Click Print. The topic is printed to the specified printer.

General application questions
Why are some of my menus missing sometimes?
Context Sensitive Menus
Menus are context sensitive. Particular menus are only visible, if the active data object supports the functions listed in the
menu.
License
Maybe your current product license does not allow you to use these features. Please contact your provider to purchase a
suitable update or upgrade.
File open failed. I cannot open data from a file!
Corrupted file?
Maybe the file you like to import, is corrupted or the dialect is not supported by the software. Please contact Agilent for
help.
We are not perfect!
Maybe the import filter is erroneous and must be revised. Please enter a new bug with a detailed description of how to
reproduce the error to our Agilent support system. Attach the file and screenshots, if required. We will resolve the
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problem as soon as possible.
Thank you for your support in advance.
How can I create my favorite working environment?
Please refer to the Customizing a Workspace section for details.
What are tabs?
Please refer to the Working with Tabs section for details.
Which tabs are available in the software?
Please refer to the Available Tabs and Tab Groups section for details.
How can I arrange tabs on the workspace?
Please refer to the Tab Arrangement section for details.
How can I show or hide tabs?
Please refer to the Tab Display Options section for details.
I want to see my full spectrum. How do I restore the displayed area?
Auto scale using a menu command
Use the Auto Scale command from the 2D View menu.
Auto Scale shortcut
Just Double Click with the Left Mouse button into the data view.
How can I remove a spectrum from a 2D view?
Remove using a keyboard command
1. Activate the spectrum you like to remove.
2. Press the DEL key.
Remove using drag & drop
1. Move the mouse pointer next to the spectrum slope.
2. Hold the Left mouse button down.
3. Move the mouse to an empty space on top of the 2D view, where all the tab flags are located.
4. Releases the Left mouse button.
Why are my units on the yaxis are gone?
Available data objects have been shifted to separate overlaying data. Please unshift your data to restore appropriate
display ratio.
How can I define the current view port manually?
Manual view port configuration is available from the 2D preferences dialog.
1. Activate the data view of interest.
2. From the 2D View menu, select the Preferences... command.
3. In the 2D Preferences dialog, select the Displayed Area item.
4. Enter your custom view port ranges into the property fields.
How can I change the color of a spectrum?
Manual color settings for 2D data objects are available from the 2D preferences dialog.
1. Activate the data view with the spectrum of interest.
2. From the 2D View menu, select the Preferences... command.
3. In the 2D Preferences dialog, select the Spectrum Name item.
4. Select your custom color in the property field on the right.

3D Data View
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I want to see my full 3D spectrum. How do I restore the displayed area?
Auto scale using a menu command
Use the Auto Scale command from the 3D View menu.
Auto Scale shortcut
Just Double Click with the Left Mouse button into the data view.
How can I enable or disable contour lines?
Manual property settings for 3D data objects are available from the 3D preferences dialog.
1. Activate the data view with the object of interest.
2. From the 3D View menu, select the Preferences... command.
3. In the 3D Preferences dialog, select the Rendering item.
4. Toggle the Contour Lines Enabled property field on the right.
Can I print a 3D object black & white?
Manual property settings for 3D data objects are available from the 3D preferences dialog.
1. Activate the data view with the object of interest.
2. From the 3D View menu, select the Preferences... command.
3. In the 3D Preferences dialog, select the Color Mapping item.
4. Toggle the Scale property field on the right to White Tones or Grey.
How can I extract 2D data from a 3D object?
Please refer to the 2D Extraction section for details.

Working tools and data sharing
Can I use copy & paste?
Please refer to the Copy and Paste Opportunities section for details
Can I use Drag & Drop?
Please refer to the Drag and Drop Objects section for details
What keyboard shortcuts are available?
Please refer to the Keyboard Shortcuts section for details
What is copied into the clipboard?
Selected information is copied into the clipboard in multiple formats (if supported).
E.g. a spectrum is copied as bitmap and as x,y data table into the clipboard.
How do I search on a search result?
It is possible to refine your search by just searching on an already existing search result.
In the search query dialog, please select a search result as library to limit your search request to the results of a previous
search request.
The other way to perform a refined search is to drag & drop an object, e.g. a spectrum, onto a search result node in the
library explorer.

Library
What is a library?
Please refer to the Library section in the Definitions section for details.
How can I review library properties?
Library properties display:
1. Activate the library explorer tab on your workspace.
2. Expand the libraries node in the tree view.
3. Select the desired node showing the 'library name' in the tree view.
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4. Activate the properties tab on your workspace and you will see the library properties.
How can I add files into a library?
Adding just one object
If you just like to insert the current active object on your workspace into a library, click here.
Adding the contents of a whole directory
If you like to insert multiple files of a special file type into a library in a kind of batch process, please refer to the Import
Data from Directory section
What is a search result?
Please refer to the Search Result section in the Definitions section for details.
How do I search on a search result?
It is possible to refine your search by just searching on an already existing search result.
In the search query dialog, please select a search result as library to limit your search request to the results of a previous
search request.
The other way to perform a refined search is to drag & drop an object, e.g. a spectrum, onto a search result node in the
library explorer.

Audit Trail
What is an audit trail?
Please refer to the audit trail section in the Definitions section for details.
What happens to the audit trail if the undo operation is performed?
If the last operation is undone on an object, the original object is restored in its state before the last operation has been
applied.
In this case, the operation, that has been undone, will not occur in the audit trail of the object.
Undo and Redo operations can be executed as many times as desired without taking effect on the audit trail of an object
as long as the object is not stored meanwhile.
Once the object is stored, the modifications will be applied and cannot be undone anymore.
Where can I see the audit trail of an object?
The audit trail of an object can be reviewed in the audit trail tab.
Just click the object or project in the project explorer. The audit trail tab shows the audit trail of the selected object

File Handling
Why is the Save all... command inactive sometimes?
The Save All... command is only active in the menu, if any modified objects are available in the software.
What happens to the modified files when closing the application?
The user is prompted for not yet saved files when he closes the application. He can either save them or discard changes.
A list of all modified files will be presented and the user might select those files to be stored and deselect those to be
discarded.

Project Administration
Must I save a project?
Projects will be saved automatically on confirmation of modifications of files enclosed. This is for security reasons.
How can I review library properties
Projects cannot be renamed in the software, but they can be copied and pasted within the project explorer. You are
prompted to store the project under a different name on your hard disc then.
Alternatively, use the Save as command to save a project under a new name.
Can I add the same file multiple times into a project?
File names in a project must be unique within the same level. You might add the same file multiple times into different
folders or under different names.
If you open the same file twice, the file will be automatically renamed into 'Copy of...'.
Must I save files located in a project?

EN

Main Software Manual . 271
Projects and file enclosed can be saved using the Save command. Modified files will be marked by an asterisk (*) symbol
and they are red colored.
Why do opened files do not appear in my project?
If you open files via the Open command in the File menu, the file is just opened and shown on the workspace.
If you like the file to be added into a project, please use the Add Files command from the Project menu or the Add Files
toolbar icon in the project explorer

Mathematics
How can I change the resolution?
The software offers the opportunity to Adjust the xaxis properties of an equidistant data object. Here the resolution can
be changed or data points can be shifted.
How can I set new borders of a spectrum?
Use the Adjust XAxis command from the Mathematics menu to perform this operation.
Enter a new starting value and / or new ending value within the current spectrum borders in the adjust xaxis function
and the spectrum will be cut according to the new borders.
What is zapping?
To learn more about zapping, refer to the Zapping section in the Mathematics chapter.

AGILENT TECHNOLOGIES, INC. SOFTWARE LICENSE AGREEMENT
ATTENTION: USE OF THIS SOFTWARE IS SUBJECT TO THE AGREEMENT SET FORTH BELOW.
IF YOU DO NOT AGREE TO BE BOUND BY THIS SOFTWARE LICENSE AGREEMENT, THEN (A) DO
NOT INSTALL OR USE THE SOFTWARE, AND (B) YOU MAY RETURN THE SOFTWARE FOR A FULL
REFUND, OR, IF THE SOFTWARE IS SUPPLIED AS PART OF ANOTHER PRODUCT, YOU MAY
RETURN THE ENTIRE PRODUCT FOR A FULL REFUND. NOTWITHSTANDING ANYTHING TO THE
CONTRARY IN THIS NOTICE, INSTALLING OR OTHERWISE USING THE SOFTWARE INDICATES
YOUR ACCEPTANCE OF THESE TERMS.

Software
"Software” means one or more computer programs in object code format, whether standalone or bundled with other
products, and related Documentation. It does NOT include programs in source code format.

License Grant
Agilent grants you a nonexclusive license to install, store and use two (2) copies of the Software for internal use and
purposes in accordance with this Agreement and the Documentation provided with the Software. Specifically, the license
granted herein is limited to installing one copy of the Software on a computer which is directly connected to the Agilent
hardware product you have purchased; and installing a second copy of the Software on a computer which is not directly
connected to the Agilent hardware product you have purchased, provided the second copy is solely for your own use.
You may use the two copies of the Software simultaneously.

Documentation
The Documentation may include license terms provided by Agilent’s third party suppliers, which will apply to the use of
the Software and take precedence over these license terms.

License Restrictions
You may make copies or adaptations of the Software for archival purposes or when copying or adaptation is an essential
step in the authorized use of the Software, but for no other purpose. You must reproduce all copyright notices in the
original Software on all permitted copies or adaptations. You may not copy the Software onto any public or distributed
network.

Upgrades
This license does not entitle you to receive upgrades, updates or technical support. Such services may be purchased
separately.
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Ownership
The Software and all copies thereof are owned and copyrighted by Agilent or its third party suppliers.
Agilent and its third party suppliers retain all right, title and interest in the Software. Agilent and its third party suppliers
may protect their respective rights in the Software in the event of any violation of this Agreement.

No Disassembly
You may not disassemble or otherwise modify the Software without written authorization from Agilent, except as
permitted by law. Upon request, you will provide Agilent with reasonably detailed information regarding any permitted
disassembly or modification.

High Risk Activities
The Software is not specifically written, designed, manufactured or intended for use in the planning, construction,
maintenance or direct operation of a nuclear facility, nor for use in on line control or fail safe operation of aircraft
navigation, control or communication systems, weapon systems or direct life support systems.

Transfer
You may transfer the license granted to you here provided that you deliver all copies of the Software to the transferee
along with this Agreement and pay any applicable fees to the extent permissible under local laws. The transferee must
accept this Agreement as a condition to any transfer. Your license to use the Software will terminate upon transfer.

Termination
Agilent may terminate this license upon notice for breach of this Agreement. Upon termination, you must immediately
destroy all copies of the Software.

Export Requirements
If you export, reexport or import the Software, technology or technical data licensed hereunder, you assume
responsibility for complying with applicable laws and regulations and for obtaining required export and import
authorizations. Agilent may terminate this license immediately if you are in violation of any applicable laws or regulations.

U.S. Government Restricted Rights
Software and technical data rights granted to the federal government include only those rights customarily provided to
end user customers. Agilent provides this customary commercial license in Software and technical data pursuant to FAR
12.211 (Technical Data) and 12.212 (Computer Software) and, for the Department of Defense, DFARS 252.2277015
(Technical Data – Commercial Items) and DFARS 227.72023 (Rights in Commercial Computer Software or Computer
Software Documentation).

NO WARRANTY
TO THE EXTENT ALLOWED BY LOCAL LAW, AND EXCEPT TO THE EXTENT AGILENT
HAS PROVIDED A SPECIFIC WRITTEN WARRANTY APPLICABLE TO THIS PRODUCT, THIS SOFTWARE IS
PROVIDED TO YOU "AS IS" WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, WHETHER ORAL
OR WRITTEN, EXPRESS OR IMPLIED. AGILENT SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES
OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, NONINFRINGEMENT AND
FITNESS FOR A PARTICULAR PURPOSE. SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU ASSUME
THE ENTIRE RISK AND COST RESULTING FROM OR RELATING TO THE DEFECT. SOME JURISDICTIONS
DO NOT ALLOW EXCLUSIONS OF IMPLIED WARRANTIES OR CONDITIONS, SO THE ABOVE EXCLUSION
MAY NOT APPLY TO YOU. YOU MAY HAVE OTHER RIGHTS THAT VARY ACCORDING TO LOCAL LAW.

LIMITATION OF LIABILITY
TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL AGILENT
OR ITS SUBSIDIARIES, AFFILIATES OR SUPPLIERS BE LIABLE FOR DIRECT, SPECIAL, INCIDENTAL,
CONSEQUENTIAL OR OTHER DAMAGES (INCLUDING LOST PROFIT, LOST DATA, OR DOWNTIME
COSTS), ARISING OUT OF THE USE, INABILITY TO USE, OR THE RESULTS OF USE OF THE SOFTWARE,
WHETHER BASED IN WARRANTY, CONTRACT, TORT OR OTHER LEGAL THEORY, AND WHETHER OR
NOT ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. YOUR USE OF THE SOFTWARE IS ENTIRELY
AT YOUR OWN RISK. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
LIABILITY FOR DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.
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Applicable Law
Disputes arising in connection with this Agreement will be governed by the laws of the United States and of the State of
New York, without regard to choice of law provisions. The United Nations Convention for Contracts for the International
Sale of Goods will not apply to this Agreement.

Unenforceability
To the extent that any provision of this Agreement is determined to be illegal or unenforceable, the remainder of this
Agreement will remain in full force and effect.

Entire Agreement
This Agreement constitutes the entire agreement between you and Agilent, and supersedes any previous
communications, representations or agreements between the parties, whether oral or written, regarding transactions
hereunder except for a specific warranty issued by Agilent with regard to this product. Your additional or different terms
and conditions will not apply. This Agreement may not be changed except by an amendment signed by an authorized
representative of each party.
G922690004

Corporate Headquarters

Address:

Agilent Technologies, Inc. Headquarters
5301 Stevens Creek Blvd
Santa Clara, CA 95051
United States

Telephone:

+1 408345885

Fax:

+1 4083568474

Support:

http://www.agilent.com/chem/contactus

World Wide Web:

http://www.agilent.com

Technical Support
Problems? Questions? Updates?
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Anyway, please contact us. We will answer your questions and help you to solve your problems. Please take one moment
and prepare the following information before you contact Agilent technical support:
Locate your maintenance contract number, if available.
Find the version and serial number of your product in the About dialog.
Determine your operating system version and the current service pack status.

Contact information:
Corporate Headquarters
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Calibration Manual
This chapter contains following topics:
Chemometry
Univariate calibration
Multivariate calibration
Calibration
Calibration Model Wizard
Calibration Results Overview
Prediction of unkown Samples
Calibration formula editor

Chemometry
Chemometrics is the chemical discipline that uses mathematical and statistical methods to design or select optimal
measurement procedures and experiments, and to provide maximum chemical information by analyzing chemical data.
In modern analytical chemistry and biochemistry, chemometric approaches have become famous in quantitative and
qualitative analysis of samples from spectroscopic data. The process of data evaluation is called calibration and will be
described in more detail in the following.
In calibration, indirect measurements are made from samples where the property or the amount of a property to be
evaluated has been predetermined, usually by an independent technique or reference measurement. These
measurements, along with the predetermined property or property levels, comprise a group known as the calibration
set. This set is used to develop a model that relates the property or property level of a sample to the instrumental
measurements. In some cases, the construction of the model is simple due to a certain relationship, such as Lambert
Beer's Law in the application of UV, IR and NIR spectroscopy. Unlike spectroscopy, other cases can be much more
complex, and it is in these cases where construction of the model is the timeconsuming step. Once the model is
constructed, it can predict sample properties or property levels based on measurements of new or even unknown
samples.
The concepts of calibration have been well defined basically by the International Union of Pure and Applied Chemistry
(IUPAC). For more comprehensive approaches several organizations like the International Dairy Federation (IDF) or
others developed special methods. Please review the literature of chemometry for details.
The software focuses on two classical calibration approaches, which have been widely accepted in the world of analytical
chemistry, the quantitative and the qualitative calibration.

Calibration Algorithms
Multivariate calibration allows for the analysis of several measurements from several samples. This compares to
univariate calibration, which involves the use of a single instrumental measurement to determine a single sample
property. Either method may contribute to a multistep procedure where data is calibrated, validated (optional) and
further samples predicted based on the calibration model.
Quantitative Calibration
The following quantitative calibration methods are available:
1. Univariate calibration following Lambert Beer's Law
2. Multivariate calibration
Partial Least Squares Regression (PLS1, PLS2 or SIMPLS)
Multiple Linear Regression (MLR, PCR)
Qualitative Calibration
The following qualitative calibration methods are available:
PCA

Creating Calibrations
Calibrations are constructed using a wizard which guides the user through the steps of a calibration. The Calibration
Model Wizard supports the user in creating Univariate Calibrations and Multivariate Calibrations.

Predicting unknown Samples
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After creation of calibration models they will be applied in routine analysis to predict unknown samples and their
concentrations. The software provides several options to perform predictions and present prediction results:
Online prediction
Prediction result report

Analysis of Variance
The robustness and reliability of the calibration model is reflected by the results of the analysis of variance. Several
statistical values are available as shown in the following.
For calibration spectra the following statistics are calculated:
Standard Error of Calibration (SEC)

Root mean square error of Calibration (RMSEC)

Standard Error of cross validation (SECV)

Root mean square error of cross validation (RMSECV)

For validation spectra the following statistics are calculated:
Standard error of prediction (SEP)

Root mean square error of prediction (RMSEP)

References
K. Danzer and L.A. Currie
Guidelines for calibration in analytical chemistry
Part 1. Fundamentals and single component calibration
Pure & Applied Chemistry, 70 (1998) 9931014.
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K. Danzer, M. Otto and L.A. Currie
Guidelines for calibration in analytical chemistry
Part 2. Multispecies calibration
Pure & Applied Chemistry, 76 (2004) 12151225.
M. Otto
Chemometrics, WileyVCH, 1999
H. Martens, T. Naes
Multivariate Calibrtion, Wiley, 1989

Univariate calibration
In univariate calibration the aim is to find a relationship which relates a sample property to a peak area, a ratio of peak
areas or a spectral intensity at characteristic positions. This technique is widely accepted for quantitative analysis in UV,
IR and NIR spectroscopy, where the correlation of the concentration of a sample and the spectral intensity is stated by
Lambert Beer's Law.

Univariate Calibration Algorithm
In regression the relationship which relates a sample property like the concentration C and one or more explanatory
spectral variables X1 , X2 , ... Xn is defined by a
polynomial function of nth order. Thus the physical property is expressed by spectral variables as shown in the following
equation:
C = c0 + c1 X1 + c2 X2 + ... + cn Xn + e
Legend:
C

Amount of an investigated sample property such as the
concentration.

e

measurement error or random error

c0 , c1 , ..., cn

usually unknown regression coefficients, which need to be
determined during construction of the calibration model.

X1 , X2 , ...,
Xn

explanatory variables taken from spectral data.

The simplest case is, when there is a single variable X1 and the relationship is linear:
C = c0 + c1 X1 + e
Usually, the regression coefficients c0 and c1 are unknown and e is some kind of measurement or random error.
In construction of a calibration with suitable reference data and known property values, the regression coefficients need
to be calculated by polynomial regression following one of the equations given above. The quality of regression can be
seen from the correlation coefficient and must be optimized by the user.
Once a calibration model has been established, the property C can also be calculated for unknown samples. This
procedure is called prediction.

Multivariate calibration
Multivariate calibration methods like PLS, SIMPLS, MLR, PCR and PCA are well documented in corresponding literature.
Therefore they will not be described in further detail here.

Calibration
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A calibration comprises a collection of spectral data and a customizable set of parameters describing a particular analysis
procedure.
Calibrations are used in quantitative and qualitative analysis either to detect an amount of a particular substance
contained in a sample or to prove the identity of a substance or compound. Such investigations are based on a previous
mathematical and statistical interpretation of a known set of substances or amounts. The results of these investigations
are stored in a so called calibration.
Based on these precalculated results, reliable predictions for the identity or an amount of a substance in an unknown
samples can be made.

Calibration Model Wizard
The calibration model wizard is used for creating and editing quantitative calibrations. Calibration spectra and suitable
parameters will be adjusted here to get a calibration model for evaluation of samples in routine analysis. One or more
physical properties of a sample can be evaluated according to numeric values (constituents/properties) which must be
attached as label to all calibration spectra. This should be done before you start the calibration process, although editing
of the property values is also possible from within the wizard.

Prerequisites to a Calibration
Creating a new calibration requires a set of calibration spectra. The following preparative steps are mandatory:
Add / Edit labels
The properties to be calibrated containing e.g. concentration values must be stored in a corresponding label before
starting a new calibration. For this purpose a Label Editor dialog is available, which allows editing labels in a spread
sheet. If you need to make corrections the label editor is also available from within the wizard.
The wizard will only accept the calibration spectra as part of a project. Add the calibration to a project or load a
project which contains the spectra. Select the project in the Project Explorer and start the Calibration Model
Wizard.
At least two spectra need to be added to the calibration set in order to perform a successful calibration. The
exception is the univariate calibration which can be performed with only one spectrum. In that case the option
Data Origin is Zero will be automatically activated and an additional dummy spectrum with (0,0) data values will be
added to the calibration set and calibration project.

Calibration Steps
Univariate Calibration
1. General information on the calibration.
2. Selection of a calibration model and one or more properties to be calibrated.
3. Selection of calibration and validation spectra including validation options.
4. Mathematical preprocessing in order to prepare spectra for calibration.
5. Data Extraction
6. Display of calibration and prediction results including plots and report.

Depending on your license not all calibration models may be available!
Your licensing model may not support the full quantify package. In this case only the Univariate
Calibration will be available. Please contact your vendor for information on how to purchase additional
modules.

MLR Multiple Linear Regression
1. General information on the calibration.
2. Selection of a calibration model and one or more properties to be calibrated.
3. Selection of calibration and validation spectra including validation options.
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4. Mathematical preprocessing in order to prepare spectra for calibration.
5. Selection of significant spectral ranges.
6. Display of calibration and prediction results including plots and report.

PLS (Partial Least Squares Regression) and PCA (Principle Component Analysis)
1. General information on the calibration.
2. Selection of a multivariate calibration model and one or more properties to be calibrated.
3. Selection of calibration and validation spectra including validation options.
4. Mathematical preprocessing in order to prepare spectra for calibration.
5. Selection of significant spectral ranges.
6. Primary calibration results and fine tuning of parameters  Factor analysis.
7. Display of calibration and prediction results including plots and report.

Navigation in the calibration wizard
A wizard contains a predefined sequence of steps, which must be passed through to reach a particular result. In this
case, the wizard guides the user through the steps of preparing a calibration model. The user has the following
opportunities to navigate within the wizard:
Why are some buttons inactive in the wizard?
Navigation items like buttons are only active, if all required conditions are fulfilled to proceed to the
desired step. If not, please check the contents of the current wizard step.

Proceeding to the next step
By clicking the Next > button, you will move one step forward in the wizard.
Proceeding to the previous step
By clicking the < Back button, you will move one step back in the wizard.
Aborting the calibration wizard
To abort the current calibration without saving, press the Cancel button or just press the ESCkey.
Finishing a calibration
When all steps have been accomplished successfully, the Finish button will become active. Click this button to save the
calibration and leave the calibration wizard.

Calibration Model Wizard  Step 1  General information
Step 1 offers the general information setup of the new calibration. The new calibration needs to be named and a
description should be entered. Ideally the name should briefly describe the type of calibration and the calibration model
or algorithm used. The calibration will be referred to by this name throughout the software. Additionally more detailed
information can be entered into the description field. This will help you later on to identify the calibration from a list of
calibrations in the Quantify explorer.
Where can I review this description later on?
A summary of important information on a calibration can be reviewed in the properties tab after the
calibration has been finished. Just select the calibration node in the quantify explorer and you will see
the summarized information in the properties tab.

Step 1 shows the following dialog:
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Calibration Model Name
Enter a unique name for the calibration here. This name will be displayed as a reference on reports and is also used in
the software to address the calibration. Suitable names include the model and a description of the calibrated property as
shown in the following example:
Intensity1745Protein
Denotes a Intensity calibration for the property Protein at 1745 nm.
Ratio1745(1807)Protein
Denotes a Intensity ratio calibration for the property Protein where the intensity at 1745 nm is divided by the
intensity at 1807 nm.
Description
The description text field might be filled optionally with additional sample information being important to the user. It might
contain e.g. details on sample preparation, applicable concentration ranges for the calibration, procedure for preparation
of reference concentrations, etc.
How can I add multiple lines in the Description field?
When adding text in multiple lines to the description field, the lines can be separated by CTRLRETURN
keys. Simply pushing RETURNkey does not work (this will trigger the Nextbutton).

Navigation
Just click the Next > button to proceed to the next step.
Clicking the Cancel button will abort creating a new calibration.
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Calibration Model Wizard  Step 2  Model Setup
Step 2 guides you through the general setup of the new calibration model. The dialog allows you to select the calibration
model, the properties to be calibrated and specific calibration parameters.

Calibration Model Parameter
Calibration Model
Select the desired calibration model from the dropdown box. The following models are available:
PLS1
PLS2
SIMPLS
MLR
PCA
PCR
Univariate
Model Settings
These additional parameters allow further adjustment of the calibration model and result.
Prediction Result Options:

Show Calibration details in report
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This option is designed to hide potentially sensitive/unwanted information from the calibration reports when using
calibration in routine analysis of unknown samples. This flag controls if Ranges, Calibration PreProcessing,
Calibration Data and Regression Statistics will be included in the report when unknown spectra are evaluated via
the function 'Evaluate with...' in the Quantify Menu. This only applies to finished calibrations which are applied with
the function evaluate. Check this option to include all Calibration Ranges, Calibration PreProcessing, Calibration
Data and Regression Statistics in the calibration report when spectra are evaluated.
Show outlier details in prediction report
If this option is used (which is the default) the results of outlier detection according to predefined outlier tests and
discrimination criteria settings are displayed in detail on the prediction result report. Otherwise such details are not
displayed. See Evaluate With... feature for details.
Number of displayed decimals
Specifies the visible number of decimals for labels and predicted values in reports.
Number of Report Columns
Specifies the number of columns the results will be presented in.
Result Unit
Specifies the unit of the calibration results.
Matrix Preprocessing Options:

Number of factors to analyze
Specifies the maximum number of factors that may be used in the calibration model.
Mean centering
This parameter controls, whether the data matrix used for calibration is centered before calculation or not.
Variance scaling
This parameter controls the scaling of the data matrix.
Use squared leverage correction
Specifies wether the data matrix is leverage corrected or not.
Polynomial fit (only available for the univariate model):

Polynomial order
Specifies the order of the polynomial used in the calculation
Data passes through origin of the coordinate system
Specifies if the regression line is forced through the origin (0,0).
Discrimination Criteria Options
If the calibration contains multiple constituents, the discrimination criteria for each constituent can be specified. Default
discrimination criteria are a factor of 2 for the warning limit and a factor of 3 for the alarm limit. Please see below for the
actual calculation formulas of the different parameters.
Warning Limit
Specifies the low and high warning limit factor. If these limits are exceeded a warning will be displayed.
Alarm Limit
Specifies the low and high alarm limit factor. If these limits are exceeded an alarm will triggered.
Outlier Detection Status
Specifies the statistical basis for the detection of outliers.
Calculation details:
Parameter

Limits

Formula for Low Limit

Formula for High Limit

Predicted

calculated according to
the actual concentration
range (not the predicted
concentrations!)

Minimum(actual)  limit *
SECV

Maximum(actual) + limit *
SECV

Residuals

calculated according to
the prediction residuals

Minimum(residuals)  limit
* SECV

Maximum(residuals) +
limit * SECV
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Spectral Residuals

calculated according to
the worst spectral
residual

0.0 for both limits as a
constant

Worst(spectral residual)
* limit

Spectral Residual F
Ratios

calculated according to
the worst spectral
residual FRatio

0.0 for both limits as a
constant

Mean(spectral residuals)
+ (Maximum(spectral
residuals) * (No. of
calibration spectra  1) *
limit)

Mahalanobis Distance

not calculated, limits are
constant

Low Alarm: 0.0
Low Warning: 0.0

High Warning: 3.0
High Alarm: 3.0

Scores

calculated as interval
according to the worst
score value = biggest
distance from mean score
value

Mean(Scores[factor]) 
(Worst(Scores) * limit)

Mean(Scores[factor]) +
(Worst(Scores) * limit)

Property Evaluation Settings
By convention, the constituents/properties to be calibrated must be located in the labels of all data used in the
calibration. Thus each data object requires the same label which needs to hold a certain value. These values may indicate
a concentration, a fraction, color value, etc. However, it must be a quantifiable value, which can be interpreted in a
statistical manner. The application will scan all selected data for common labels with numerical values and will display
these in the dialog.
How can I edit the labels of my calibration data?
The most convenient way to add a new label, change existing label or remove labels from multiple
spectra at once is using the Label Editor dialog. New Properties can be added directly in this step of the
wizard using the New Property button. Clicking on this button will start the Label Editor. It is also
available in step 4 of the Calibration Model Wizard. Outside of the wizard the Label Editor can be started
from the Tools menu.

Depending on the selected calibration model, one ore more labels need to be chosen. Multiple labels can only be selected
when using PLS2, SIMPLS and PCR as model. Select the appropriate label by left clicking. Hold the CTRLkey to select
more than one label.
In case of a PCA calibration there are two different options to choose for the property evaluation settings and an
additional Groups parameter will be available (see below):
Normal PCA  No Property/Groups defined
By selecting this option a normal PCA calibration without any property/group definition will be executed. The
calibration will yield the regular PCA results, but the software will not be able to automatically assign the calibration
samples to groups. The groups parameter selection will be disabled when choosing this option.
Property selection
By selecting an available label/property the software will automatically analyze the different contents of this label
and display them in the Groups parameter section. The user may choose different assignment options for the
available groups and the software will use these settings to automatically assign the calibration samples to the
groups according to the PCA calibration results. Refer to the Groups section below for further details.
Groups (only available for PCA)
If the PCA calibration model is chosen an additional Groups parameter will be available. Since the PCA is a qualitative
calibration, the Groups parameter is used to display/define the possible assignment options for the previous selected
property. The following screenshot shows an example with a selected property that has four different assignment
options:
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In the above example the label "Material" has been selected which contains four different values. These values will be
autodetected and assigned to groups as shown in the screenshot. The PCA calibration will try to assign the calibration
samples to these four groups. Samples that do not fit into any of these groups will be marked as unassigned in the
calibration results.

Navigation
Just click the Next > button to proceed to the next step.
Clicking the Cancel button will abort creating a new calibration.

Cross validation setup
In the multivariate calibration wizard cross validation can be used with PLS calibration models.
This validation process allows automatic quality control of the derived calibration model by keeping some samples out of
the calibration and only use them for prediction. This procedure is repeated during calculation of the calibration model
until all samples have been kept out once. The residual variance is then calculated from the prediction residuals showing
the overall quality of the model.
In segmented cross validation, the samples are divided into several groups. During calculation of the calibration model
each group or segment is kept out at a time. There are as many calculations for the calibration as segments. This
procedure will allow to make predictions on all samples. A final calibration is then calculated including all samples.
The cross validation method can be selected in the following dialog. Parameters for the selected method must be
configured here.
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Contents
The dialog contains a drop down box for selection of the cross validation method applied in calibration process.
With segmented cross validation methods, two additional parameters for segment adjustment are available:
Number of segments
This number indicates the number of groups. All samples will be evenly divided and assigned to one of the groups.
The maximum number of groups is equal to the number of samples.
Samples per segment
The user selects the maximum number of samples assigned to a segment or group. The number of segments is
calculated automatically according to the specified number of samples per segment.
A list box in the lower part of the dialog shows current settings and assignment of samples per segment.

Cross validation methods
The following cross validation methods can be configured:
None
The cross validation is deactivated.
Full
The full cross validation considers all samples during calculation of the calibration model except one. Only one sample at a
time is kept out respectively. There are as many calibration calculations as samples are included.
Random
All samples are randomly divided into a given number of segments. Either the number of segments or the number of
samples per segment can be adjusted in the dialog. Samples are randomly assigned and the resulting assignment is
shown in the list box below.
Systematic 123123123
All samples are assigned systematically in a predefined order following the number of samples per segment.
Example:

EN

286 . Calibration Manual

Systematic 111222333
All samples are assigned systematically in a predefined order following the number of samples per segment.
Example:

Calibration Model Wizard  Step 3  Calibration & Validation data
Step 3 shows a first overview of all spectra and the calibration and validation data. Additional statistical analysis is also
available:

The calibration data view in the upper part of the dialog shows an average spectrum (red line) derived from all data
objects selected for calibration. The light red shape around the average spectrum indicates the variance of all spectra. If
a particular data object is selected in the tree view below, the corresponding spectrum graph is shown as green line in
the data view.
As in all data views in the software, the user can zoom into spectral regions by left clicking and dragging the mouse. A
doubleclick in the data view restores the original view.
The experienced user will draw conclusions for selection of significant spectral regions. Some additional statistical spectra
can be displayed as described below.
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In the lower part of the dialog, a tree view shows all available data objects from the selected project. By default all
objects are taken into account for calibration and none are used for validation. Corresponding property values of the
selected property are shown accordingly.
The user can change the selection for calibration and validation spectra and also modify property values in this dialog.

Statistical spectra
Clicking the Statistical Spectra button shows a menu with several statistical spectra:

Show Correlation for property
Show Mean
Show Variance
Show Standard deviation
Show Calibration Spectra
Show Validation Spectra
Show Band
By checking or unchecking those entries the corresponding item is shown in the data view or not. The mean spectrum
and the band are shown by default. The top of the menu will hold entries to show the correlation for each selected
property.

Changing calibration and validation data selection
Data objects can be selected for use in calibration or validation data sets or both.
The selection of a single data object is modified by double clicking on Yes or No with the Left mouse button in the
respective calibration or validation column field. In this case selection is toggled.
What is the minimum number of calibration spectra allowed?
For all calibration models except for the univariate model at least two spectra need to be part of the
calibration set in order to perform a successful calibration.
For the univariate model one spectrum is sufficient, but additional options will be added to be able to
perform a successful calibration: The flag Data Origin is Zero in the General Options of the Model
Settings will be automatically activated and dummy spectrum with data value of (0,0) for all datapoints
will be added to the calibration set and calibration project.

To change selection for multiple data objects at once, please select the project or folder node above in the tree. Then
click the Right mouse button to show the following context menu. Alternatively multiple objects can be selected by
holding the shift or ctrl button and left clicking.

Add to calibration set
Adds all selected data objects to the calibration set. In the calibration column, all entries for those data objects will
be changed to Yes.
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Remove from calibration set
Removes all selected data objects from the calibration set. In the calibration column, all entries for those data
objects will be changed to No.
Add to validation set
Adds all selected data objects to the validation set. In the validation column, all entries for those data objects will
be changed to Yes.
Remove from validation set
Removes all selected data objects from the validation set. In the validation column, all entries for those data
objects will be changed to No.

Auto validation
Those users, who do not have a separate or independent set of validation spectra, may use the calibration spectra for
validation purposes. In order to define a random set of validation spectra, click the Auto Validation button. The following
dialog is shown:

Percentage of Spectra
A user defined percentage of available data objects will be randomly assigned as validation spectra according to
the following conditions:
Selection Based On
Calibration Data
Only those objects in the tree being used in calibration (Calibration column entry = Yes) are considered for
validation data selection
All Data
All data suitable objects in the project are considered for validation data selection.
Why are some data objects not considered?
Only those spectra can be considered, which have a properly assigned component label. Especially
for quantitative calibration modelling a numeric value must be present to be considered for use in
calibration modelling.
Action
Toggle Selection
This toggles the given percentage of the current active data selection. Spectra defined as calibration spectra
become validation spectra and vice versa.
Only Activate Validation
This keeps the current selection of calibration spectra and will only add the given percentage of validation
data.

Cross Validation
Cross validation is another option to perform the validation of the calibration model. Please refer to the topic Cross
Validation Setup in the chapter Chemometric Analyis for detailed description of the Cross Validation.

Modifying property values
Typically, all property values should be properly adjusted before starting the calibration wizard.
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How can I edit the labels of my calibration data?
The most convenient way to add a new label, change existing label or remove labels from multiple
spectra at once is using the Label Editor dialog. It can be started by clicking on the Edit Labels button on
the right side of the window. Outside of the Calibration Model Wizard it can be started from the Tools
menu.

Nevertheless, in some cases it will be necessary to change a property value during calibration, e.g. because of typing
errors.
A value can be changed by clicking on it with the Left mouse button. In this case, the value becomes editable. After
completion of changes, you need to click somewhere else to apply changes.

Navigation
Just click the Next > button to proceed to the next step.
Clicking the Cancel button will abort creating a new calibration.

Calibration Model Wizard  Step 4  Mathematical preprocessing
Step 4 offers mathematical preprocessing of the calibration data in order to increase the influence of significant spectral
regions in contrast to nonsignificant parts. One or a series of mathematical operations can be applied to improve the
calibration model.

In the upper data view the original spectrum and the selected statistical spectra are shown as described previously. In
the lower part of the data view, the corresponding result spectra are shown after applying the sequence of mathematical
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operations.
The lower part of the dialog on the left shows a list of actual mathematical operations applied to calibration data. On the
lower right parameters of the current selected mathematical operation are displayed.

Adding new mathematical operations
To add a new mathematical operation to the list in the lower left of the dialog, please follow the instruction below:
1. Click the Add button .
The following dialog is opened where a suitable mathematical operation can be selected:

2. From the list, select the operation you like to apply.
3. Click the Apply button to confirm selection or the Close button to discard.

Delete mathematical operation
To remove a mathematical operation from the list in the lower left of the dialog, please follow the instruction below:
1. From the list of mathematical operations in the lower left of the dialog, select the operation you like to remove.
2. Click the Delete button.

Calculate Button
For certain mathematical operations with additional parameters the calculate button will be enabled. If changes are made
to the parameters, the result can be updated by clicking on the Calculate button.

Changing mathematical operation parameters
The parameters of the current selected mathematical operation are displayed in the property grid on the right side of the
dialog. All parameter modifications will be directly applied and visible. For details on those parameters, please refer to the
Mathematical Overview section of the manual.

Changing the order of mathematical operations
The order of applied mathematical operations can be altered as described in the following:
1. Select the mathematical operation you like to move.
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button to move the selected operation upwards in the list.

3. Click the

button to move the selected operation downwards in the list.
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Navigation
Just click the Next > button to proceed to the next step.
Clicking the Cancel button will abort creating a new calibration.

Calibration Model Wizard  Step 5  Range Selection/Data extraction
Step 5 assists the user in selecting a significant spectral range for the calibration. Finding the significant spectral ranges
is the most challenging part of the calibration model setup since the chosen area strongly influences the quality of the
resulting model. The software assists the user in finding the optimal spectral regions to create a good calibration model.
The range selection / data extraction will differ depending on the selected calibration model. Step 5 of the Calibration
Model Wizard will show the appropriate method for chosen calibration model. The options are:
Data extraction for the univariate model
Spectral range selection for PLS models
Spectral range selection for MLR models
The three different options will in explained in detail in the following section.

Data extraction  Univariate Model
The data extraction for the Univariate Model is described in detail in the topic Data extraction  Univariate Calibration.
Please refer to this topic in the chapter Chemometric Analysis.

Spectral range selection for PLS models
Spectral range selection for PLS calibration models does not be as accurate as for MLR the models, because the algorithm
will find the optimal spectral regions by iteration on its own. The user is advised to limit investigations and modelling to
spectral regions of interest in order to avoid misinterpretation. Thus the user starts with a wide spectral range and will
refine selection during subsequent recalculation of the model.
The initial selection is by default the complete spectral range:
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Modifying spectral region
Refinement of the spectral region requires unchecking the "Use Full Spectral Range" checkbox. A spectral range table is
shown with a default range in the center of the applicable spectral range. User defined spectral ranges can be adjusted
easily either graphically by adjusting the range selector with the mouse or by directly entering numerical values in the
table.
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This example uses the automatically proposed ranges.

MLR spectral range selection
MLR is a very sensitive calibration model providing excellent and reliable results if parameters are properly adjusted.
There are several and mostly time consuming automatic algorithms available for this purpose, but the most reliable
results will be obtained by manual selection.
The wizard will assist the user during spectral range selection which is an interactive process strongly related to cross
correlations between highly correlated spectral regions. Initially the software proposes the optimal and highest
correlated spectral range. After fine tuning by the user the next spectral range is proposed. These steps are repeated
until no more cross correlations are detected.
This procedure will prevent the user from over fitting the calibration model or selecting noncorrelated spectral ranges.
Furthermore spectral regions are very narrow and can be precisely defined according to the quality of spectral data.
The corresponding dialog looks like this:
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Contents
In the data view, the average spectrum (red line), the standard deviation shape (light red shape) and the correlation
spectrum (grey line) are displayed as described before. Additionally, the initial spectral range proposed by the software is
shown as vertical light blue rectangle shape (at approx. 1550 wave numbers in the picture above).
In the table below details of the first proposed spectral range are shown.
Fine tuning of spectral ranges
After proposal of a spectral range by the software, the user must tune the precise position of the range to fit the peak
position of interest best. For this purpose, the user should zoom into the region around the selected spectral range:
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The center of the selected spectral region is emphasized by a vertical red line. Start and end markers are indicated by
little blue squares. All items (the spectral range, start marker and end marker) can be moved to desired positions within
the spectrum using drag&drop with the Left mouse button.
Alternatively, the precise values can be directly entered into the particular fields of the spectral range table below the
data view.
Automatic proposal of spectral ranges!
The software always proposes a symmetrical spectral range with an absolute size of five data points.
The user may change the number of data points or select different start and end markers, so that an
asymmetric range is applied. This strongly depends on the peak requirements.
Adding new spectral ranges
After proper adjustment of the first spectral range, further ranges can be added by clicking the New button.
The next spectral range is proposed automatically and the correlation spectrum is updated accordingly. The slope of
correlation spectrum changes, because already selected spectral ranges are no longer considered in calculation. The
actual correlation spectrum will help the user to identify the next significant range and it also helps to prevent selection of
cross correlated regions.
The new proposed range is shown as light blue rectangle, whereby the color of the last one has changed into light green.
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Again, the position and the size of the actual spectral region can be changed by the user.
Changing previously selected spectral ranges!
Previously adjusted ranges affect all subsequent ranges. The software will display a warning if the user
tries to modify the previously selected ranges. An earlier range may be modified if the later ranges are
discarded.
Over fitting warning
The user can add as many new spectral ranges as he likes, but adding too many of them will over fit the model. In this
case cross correlations will reduce the quality of the final result. The user will be warned by the software automatically, if
this limit is reached.

The warning limit depends on the Overfitting Threshold. The parameter can be adjusted in the corresponding box in the
dialog.
After confirming the message by clicking the OK button, the new spectral range is added anyway to give the user the
freedom of choice. It should be deleted again to ensure integrity of the model.
Deleting spectral ranges
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Deletion of spectral ranges is performed as described in the following:
1. Select the desired range either in the data view or in the spectral ranges table.
2. Click on the Deletebutton or press the Delkey on your keyboard to delete it.
Deletion must only be applied to the last / actual range in the list.
Can I remove intermediate spectral ranges?
If any intermediate range is removed from the list, the whole selection process will collapse and any
successors must be removed as well in order to avoid over fitting or misinterpretation.
Resetting spectral ranges
To completely remove all selected spectral ranges and restart the selection process, the user may click the Reset button.
Range selection for manual background noise correction
When using the manual background noise correction the range selection differs slightly from the automatic workflow. If
the Manual Noise Correction checkbox has been activated, the range selection dialog will look like this:

Again, the software will propose a spectral region for the calibration (vertical red line with blue border) and the user may
change the position and extent of this region. Additionally a second region for the background noise correction (vertical
red line with yellow border) will be proposed. The position and extent of this selection may also be edited by the user.
Ideally, the select region should lie in a preferably noncorrelated area with similar background noise as the calibration
region. Regions close to the selected calibration region should be preferred for noise correction.

Navigation
Just click the Next > button to proceed to the next step.
Clicking the Cancel button will abort creating a new calibration.
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Calibration Model Wizard  Step 6  Factor Analysis
The Factor Analysis is part of all calibration models except the MLRModel. When using the MLRModel this step will be
omitted.
The PLS calibration model analyses the data and divides variables into principle components. They are also called factors
forming an ndimensional factor space. The number of factors taken into account for calculation of a calibration model is
very important, because if the user selects too many, he will interpret spectral noise. This reduces the quality of the
calibration model significantly.
Thus factor selection is very important and the predictive residual error sum of squares (PRESS) plot provides a good
overview on how many factors need to be used for calculation. It gives an indication of the model error vs. the number of
factors.
Within the wizard the software proposes a number of analyzed factors. This number can be accepted or may be changed
interactively later by moving the vertical line or increasing / decreasing the values using the spin boxes.

The PRESS plot shows a graph of the PRESS values plotted against the factors and will always look like a decaying curve.
In the figure above, the total number of factors is 10 according to the number of principle components. The PRESS values
indicate a high priority for factors 1 to 3. Factors beyond 3 do not contain any additional information useful for calibration.
The vertical green line indicates the automatically proposed number of factors for which the model reached its minimum.
In the present case, the number of factors at the minimum is three. The user can accept this number or change it now or
later on.

Navigation
Just click the Next > button to proceed to the next step.
Clicking the Cancel button will abort creating a new calibration.
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Calibration Model Wizard  Step 7  Result Display
Finally, the calibration model is calculated according to all parameters adjusted previously and the result are displayed.
The different calibration models all show different results. Please refer to Calibration Results Overview in the chapter
Calibration Results for a detailed description of the result plots.
Customizing the result display and the result plots.
The user may customize the result display window and the individual result plots by using the context menus.
Rightclicking on a result window tab offers the option to add and remove tabs, rightclicking on a result plot
offers additional options to adjust the plot.

An example result display looks like this:

If the calibration model contains multiple constituents the result window will show additional tabs with the property
results. For example:

Calibration Results Overview
The final step of the calibration model wizard displays all calibrations results and detailed information about the
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calibration. Each calibration model shows a certain combination of result windows by default. These result windows are
displayed as tabbed array which allows easy switching between results. Tabs can be added or removed and the user
may add additional analysis options using the Configure button. Some of the result windows offer the option to change
calibration parameters and recalculate the whole calibration by clicking the Recalculate button. This enables the user to
fine tune the calibration. Details of the Calibration Result Display are described in the following section:

Default Univariate Results
Univariate Report
Regression
Predictions
Residual Spectra
Spectra Selection

Default MLR Results
MLR Report
Predictions
Property Residuals
Spectra Selection

Default PLS/PCR Results
PLS Report
Predictions
Property Residuals
Spectral Residuals
Scores
Scores 3D
Loadings
Residual Spectra
Spectra Selection

Configuring the Calibration Results
The calibration result windows may be customized by clicking on the Plot Options button. This will show the configuration
menu for the result window. The menu looks like this:

The configuration can be reset to restore the default values. Plot tabs can be closed or new plots with a multitude of
options can be added. As an example the first submenu options are shown:

Calibration report
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The calibration report contains a summary of the whole calibration settings and results. The report contains the following
results and basic information. When using calibrations with multiple constituents/properties (eg. PLS2 and SIMPLS), some
of these sections will contain additional information and tables for each further property.
1. General Information:
This section lists general information about the calibration. Details about the used project, operator, calibrated
spectra and constituents/properties are shown.
2. Data Pretreatment:
All operations performed on the data before the calibration are listed in the data pretreatment section. This
includes cross validation, data centering and scaling and all mathematical preprocessing options.
3. Model specific section:
This section lists detailed information about the employed calibration model and the results. It includes all the
quantitative information, equations, used ranges and statistical information. The information shown here varies
with the used calibration model and the number of calibrated properties.
4. Qualitative Model Statistics:
This sections shows the qualitative model statistics for each calibrated property. This includes regression
information, slope, variance etc.
The result report is displayed on the final page in the calibration model wizard:

Regression
The Regression plot is only available in the univariate calibration. It simply plots the constituent property value against
the evaluation parameter. This gives the user a quick overview how well the chosen evaluation parameter correlates with
the property value. An optimal correlation would show all data points on a straight diagonal line.
The regression parameters can be adjusted by using the regression settings window on the right side of the tab:

Predictions Plot
The prediction plot shows predicted values derived from the calibration model versus actual values of the data object.
Each data point in the plot represents a calibration data object. In addition to the trend line, the prediction plot will also
show the underlying linear equation of the trend line in the upper left corner. Therefore slope and offset of the trend line
are available at a glance. The corresponding correlation coefficient R2 is also shown.
All data points should be located close to the diagonal line. The closer the they are, the better the predicted value
matches the actual value of a sample.
Additional information on particular samples can be reviewed, if you move the mouse pointer close to data point of
interest. A tool tip help is displayed automatically containing additional information on the sample and the results.

Property Residuals Plot
The residuals plot is the graphical display of the residual concentration values. The plot shows the difference between the
actual concentration values and the predicted values.
This is an example residual plot:
The horizontal line at 0 marks the center of the plot. The closer the data points are to this line, the smaller is the
difference between predicted and actual value.
Actual samples are shown as data points (crosses). Hovering the mouse pointer over a square will show a tooltip with
plot specific sample information.

Spectral Residuals Plot
The spectral residuals plot is the graphical display of the spectral residual values.
This is an example residual plot:
Actual samples are shown with the selected marker shape. Hovering the mouse pointer over a square will show a tooltip
with plot specific information.
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Scores Plot
The scores plot shows the scores of two principle components of a calibration plot against each other. This plot helps to
identify samples with similar spectral properties. Those samples are located in the same region of the plot and they are
close to each other. In some cases a kind of clustering can be observed.
Additionally, this plot shows the overall variation of samples among the two selected principle components. If the samples
are widely spread over the full range of the plot, the variation is big. Relationships between samples can be interpreted
with a high degree of certainty for such principle components.
If all samples stick to a particular position in the plot, the overall variation is quite small. This indicates similarity between
both principle components and the certainty for prediction of a relationship between samples is very low.
A typical 2D factor plot is shown below, the result window shows multiple plots:
The samples are shown as markers. Hovering the mouse pointer in proximity to the marker will show a TooltipHelp with
additional information about the sample.
In case of a PCA calibration the score plot gives a convenient overview of the qualitative results of the calibration. A good
result will show all samples assigned to one of the predefined groups ( see Calibration Model Wizard  Step2 ) and the
groups itself will be clearly separated.
It is also possible to make changes to the group assignments. Select the samples by left clicking while holding the Ctrl
Key. The selected samples will be displayed with a stronger outline. Right clicking in the plot will show the context
menu. Use the commands "Assign to" or "Assign to new group" to change the assignment of the sample. If a change
has been made, the button Recalculate will become active to enable the recalculation of the calibration model.
How do I change the group assignment of samples?
Select samples in the plot by left clicking while holding the CtrlKey.
Open the context menu by right clicking and use the commands "Assign to" or "Assign to new
group" to change the assignment of samples.
Update the calibration model by clicking on the button Recalculate.

Scores 3D Plot
The Scores 3D plot adds a third principle component to a Scores plot and shows relationships between samples and
variation among selected factors.
The principles for variation and similarities between samples described for Scores plots are applicable here as well. The
3D plot can also customized by utilizing the context menu. Simply rightclick on the plot and make the desired
adjustments.
In case of a PCA calibration the score plot gives a convenient overview of the qualitative results of the calibration. A good
result will show all samples assigned to one of the predefined groups ( see Calibration Model Wizard  Step 2 ) and the
groups itself will be clearly separated.
A typical Scores 3plot is shown in the following:
You have the following possibilities to customize the 3DGraph view in order to see all aspects of the 3DFactor Plot:
Rightclick and hold the mouse button to move the whole 3DFactor Plot in the view plane.
Hold down the Shiftbutton and move the mouse to zoom in and out of the 3DFactor Plot. This can also be
achieved by using mouse wheel.
Hold down the Ctrlbutton and move the mouse to rotate the whole 3DFactor Plot.
Perform a doubleclick with the Left mouse button to restore the original scale/zoom/rotation factor.

Loadings plot
The loadings plot shows the contribution of spectral regions to the variation of a factor. Their values range between 1
and 1 and they directly reflect the correlation of a particular spectral region to the factor. The closer a spectral region in
this plot is located at 1 or 1, the more this spectral region is explained by this factor.
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By default the loadings plot is displayed together with the plot configuration window on the right side of the tab. The
configuration window may be used to customize the loadings plot.

Residuals Spectra Plot
The spectral residuals matrix plot shows the spectral residual values for each wavelength of the calibration spectrum.
Large residuals indicate a wavelength that does not contribute very well to the calibration model. Therefore the spectral
residuals matrix plot can aid the user in selecting an optimal spectral range for a given calibration. By starting a
calibration with the full spectral range and subsequently analyzing the matrix plot, one can eliminate less import
wavelength from the calibration.
The dialog initially displays all relevant spectra. The configuration windows on the right side of the tab enables the user
to customize the plot. The following picture shows an example residual spectra plot:

Spectra selection
The spectra selection shows a complete overview of all samples and spectra. Similar to step 4 of the calibration wizard,
the calibration, validation and outlier status of each sample is visible. Additional columns show the label values used in
the calibration and the corresponding predicted and residual results.

Prediction of unkown Samples
In routine analysis samples need to be evaluated using previously designed calibration models. This procedure is called
prediction. The result is either a qualitative information, which identifies a product or compound or quantitative, which
produces a concentration or similar value. The software provides several opportunities to present prediction results as
described in more detail in the following:

Online Prediction
Some applications simply require a quick overview of the prediction results without the need for all the statistical details
of a report. Displaying the predicted value, e.g. the predicted concentration is sufficient in most cases. The auto
evaluation tool of the software provides an online prediction capability, which shows the result for the active data object
on screen immediately.
The name of the calibration and the predicted value is shown in the top left corner of the data view as illustrated in the
screenshot below:

One or more calibrations can be activated for autoprediction at the same time by selecting them in the Quantify Explorer.
Please refer to the function Autopredict data using calibrations in the chapter "Commands" for more details.
If more than one data objects are displayed merged in a single data view, the active object is shown emphasized. The
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results are updated automatically for the current active data object in the data view.

Prediction Result Report
A more comprehensive prediction result is provided in a detailed evaluation report. Herein all statistical results of the
calibration plus the prediction results are listed together with a spectrum screenshot in one report. The report can be
easily printed out from the software using the Print command. Alternatively it can be copied into the clipboard to be
pasted into other office applications. All the details provided in the reports satisfy most requirements to give evidence for
CFR21 part 11 regulated environments. A sample report looks like this:

A report can be easily created for a single or multiple calibrations at once.
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Creating a prediction report for a single calibration
Please refer to the "Evaluate with..." command section.
Creating a prediction report for multiple calibrations
Please refer to the "Evaluate" command section.
Herein all calibrations of all open projects are considered. However, only those calibrations are considered, which
contain suitable evaluations for the actual data object.

External Prediction Tool
The software can be used as an external prediction tool. It can be controlled from the command line. Please refer to the
section "Command Line Control" for details.

Prediction Report
The evaluation report is shown after prediction of a sample from a univariate or multivariate calibration or calibration
method. The report is displayed as tabbed window and holds all prediction results plus detailed information on used
calibrations. It looks like this:
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Report Contents
The evaluation result holds the evaluation results of the univariate or multivariate calibration or method. The calibrated
label/property and predicted values are shown for each spectrum, along with all statistical details of the calibration
model. A screenshot of the actual evaluated spectra is shown on top of the report.
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Sharing the report...
It is possible to copy the report or a particular part of the report into the clipboard by selecting it and
pressing CTRLC keys.

Print Report
The report can be printed easily by clicking the Print command in the file menu.

Save Report
To save the report, choose the Save as... command from the file menu.
Alternatively the report can be added to an existing project using the Add Object to a project command in the Project
menu.

Auto predict data using a calibration
After creating a calibration model for a particular qualitative or quantitative analysis, the derived calibration model can be
automatically applied to samples in routine analysis. Every time a suitable spectrum is opened, a brief result of the
automatic prediction is shown in the upper part of the spectrum view. The autoprediction can be toggled on or off by
checking or unchecking the a calibration in the Quantify Explorer list. Autoprediction is also possible with multiple
calibrations. Simply select the desired calibrations in the quantify list:

Please also review the section Prediction of unknown samples in the chapter Chemometric Analysis for further
information.

Auto predict using the Quantify Explorer
To start or stop autoprediction of a spectrum with an existing qualitative or quantitative calibration, please follow the
instructions below:
1. In the Quantify Explorer, select the calibration for prediction and activate the checkbox.
2. Open the spectrum that needs to be predicted. If the spectrum is compatible with the calibration, the Prediction
Result will be displayed in the spectrum view:

3. As long as the checkbox is activated all spectra that are opened will automatically be predicted.

Auto predict keyboard shortcut
None.
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Auto predict toolbar command
None.

Calibration formula editor
The calibration formula editor allows you to enter an individual formula for calculating a result value for a physical property
from spectral data. All intensity values, peak heights or peak areas might be addressed in a custom formula for
calculation. Furthermore it is possible to use data stored in custom labels attached to data objects in use.
The calibration formula editor looks like this:

Enter any formula using simple arithmetic operations into the text field. If you are not sure about the syntax, please use
the short hand buttons underneath the text field or the context menu available on Right Mouse button click for
assistance.
Context menu
To open the context menu, giving access to all functions listed below, please follow the instructions:
1. Move the mouse pointer to the position in the text field, where you like to insert a parameter, operator,
mathematical function or label.
2. Click the Right Mouse button to open the context menu.
3. From any submenu, select the desired command.

Formula parameters
The following values, variables, mathematical functions and operators are allowed to create a formula:
Values
Positive or negative numeric values
Spectral Macros
Intensity values at a defined position on the xaxis of the current set of calibration spectra. For assistance, please
click the Intensity button.
Peak area of a defined peak position within the current set of calibration spectra. A peak will be defined by a
starting and an ending position on the xaxis. The peak area will be calculated as the area between the baseline of
the peak and the graph of the spectrum. The baseline of the peak is meant to be a straight line between starting
and ending point of the peak. For assistance, please click the Peak Area button.
Peak height of a defined peak position within the current set of calibration spectra. A peak will be defined by a
starting and an ending position on the xaxis. The peak height is determined from the maximum intensity value
within the peak range with respect to the baseline of the peak. The baseline of the peak is meant to be a straight
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line between starting and ending point of the peak. For assistance, please click the Peak Height button.
Absolute peak height. Same as the peak height function but returning the absolute peak height.
Any additional information stored in custom labels of the data object are available on the Label button.
If the user has stored additional information like concentrations, dilution factors, etc. in labels, he can use them in
calculation by selecting the respective label. Click the button to show a list of all available labels.
Mathematical functions
Default mathematical functions from a pocket calculator like sin(x), cos(x), tan(x), sqrt(x), sqr(x), etc. are available in the
context menu of the editor.
Tags
Tags are defined variables for a given spectrum. Available tags are the minimum and maximum data values of the xaxis
and yaxis.
Operators
A list of operators is given as buttons below the formula text field. They are also available in a context menu.
Any basic mathematical operators are allowed to add, subtract, multiply or divide values. For assistance, please
click one of the operator buttons.
Mathematical terms can be put in parentheses to control the order of calculation.
Example:
The ratio between the intensity at a desired xaxis value and the height of the underlying peak in this area must be
evaluated. Spectral data needs to be corrected by a dilution factor, which has been retrieved in previous "wet chemistry"
analysis. The dilution factor was attached to the data objects in a label called "Dilution Factor" and can be used in the
formula now.
Intensity[ 612 ] / Peak Height[ 580; 690 ] * Label[ Dilution Factor ]
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Library and Search Tutorial
This chapter contains following topics:
How to work with libraries
How to search data in a library
Search algorithms

How to work with libraries
Libraries are useful for archiving your analytical data and related information. For a guided tour through available
functions around libraries, please review one of the following topics:
Creating a new library
Opening a library
The library explorer
Adding data into a library
Adding single data objects
Adding or searching single data objects with Drag & Drop
Adding multiple data from files in a directory
Opening and modifying data of a library
Removing data from a library
Removing/Closing a library

Creating a new library
1. From the Library menu, select the New... command.
2. A New Library Settings dialog is displayed:
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3. Fill in the fields of the dialog.
Name
The library name will also be the file name
Comment
You may enter a description for the library optionally. The comment field allows to save some keywords on
the main purpose of the library.
Is ATR
If this flag is set, the spectra in the library are treated as ATR spectra. While searching a spectrum there will
be an automatic ATR correction on searched data in order to improve compatibility between the query
spectrum and library spectra.
Unit X and Unit Y
These units specify the target axis units of spectra inside the library. All spectra inserted into a library will be
automatically converted according to these required unit.
Autodetect
If this flag is checked, the spectral resolution and the spectral range of the first spectrum inserted into the
library will specify the required range and resolution condition for all future spectra to be inserted into the
library. If possible, new spectra will be automatically converted to match the library specifications.
If unchecked, the user may define the conditions described above manually.
Baseline
If checked, all spectra to be inserted into the library are automatically baseline corrected.
Single Byte
This parameter specifies the data precision of the library. Single byte means float precision (= 8 decimal
digits) whereas 2 byte precision means double precision (= 16 decimal digits) of numeric values.
4. Click the New button to create the library.

Opening a library
Before you can work with libraries and access data inside a library, you either need to create one or open an existing
library similar to files and projects. Please follow the steps below to open a library:
1. From the Library menu, select the Open... command or just click the

icon in the toolbar of the library explorer.

2. In the file selection dialog, select a library file with the extension *.library from your preferred hard disc or
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network location.
3. Click the Open button in the file selection dialog to continue.
4. The library is now connected to the software and a corresponding node is available in the library explorer tree.

Other library formats are also supported!
Galactic libraries and Nicolet libraries are also supported. If you need to connect to other libraries,
please contact your software vendor for help.

The library explorer
The library explorer is the most important tool when working with libraries. It always provides a good overview over your
data and connected libraries. From this central tool you can create, open and close libraries, add data, remove data and
search data on libraries.
After a library has been created or opened successfully, a new library node is added to the library explorer:

Initially, a new library is empty. The properties and some statistical information about the library can be reviewed in the
properties tab below the library explorer. Herein all information previously entered during creation of the new library are
visible. Additionally, some statistics about the contents and resolution settings of the library are shown. For each data
type a separate statistic category is available.

Adding data into a library
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For the analyst the default pathway to work with analytical data is to open e.g. a spectrum of interest in a software,
evaluate or manipulate the spectrum and then save it together with the results either back to a file or into a library.
There are several ways to insert data into libraries. You can add single data objects one by one or a batch import can be
performed, where data is located in a particular folder of your file system.
Adding single data objects
Please follow the steps below to insert a data object into a library:
1. Open the data object file, e.g. a spectrum you like to insert into a library.
From the File menu, select the Open command.
Navigate to the file location on your hard disc or network and select the file to be loaded.
Click the Open button.

Project data is also applicable...
If you have a project with your particular collection of analytical data to be stored in a library, you
can open the objects in the main workspace from the project as well by Double clicking with the
Left mouse button onto the desired object.

2. The data object, e.g. a spectrum is now displayed in the main workspace of the software. In the figure below, an IR
spectrum of 4Chloro2Methoxyphenol is shown.
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Properties tab is updated automatically!
You may wonder, why the properties tab on bottom right has changed. It holds the properties of the opened
spectrum now, because the contents of all tabs on the bottom right will always be updated automatically
according to the current active object in the software. In this case you see the details about the active
spectrum in there.

3. From the Library menu, select the Insert 'spectrum name' into Library command or use the keyboard short hand
CTRLSHIFTI.
The spectrum name available in the menu will be updated automatically according to the current active data object.

4. If no destination library has been selected in the library explorer, a library selection dialog is opened.
From the library selection dialog, select the destination library.
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Click the OK button to complete insertion of data.
5. The library explorer tree is updated accordingly. If you expand the nodes below the 'IRLibrary' node, you will see a
new category for IR spectra and below this a new spectrum node for the spectrum which has been inserted.

Adding or searching single data objects with Drag & Drop
Those users, who do not like to work with menus or keyboard short hands, can insert data into a library or search via
Drag & Drop with the mouse.
1. Just open the data object to be inserted or searched as described above.
2. Now move the mouse pointer somewhere close to the spectrum graph.
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3. Hold down the Left mouse button and move the mouse pointer. The

mouse pointer is shown.

4. Move the mouse pointer to the destination library node in the library explorer tree on the right.
5. Release the Left mouse button.
6. A context menu is opened, which offers the following options:

Select the Search command to search the data object on the library.
Select the Insert command to insert the data object into the library.
Select Cancel to discard the operation.

Adding multiple data from files in a directory
Users usually have collected many files with analytical data in one or more folders and subfolders on their hard disc or
network. The more files are available the greater the chaos. In order to circumvent loosing control over your data, you
might archive those files from a folder and subfolders enclosed into a library just by a single command in the software:
1. Create a new library as described above before starting the archiving process (Optional).
2. From the Library menu, select the Import Data from Directory command or use the CTRLSHIFTD short hand.
The following dialog will be opened:

3. Type the complete path into the Source Directory field, where your data files are located or click the
select a path from a dialog.

icon to

4. Type a valid file mask into the file mask field.
You may import files by extension.
In this case type e.g. *.dx to import all JCAMPDX files.
You may import files by name.
In this case type e.g. MyFile*.* to import all files starting with 'MyFile'. One or more asterisk wild cards can be
used in the file mask.
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Can I import various data types at once?
Yes, if the file mask is set to *.*, all files of all known data types will be imported automatically.

5. Toggle the Include Subdirectories flag on or off.
If you also like to include all subfolders located in the source directory for importing data, please check the
checkbox.
6. Select the destination library, where files will be imported.
7. Click the Import button to start the import process.

Duration of import!
The import of files into a library may take minutes or even hours depending on your hardware performance and
the number of files to be applied. While importing you cannot continue working with the software.

8. After completion of the file import, a report is shown with the import results and details about errors. This report
can be saved or copied as text into the clipboard with CTRLC short hand.

9. Click the Close button to finish or the Save Log button to store the report.
10. The contents in the library explorer tree are updated accordingly.
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Opening and modifying data of a library
Analytical data located in a library are treated like data in projects.
To open e.g. a spectrum, simply double click with the left mouse button onto the desired item in the library tree.
The data object will be opened in the main workspace.
Any modification of the data object will be temporarily applied until the user finally saves or discards these modifications.
Example:
If a spectrum is opened from a library and a normalization has been carried out, the spectrum is marked modified. The
user needs to save or close the data window to finally apply these modifications. Only if the user applies the
modification, data will be permanently changed in the library.

Removing data from a library
Data, which is no longer required, e.g. because it is a duplicate of another object or it has been replaced by a more
reliable object, can be easily removed from the library.
1. Expand the libraries tree in the library explorer until you see the node of the item you like to remove.
2. Select the item to be deleted in the tree.
3. Press the DELkey and the object is removed without further confirmation.

Removing/Closing a library
To keep control and an overview over your data you have the opportunity to temporarily remove or close libraries, which
are no longer required at the moment. In this case the library node will be no longer available in the library explorer. But
it does not mean, the library has been physically deleted from your hard disk! You can reopen it any time later on.
1. In the libraries tree of the library explorer, select the library node you like to remove.
2. From the Library menu, select the Close command or click the

icon on top.

How to search data in a library
Once analytical data has been archived in a library, the user needs to search and retrieve data according to different
approaches in order to find and receive information as quickly as possible.
The following information can be retrieved from a library:
Searching spectra
Display of search results and navigation
Selection of one or more results
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Overlaying spectra
Filtering search results
Sorting search results
Searching for Residual spectra (analysis of mixtures)
Searching for text information related to archived data

Searching spectra
In every day work of an analyst analytical data, especially spectra, need to be analyzed and compared to already
evaluated material. In order to assist the analyst in his work and save analysis time or prevent wasting time for duplicate
analyses, powerful search tools are available in the software. They quickly provide results on similar data, which have
been previously evaluated.
Depending on the data type of a spectrum, various search algorithms will be available to provide optimal search results.
To search for similar spectra in a library, please follow the steps below:
1. Open the spectrum you like to search either from a file or project.
2. The spectrum is displayed in the main workspace then.
3. From the Library menu, select the Search Spectrum command.
4. The following dialog is opened for defining search conditions and parameters:

On the Microlab tab setup all search parameters for searching on Agilent libraries:
Setup the search parameters
Derivative Gap
This parameter specifies the number of gap points for derivative calculation. It is only applicable for
Derivative search algorithms
Max. Number of Hits
This parameter specifies the maximum number of hits shown in the hit list
Min. Hit Quality
This parameter specifies the minimum result quality. Results below this quality are automatically
filtered out
Search Algorithm
This parameter specifies the search algorithm to use for spectral data comparison between the query
and the library spectra
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Define excluded search ranges (Optional)
If you need to limit the search to particular spectral regions, you may exclude search ranges by clicking the
New Range button. Searching is applied only to those regions not listed in the excluded range list. Obsolete
exclude regions can be deleted using the Delete button.
Specify Displayed Labels
MicroLab libraries support the Match Name and the CAS number labels for searching. At least one of the
labels must be selected in order to show a result in the hit list.
On the 3rd Party tab, search parameters for searching on external libraries can be adjusted:

Define search ranges (Optional)
If you need to limit the similarity search to particular spectral regions, you may define search ranges by
clicking the New Range button. Searching is applied only to those regions then. (Search regions are
emphasized by a green background in the figure above). Obsolete regions can be deleted using the Delete
button.
Please refer to the Library Search Parameter Dialog section for details.
Normalize Each Search Range (Optional)
This option is only used, if search ranges have been defined. In this case, intensities in each search range
are scaled between 0 and 1 yaxis units before searching.
Setup Minimum Quality
The search result provides a list with hits sorted by matching quality values. Hits with a matching quality
value below the minimum quality will be automatically eliminated from the result. If the number of hits is too
high, please change this value to higher numbers, e.g. 80.
Select the comparing algorithm
Depending on the data type, various comparing algorithms are available. Please select the most reliable
algorithm for your data.
Select on or more libraries for searching by checking the check boxes in the Libraries to search list.
At least one library must be selected.
Select those data labels from the list of displayed labels in the search result table, which might contain
additional information of interest. Contents will be retrieved together with the spectrum. (Optional)
Save the search query (Optional)
After setting up the search query, you have the opportunity to save this query under a particular name for
using it again later on.
Click the Save button to save the search query.
Enter a meaningful name for the search query.
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Your search query is now available in the Predefined Queries folder of the library explorer.
5. Start searching by clicking the Search button.
Searching will take a moment depending on the number of spectra and libraries which have been selected
previously. Meanwhile a progress dialog is shown:

Display of search results and navigation
After performing a library search, either spectrum or text search, results are presented in a search result table as shown
in the following figure:

Search results are sorted automatically!
Search results are sorted automatically by descending order of the match quality. When mixing
MicroLab with 3rd party libraries during searching, the list might not be in proper order because
with some MicroLab algorithms results do have different quality scaling!
Additionally, the search result is stored in the Search Results folder of the library explorer.
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Search results are stored automatically!
Whenever this search result might be of interest later on again, it can be reopened by double
clicking the search result node in the library explorer.

The search result shows the query spectrum on top of the search result. The spectrum of the current activated hit in the
search result table is shown below in order to allow direct visual comparison.
Selection of one or more results
One or more hits in the search result table can be selected to see the corresponding spectra.
1. Selection of a single hit is carried out by clicking the Left mouse button on the desired row in the search result
table.
2. Selection of multiple hits is performed with the SHIFTkey or CTRLkey held down when clicking the Left mouse
button. Selection is identical to file selection in MSWindows explorer.

3. Reset selection by selecting a single hit in the search result table.
Overlaying spectra
If many spectra have been selected in the search result table, the spectrum view on top of the search result is quite
overcrowded. In this case, spectra can be overlaid in just one view similar to the Merge Views function.
1. From the Library menu, select the Overlay Spectra command.
2. The query spectrum (red) and all selected spectra (green, blue) of the search result table will be merged into one
view:
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3. Reset the display by repeating the Overlay Spectra menu command.
Filtering search results
Although the minimum hit quality might have been properly adjusted, the number of hits in the search result table could
be enormous. If you are looking for a particular result, e.g. a name of a compound, you will be able to filter the results as
described in the following:
1. Perform a default library search, either spectrum or text search as described above.
2. The search result table is shown with many hits then.
3. From the Library menu, select the Apply Filter to Search Result command.
4. A dialog is shown, where you can type a particular substring including wild cards, which is used to filter the search
result table. Only those results, which contain the substring will be shown.

Examples:
*benzene: shows all results ending with 'benzene' in any field of the search result table.
*benzene*: shows all results containing 'benzene' anywhere in any field of the search result table.
1Phenyl*: shows all results starting with '1Phenyl' in any field of the search result table.
*: Resets all previous filter settings
Sorting search results
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The search result table can be sorted ascending or descending by column.
Click once on a column header to sort the search result table ascending by this column.
Click another time on a column header to sort the search result table descending by this column.

Searching for Residual spectra (analysis of mixtures)
Analysis of substance mixtures is a difficult task for the analyst or spectroscopist. The software helps him to find suitable
compounds contained in a mixture by spectrum search on custom or commercial libraries. Once the analyst has discovered
and identified one of the substances included by comparing the spectrum of the mixture with spectra found in a library,
further investigation of the "remaining" spectrum might be interesting. Therefore, the software offers the Search residual
spectrum function:
1. Perform a default spectrum search with the mixture spectrum as described above.
2. Select the most suitable compound with high quality, which should be located somewhere on top of the search
result table.

3. From the Library menu, select the Search Residual Spectrum command.
4. A new search Search Residual Spectrum dialog is opened, which shows the original query spectrum, the selected
result spectrum and the residual spectrum.
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The upper data view holds the original query spectrum plus the selected search result spectrum. The lower data
view shows the difference spectrum which is going to be searched. The difference spectrum can be manipulated by
scaling the search result spectrum with the reference factor slider. Alternatively, the reference factor can be
entered into the Reference Factor field manually. The display is updated automatically when parameters are
changed.
A second option allows to eliminate negative values. Here, all negative values occuring after subtraction of the two
spectra will be replaced by zero.
5. Scale the search result spectrum using the Reference Factor Slider.
Alternatively, enter a reference factor into the field manually.
6. Setup the Zero Negative Values flag in order to eliminate negative intensities arising from spectrum subtraction.
Yes
Negative intensities are automatically replaced by 0.
No
Negative intensity values are kept.
7. Click the Search button to repeat searching with the residual spectrum as new query spectrum.
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Residual spectrum search can be performed multiple times!
This procedure can be repeated as many times as required to identify a number of compounds
included into a substance mixture.

Searching for text information related to archived data
In many cases, analysts need to look for additional information on spectroscopic data to find similar measurements and
related data. E.g. if an analyst needs to investigate his recently archived measurements for a particular compound, he will
search for the compound name to get all available information on it. For such purposes, the software offers a full text
search function.
Residual spectrum search can also be used with the results of a text search!
If you want to use a residual spectrum search with the result of a text search, simply activate the
option Show Active Spectrum in Search Result. This will display the currently active spectrum
together with the results of the text search. You may then use the residual search described
above.

1. From the Library menu, select the Search Text command or press CTRLF keys.
2. A text search query dialog is opened:
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3. Type a suitable search string into the Find Text field. Wild cards are allowed.
Examples:
*benzene: shows all results ending with 'benzene' in any field of the search result table.
*benzene*: shows all results containing 'benzene' anywhere in any field of the search result table.
1Phenyl*: shows all results starting with '1Phenyl' in any field of the search result table.
4. Adjust the Searched labels settings (Optional)
Limit searching to a number of predefined labels or just search on all labels (default).
5. Select on or more libraries for searching by checking the check boxes in the Libraries to search list.
At least one library must be selected.
6. Select those data labels from the list of displayed labels in the search result table, which might contain additional
information of interest. Contents will be retrieved together with the spectrum. (Optional)
7. Save the search query (Optional)
After setting up the search query, you have the opportunity to save this query under a particular name for using it
again later on.
Click the Save button to save the search query.
Enter a meaningful name for the search query.
Your search query is now available in the Predefined Queries folder of the library explorer.
8. Start searching by clicking the Search button.
Searching will take a moment depending on the number of data and libraries which have been selected previously.
9. Search results are displayed as described above.

Search algorithms
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Today, the performance of computers is high enough to perform powerful search requests on large libraries for analytical
data in minutes or even seconds. Similar analytical data and related information can be retrieved in a short time. The
following search algorithms for spectrum searches on libraries are available in the software:

Scalar product algorithm
This search algorithm calculates the angle between the query spectrum intensity vector and all library spectrum intensity
vectors using the scalar product of the two intensity vectors. The closer the angle is to zero, the better is the matching of
query and library spectrum. The scalar product is calculated according to the following equation:

Legend
a

angle between query spectrum intensity vector and library spectrum intensity vector

Q

query spectrum intensity vector

L

library spectrum intensity vector

Derivative algorithm
This search algorithm investigates the difference between slopes of a query spectrum and library spectra. This algorithm
is nearly independent of the baseline shape, because only the slopes are considered.
The slope is calculated from the derivatives of two adjacent data points, respectively and summed up to get the total
absolute difference between both spectra. The smaller the absolute difference between the spectrum slopes will be, the
better the correlation.

Legend
D

absolute difference between slopes of query spectrum and library spectra

n

total number of data points to be compared

dQi

slope of query spectrum at ith data point

dLi

slope of library spectrum at ith data point

Squared derivative algorithm
This search algorithm investigates the squared difference between slopes of a query spectrum and library spectra. The
slope is calculated from the derivatives of two adjacent data points, respectively. The differences will be squared and
summed up to get the total squared difference between both spectra. The smaller the squared difference value between
the spectrum slopes will be, the better the accordance.

Legend
D2
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n

total number of data points to be compared

dQi

slope of query spectrum at ith data point

dLi

slope of library spectrum at ith data point

Difference algorithm
This search algorithm investigates the absolute intensities of the query spectrum and library spectra. The differences
between the intensity value of the query spectrum and the library spectra at each data point is determined and summed
up to get the total absolute difference value for a spectrum. The smaller the absolute difference will be, the better is the
accordance between query and library spectrum.

Legend

D

total difference between intensity values of query spectrum and library spectra

n

total number of data points to be compared

Qi

intensity of query spectrum at ith data point

Li

intensity of library spectrum at ith data point

Normalization and baseline correction are mandatory!
This algorithm strongly depends on a good baseline and normalized intensities.
Normalization will be carried out automatically before comparing spectra, but the
baseline should be corrected manually before searching. The baseline correction
function of the software may be used for this purpose.

Squared difference algorithm
This search algorithm investigates the squared intensity differences of the query spectrum and library spectra according
to a least squares fit. Larger differences will be weighted higher than smaller differences by using this algorithm.
The differences between the intensity values of the query spectrum and the library spectra at each data point are
determined and squared. The sum of all squared difference values for a spectrum are calculated. The smaller the square
difference will be, the better is the accordance between query and library spectrum.

Legend

D2

total squared difference between intensity values of query spectrum and library spectra

n

total number of data points to be compared

Qi

intensity of query spectrum at ith data point
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Li

intensity of library spectrum at ith data point

Normalization and baseline correction are mandatory!
This algorithm strongly depends on a good baseline and normalized intensities.
Normalization will be carried out automatically before comparing spectra, but the
baseline should be corrected manually before searching. The baseline correction
function of the software may be used for this purpose.

Correlation coefficient algorithm
This search algorithm facilitates a linear regression of the query spectrum intensities versus the library spectrum
intensities. The correlation coefficient of the resulting linear function is very characteristic through deviations from
linearity. The closer the correlation coefficient is to 1, the better is the accordance of both spectra.

Derivative correlation coefficient algorithm
This search algorithm facilitates a linear regression of the derivative of the query spectrum intensities versus the library
spectrum intensities. The correlation coefficient of the resulting linear function is very characteristic through deviations
from linearity. The closer the correlation coefficient is to 1, the better is the accordance of both spectra.
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Reaction Monitoring Overview
This chapter gives a short introduction to the reaction monitor module. The reaction monitoring module is a powerful tool
to aid the user in performing reaction monitoring, trend analysis and process analysis with spectroscopic data. The main
features of the reaction monitor module are listed below:
Online processing
Monitor live reactions with an attached spectrometer. Multiple reaction phases with different spectrometer settings
may be configured. A file system folder may be monitored as alternative data input option enabling the use of
unsupported spectrometers as spectroscopic data providers.
Offline processing
Perform reaction analysis on spectra that have been recorded earlier. Rerun previously recorded reaction analyses
with different parameters.
Routine mode
Simple user interface to select reaction runs for the everyday routine analysis. The main application interface will be
hidden.
Reaction window
Configurable user interface for reaction monitoring which includes 2Dview, 3Dview, Trend view, Data/Table view
and full access to all relevant parameters. Please refer to the chapter Reaction Window for a detailed description.
Reaction wizard
The reaction wizard guides the user when setting up a new reaction. Simple step by step configuration allows the
quick creation of new reaction templates. Please refer to the chapter Reaction Wizard for a detailed description.

Reaction Monitoring menu
This menu contains all commands for setting up and running the reaction monitoring module. New reaction can be
created, already configured reactions can be started and existing data can be loaded for offline processing. The menu
also contains the commands for configuring and running the Routine Mode.

Reaction monitoring menu commands

All available Reaction Monitoring menu commands are listed below:
New Reaction:
Starts the Reaction Wizard to configure a new reaction.
Run Reaction:
Opens a submenu which shows all configured reactions. The selected reaction will be opened in the reaction
window.
Process Reaction with active Spectra:
Only available if spectral data is loaded in the main application. Opens a submenu which shows all configured
reactions. Runs the selected reaction with the active spectral data from the main application.
Set Directory for Reaction Runs:
Opens a folder selection dialog to choose the main folder for all reaction runs. All reactions will be saved to
substructures in this main folder. The default reaction run folder is \userdata_folder\ Data\Reaction Runs\.
Configure Reactions:
Opens a dialog to choose the reactions that will be available for selection in the Routine Mode start screen and the
Run Reaction/Process Reaction submenus.
Enable Routine Mode:
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Switches the software to routine mode. The main application will be hidden and a simple dialog for selecting
reaction templates will be shown. Please review the chapter Routine Mode for a detailed description.
Load Data for Offline Reprocessing:
Loads data via a time table file. This allows to process data that has no direct time information. Please review the
chapter Offline Processing / Reprocessing for a detailed description.

Reaction Window
This chapter contains following topics:
Operations
3DView
Control Panel
Log View
Overlay View
Parameter Panel
Reaction Window Overview
Report View
Trend Monitor View
Trend View

Operations
This chapter contains following topics:
Add/Remove Comments
Add/Remove Golden Batches
Add/Remove Limits
Add/Remove Phases
Add/Remove Preprocessing
Add/Remove Trends
Configure Reactions
Customizing the Reaction Window
Offline Processing / Reprocessing
Running Reactions
Sample Selection
Saving Reactions

Add/Remove Comments
Comments are designed to add remarks to the reaction run. The comments will be displayed as colored vertical bars in
the trend view, indicating the comment time by the position on the time axis. The actual comment text will be shown as
tool tip if the mouse pointer is hovering close to the comment in the trend view. Comments will also be displayed as a
colored extra row in the report grid. Use the parameter option Show comments in the parameter panel / reaction wizard
(step 5) to turn the comment display on or off. For example:
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Adding Comments
Please perform the following steps to add a comment to a reaction:

1. Click on the Add Comment button

in the control panel

or
rightclick into the trend view and select the command Add Comment from the context menu.
2. The mouse pointer will be constrained to the trend view window to select the time position for the comment. Move
the pointer to the desired position and leftclick to add the comment.
3. Enter the comment text into the comment dialog or select a previously entered comment from the dropdown box:

4. Click on the OKbutton to add the comment.
Remove Comments
Please perform the following steps to remove a comment:
1. Select the comment in the report grid view.

2. The Remove Comment button
comment.

in the control panel will be activated. Click on the button to remove the

3. Confirm the security prompt to finally remove the comment from the reaction.

Add/Remove Golden Batches
Golden batches are the results of reactions with good product characteristics. These are usually used as reference
batches for other runs. In the application context a golden batch is simply the saved trend data of a good reaction run.
Golden batches can be added to another reaction to compare this reaction to the reference run. The following view
shows an example reaction with two added golden batches and a corresponding limit:
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Golden Batch options
The options for the golden batches are found in the Limit Tab of the Parameter Panel. The following options are
available:
Statistical Base Value:
Selects the statistical value to be calculated from the added golden batch data. This value will be used to calculate
limits for the reaction control. The available statistical values are:
 Data Shape: Calculates a "shape" of the golden batch data by simply calculating the minimum and maximum value
per data point.
 Average: Calculates the average of the golden batch data.
 Standard Deviation: Calculates the standard deviation.
 Variance: Calculates the variance of the golden batch data.
Show Average:
If this option is selected the average of the golden batch data will be displayed as plot in the trend view.
Show Data Shape:
If this option is selected the data shape of the golden batch data will be displayed as colored region in the trend
view. In the example above this is the yellow area.
Color:
Selects the color for the display of the golden batch plots and data shape.
Golden Batches:
Lists all golden batches that have been added to the reaction. The data plots of individual golden batches may be
turned of by unchecking the corresponding checkboxes. Disabling a golden batch in this section only affects the
data plot display, the batch will still be used for the calculation of the statistical base value.
Create limits using Golden Batches
Golden batches can easily be used to create limits for a reaction run. This allows to control a reaction on the basis of a
reference run. In addition to the golden batches the user simply needs to add a limit. The limit will provide factors which
will be used to calculate the lower and upper boundary using the statistical base value of the golden batches. Please
perform the following steps to create a limit from golden batches:
1. Add golden batches to the reaction.
2. Choose the Statistical Base Value for the limit calculation.
3. Add a limit to the reaction. In contrast to the regular limits the golden batch limit will show the fields Low Factor
and High Factor as factors. The actual limit will be calculated by the following formulas:
 Data Shape: Low Limit = Data_shape_minimum  Low_Factor, High Limit = Data_shape_maximum +
High_Factor
 Average, Variance, Standard Deviation: Low Limit = StatisticalBaseValue  Low_Factor *
StatisticalBaseValue, High Limit = StatisticalBaseValue + High_Factor * StatisticalBaseValue
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4. Adjust the low and high factor as desired.
5. The limit will be shown in the trend view with the color specified. In the example above the limit is shown as green
area.
Add Golden Batch
To add a golden batch existing trends simply need to be added to the reaction. This can either be done by directly
opening the trend file of the golden batch run or by transferring a current trend to the main application and saving it from
there. Please perform the following steps to add a golden batch to a reaction:
1. Switch to the Limit Tab of the Parameter Panel.

2. Click on the Add Golden Batch button

in the control panel. A file selection dialog will be opened.

3. Select the trend files to be added as golden batches and click the Open button.
4. The selected golden batches are added as data plot and data shape to the trend view.

5. If a limit is need then add a limit via the Add Limit

and adjust the limit factors.

Remove Golden Batch
Please perform the following steps to remove a golden batch from the reaction:
1. Remove a limit via control panel:
1. Switch to the Limit Tab in the Parameter Panel and select the golden batch to remove.

2. The Remove Golden Batch button
remove the limit.

in the control panel will be activated. Click on the button to

3. Confirm the security prompt to finally remove the selected batch.
2. Remove a golden batch via context menu:
1. Rightclick into the trend view and select the command Remove Golden Batch 'Batchname' from the
context menu.
2. The limit will be removed immediately without further prompting.

Add/Remove Limits
Limits are designed to add boundaries to the trend evaluation. If the trend values of the reaction run exceed a certain
threshold which is defined by one or more limits, the corresponding samples can be easily separated from the regular
data. All samples that exceed the limit threshold will be automatically classified as outliers. Outliers are easily
distinguished visually in the trend view and property grid view by different coloring according to the limit settings. The
outlier samples can also be saved separately. It is even possible to trigger external events if a limit is reached. An
example with two limits is shown in the following screenshot:
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Adding Limits
Please perform the following steps to add limits to a reaction:

1. Select the Limit Tab in the Parameter Panel and click on the Add Limit button

in the control panel

or
rightclick into the trend view and select the command New Limit from the context menu.
2. Enter the name for the limit into the dialog box.
3. The mouse pointer will be constrained to the trend view window to select the upper and lower boundary for the
limit. Move the pointer to the desired yposition and leftclick to add the first boundary, repeat to add the second
boundary. The selected boundaries will be displayed immediately as colored horizontal bars. To abort the limit
selection and exit the trend view simply press the ESCbutton.
Remove Limits
Please perform the following steps to remove a limit:
Remove a limit via control panel:
1. Select the limit to delete in the Limit Tab of the Parameter Panel.

2. The Remove Limit button

in the control panel will be activated. Click on the button to remove the limit.

3. Confirm the security prompt to finally remove the selected limit.
Remove a limit via context menu:
1. Rightclick into the trend view and select the command Remove Limit from the context menu.
2. The limit will be removed immediately without further prompting.
Limit Options
The settings for each limit are accessible in the Limit Tab of the Parameter Panel. The following screenshot shows the
limit tab with two example limits:
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The limits are grouped together by their corresponding trends. If multiple trends are defined, there will multiple groups
which contain the trends. The following options are available:
Trend Group:
A group with the trend name that organizes all limits for the trend. Groups can be collapsed for a better overview.
Limit Subgroups:
Subgroups with the limit name that contain all relevant limit settings. Limits can be enabled/disabled by toggling
the checkbox in front of the limit name. One of the limit subgroup fields needs to be selected in order to be able to
delete the limit via the Remove Limit button in the control panel.
Low:
Defines the lower threshold of the limit. The initial value is defined by selecting a value inside the trend view during
the limit creation. This field shows the numerical value of the lower threshold and allows manual editing of the
value.
High:
Defines the higher threshold of the limit. The initial value is defined by selecting a value inside the trend view
during the limit creation. This field shows the numerical value of the higher threshold and allows manual editing of
the value.
Color:
Defines the color of the limit. The limit is displayed in the trend view as vertical bars of this color. Samples that
trigger the limit will be colored with this color in the trend column of the report grid. Disabling the limit will remove
the coloring in the trend view and the report grid. A predefined color may be selected from the dropdown box or
userdefined color may be select using the custom color dialog.
Action:
Defines an external executable file (*.exe, *.cmd, *.bat) which will be executed each time the limit is triggered. If
for example a reaction contains five samples that trigger this limit, the external file will be called five times.

Add/Remove Phases
Phases are the sections of a reaction which allow to divide the run into parts with different parameter settings. Each
phase may have different settings concerning the sample count and sample frequency as well as the instrument settings.
To visualize the different reaction stages, the phase information can be displayed in the trend view as well as the report
grid view. The trend view shows the different phases as colored vertical bars and hovering the mouse pointer close to a
bar will show a tool tip with additional information. The report grid inserts an additional colored row for each phase. The
option Show Phase Information in the parameter panel / reaction wizard (step 5) turns the phase information display on
or off. The following screenshot shows a sample reaction with three phases:
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The phase tab of the parameter panel basically duplicates the phase settings from Step 4 of the Reaction Wizard where
the initial phase configuration is entered. The phase tab stays accessible while a reaction is running. The currently active
phase group will automatically be expanded and is marked by a
edited except for the number of measurements.

icon. The settings of the active phase cannot be

The phase tab with two sample phases looks like this:

Adding Phases
Please perform the following steps to add a phase to a reaction:

1. Make sure that the Phases Tab of the parameter panel is activated and click on the Add Phase button
the control panel.
2. A new phase with the same settings as the current one will be added immediately.
3. Adjust the settings of the new phase.
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Remove Phases
Please perform the following steps to remove a phase from the reaction:
1. Select the phase in the phase tab.

2. The Remove Phase button

in the control panel will be activated. Click on the button to remove the phase.

3. Confirm the security prompt to finally remove the phase from the reaction.
Skip Phases
The Skip Phase option is only available during a running reaction. Please perform the following steps to skip the current
phase of a reaction:
1. Select the phase in the phase tab.

2. The Remove Phase button

in the control panel will be activated. Click on the button to remove the phase.

3. Confirm the security prompt to finally remove the phase from the reaction.
Phase Options
The following settings are available for phases:
Initial Delay:
Defines the initial "zeroth" phase with no measurement activity. Only the length of the initial delay can be entered.
Phase Group:
Groups together all settings for one phase. The group can be collapsed for a better overview. The header shows
the group name and starting time of the phase.
Endless:
Makes the phase an infinite phase. Only the measurement interval must be defined additionally and the phase will
run "infinitely" until the user aborts the reaction. Naturally only the last phase has the endless option.
Comment:
A comment describing the current period may be entered for each reaction phase. If the phase information display
is activated, the comments are shown in the report grid rows of the phase and as tool tip in the trend view.
Duration:
Defines/displays the overall duration of the current reaction phase. This field is linked with the other fields that are
relevant for the measurement duration ( interval, No. of measurements ). Changing the duration will automatically
adjust the interval to a correct value.
Interval:
Defines/displays the time period between two measurements. Changing the interval will automatically adjust the
No. of measurements to match the phase duration.
Number of measurements:
Defines/displays the total number of measurements for this phase. Changing the number of measurements will
automatically adjust the interval to match the phase duration.
Instrument Parameters:
Defines the number of scans and the instrument gain for the current phase.

Add/Remove Preprocessing
The mathematical preprocessing can be used to prepare the measured spectra before these are being used in the trend
evaluation. This may involve spectral optimizations as for example baseline correction or other mathematical operations.
Most of the mathematical operations that are available in the main software can be used as preprocessing in the reaction
monitoring module. Preprocessing operations can only be added to an already configured reaction in the main Reaction
Window. In addition at least one sample spectrum must have been measured or loaded with the reaction in order for the
preprocessing dialog to work properly. The spectral preprocessing dialog looks like this:
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Preprocessing Options
The preprocessing dialog has the following components:
1. Spectrum/Preview display:
The top half of the dialog shows the sample spectra and the preview spectra that have been processed with the
selected operations. Additional statistical display options may be selected for the display by using the Displayed
Spectra button.
2. Mathematical Preprocessing group:
Shows all mathematical operation that have been added to the preprocessing set. Use the buttons Add/Delete to
add/remove an operation (see below). Select an operation and click the Arrow up/Arrow down buttons to change
its position in the set.
3. Operation Parameters group:
Shows all relevant parameters of the selected operation. Select an operation and edit its parameters using the
parameter grid. For a detailed description of all operation parameters please review the chapter Mathematics.
4. Name edit box:
Shows the name of the current preprocessing set. This will identify the set in the preprocessing tab of the
parameter panel.
Preprocessing Tab
Configured preprocessing sets are shown in the preprocessing tab of the parameter panel:
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Preprocessing sets can contain multiple operations and can be activated/deactivated for individual trends. The
preprocessing sets are grouped by their name and list the operations and parameters of the set in the lower part of the
tab. The above example shows one trend that is using the preprocessing set with two operations and another
preprocessing set is defined but not in use. Preprocessing operations may be edited, added or removed using Edit
, Add
and Remove Preprocessing
preprocessing parameter tab is active.

buttons in the control panel. These buttons are only available if the

Add Preprocessing
Please perform the following steps to add a preprocessing operation to a reaction:
1. Load or create a reaction. The reaction needs to contain at least one sample to be able to add a preprocessing
operation.
2. Make sure that the Preprocessing Tab of the parameter panel is activated and click on the Add Preprocessing
button

in the control panel.

3. The spectra preprocessing dialog as shown above will be displayed.
4. Click the Load button to load a previously saved configuration or click the Add button. The following dialog is
opened:

5. Select a mathematical operation and click the Apply button. The operation will be added to the preprocessing list
immediately and an additional preview with the processed spectra is shown in the main dialog.
6. If a sequence of operations is needed then select another operation and click the Apply button, otherwise click
Close to exit the dialog.
7. Adjust the parameters for each operation in the Operation Parameters section.
8. Enter/edit the name for the preprocessing.
9. Click OK to add the preprocessing to the reaction or click Save to save the preprocessing set for later use.
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Remove Preprocessing
Please perform the following steps to remove a preprocessing set from the reaction:
1. Activate the preprocessing tab in the parameter panel. The preprocessing configuration and preprocessing sets are
shown.

2. Select a preprocessing set and click the Remove Preprocessing

button.

3. Confirm the security prompt.
4. The preprocessing set is removed.
Edit Preprocessing
Please perform the following steps to edit a preprocessing set:
1. Activate the preprocessing tab in the parameter panel.

2. Select a preprocessing set and click the Edit Preprocessing

button.

3. Adjust the settings in the preprocessing dialog.
4. Click OK to apply the changes.

Add/Remove Trends
Trends define the data extraction methods for the reaction. The main trend is defined during the initial reaction setup in
the reaction wizard but trends can be still added/removed and edited later on in the reaction window. All trends are
displayed in the Trend View window, please refer to this chapter for detailed description of trend display options.
The trend configuration dialog used for adding and editing of trends looks like this:

Trend Configuration Options
The trend configuration dialog has the following components:
Spectrum View:
If a sample spectrum is available from a loaded or finished reaction it will be displayed in this view to facilitate the
trend configuration.
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Trend:
Lists all data extraction options for defining the trend. Along with the spectral method such as Intensity, Peak
Height, Peak Area etc. all calibrations that are loaded in the Quantify Explorer will be available. If a calibration is
missing, close the configuration dialog by clicking Cancel and switch to the main application to load the calibration.
After reopening the configuration dialog the calibration will be available. Please review the chapter Step 2  Trend
Configuration in the section Reaction Wizard for a more detailed description of the trend options.
Trend Configuration:
Shows the configuration options for the selected trend method. These are the general options such as the display
name and the trend line color, as well specific parameters concerning the data extraction. Numerical values may be
entered directly, or if applicable may be selected graphically in the spectrum view. If a calibration is selected the full
range of statistical values are available for defining the trend. Please review the aforementioned chapter for a
detailed description.
Add a Trend
Please perform the following steps to add a trend to a reaction:
1. Load or create a reaction. Make sure the View Tab in the Parameter Panel is selected.

2. Click on the Add Trend button

in the control panel

or
rightclick into the trend view and select the command New Trend from the context menu.
3. The Trend Configuration dialog will be opened.
4. Select a trend method and adjust the trend configuration options.
5. Click on the OKbutton to add the trend.
6. The trend will be added as additional window in the trend view. To display multiple trends in only one window,
rightclick into the trend view and select the command Show Single View from the context menu.
Remove a Trend
Please perform the following steps to remove a trend from the reaction:
1. Make sure the View Tab in the Parameter Panel is selected and multiple trends are display in separate windows in
the trend view.

2. Select a trend in the Show Trend View subgroup of the view tab and click on the Remove Trend button
the control panel

in

or
rightclick into the trend view window of the trend to remove and select the command Remove 'Trendname' from
the context menu.
3. Confirm the security prompt (only shown if the trend is removed via button).
4. The trend is removed.
Edit a Trend
Please perform the following steps to edit a trend:
1. Rightclick into the trend view window of the trend to edit and select the command Edit 'Trendname' from the
context menu.
2. The Trend Configuration dialog will be opened.
3. Adjust the settings in the trend configuration dialog.
4. Click OK to apply the changes.
Clone a Trend
Adds a new trend to the reaction which is an exact copy of the current trend. This simplifies creating new trends with only
small changes to the existing settings. Please perform the following steps to clone a trend:
1. Rightclick into the trend view window of the trend to edit and select the command Clone 'Trendname' from the
context menu.
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2. The Trend Configuration dialog will be opened with the settings of the current trend.
3. Adjust the settings in the trend configuration dialog choose a name for the cloned trend.
4. Click OK to apply the changes and clone the trend.

Configure Reactions
The configure reactions commands enables the user to select the list of reactions that will be quickly accessible using the
Run Reaction, Process reaction with active spectra or the Routine Mode. The following dialog will be displayed to
configure the reaction list:

Add Reaction
Please perform the following steps to add a reaction to the configured reactions list:
1. Select the command Configure Reactions from the Reaction Monitoring menu. The configure reactions dialog will
be shown.
2. Click on the Add button.
3. Use the file open dialog to select the reaction template (*.reactionConfig file) to be added to the list.
4. Click on the OKbutton to close the dialog.
Remove Reaction
Please perform the following steps to remove a comment:
1. Select the command Configure Reactions from the Reaction Monitoring menu. The configure reactions dialog will
be shown.
2. Select the reaction to be removed and click the Remove button.
3. Click on the OKbutton to close the dialog.

Customizing the Reaction Window
The default reaction window will have a mostly fixed layout as shown in the section Reaction Window Overview.
Individual views may be switch on or off using the view options, but view sizes and positions are generally fixed. To be
able to freely customize the views and the reaction window, View Layout Mode can be activated. The available
customization options are described in the following:
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Resetting the layout...
If something has gone wrong while rearranging the views, the original layout can be restored by clicking
on the command Reset View Layout in the View Tab of the Parameter Panel.

Default Mode
The only available customization in the default mode is the docking of the Parameter Panel and Control Panel by
dragging the corresponding title bar and dropping it on a different side of the reaction window. The parameter panel may
be auto hidden by clicking the
icon in the upper right corner of the title bar. It will the be minimized to a tab on the side
of the main window. Hovering the mouse pointer over this tab will automatically expand the parameter panel again. The
control panel will always be visible but may be docked to a different side of the main window.
Layout Mode
The layout mode is enabled by activating the checkbox Enable View Layout in the View Tab of the Parameter Panel. If
activated this mode allows the free positioning and sizing of all views in the main window. The following options are
available:
Resizing views:
The general MSWindows convention to resize a window applies: Move the mouse to the edge of the view until the
pointer switches to the Resize Cursor. Click and hold the leftmouse button and drag the mouse to resize the
view. Release the mouse button to finish resizing.
Docking views to a different side of the main window:
Click and hold the leftmouse button on the Title Bar of the view to move. Drag the mouse to remove the view
from its current position. Docking symbols will be shown close to all sides of the main window. Drop the view onto
the desired docking symbol and it will be moved to that position.
Docking views to the side of another view:
Click and hold the leftmouse button on the Title Bar of the view to move. Drag the mouse to remove the view
from its current position. Move the view close to another view to dock to. Docking symbols will be shown inside the
view to be docked to. Drop the view onto the desired docking symbol and it will be moved to that position.
Docking views inside another view:
Click and hold the leftmouse button on the Title Bar of the view to move. Drag the mouse to remove the view
from its current position. Move the view close to another view to dock into. Docking symbols will be shown inside
the view to be docked to. Drop the view onto the central tab docking symbol and both views will be merged into a
Tabbed View. To remove a tabbed view simply repeat the moving procedure by clicking on the view tab.

Offline Processing / Reprocessing
The reaction monitoring module allows the reprocessing of spectroscopic data with different reaction templates and also
the offline processing of data from a different sources. There are multiple options to reprocess/offline process data, these
are described in the following:

Reprocessing data from an existing Reaction Run
To reprocess data from an existing reaction run, simply load the reaction data from a project or folder and make the
desired changes to trends, preprocessing, limits etc. The reaction data will be automatically reprocessed immediately and
the results will be show in the reaction window.

Processing new data with an existing Reaction Template
To process a new data set with an existing reaction template the application needs to be able to extract the time
information from the data. This will be done automatically for native data that has been recorded with the application and
for data that has valid file time stamps (file creation/modification date). If no time information is found in the data or
attached to data labels, the application will try to sort the data by using the spectrum names. The time values for each
sample can also be edited manually in the time column of the Report View. Should this not work satisfactorily please use
the Load Data for Offline Reprocessing option with a manually generated Time Table (see below). Please perform the
following steps to process new data:
1. Load the new data in to the main application.
2. Make sure the desired reaction template is present in the Process Reaction with active spectra submenu of the
Reaction Monitoring menu. If the template is not listed, it needs to be added using the Configure Reactions
command.
3. Select the reaction template to use for processing from the Process Reaction with active spectra submenu.
4. The new data will be processed and displayed in the reaction window.
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Offline Processing of new data using a Time Table
If the new/external data is not processed correctly when using the Process Reaction with active spectra command, the
application can be forced to load the data in the correct order by using a manually generated Time Table file. The time
table is a simple text file which lists the file names of the spectra to import along with a TABseparated time value. This
file needs to be generated manually using external applications (e.g. MSExcel or similar, or a Text editor). An example
time table would look like this:
THF_1.spc
THF_2.spc
THF_3.spc
THF_4.spc
THF_5.spc
THF_6.spc

90
102
120
150
186
210

The file names are followed by a numerical time value using the TABcharacter as delimiter (not shown above). To
process data using a time table file please performs the following steps:
1. Create a Time Table text file from your data using a spreadsheet application or a text editor. The file needs to
have the *.txt extension!
2. Place the time table file in the same folder as the data to import.
3. Select the command Load Data for Offline Reprocessing from the Reaction Monitoring menu. A file selection
dialog will be shown.
4. Navigate to your data folder and select the Time Table text file and click the Openbutton.
5. The data will be loaded with the correct time information.
6. Select the command Process Reaction with active spectra and choose the reaction template to process the data
with.
7. The new data will be processed and displayed in the reaction window.

Running Reactions
After completing the Reaction Wizard or loading a preconfigured reaction template the Reaction Window is shown. The
user may start the reaction or continue to adjust the view and reaction settings using the Parameter Panel. There are no
special prerequisites for running reactions but please take into account the system requirements and consideration for
reactions with a high sample count and/or high resolution samples:
Maximize the available memory and reduce the Reaction Window display options to achieve the
maximum possible sample count for long running/high resolution reactions.

System requirements and considerations for high sample count / high resolution reactions
The amount of possible measurements in a reaction is correlated to the amount of available system memory. To maximize
the number of possible measurements consider the following guidelines:
Close all unneeded additional applications that are running on the system to maximize the available memory.
Turn off unneeded views in the reaction window. Disable the Every Nth Sample option: The preparation of the
measured sample data for the visual representation in the Reaction Window consumes a large part of additional
memory. Turning off or increasing the Every Nth Sample option will drastically increase the number of maximum
possible sample measurements.
Use the Save to Folder option to guarantee data safety when running long reactions. Using this will ensure that
every measured sample is directly written to disc and you will still have access to the measured data, even if the
system should run out of memory or should encounter other difficulties. Saving data to projects is perfectly save for
the most situations, but saving large projects when the system runs low on resources may be problematic.
To give an idea of the maximum number of possible measurements when saving a reaction to a project, endless
reaction have been run with the current software build using the full available resolution (1) and range (016000cm1).
This equals a sample size of approximately 16kB.
Windows XP, 2GB RAM, default RX settings (Save to project, Every 2nd sample, 3Dview enabled, Overlay view
enabled): 1500 max. possible samples.
Windows XP, 2GB RAM, minimal RX settings (Save to project, Every nth sample off, 3Dview off, Overlay view
off): 7000 max. possible samples.
These are approximate numbers for your orientation. Changing the sample parameters or system settings will yield
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different results, but the parameter scaling should be approximately linear (e.g. only using a resolution of 2 should double
the sample count; doubling the system memory (if the operating system supports it) should also double the sample
count.
These guidelines mainly apply when auto saving long running/high resolution reactions to a project.
When using the Save to Folder option as suggested above, the maximum possible sample counts are
significantly higher.

Running Reactions

To run the reaction simply click on the Start Reaction button
in the control panel. Depending on the configuration
the user will be prompted for the reference measurements or the reaction will start directly. Most of the Reaction Window
options will still be available while a reaction is running. Display options may be adjusted, Phases, Limits, Golden Batches,
Preprocessing settings and Comments can be added or modified. The reaction may also be paused temporarily  see
below.

Pausing Reactions / Pausing Measurements

To pause a reaction simply click on the Pause Measurements button
in the control panel. Pausing a reaction will
not actually suspend the complete reaction but will only pause the following measurements. For this purpose a Pause
Phase will be inserted into the current phase. Consequently the current phase will be split into three phases: A phase
with the already measured samples, a now active pause phase with zero measurements and a duration that equals the
actual paused time and a new phase with the still remaining measurements of the original phase. All following phases will
be shifted accordingly.
Since the pause only suspends the actual measurements, a pause phase will only be inserted if a measurement is
encountered during an engaged pause. For example: If pause/resume is engaged inbetween two measurements of a
phase with long intervals, this will have no effect on the phase configuration as long the engaged pause does not reach
the next measurement.
The regular reaction workflow is resumed by clicking on the Resume Measurements button.

Stopping Reactions

To stop a reaction simply click on the Stop Reaction button
in the control panel. The reaction will stopped at its
current state and saved if the automatic saving option is enabled.

Sample Selection
By selecting samples in the reaction window it is possible to mark certain spectra of the reaction run. Selecting a sample
will have the following effects:
The checkbox in the row of the chosen sample in the Report View will be checked.
The data point marker of the chosen sample in the Trend View will be shown.
The corresponding sample spectrum will be added to the Overlay View.
There are different options to select samples in the reaction window:
Selecting samples using the Report View
To select samples via the Report View simply check the corresponding boxes in the sample row of the report table. To
completely select/deselect all samples use the master checkbox in the header of the first column.
Selecting samples using the Trend View
To select samples via the Trend View please perform the following actions:
Selecting consecutive samples:
To a select group of consecutive samples press and hold the Shiftkey and drag the mouse while leftclicking. If
another group of samples is already selected when performing this action, this group will be deselected.
Selecting nonconsecutive samples:
To select multiple nonconsecutive samples/groups of samples press and hold the Ctrlkey and drag the mouse
while leftclicking. If another group of samples is already selected when performing this action, this group will be
stay selected.
Deselecting all samples:
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To deselect all samples in trend view hold the Shiftkey and drag the mouse while leftclicking and selecting an
empty area. Alternatively rightclick in the view and select the command Clear Shown Samples.
Selecting samples using the View Tab of the Parameter Panel
To select samples using the View Tab of the Parameter Panel please use any of the following options:
Selecting every Nth sample:
To select a group of samples with constant spacing simply enter the desired number into the Every Nth Sample
box of the Sample Display Options group.
Selecting the first sample:
To simply select the first sample of a reaction run, activate the Show First Sample checkbox in the Show Overlay
View group.
Selecting all outlier samples:
To automatically select all samples that have exceeded a limit and are therefore marked as outliers, simply activate
the Show Outlier Samples checkbox in the Show Overlay View group. Deactivating this option will deselect the
outliers again.

Saving Reactions
In addition to predefining the auto save options in Step 3 of the Reaction Wizard the user may save reactions directly
from the reaction window. If the reaction configuration does not contain any auto save settings the user will be prompted
to save the reaction data/configuration if changes have been made. The following options are available for saving
reactions:
Why are the save buttons inactive?
The save buttons are only active if any changes have been made to an existing configuration/data set. If a
reaction has been loaded from a file or project the save buttons will be initially deactivated.

Saving the reaction configuration:
Clicking on the save configuration button will save only the reaction template as *.reactionConfig file. The user will
be prompted by a file selection dialog to select file name and location.

Saving the reaction to a project file:
Clicking on the save reaction to project button will save the reaction data to a project file. Depending on the
current status of the reaction different saving options will be available:
 Unsaved reactions will be saved to a new project file.
 If the reaction has been loaded from a project and only the reaction configuration has been changed, then the
user will prompted to save the modified files to the same project. Files will be added to the existing project file.
 If the reaction has been loaded from a project and the reaction data has changed, then the user will be prompted
to save the reaction to a new project file.

Saving the reaction to a folder:
Clicking on the save reaction to folder button will save the complete reaction data to a folder on the file system.
The user will be prompted by a folder selection dialog. Please review the section Step 3 of the Reaction Wizard to
learn more about the folder saving structure.

3DView
The 3DView shows a threedimensional representation of the sample spectra acquired during the reaction run. It can be
activated or deactivated in Step 5 of the Reaction Wizard or using the View tab in the Parameter Panel. The 3Dview is
directly correlated with the trend view and will show all samples that are displayed in the trend view. Moving the time
axis of the trend view by left clicking and dragging the mouse will simultaneously move the time axis of the 3Dview.
The view is closely related to the general 3D data view of the application and has most of the same options. Please refer
to the sections 3D Data View, 3D Top View and 3D Waterfall View in the chapter Data Views for a detailed description.
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A sample 3DView looks like this:

Control Panel
The control panel holds the main control buttons for the reaction run. All main actions concerning the reaction run can be
controlled here. Not all buttons may be available at all times, dependent on the objects that are currently selected in
reaction window. Hovering the cursor over a button will a show tool tip with a short description of its function. The
following buttons/actions are available:

Start Reaction: Start the reaction monitoring run. This button may be disabled if the reaction is configured
Reference button to measure a reference.

Stop Reaction: Stops the current reaction monitoring run.

Pause Reaction: Pauses the current reaction. A pause phase will be inserted. Please review the chapter

Resume Reaction: Resumes a paused reaction. Please review the chapter Running Reactions.

Measure Reference: Manually starts the reference measurement. The user will be prompted to prepare
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Print Reaction Results: Print the results of the reaction monitoring run.

Save Reaction Configuration: Only save the reaction configuration to the file system. Please review

Save Reaction to Folder: Save the data and results of the reaction monitoring run to folder on the file

Save Reaction to Project: Save the data and results of the reaction monitoring run to a project file. Please review th

Show Application: Makes the main application visible / gives focus to the main application.

Add Comment: Adds a comment to the reaction run.

Remove Comment: Removes a previously added comment. Only available if a comment is selected in the

Add Limit: Adds a limit to the trend. Only available if the limit tab is active. Please review the chapter

Remove Limit: Removes a limit. Only available if an active limit is selected in the limit tab.

Add Golden Batch: Adds a golden batch. Only available if the limit tab is active. Please review the chapter

Remove Golden Batch: Removes a golden batch. Only available if a batch is selected in the limit tab.

Add Trend: Add a new trend to the reaction. Only available if the view tab is active. Please review the chapter

Remove Trend: Remove the selected trend from the reaction. Select an active trend to activate this button.
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Add Phase: Adds a new phase to the reaction. Only available if the phases tab is selected. Please review the chapter

Remove Phase: Removes a phase from the reaction. Select a phase in the phases tab to activate this button.

Skip Phase: Skips the current phase. The current phase is terminated and the reaction resumes with the following ph

Add Preprocessing: Adds a preprocessing operation to the reaction. Only available if the preprocessing
PreProcessing.

Remove Preprocessing: Remove a preprocessing operation to the reaction. Select a preprocessing operation

Edit Preprocessing: Edits the selected preprocessing operation.

Log View
The log view is basically an activity log of the running reaction. It lists all events that occur during a reaction run. The log
view window looks like this:

The log view can be activated or deactivated in Step 5 of the Reaction Wizard or using the View tab in the Parameter
Panel.

Overlay View
The overlay view shows a simple twodimensional overlay of the sample spectra that are acquired during the reaction
run. It can be activated or deactivated in Step 5 of the Reaction Wizard or using the View tab in the Parameter Panel. The
overlay view responds to the Runtime View Configuration settings from the wizard/parameter panel. Dependent on these
settings the view may only show selected samples during the reaction run. The samples to be displayed can also directly
be selected in the Report Grid View.
Three configuration options are selectable in the wizard/parameter panel:
Show first sample:
If activated always shows the first sample along with the other spectra.
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Show outlier samples:
Two operational modes are possible: If the reaction run is stopped, selecting this will show all outlier spectra
overlayed in the view. This will also automatically select all outlier spectra in the Report Grid. If the reaction is
running, this will show all outlier spectra that have been measured up to the current time but will also show the
current spectra according to the Runtime View configuration. If a new outlier is measured this will be added to
view.
Show sample shape:
Shows a colored data shape that represents all measured samples.
The view also has a context menu which is accessible via the Right Mouse button. It offers the following commands:
Show Legend:
Offers different settings for the legend display. Never completely disables the legend display. Always permanently
enables the legend.
Show data in MicroLab Expert :
Transfers all spectra that are shown in the view to the main application.
A sample overlay view looks like this:

Parameter Panel
The parameter panel holds all configurable options for the reaction run. The basic parameters for the reaction will be set
using the Reaction Wizard but all parameters can be edited in the panel later on to optimize the reaction. The panel can
be detached from the Reaction Window to make more room for the data displays. The detached parameter panel looks
like this:

EN

Reaction Monitoring . 353

The panel contains different tabs which provide settings for the view, the reaction phases, the instrument and saving
parameters, the reaction limits and the preprocessing. Apart from the limits and preprocessing, all other tabs basically
duplicate the configuration settings from the Reaction Wizard.
View Parameters
The view parameters show all settings relevant to the overall visual configuration of the Reaction Window. These settings
will initially be defined in Step 5 of the Reaction Wizard. Please refer to that chapter for a detailed description of the
parameters. To customize the reaction window by rearranging the separate view window position check the option
Enable View Layout. Please review the chapter Customizing the Reaction Window for a detailed description.
Phase Parameters
The phase parameters show all settings concerning the reaction phases. These settings will initially be defined in Step 4
of the Reaction Wizard and can be edited here. Please refer to Reaction Wizard chapter or the section Add/Remove
Phases for a detailed description of the parameters. Additional phases may be added or removed by using the Add Phase
and Remove Phase
tab is active.

buttons from the Control Panel. The buttons are only available if the phase parameter

General Parameters
The general parameters contain settings that concern the instrument, general naming and the saving options similar to
Step 3 of the Reaction Wizard. Please refer to that chapter for a detailed description of the parameters.
Limit Parameters
Limits that have been added to the reaction will be shown in this parameter section. The limit settings may be edited and
new limits can be added or removed using Add Limit
and Remove Limit
button. These buttons are only
available if the limit parameter tab is active. Please refer to section Add/Remove Limits for detailed description of limits.
Preprocessing Parameters
The preprocessing parameters show all settings relevant to preprocessing operations that have been added to the
reaction. Preprocessing operations may be edited, added or removed using Edit

, Add

and Remove

Preprocessing
buttons. These buttons are only available if the limit parameter tab is active. Please refer to section
Add/Remove PreProcessing for detailed description of preprocessing operations.
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Reaction Window Overview
The reaction window is the main user interface for the actual reaction monitoring run. The reaction windows is opened by
selecting a reaction in the menu entries Run Reaction or Process Reaction with active Spectra. The reaction window
looks like this:

Reaction Window Contents
1. Trend View
The trend view shows a plot of the data that is being extracted from the spectra during the reaction run. Options for the
trend view may be adjusted via the context menu by clicking the Right Mouse button or by the parameter panel (5) on
the right side. A detailed description of the display and configuration options can be found in the section Trend View.
2. Report View
The report view shows the numerical data of the reaction run in form of a data table. The table will also show information
about the current reaction phase and the limits and batches that have been added. It also enables the user to select a
certain range or group of samples to be displayed in the other views. Additional data columns and other options for the
grid view may be adjusted using the parameter panel (5). A detailed description of the display and configuration options
can be found in the section Report View.
3. Overlay View
The overlay view shows a simple twodimensional overlay of the sample spectra that are acquired during the reaction
run. Either all spectra may be shown or only certain samples may be selected in the report grid view (2). Spectra can be
transferred directly to the main application by using the Right Mouse button context menu. Options for the overlay view
may be adjusted in the parameter pane (5). A detailed description of the display and configuration options can be found
in the section OverlayView.
4. 3DView
The 3DView shows a threedimensional representation of the sample spectra that are acquired during the reaction run.
A detailed description of the display and configuration options can be found in the section 3DView.
5. Parameter Panel
The parameter panel shows a tabbed overview of all parameters. In addition to the view options information about the
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phases, instrument parameters, limits and preprocessing is shown and may also be edited. The parameter panel can be
undocked from the reaction window. A detailed description of the parameter panel can be found in the section Parameter
Panel.
6. Control Panel
The control panel shows the main control buttons for the reaction window. These include general controls (print, exit,
save etc.) as well as special controls (add limit, add preprocessing, add golden batch etc.) depending on the tab that is
selected in the parameter pane. A detailed description of the parameter pane can be found in the section Control Panel.
7. Trend Monitor View
If activated this large numerical representation of the trend evaluation will be shown. Useful for monitoring the trend
values from a greater distance to the computer display. A detailed description of the monitor view can be found in the
section Trend Monitor View.
8. Reaction Log
If activated an event list for the current reaction will be shown.
9. Status Bar
The status bar at the bottom of the reaction view shows real time information about the reaction run and the current
status. This includes current measurement information and information about the current phases, the elapsed and
remaining time and the already measured and remaining samples.

Report View
The report view is used to display the numerical data of the reaction run in form of a data table. This gives the user a
chronological overview of the reaction as well as additional information about the limits, batches and comments that have
been added. It also enables the user to select a certain range or group of samples to be displayed in the other views.
Additional data columns and other options for the view may be adjusted using the Parameter Panel. The view is enabled
by default but can be deactivated by unchecking the Show Report View checkbox in the parameter panel. The report
view looks like this:

Report Columns
The report view displays the reaction data in tabular form. The following default columns will always be shown:
Selection column:
Each sample of the reaction may be selected or deselected individually. The selection of a sample will affect the
display of a data point marker in the Trend View and the display of the sample spectrum in the Overlay View. For
example: Selecting all samples will display all data point markers in the trend view and all sample spectra in the
overlay view. The initial sample selection will be done automatically according to the Every Nth sample setting in
the parameter panel / reaction wizard (step 5). The user may select/deselect samples during or after the reaction
run using the individual checkboxes. A global selection checkbox is located in the table header which allows the
selection/deselection of all samples at once. A complete description of all sample selection options is given in the
section Sample Selection in the chapter Operations.
Sample column:
Displays the consecutive number of the samples.
Time column:
Displays the reaction time at which the sample was measured. The unit for the time column is defined by the Trend
Unit parameter in the parameter panel / reaction wizard (step 5).
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Trend column:
Displays the numerical value of the trend evaluation for each sample. The formatting of the numerical value is
selected by the parameter Number of Displayed Decimals in the parameter panel. The trend column will have the
same name as the trend. A separate column for each defined trend will be displayed. If a limit or golden batch has
been added to the reaction, the trend column will also be colored according to the sample status (regular sample
or outlier). This allows for a quick visual distinction of different samples. The display color is defined in the Limits
tab of the parameter panel.
In addition to the default columns the user may select more columns to add extra sample information:
Measurement date column:
Displays the full measurement date for each sample.
Sample name columns:
Displays the full sample name for each measurement. The sample name is linked to the reaction name and can be
edited in the General Parameter tab of the parameter panel.
Report Rows
Apart from the reaction data display that is defined by the Report View Columns, additional information can be displayed
by inserting special rows into the table:
Phase information rows:
If the option Show Phase Information is checked in parameter panel / reaction wizard (step 5), an extra row with
a different color will be inserted for every new phase that is entered during the reaction run. This helps to visually
represent the segmentation of the reaction data into phases.
Show comments rows:
If the option Show comments is checked in parameter panel / reaction wizard (step 5), an extra row with a
different color will be inserted for every new comment that is added to the reaction. The comment will also be
shown as vertical bar in the trend view. A detailed description of how to add comments to a reaction is given in the
chapter Add/Remove Comments.

Trend Monitor View
The trend monitor view adds a large numerical representation of the trend evaluation to the reaction window. In addition
other numerical values can be added to the view. The view can be useful if the trend values need to be monitored from a
greater distance to the computer display. A typical trend value view with all options enabled is shown in the following
picture:

Trend Monitor View options
The trend monitor view can activated/deactivated by the checkbox Show Trend Monitor View in the View Tab of the
Parameter Panel. Additional parameters can be added by activating the corresponding controls in the trend monitor view
group of the view tab. The default view will only show the trend name, the trend value and the trend status.
Trend:
Shows the name of the trend. Multiple trends will be displayed in separate rows.
Value:
Shows the current trend value. If the value is exceeding a limit the display will be colored accordingly. The
displayed decimals are configured by the parameter Number of Decimals in the view tab.
Status:
Shows the movement of the trend. If the current values is rising an uparrow will be shown, if the value declines a
downarrow is displayed.
Min:
Activated by the Show Overall Minimum Value option in the view tab. Displays the global minimum of all trend
values.
Max:
Activated by the Show Overall Maximum Value option in the view tab. Displays the global maximum of all trend
values.
Avg:
Activated by the Show Overall Average Value option in the view tab. Displays the average of all trend values.
Out:
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Activated by the Show Outlier Count option in the view tab. Displays the number of outliers in the reaction run.
In:
Activated by the Show Inlier Count option in the view tab. Displays the number of regular samples in the reaction
run.

Trend View
The trend view is the main view of the reaction window. It shows a plot of the actual data that is being extracted from
the spectra during the reaction run by means of the defined trends. In addition to the trend plot the view shows
information about the reaction phases, the limits, the golden batches and the comments that have been added. A sample
trend view with three reaction phases, one limit and one comment looks like this:

Trend View Data Display
Trend Data
The trend data is plotted in real time in the trend view. The display options for the trend plot are defined in the parameter
panel / reaction wizard (step 2). By default the view will be autoscaled to completely display all data but a user defined
display region for the yaxis may also be entered. Trends can be edited using the View Tab in the parameter panel and
the Add Limit/Remove Trend buttons in the control panel as well as the trend view context menu (see below). A
detailed description for working with trends can be found in the section Add/Remove Trends in the chapter Operations.
In addition to trend curve, data point markers will be plotted according to the Every Nth sample setting in the parameter
panel / reaction wizard (step 5). The data point markers are also correlated to the sample selection in the Report Grid
and samples can be directly selected in the trend view. Please refer to the section Sample Selection in the chapter
Operations for a detailed description.
Multiple trends will be displayed in a split window configuration by default but can be merged into a single view by using
the Show Single View/Show Multi View command in the context menu.
Phase Information
If the option Show Phase Information is activated in the parameter panel / reaction wizard (step 5) a blue vertical bar
for every phase transition of the reaction will be displayed in the trend view. This gives a quick overview of all phases of
the reaction run. The above sample reaction for example has three phases. The phases itself can be edited using the
Phases Tab in the parameter panel and the Add Phase/Remove Phase buttons in the control panel. Please review the
section Add/Remove Phases in the chapter Operations for a detailed description.
Limit Information
Limits are displayed as colored horizontal regions in the trend view. The above sample reaction has one limit with an
upper/lower threshold of 0.70/0.88 shown as yellow areas. Limits can be edited using the Limits Tab in the parameter
panel and the Add Limit/Remove Limit buttons in the control panel as well as the trend view context menu (see below).
A detailed description for working with limits can be found in the section Add/Remove Limits in the chapter Operations.

EN

358 . Reaction Monitoring

Golden Batch Information
Golden batches are displayed as separate trend lines with the color that is defined in the Golden Batch group of the
Limit Tab. In addition the display of the golden batch average and golden batch data shape can be selected. The
addition of a limit to a golden batch allows the control of the reaction with the golden batch data. Please review the
chapter Add/Remove Golden Batches for a detailed description.

Trend View Context Menu
The trend view context menu is available by rightclicking into the trend view and looks like this:

The following options are available:
Display Options
Show Legend:
Offers different settings for the legend display. Never completely disables the legend display. Always permanently
enables the legend.
Show data in MicroLab Expert :
Transfers the trend plots that are displayed in the trend view to the main application. This allows the trend data to
be edited/saved separately. All current trend data will be added to a new data view in the main application.
Show Single View/Show Multiple View:
Toggles the trend view between single window and multiple window mode if several trends are defined.
Add Comment:
Adds a comment to the reaction. The position of the comment on the reaction time line needs to be selected per
leftclick in the trend view and the user will be prompted for a name. The comment will be added as colored
vertical bar in the trend view and as extra row in the report grid. A detailed description for working with limits can
be found in the section Add/Remove Comments in the chapter Operations.
Trend Options
New Trend:
Adds a new trend to the reaction. Selecting this command will open the Trend Configuration Dialog. The new trend
will be opened in an additional window in the trend view. To show multiple trends in a single window, the command
Show Single View needs to be selected. For a detailed description of adding/editing trends please review the
sections Add/Remove Trends and Trend Configuration (reaction wizard  step 2).
Edit Trend:
Opens the Trend Configuration Dialog to allow editing of the current trend settings. Please review the
aforementioned sections for description of trend editing.
Clone Trend:
Adds a new trend to the reaction which is an exact copy of the current trend. This simplifies creating new trends
with only small changes to the existing one. The Trend Configuration Dialog will be opened directly with the
settings of the current trend.
Limit / Golden Batch Options
New Limit:
Adds a new limit to the reaction trend. The user will be prompted for a name and needs to select the upper and
lower boundary of the limit in the trend plot. A detailed description for working with limits can be found in the
section Add/Remove Limits in the chapter Operations.
Remove Limit:
Removes the selected limit from the reaction.
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Remove Golden Batch:
Removes the selected golden batch from the reaction. A detailed description for working with golden batches can
be found in the section Add/Remove Golden Batches in the chapter Operations.

Reaction Wizard
The reaction wizard is used for setting up a new reaction. The wizard guides the user in adjusting all the necessary
reaction parameters in an easy step by step procedure. All parameters entered with the wizard can still be edited later
on in the reaction window. The wizard is started by selecting the command New Reaction in the Reaction Monitoring
menu.

Prerequisites to a Reaction
Setting up a new reaction does not require special prerequisites. The reaction wizard may be started with or without a
loaded spectrum. Starting the wizard with a loaded sample spectrum might simplify the trend setup in step 2 of the
wizard, since the spectrum can be used to visually select the data extraction points for the reaction.
Long reaction runs with a large number of measured samples and reaction runs with high resolution spectra are limited
by the amount of available system memory. Please review the current system requirements in the chapter Running
Reactions.

Reaction Wizard Steps
1. General information on the reaction.
2. Trend configuration.
3. Measurement parameter setup.
4. Reaction phase setup
5. Reaction view configuration.

Reaction Wizard  Step 1  General Information
Step 1 offers the general information setup of the new reaction. Here the name and a meaningful description of the
reaction should be entered. Ideally the name should briefly describe the reaction. The reaction will be referred to by this
name throughout the software. Additionally more detailed information can be entered into the description field.
Step 1 shows the following dialog:
Reaction Name
Enter a unique name for the calibration here. A meaningful name helps to distinguish different reaction at a glance.
Description
The description text field may optionally contain additional reaction information and other details concerning the sample
preparation, preprocessing or trend selection.
Navigation
Just click the Next > button to proceed to the next step.
Clicking the Cancel button will abort the wizard.

Reaction Wizard  Step 2  Trend Configuration
Step 2 allows the user to setup the trend to monitor during the reaction run. All data extraction methods available in the
software may be selected to create a new trend. If a spectrum is opened in the software when starting the reaction
wizard, this spectrum will be displayed in the trend configuration to facilitate the selection of a suitable data extraction
point.
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Using calibrations to create a trend...
Existing calibrations may also be used to create trends for a reaction run. In order to be able to use
calibrations as trend, the calibration must be loaded in the main application before calling the Reaction
Wizard or the Trend Configuration dialog. The calibration may either be loaded as part of a project or
directly as calibration model. All calibration models that are available in the Quantify Explorer will be
available in the trend configuration. For general informations concerning calibration please review the
chapter Chemometric Analysis.

Step 2 shows the following dialog:
Trend Parameters
Trend
One of the data extraction methods must be selected to provide the trend data for the reaction run. The following
methods may be selected:
Intensity:
Extracts the intensity values at the defined wavelength position.
Intensity Ratio:
Calculates the ratio of two extracted intensity values.
Peak Height:
Extracts the peak height at the selected position.
Absolute Peak Height:
Extracts the absolute peak height at the selected position.
Peak Area:
Extracts the peak area at the selected position.
Absolute Peak Area:
Extracts the absolute peak are at the selected position.
Peak ratio:
Calculates the ratio of two peak areas.
Formula:
Calculates the trend value by applying a user defined formula. The formula may be entered by using the Formula
Editor.
Calibration:
All calibrations that are loaded in the Quantify Explorer will be listed as methods to create a trend.
The available data extraction methods generally correspond to the methods used in the calibration module of the
software. Please review the section Data extraction  Univariate Calibration in the chapter Chemometric Analysis for a
detailed description of all methods. The formula editor may be used to perform more sophisticated calculations to extract
a trend. Please refer to the section Calibration Formula Editor also in the chapter Chemometric Analysis for a detailed
description of the editor.
Trend Configuration
The general trend configuration defines the name of the trend as well as the color of the trend line. These are relevant
for trend display in the reaction view.
In addition the Evaluation Parameters for the selected extraction method can be defined in this section:
Intensity & Intensity Ratio:
The position for the intensity extraction may be entered numerically or can be selected directly in a spectrum by
dragging the line selector to the desired position. For the ratio calculation two positions need to be
entered/selected.
All peak methods:
The peak boundaries may be entered numerically by defining the minimum and maximum or can be selected directly
in a spectrum by dragging the area selector to the desired position and resizing it accordingly. The ratio calculation
requires the selection of two areas/four numerical values and the peak evaluation method.
Formula:
Clicking on the

button opens the Formula Editor.

Calibration:
All statistical values available as part of the chemometric analysis may be used as a trend. For example: Predicted,
Actual, Estimated, Leverage, Scores and so forth. The dropdown box will show all available values for selection.
Navigation
Just click the Next > button to proceed to the next step. Click the < Back button to revert to the last step.
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Clicking the Cancel button will abort the wizard.

Reaction Wizard  Step 3  Measurement & Data Saving Parameter
Step 3 configures the data input and data output settings of the reaction run. The data input can be provided via an
attached instrument or directly from the file system. The output data can be saved to files and/or projects. If an
instrument is used as data provider, the main instrument parameters ( acquisition range, resolution ) need to be
configured in this step.
Step 3 shows the following dialog:
Measurement Settings
Data Provider
Configures the input data provider for the reaction run. The following options can be selected:
Instrument:
Any instrument available on the local machine can be used as input data provider. The actual instrument name will
be shown in the dropdown list. The list will show all instruments that are currently available for a connection.
Instruments that are currently busy will not be shown, you will have to wait until it they are available again. If an
instrument is selected, the basic instrument parameters also have to be defined in the subgroup below.

Why is my instrument not available?
The instrument selection box will only list those instruments that are available for a connection.
Instruments that are currently busy measuring cannot be detected and therefore are not shown in the
list. The user has to wait until an instrument is available again to be able to connect to it.

File System Data Provider (not available on all Systems):
This option enables the use of a file system folder as input data provider. The software will monitor the selected
folder for new files. All spectra written to the monitored folder will be used as input data for the reaction run. This
option is useful for using unsupported spectrometers or other sources as data input.
Reference Measurement Settings
Configures the reference measurement options for the instrument data provider. The following options are available:
None:
No reference is measured.
Manual:
The reference spectrum needs to be measured manually prior to each reaction run, the reaction view provides an
additional button for starting the reference measurement. The reaction run itself cannot be started until the
reference spectrum has been measured.
For each reaction run:
The user will be prompted by the software to measure a reference prior to each reaction run. The message shown
to the user before the reference measurement and before the reaction run start can be customized here.
Predefined File:
A predefined spectrum file will be used as reference. The file can be selected via File Open dialog by clicking on the
button.
Instrument Parameter
The contents of this section depend on the selected data provider. Either the instrument parameters or the file system
parameters need to be customized here:
Instrument Data Provider:
The basic measurement parameters (Instrument name, start & stop wavenumber, resolution) need to be provided
for the selected instrument. The acquisition range is defined via start and stop wavelength and the measurement
resolution can be selected by dropdown box.
File System Provider:
The basic parameters for the file system monitoring need to be provided. The Path to the monitoring folder is
selected via File Open dialog by clicking on the
button. The Filter needs to be set according to the spectrum
files to be opened. If only the actual spectrum files are written to the monitoring folder, the generic filter *.* is
sufficient. If any other files are written along with the spectrum files, the filter must match the file extension of the
spectrum files. The monitoring may be extended to all subfolders of the selected path by activating the Include
Subdirectories checkbox.
Save to Folder Configuration
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Saving the measured data to the file system is optional and may be activated by checking the Autosave checkbox. If this
is not activated, the user still has the option to save the reaction data manually using the Save buttons from the control
panel of the reaction window. The "Save to Folder" option is only available if a physical instrument is selected as data
provider. The root folder for all reaction data can be configured using the command Set Directory for reaction runs in the
Reaction Monitoring menu. The following options are available:
Autosave:
Activate this option to automatically save the reaction data to the file system using the configured options.
Directory Name:
Predefined naming schemes for the data folder can be selected here. The edit box will automatically show the
current value of the selected naming scheme. Clicking into the edit box allows the user to select/edit the naming
scheme. The predefined options are %NAME% %COUNT%, %NAME% %HHmm%, %NAME% %HHmmss% and
%NAME% %yyyyHHmmss%. The naming placeholders resolve to the following values:
%NAME%: Inserts the name of the reaction into the folder name. Example: In step 1 of the wizard the name of the
reaction was specified as "Hydrolysis of Butylacetat". All reaction data will then be saved to a folder which begins
with that name.
%COUNT%: A continuous number indication the reaction count.
%HHmm%: A timestamp value that resolves to the actual time is inserted into the folder name. Example: The
selected timestamp is %HHmmss% and the reaction is run at 11:23 and 30 seconds. Therefore it will saved to a
folder with the name "Hydrolysis of Butylacetat 112320". The placeholder itself may be edited by the user.
File Format:
A dropdown box shows all available file formats. The desired format for saving the input data needs to be selected
here. This option defaults to the native Panorama data format (*.panorama).
Export Samples:
Activate this option to additionally save the measured samples to the save folder as separate files in the above
selected format.
Export Outliers:
Activate this option to additionally save the outlier samples to the save folder as separate files.
The general folder structure of a reaction save folder will look similar to this example:

Save to Project Configuration
Saving the measured data to a project file is optional and may be activated by checking the Autosave checkbox. The
naming scheme for the project file can be configured in the same way as for the "Save to Folder" option. The folder
structure of the project is also similar to the file system folder structure. The project file itself will be written to the root
folder for all reaction data, which can be configured using the command Set Directory for reaction runs in the Reaction
Monitoring menu.
Autosave:
Activate this option to automatically save the reaction data to a project.
Project Name:
Predefined naming schemes for the project. See above.
Time Stamp Settings
The timestamp strings follow the common date/time formatting convention ( HH=two digit hour, mm=two digit minutes,
ss=two digit seconds etc. ) and may be edited by the user to his liking. The following strings are predefined:
HHmm: Converts 11:23:54 AM to 11_23
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HHmmss: Converts 11:23:54 AM to 11_23_54
yyyyMMdd HH_mm: Converts the 15th of April 2011 and the above time to: 20110415 11_23
Navigation
Just click the Next > button to proceed to the next step. Click the < Back button to revert to the last step.
Clicking the Cancel button will abort the wizard.

Reaction Wizard  Step 4  Reaction Phase Setup
Step 4 assists the user in setting up the actual reaction run. Initial delays and reaction phases can be added or removed
and the phases itself can be configured defining the number of measurements, instrument parameters and all other
relevant settings.
Step 4 shows the following dialog:
Reaction Phase Settings
Initial Delay
Defines the initial delay before the first reaction phase is entered.
Reaction Phases
Reaction phases define the different sections of a reaction. Each phase may have a different duration with a different
number of measurements and measurement parameters. A simple reaction may be monitored with just a single phase
with constant measurements. More complex reactions on the other hand may require several different phases. A phase
can simply be added by clicking on the Add Phase button, removing a selected phase is done by clicking the Delete
Phase button. The following options are available for defining a reaction phase:
Endless:
Activating this option makes the phase an infinite phase. Only the measurement interval must be defined
additionally and the phase will run "infinitely" until the user aborts the reaction.
Comment:
A comment describing the current period may be entered for each reaction phase.
Measurement Interval:
Defines the time period between two measurements. Depending on the selected instrument and resolution, the
interval parameter may not be freely editable. The sample measurement time rises with increasing resolution and
therefore the measurement interval may possibly be to short to perform the next measurement on time. The
software takes this into account and suggest the minimum measurement interval for the selected instrument
parameters. Should for some reason the interval be temporarily too short between to measurements in a reaction
run, the run will not be aborted. In a case like this the next measurement will simply be skipped and the reaction
run continues as usual. This also ensures the completion of a reaction run even if there are temporary
measurement problems.
Number of measurements:
Defines the total number of measurements for this phase.
Instrument Parameters:
Defines the number of scans and the instrument gain for the current phase.
The bottom pane of the wizard shows an overview of the complete reaction. The total reaction time and the total number
of measurements for all phases are displayed. The starting time for each separate phase is shown in the phase header
itself.
Navigation
Just click the Next > button to proceed to the next step. Click the < Back button to revert to the last step.
Clicking the Cancel button will abort the wizard.

Reaction Wizard  Step 5  Reaction View Configuration
Step 5 of the reaction wizard configures the reaction view settings. The overall appearance of the main reaction view can
be configured here. This is the last step of the wizard and by clicking the Finishbutton the reaction setup will be
completed. The user will be prompted to save the reaction configuration.
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Changing the configuration later on...
The last step of the wizard is used to set up the basic view configuration. All view configuration options
will still be available in the reaction view and can be edited while the reaction is running!

Step 5 shows the following dialog:
Reaction View Configuration
Runtime View Configuration
Configures the display options for all data views during runtime. The following options are available:
Moving Time Window:
Shows a time window with the selected "size" centered around the current time. For example: The moving time
window is configured to 40 seconds and the current reaction time is 2:20. The views will then show the reaction
time from 2:00 to 2:40, or will show all the data that has been acquired in that time period.
Last N Samples:
Configures the overlay view to show the last N samples of the reaction. For example: Setting this to 5 will show the
last five samples. Dependent on the Every Nth Sample parameter these may not be the actual last five
consecutive samples since the "Every Nth" filter is applied before the "Last N" filter (e.g. Samples > EveryNth >
LastN). For example: Setting "Last N" to 5 and "Every Nth" to 1 will show the actual last five samples that have
been measured. Setting "Last N" to 6 and "Every Nth" to 2 will show the samples 2, 4, 6, 8, 10 and 12.
Every Nth Sample:
Configures the view to only show every Nth sample. For example: Setting this to 10 will only show the first, tenth,
twentieth etc. sample. The total number of spectra that are accumulated in the overlay view is defined by the "Last
N" parameter as described above.
Show Trend View
Activate this option to show the trend view in the reaction window. This option is enabled by default and should stay
enabled for most cases since it shows the graphical representation of the trend evaluation. The time unit of the trend
view xaxis can also be configured here. Please review the section Trend View for a detailed description.
Show Overlay View
Activate this option to show the measured sample spectra in an overlay view. Dependent on the configuration the
relevant spectra will be added to a single spectrum view and all spectra in the view will be displayed overlayed. The
configuration options for this view include the activation/deactivation of the first, current and outlier samples. This option
is enabled by default. Please review the section Overlay View for a detailed description.
Show 3D View
Activate this option to show the sample spectra in a 3Dview. The sample spectra will be displayed with an additional time
axis to form a threedimensional graph. The 3Ddisplay can be configured three different modes: Perspective, Waterfall and
Topview. Please refer to the sections 3D Data View, 3D Top View and 3D Waterfall View in the chapter Data Views for a
description of the different modes. Additional information can be found in the section 3D View. This option is enabled by
default.
Show Report View
Activate this option to show additional information about the reaction run in a grid view. The reaction data will be
presented in a table with each new sample being added as a new table row. The report grid option is enabled by default.
The basic sample information ( sample name, time recorded, trend data ) can be complemented by additional data:
Show Measurement Date: Adds an additional column to the table which holds the detail measurement time and
date of the sample.
Show Sample Names: Adds an additional column to the table which holds the full sample name of the sample.
Show Phase Information: Adds a separating row to the table if a new reaction phase begins. This helps to visually
separate the different phases in the table.
Show Comments: Inserts the comments that have been entered during the reaction run in the table.
Please review the section Report View for a detailed description.
Show Trend Monitor View
Activating this option will add a large numerical representation of the trend evaluation to the reaction window. This can
be useful if the trend values need to be monitored from a greater distance to the computer display. Additional information
can be found in the section Trend Monitor View.
Show Log View
If activated, this option shows an additional view with activity information about the reaction run. Please review the
section Log View for a detailed description.
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Finalizing the Reaction Configuration
By clicking the Finishbutton the reaction setup will be completed. The user will be prompted to save the reaction
configuration as *.reactionConfig file to the file system. The newly created reaction will automatically be added to the
Reaction Monitoring menu entries Run Reaction and Process Reaction with active Spectra.
Navigation
Click the < Back button to revert to the previous step.
Clicking the Cancel button will abort the wizard.

Routine Mode
The routine mode is a special application mode for the everyday use of the application in the reaction monitoring mode.
The main application interface will not be available and the user will be prompted with a simple dialog to select a
preconfigured reaction. The routine mode is enabled by using the command Enable Routine Mode from the Reaction
Monitoring menu. The selection dialog looks like this:

Run Reaction
To run a preconfigured reaction, the user simply needs to select a reaction template and click on the Run button. The
corresponding reaction window will be opened. The reaction templates available in the selection dialog of the routine
mode need to be selected by using the Configure Reactions command from the Reaction Monitoring menu.
Switch to the main application
To exit the routine mode and return to the main application simply click on the Go to MicroLab Expert button. The
selection dialog will be closed and the main application will be shown. This will also switch off the routine mode. On the
next start the main application will started automatically. To return to the routine mode use the command Enable Routine
Mode from the Reaction Monitoring menu.
Exit dialog
To exit the selection dialog simply click on the Exit button. The application will terminate and will directly return to the
selection dialog on the next start.
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IR/RAMAN Analysis Overview
IR spectrum measurement and interpretation is one of the most useful and quick analysis methods in routine analysis and
chemical research. It is cheap and results can be retrieved quickly. High throughput analysis is not possible in most cases,
because experienced analysts are rare these days.
RAMAN spectrum measurement is long known technology producing appropriate results in short time. Especially sample
preparation is much easier than for IR. However, instruments were very expensive in the past but recently become
cheaper and hence more attractive to routine analysis in these days.
The main target of IR/RAMAN Interpretation in the software is to assist experts and also inexperienced users with
powerful tools and the computer encoded knowledge of IR and RAMAN experts as predefined interpretation rules. This
way automatic and interactive IR/RAMAN spectrum interpretation or Validation of spectra and molecules are possible
within short amounts of time.
Functional groups of chemical compounds cause one or more related bands at known positions in IR/RAMAN spectrum. In
structure evaluation and elucidation, the analyst matches measured IR/RAMAN spectra and molecules by hand.
Prominent IR/RAMAN bands need to be identified in a spectrum
Identified IR/RAMAN bands need to be assigned to functional groups.
Molecules need to be analyzed for functional groups.
Both information needs to be matched and evaluated.
The software provides comprehensive tools to assist the user with all these steps.
A comprehensive set of interpretation rules is used to categorize IR or RAMAN bands and assign them to particular
functional groups. A rule contains a characteristic description of an IR or RAMAN band using chemical properties, which can
be understood by a computer. Rules can be customized by the user (optionally) in order to provide a convenient way
adapting them to special requirements. A set of basic interpretation rules covering almost all fields of Organic Chemistry is
provided by default.
Please follow the chapters below to learn all about IR and RAMAN spectrum analysis with the software.

Getting started
Before starting IR or RAMAN spectrum interpretation, a set of rules need to be loaded. Please refer to the chapter
"Loading IR/RAMAN Interpretation Rule Database" for details. By default a IR rule database and a RAMAN rule database
are installed together with the software. If not changed these rule databases are used for analysis.
Load the Demo Project for testing!
A demo project called "IR Analyze Demo.project" is installed together with the software for IR
interpretation testing. A corresponding RAMAN project is included as well. It is called
"RAMalyzeDemo.project".
Both files are located in your ".\My Documents\MicroLab Expert Data\Projects" folder by default. It
contains several spectra and corresponding molecules for testing.
Please open the project and try. For detail on how to open a project, please refer to the chapter "Open
a Project".

Analysis Modes
The software supports both analysis techniques, but only one at a time. The actual interpretation mode is indicated by
the interpretation menu name. Possible menu names are:
IR Interpretation
The software is now in IR interpretation mode. The corresponding IR rule database is applied for analysis.
RAMAN Interpretation
The software is now in RAMAN interpretation mode. The corresponding RAMAN rule database is applied for analysis.
Both modes provide the same interpretation software features. However, core spectrum analysis and of course the
applicable rule database are different for IR and RAMAN interpretation accordingly. The mode can be easily toggled using
the Toggle to ... menu command in the IR/RAMAN Interpreation menu.
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Can I run RAMAN interpretation with an IR spectrum and vice versa?
Yes!
The software does not check the actual spectrum type before doing an analysis for different reasons:
In many other and mainly older software packages and also software packages from instrument
vendors, IR spectra and RAMAN spectra are not well distinguished. If you import such spectrum into this
software the identified spectrum type might be IR although it is a RAMAN spectrum. If the software would
be that strict to deny RAMAN interpretation for IR spectra, you would never be able to analyze legacy
spectra.
Spectra are preprocessed before doing an analysis in order to take into account the different spectrum
shapes for IR and RAMAN. Preprocessing is different for both spectrum types. You may want to use both
preprocessing types with IR or RAMAN spectra. It is possible to do that using the correct mode.

Analyzing IR and RAMAN Spectra
Based on the actual interpretation rule database loaded for the current analysis mode and current parameter settings an
IR or RAMAN spectrum is analyzed. A result with prominent identified functional groups is shown, which helps the analyst
in interpretation of the spectrum.
For details please refer to the "Analyze spectrum" section.

Validating Spectrum and Molecule
Based on the rule data base of the actual analysis mode and advanced parameter settings a molecule and a potentially
corresponding spectrum are analyzed. A result with identified functional groups for both is shown, which gives an
overview over matching functional groups.
For details please refer to the "Validate Spectrum and Molecule" section.

Browsing Functional Groups and instant Interpretation
For a quick interpretation of a particular peak in your spectrum, the Functional Group Browser is a perfect tool. Based on
your interpretation rules of the actual analysis mode it provides suggestions for suitable functional groups at specific
position in your spectrum. This feature is like an electronic catalog for functional groups. In printed catalogs functional
groups are typically listed by name and the analyst needs to know the name and corresponding position in the spectrum.
The Functional Group browser does not require that information. The user just moves to a band and he will get all
information at a glance.
For detail, please refer to the chapter "Functional Group Browser".

Menus
A list of all available menu commands in the software is given in the "IR/RAMAN Interpretation Menu" section.

Changing Interpretation Parameters
Initially, all interpretation parameter settings are set to automatic mode. This way you will be able to perform IR or RAMAN
interpretation without prior configuration of the system. However, advanced users may choose special parameters or pre
processing options and like to modify analysis parameters to optimize results.
Please refer to the chapter "Preferences" for details.

Designing and modifying Interpretation Rules
A rule designer is used to define and organize interpretation rules being used in IR and RAMAN interpretation. Current set
of rules for the actual analysis mode can be customized by experienced users.
Please refer to the "Rule Designer" section for details.
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Be careful when modifying interpretation rules!
Any changes in the existing set of interpretation rules might have unwanted effects on your analysis
results. This might also lead to completely wrong results.
On the other hand side it is important to add new interpretation rules to meet your personal and
experimental analysis conditions. Adding new interpretation rules will improve the system in your
working environment.

Data View Enhancements
This chapter contains following topics:
Spectrum View Functions
Highlight all assigned Functional Groups
Displaying Structural Fragments inside a Spectrum View

Spectrum View Functions
The basic spectrum view functionality is also available here, but some additional information is provided in IR/RAMAN
Spectrum Interpretation as described below:
The spectrum view of a typical IR or RAMAN spectrum interpretation result looks like this:

The spectrum view supports all functions of a default spectrum view. Besides the spectrum curve, some more information
is available in the spectrum view:

Peaks
All identified peaks considered in spectrum interpretation are indicated by vertical red lines from the peak
maximum/minimum to the baseline. These lines are not shown by default, but they can be either activated or deactivated
using one of the following ways:
Show Identified Peaks Context Menu Command
1. In the spectrum view, click the Right Mouse button.
2. From the context menu, check Show Identified Peaks.
Show Identified Peaks Menu Command
1. From the IR/RAMAN Interpretation menu, check Show Identified Peaks.

Peak Area
The peak area of identified peaks of the current active functional group is filled light green to emphasize position in the
spectrum. Green color means, the peak is a positive match in spectrum interpretation.

EN

IR/RAMAN Analysis . 369

The tool tip help shows information on bands...
Whenever the mouse pointer resides over a peak area of a functional group, a tool tip help is shown
with detailed IR or RAMAN band information. This information is also available in the identified chemical
classification rule table.

Coloring of Interpretation Rules
Colored rectangles outside the identified peaks in the spectrum have different meaning. From spectrum interpretation
rules, IR or RAMAN bands are defined as expected spectral regions. They possess a particular spectral range and an
expected intensity. These parameters span a rectangle in the spectrum view indicating the expected peak position.

Passed Interpretation Rules
Positive matches will produce green rectangles. This means, there is no peak in a specified region of the spectrum,
because the region is excluded and no peak was expected there (excluded region).
Failed Interpretation Rules
Red colored regions indicate regions where a peak was expected, but none was found during analysis. The other way
around, if a peak is found in an excluded region, where none is expected, it will be also red colored.

Browsing Frequencies and Proposal of Functional Groups
To enter the Functional Group Browser follow the steps below. For details on this feature, please refer to the chapter
"Functional Group Browser".
1. Move the mouse pointer close to the peak of interest in the spectrum area.
2. Click the Right mouse button inside the spectrum view to popup the context menu.
3. From the context menu, select the menu entry Show Functional Groups at...
The Functional Group Browser opens and shows a list of best matching functional groups at the selected peak.

Functional Group Molecule
A molecular representation of the functional group is shown in the spectrum area. The functional group item can be
selected, resized and moved around inside the spectrum view. For details, please refer to the chapter "Molecule and
Functional Group View".

Highlight all assigned Functional Groups
The command "Highlight all assigned Functional Groups" provides a quick way of visualizing all vibrations in the current
spectrum that are already assigned to functional groups in the interpretation result. This enables the user to quickly
reveal all assigned and yet unassigned vibrations for further optimization or additional manual interpretation.
The selection of this command toggles highlighting on or off. All identified functional groups are colored blue as shown in
the following figure:
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The transparency level of blue colored vibrations indicate, which bands belong to the current selected functional group.
Vibrations of the current selected functional group are marked dark blue. Others are light blue. On selection of a different
functional group, colors of the current selected group return to original coloring and others keep their blue shape.

Enabling and Disabling Highlighting all identified Functional Groups
To enable or disable highlighting all identified functional groups the following options are available:
Why is the command disabled?
This command is only available, if a valid spectrum interpretation result or spectrum versus molecule
validation result is active!

The function is toggled on subsequent use.
Menu Command
1. In the IR/RAMAN Interpretation menu, select Highlight all assigned Functional Groups.
Context Menu Command
1. In the spectrum view of the IR spectrum interpretation result, click the Right mouse button.
2. A context menu is shown. From the context menu, select Highlight all assigned Functional Groups.
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Displaying Structural Fragments inside a Spectrum View
Basic molecule view functions are also applied here, but some additional functions are required for IR/RAMAN Spectrum
Analysis. Here, structural fragments need to be displayed according to investigated functional groups. Molecule fragments
are shown and they might have undefined residuals representing an unknown rest of a molecule. It is also possible, that
more than one structural representation is available for a functional group. In this case each molecule fragment can be
displayed alone or all can be shown together.
A typical Imine molecule fragment view looks like this. It represents all kinds of molecules containing an Imine functional
group.

Contents of the molecule view are updated on selection of spectrum analysis results.

Atom Placeholders and undefined Residuals
As described above some residuals or atoms in the molecule fragments might be undefined in order to give a
representation of a chemical environment for a set of various molecules. In Chemistry some well known abbreviations for
such atoms or residuals are given in the following:
Alkyl Groups
Alkylgroups are indicated by a super atom "R".
Aromatic Groups
Aromatic residues are represented by "P h" for phenyl or "Ar" for general aromatic residual.
Any Generic Groups
Generic groups, either alkyl, aromatic, cyclic or noncyclic, etc. are represented by "G".
Halogen Atoms
Halogen atoms are indicated by "X"

Molecule View Display Options
Some functional group representations cannot be depicted by only one particular molecule, but a set of various molecule
fragments representing all possible chemical environments. In this case multiple molecules are displayed in the view:
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The navigation toolbar in the top left corner provides convenient control of visible molecule items. It will be shown
automatically, whenever more than one molecules is displayed and the molecule view is activated or the mouse pointer
resides in the view. The toolbar will be shown for navigation purposes. The molecule view offers two display modes:
Overview Mode
All available molecules are visible at once.
Single View Mode
Only one molecule is visible and maximized to the molecule view. The user can toggle between all available
molecules.
View mode can be altered clicking the
toggled.

button in the navigation toolbar. Single view mode and overview mode will be

In the single view mode, only one molecule is displayed at a time. In order to toggle between all available molecules,
move forwards and backwards in the list of all molecules clicking the
and the
buttons
Previous
Shows previous molecule.
Next
Shows next molecule.

Displaying Functional Groups in a Spectrum View
In the spectrum interpretation result, a molecular representation of the active functional group is displayed in the
spectrum view:

All functions described above are also available for the molecule item shown inside a spectrum view.
Click with the Left mouse button onto the molecule in the spectrum view to activate and select the molecule item.
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Move the molecule item around in the spectrum view with Drag & Drop.
Resize the molecule display by dragging and dropping the tracker symbols.
Click somewhere outside the molecule item to leave selection.
Click the Right mouse button to customize molecule view preferences.

The toolbar toggles the display mode...
Whenever the molecule display is selected, the toolbar is visible to customize display mode.

Customizing the Molecule View
Some preferences can be adjusted for the molecule view. Please refer to the chapter "Molecule View Preferences" for
details.

Infrared & Raman Spectrum Interpretation
This chapter contains following topics:
Analyze spectrum
Preferences
Validate Spectrum and Molecule
Functional Group Browser

Analyze spectrum
IR and RAMAN spectrum interpretation allows automatic and interactive analysis for popular IR or RAMAN bands in a single
spectrum based on predefined interpretation rules. A list of identified peaks and corresponding functional groups are
returned as a result of the analysis.
Before you start IR and RAMAN spectrum Interpretation...
Please make sure to load an IR/RAMAN interpretation rule database. (By default a rule database is
available already)
Expert users, please configure Preferences properly, before you start analyzing spectra.

Analyzing an IR or RAMAN Spectrum

Toggle to the right analysis mode before analyzing a spectrum!
Before analyzing a spectrum, please toggle the analysis mode to the one you want. The rule database is
loaded for the actual analysis mode accordingly!
To toggle the analysis mode, choose the Toggle to ... menu command in the IR/RAMAN Interpretation
Menu.

To analyze a spectrum, please follow the steps below:
1. Open an IR or RAMAN spectrum from a file or project.
2. From the IR/RAMAN Interpretation menu, select the Analyze Spectrum command.
3. The spectrum is analyzed automatically and results are presented in a new tab window as described below.

Presentation of Spectrum Analysis Results
The example shows the result of an IRSpectrum interpretation. For RAMANspectra similar results are obtained with the
same features.
After starting spectrum analysis successfully, the results will be displayed in the Spectrum Analysis Result dialog:
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The analyzed spectrum is displayed in the spectrum view on top of the dialog. For details about the spectrum view
functionality, please refer to the chapter "Spectrum View Functions". Matching functional groups are listed in a table on
the bottom. It shows identified functional groups including related information from the rule database:
Quality Value
Name of the Functional Group
Name of the corresponding Chemical Sub Class
Name of the corresponding Chemical Class
For current selected functional group, the subset of passed interpretation rules is shown in the upper left table. Failed
interpretation rules are shown in the upper right table. Each functional group possesses a corresponding molecular
representation. It is shown inside the spectrum view. For details about the molecule view functions, please refer to the
chapter "Molecule and Functional Group View".

Highlighting Vibrations
You may highlight corresponding spectral region of a vibration by selecting an entry in the pass or fail table.
1. Click the Left Mouse button on an entry in the pass or fail table to select a vibration.
Selection looks like this:
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The horizontal bar on top of the spectrum is an additional indicator for the spectral width of the interpretation rule.

Show Identified Peaks
IR and RAMAN interpretation strongly depends on peak detection, which is done prior to analysis. In order to see the
identified peaks you may activate peak markers in the spectrum view of the spectrum analysis result. When activated, the
peak position is indicated by a vertical red line.
For details please refer to the chapter "Peaks" in section "Data View Enhancements".
How do I control identified peaks?
Sometimes it might be necessary to modify peak detection parameters, because automatic peak
detection does not produce satisfactory results. You have the following options to take influence on peak
detection:
Open the Preferences dialog and change "peak detection" settings there. Please refer to the
section "Preferences" for details.
Before you analyze a spectrum, perform manual peak detection using the Find Peaks function in
the Mathematics menu of the software.
Analysis only considers your personal set of detected peaks then.
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You may also like to review all identified peaks. They can be colorized in the spectrum to reveal not yet analyzed areas.
Please refer to the chapter "Highlight all assigned Functional Groups" for details.

Sorting Matching Functional Groups
You may sort matching functional groups table by a preferred column:
Just click with the Left mouse button onto the caption of the desired column. The table will be sorted in ascending
alphabetical order.
A second click with the Left mouse button onto the same column caption will sort the column descending.

Modifying Interpretation Results
After automatic interpretation has been completed, results can be modified and updated manually by the user because of
the following or other reasons:
Some of the peaks in your spectrum may not be identified by automatic spectrum interpretation.
Others have been identified, but from your point of view, assignment is not correct.
Deleting Functional Groups from Interpretation Results
Functional groups that have been added to the list by mistake can be removed as follows:
1. Click the Functional Group to be deleted with the Left mouse button in the table.
2. Press the DELkey on your keyboard
3. Alternatively, Select the Remove Selected Functional Group command from the IR/RAMAN Interpretation menu.
The functional group is removed without further notification.
Adding Functional Groups to Interpretation Result
You may add functional groups for a peak in your spectrum by selecting a suitable one from the rule database. The
Functional Group Browser will help you to identify suitable functional groups and lets you add them to the current
interpretation result. Please follow the steps below:
1. Move the mouse pointer close to the peak of interest in the spectrum area.
2. Click the Right mouse button inside the spectrum view to popup a context menu.
3. From the context menu, select the menu entry Show all Functional Groups at...
The Functional Group Browser opens and shows a list of best matching functional groups at the selected peak
position.
How to use the Functional Group Browser?
Please refer to the chapter "Functional Group Browser" for details on navigation inside the browser.

4. Select a functional group from the list in the Functional Group Browser.
5. Click the Add Functional Group to Result button to add current selected one.
6. Move the black vertical line to other frequencies / Peaks of interest.
7. Repeat steps 4  6 until all required peaks have been assigned.
8. Click the Close button to return to your initial interpretation result.

Show Functional Group Definition
It might be important for improving the rule database to easily review a functional group definition. The actual selected
functional group can be reviewed in the Rule Designer using the AltF12 keys shorthand or alternatively use the
following menu command:
1. Select a functional group from the list in the spectrum analysis result.
2. From the IR/RAMAN Interpretation menu, select Show Functional Group Definition.
Both methods open the Rule Designer window to show the actual functional group. Here you may review related
functional groups or modify rule definitions to optimize the rule database.
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Share Results with other Applications
Contents of any table in the interpretation result can be copied to the clipboard and pasted in other applications.
Please refer to the chapter "Copy and Paste Opportunities" in the section "Using the Software" for details.

Saving Interpretation Results
Interpretation results can be saved to file or into a project to be reloaded for review later on.
To learn more about saving objects in the software, please refer to the chapter "Save" or "Save as" in the section
"Commands".
To learn more about adding objects to a project, please refer to the chapter "Add all Objects in the Window to Project" in
the section "Commands".

Printing Interpretation Results
Results can be printed using a predefined Interpretation Result Print Layout. Contents of the printout can be customized
there.
Please refer to the chapter "Interpretation Result Print Layout" in the section "Printing" for details.

Preferences
For IR or RAMAN spectrum interpretation or Validation of spectrum and molecule some parameters might be set to take
influence on analysis results. However, in most cases automatic selection of parameters will provide good results,
because the automatic parameter detection will analyze each spectrum and adjust settings especially for the current
spectrum. Of course all parameters can also be adjusted manually.
Parameters are stored in the Interpretation Rule Database!
Any parameters adjusted in this dialog will be stored together with the interpretation rules in the
database. Thus modification of those parameters will modify the rule database. You will be prompted to
save or discard changes, if you leave the application or switch to another rule database.
This also means, you may have different parameters for IR and RAMAN interpretation depending on the
actual analysis mode.

Opening Interpretation Parameter Dialog
To open the interpretation parameter settings dialog , select the Preferences... command from the IR/RAMAN
Interpretation menu. The dialog looks like this:

It provides parameters for the following items:
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Peak Detection
For spectrum interpretation peaks need to be identified in advance. The parameters in this section are identical to those
of the Find Peaks function in the "Mathematics" section of the software. Only identified peaks will be considered in the
interpretation process.
Automatic
If the automatic peak detection is enabled, various algorithms will find a suitable set of peaks for spectrum
interpretation. Otherwise you may adjust the parameters below for peak detection.
Perform AutoBaseline Correction
If enabled, the baseline of the spectrum is automatically corrected to obtain more precise peak detection results.
No particular parameters can be set here.
Peak Height
This parameter controls the minimum absolute or relative peak height. Only signals with intensities beyond this
value will be identified as peaks.
Use Absolute Peak Height
This parameter controls the peak height detection mechanism, which is one of the following:
Absolute Peak Height (checked)
The absolute peak height is determined from zero to the maximum peak intensity.
Relative Peak Height (unchecked)
The relative peak height is determined from the imaginary baseline of the peak to the maximum peak
intensity.
Peak Width
This parameter controls the minimum peak width. Only signals with at least this minimum peak width denoted in
wavenumber units will be identified.
An existing peak table overrides peak detection ...
If you are not satisfied with results derived from automatic peak detection or peak detection with height
and width parameter, you can provide your own list of peaks for analysis. In this case, please find peaks
yourself using the "Find Peaks" function from mathematics section before starting IR/Raman
Interpretation.
An existing peak table overrides peak detection of the interpretation algorithm. In this case the existing
peak table is considered for analysis.

Band Detection Tolerance
Interpretation rules represent the expected positions of bands in a spectrum. However because of physical or solvent
effects sometimes bands are shifted and will not appear at original position. This might cause incorrect identification in
some cases. If signal shifting is observed in the spectrum, you can correct for it by setting a particular deviation in
wavenumber units. Bands will then be identified in their original expected range and also in an interval around.
Deviation
This parameter controls the size of the tolerance interval for each IR or RAMAN band.

Intensity Threshold
The strength of a signal in the spectrum strongly depends on chemical environment and physical properties of the
substance. In interpretation rules, expected signal strengths are stored being compared now to the current sample
spectrum signal intensities. With intensity threshold settings below the analyst encodes the strength of signals in the
analyzed spectrum from his personal feeling using the following categories:
Very weak
Weak
Medium
Strong
Very strong
The numbers behind these qualitative intensity categories represent the expected intensity ranges in absorbance units
where very weak, weak, medium, strong and very strong signals are expected. Peaks appearing within one of the
categories will be identified accordingly. Intensity values of these categories span from 0 to 1.5 absorbance units.
Categories are allowed to overlap.
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Normalization of the spectrum.
The intensity of the highest detected signal in the measured spectrum is automatically scaled to 1.5
absorbance units. The lowest intensity (usually the base line) in the spectrum is set to 0. All intensities in
between will be scaled accordingly. This procedure is called normalization.

By default and as long as the Automatic checkbox is enabled, these intensity categories will be determined automatically
by some algorithms in the software.

Interactive Parameter Settings
Step by step optimization of parameters and improvement of results is also possible and you can see the result changing
directly without repeating all steps of the analysis.
1. Adjust parameters for spectrum interpretation in the dialog.
2. Click the Apply button for recalculation and update of interpretation results.

Validate Spectrum and Molecule
In most cases spectrum interpretation will only be the first step on the path to identify the analyzed substances.
Furthermore identified functional groups from spectrum interpretation need to be assigned to a molecule to finally
complete analysis results of a sample from the research point of view. The software assists you in matching a spectrum
with a molecule and vice versa.
All you need is a molecule and a spectrum either as files or combined in a project that can be loaded by the software. The
following validation approaches are available:
Starting with a spectrum you like to match a molecule.
Starting with a molecule you like to match a spectrum.
Having a spectrum with a linked molecule, you like to confirm both are matching well.

Matching a Spectrum with a Molecule
Starting with a spectrum, validation will work as described in the following:
1. Open an IR or RAMAN spectrum from a file or project.
2. From the IR/RAMAN Interpretation menu, select the Validate Spectrum and Molecule command.
3. In the file dialog that opens automatically, select a file containing a molecule.
4. Click the Open button.
Spectrum and molecule are now analyzed automatically and results will be presented in a new tab window as described
below.
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The analyzed spectrum and molecule are shown together in the spectrum view on top of the result. In the tables below,
matching functional groups as well as passed and failed interpretation rules of the active functional group are listed. For a
detailed description on the functions of the view, please refer to the chapter "Spectrum View Functions".
Selection of a functional group in the bottom table will highlight corresponding peaks in the spectrum and will also
emphasize corresponding fragments in the molecule.
Validation status is shown in the matching functional group table. In the Validated column, you see the matching result:
Both
The functional group was identified in the spectrum and in the molecule. This means perfect matching.
Molecule
The functional group was only identified in the molecule but not in the spectrum.
Spectrum
The functional group was only identified in the spectrum but not in the molecule.
If matching will not provide expected results, you may start a new validation with another molecule. You may also
investigate peaks by browsing suitable functional groups for the peak.
Please refer to the chapter "Browsing IR Frequencies and Proposal of Functional Groups" for details.

Matching a Molecule with a Spectrum
Starting with a molecule, validation will work as described in the following:
1. Open a molecule from a file or project.
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2. From the IR/RAMAN Interpretation menu, select the Validate Spectrum and Molecule command.
3. In the file dialog that opens automatically, select a file containing an IR or RAMAN spectrum.
4. Click the Open button.
Results will be provided automatically as described above.

Matching a Spectrum with a linked Molecule
If a molecule is linked to the current spectrum, validation can be started without loading a molecule. Results will be
calculated and provided as described above.
How to link a molecule to a spectrum?
Please refer to the chapter "Link Objects" in the section "Commands" for details.

Functional Group Browser
The functional group browser provides direct analysis of a particular frequency in your IR or RAMAN spectrum. A list of best
matching functional group will be derived from all available functional group definitions and shown.
The functional group browser is available
for improving interpretation results after performing spectrum analysis.
You may add functional groups to your current interpretation result, because the automatic routine may have
missed some required functional groups.
for a quick overview of suggested functional groups at a particular frequency in your spectrum. In this case the
browser is used like an online electronic functional group catalog.
Functional Group Browser Window
A new window is opened, which looks like this:
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The analyzed spectrum is shown in the upper part of the browser. In the tables below, suggested functional groups as
well as passed and failed interpretation rules of the active functional group are listed. For a detailed description on the
spectrum view functions, please refer to the chapter "Spectrum View Functions".
Selecting the Investigation Frequency
Additionally, a black vertical line marks the investigated frequency in the spectrum. The line can be moved with drag and
drop to the frequency you are interested in. The list of suggested functional groups will be updated accordingly. The list is
sorted by quality to provide the best match on top of the list.

Open the Functional Group Browser
The functional group browser can be started from the IR/RAMAN Interpretation menu, whenever an IR or RAMAN spectrum
is activated in the data view.
1. Open an IR or RAMAN spectrum in a tab window.
2. From the IR/RAMAN Interpretation menu, click the Browse Functional Groups at specific Wavelength command.

Show all Functional Groups at...
In the IR or RAMAN interpretation result view, the functional group browser is available from the context menu in the
spectrum view.
1. Move the mouse pointer close to the peak of interest in the spectrum area of the result.
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2. Click the Right mouse button inside the spectrum view to popup the context menu.
3. From the context menu, select the menu entry Show Functional Groups at...
Add Functional Group to Interpretation Result
After selecting a frequency suggested functional groups are listed in the matching functional groups table as described
above. To add one or more functional groups to the spectrum interpretation result, please follow the steps below:
1. Click the functional group in the matching functional groups table you like to add.
2. Click the Add Functional Group to Result button.
The functional group will be transferred to the interpretation result automatically. The browser window remains open for
further frequency investigation.

Rule Designer
This chapter contains following topics:
Rule Designer
Designing Molecules for a Functional Group
Generic Atom Properties
File Menu
Creating a new Rule Data Base
Rules Menu
Find Functional Groups, Chemical Classes and SubClasses
Track Rule Changes
Find Incomplete Functional Groups
SMILES and SMARTS Nomenclature

Rule Designer
Functional groups of chemical compounds cause one or more related peaks at known positions in an IR or RAMAN
spectrum. In research the analyst takes measured spectra and tries to find prominent bands. Assignments need to be
matched to suggested or known molecules. For a detailed introduction, please also refer to the chapter "IR/RAMAN
Analysis Overview".
The main target of the rule designer is defining interpretation rules and organize them in a spectroscopic manner.
Interpretation rules represent the encoded knowledge of an experienced spectroscopist.
In the rule designer, interpretation rules can be created, modified, deleted, copied and pasted and administered. The
dialog looks like this:
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Interpretation Rule Tree
The interpretation rule tree view (in the left part of the figure above) shows the organizational structure of rules within
the interpretation rule database. Rules can be organized following a particular hierarchy:
Chemical Class
The chemical class is an organizational instance, which collects all characteristic properties of a group of substances, e.g.
alcohols or aromatic hydroxy compounds.
Chemical SubClass
The chemical subclass is an organizational instance like the chemical class itself. In some cases, the chemical class is too
general and needs to be split into several subclasses, e.g. the chemical class aromatic hydroxy compound is divided into
the subclasses Aromatic Alcohol and Phenol.
Functional Group
Each chemical class or subclass contains a number of functional groups corresponding to a fragment in a molecule. These
functional groups in a molecule are responsible for a collection of characteristic bands in a spectrum.
Interpretation Rule
Each IR or RAMAN band is represented by an interpretation rule. It is the smallest available unit in the interpretation rule
database. Properties of a band have been computerized into several parameters describing the band shape and
characteristics.

Navigation in the Rule Data Base Tree
The following operations are available in the tree view on the left of the dialog:
Expanding and collapsing Tree Nodes
Nodes in the tree can be expanded and collapsed by clicking with the Left mouse button on the
respectively.
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Selection of Tree Nodes
Selection of a functional group node automatically updates the interpretation rules table and the molecule view
accordingly.
If a chemical class or subclass is selected, the views and tables are cleared.
Multiple Selection of Tree Nodes
By holding down the CTRLkey and selecting several nodes in the tree, more than one node can be selected. This
feature is useful on copying and pasting several functional groups.
Adding a new Functional Group, Chemical Class or SubClass
A new item (chemical class, subclass or functional group) can be easily inserted into the tree.
1. Just select the node, where the new item must be inserted.
2. Press the INSkey to insert the next lower level item below the selected node.
3. Type a name for the new item into the highlighted new node and press the RETURNkey to finish.
Removing Tree Nodes
An item can be easily removed.
1. Select the node of the item, which has to be removed.
2. Press the DELkey.
3. Confirm the message by clicking the Yes button.
Renaming Tree Nodes
An item can be renamed as described in the following:
1. Select the node of the item, which has to be renamed.
2. Press the F2key.
3. Type a new name for the item into the highlighted node and press the RETURNkey to finish.
4. To cancel this operation, press the ESCkey.
Copy and Paste Operation for Functional Groups
Functional groups in the tree can be copied and pasted to another item, e.g. chemical class or subclass.
1. Select the one or more functional group nodes, which has to be copied.
2. Press the CTRLCkeys to copy it into the clipboard.
3. Select a destination chemical class node or subclass node in the tree.
4. Press the CTRLVkeys to paste the functional groups.

Interpretation Rules Table
Each functional group is characterized by a set of interpretation rules being listed in the table on bottom right of the
dialog. They possess the following properties:
Vibration Name
This is meant to be a user defined name for the IR band describing the vibration type, e.g. OH stretch or OH bend.
Start Wave Number
This is the starting wave number of the interval, where the experienced analyst would expect the band in a spectrum.
Values need to be entered in 1/cm units.
Stop Wave Number
This is the ending wave number of the interval, where the experienced analyst would expect the band in a spectrum.
Values need to be entered in 1/cm units.
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The range will be used in spectrum interpretation...
The spectral range of an IR and RAMAN band defined by start and end wave number is used in band
recognition during spectrum interpretation. Some manual fine tuning might be done in the Preferences. If
the range is not clearly defined, an overall deviation should be defined there before starting a spectrum
interpretation.
Threshold
The threshold describes the expected intensity of an IR or RAMAN band. The intensity is given in the categories listed
below relative to all peaks in the analyzed spectrum. The following categories are available:
Very weak
Weak
Medium
Strong
Very strong
Variable
Variable means, the intensity strongly depends on the chemical environment and spans from very strong to very
weak.
This parameter will be used in spectrum analysis...
The threshold is used in IR and RAMAN band recognition during spectrum analysis. Some fine tuning of
the categories is done in the Preferences. The threshold values for those categories should be adjusted
properly, before starting a manual spectrum interpretation.
Priority
The priority of a band describes the relative importance of the IR band. Sometimes bands are very weak or will be rarely
observed because of the chemical environment or other experimental conditions. By experience of the analyst the
importance of an IR band must be estimated applying the following categories:
Very low (green colored)
Low (green colored)
Medium (green colored)
High (green colored)
Very high (green colored)
Excluded (red colored)
This option has an extra meaning, which overrides the interpretation of other rules in the functional group, if the
condition is met. It allows to exclude a particular IR band from a functional group
Example:
If a carboxylic acid is analyzed, strong signal at approximately 1690 1/cm is available for the carbonyl group
and a strong signal is available at approximately 3500 1/cm for the OHgroup. In the definition of an alcohol
functional group, the analyst would never expect a carbonyl band, although he would expect a OHband.
Therefore in definition of the alcohol functional group, the carbonyl band should be excluded. In this case,
the functional group would be ignored in analysis.
Mandatory (yellow colored)
This option has inverse meaning to excluded. It overrides interpretation of other rules in the functional group, if
the condition is met. It allows to include a particular spectral region as mandatory in a functional group. At least
one peak must be available in this region to match the condition.
Example:
Regarding the example from above, if a strong signal at approximately 1690 1/cm for the carboxylic acid group is
missing, this would never be a carbonyl group, although other bands might match the settings in the functional
group definition. In this case, the functional group should be ignored in analysis.
Coloring of Spectral Regions
The bands are color encoded according to their priority to allow quick identification:
Green Color
All expected bands are green colored. The degree of transparency indicates the priority. Opaque bands possess
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high priority. The more transparent they get, the less is their priority.
Yellow Color
All mandatory bands are yellow colored.
Red Color
All excluded bands are red colored.

Molecule Fragment View
On top of the dialog, the actual functional group is presented as molecule fragment. The molecule is shown in a molecule
view. Please refer to the chapter "Molecule View Functions" section for details.
Add or replace a Molecule in Functional Group
One or more molecule fragments can be added to a particular functional group. They need to be drawn with any
commercial structure editor in advance and provided as *.mol file to the software. The following methods are available to
add a molecule to a functional group:
Drag and drop a *.mol file from windows explorer to the spectrum view on top of the dialog.
Add a Molecule command
1. From the Rules menu, select the Add Molecule command.
2. In the file dialog, select a *.mol file.
3. Click the Open button to add the molecule.
How to develop molecules which can be used in Functional Groups.
In the rule designer functional group molecules need a special Shape, because the algorithm used for
Validating spectrum and molecule will analyze provided molecule itself for available functional groups.
Here the molecules of each functional group definition will be matched with the molecule provided in
validation. This matching algorithm requires special definitions for generic groups and super atoms.
Please refer to the chapter "Designing Molecules for a Functional Group" for details.

Spectrum View with Interpretation Rule Placeholders
The spectrum view shows the position of interpretation rules within the visible spectral range as colored rectangles. The
color encodes the priority of a particular spectral region.
Please refer to the chapter "spectrum view functions" for details.
Show the position of chemical classification rules on a sample spectrum...
For some applications, it is required to see the position of chemical classification rules of a functional
group directly on an underlying spectrum. For this purpose, a spectrum file (*.spc) can be directly
dragged and dropped as layer onto the spectrum view from MSWindows explorer.

Modification of Functional Groups
A basic set of interpretation rules and corresponding hierarchy is provided with the installation of the software. You may
modify, add or remove functional groups and molecules yourself to improve and adapt the rule database to your personal
requirements. For this purpose, the following options are available:
Changes will directly change all interpretation results!
Modification of the rule database will take direct effect on your interpretation results. Please be careful
when modifying interpretation rules.
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Changes will be stored automatically!
Changes will be stored, if the rule designer is closed. You will be prompted to confirm saving
modifications.
Adding a new Interpretation Rule to a Functional Group
1. A new interpretation rule can be added by clicking with the Left mouse button into the empty row (next to the
asterisk symbol) of the chemical classification rule table on the bottom right of the:

2. A new row is inserted automatically and all values are defined as (Null):

3. Enter valid values into each column now or select from the drop down boxes if applicable.
4. After leaving the current row with RETURNkey or by clicking with the Left mouse button, the interpretation rule is
updated.
Modifying a Interpretation Rule of a Functional Group
1. A interpretation rule can be modified by clicking with the Left mouse button into the desired field to be changed
in the interpretation rule table.
2. Enter new valid values for the field or select from the drop down boxes if applicable.
3. Leave the current field with the RETURNkey or by clicking with the Left mouse button into another field. The
interpretation rule is updated automatically.
Deleting a Interpretation Rule from a Functional Group
1. With your mouse point to the dark blue area in front of a row within the interpretation rule table.
2. Click the Left mouse button to select the row in the table.
3. Press the DELkey to delete the row.
4. Confirm the warning message with the Yes button.

Designing Molecules for a Functional Group
It is easy to draw molecules like benzene with an external structure editor but molecules suitable for use in functional
groups is more difficult.
An external molecule editor is required!
Any free or commercial structure editor can be used to create molecule files in the *.mol file format.
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Functional groups are meant to be parts of such molecules. From the functional group point of view, it is a molecule
residual. In the interpretation rule database these molecule fragments are used to identify a functional group within an
analyzed molecule. For this purpose, the residual part a molecule fragment is attached to needs to be well defined
according to the allowed chemical environment.
Example:
A carboxylic acid functional group is shown in the following, which might be attached to any residual molecule:

In the corresponding functional group definition, the molecular fragment needs to be assigned. Furthermore, the
unknown residual (indicated by the question mark) needs to be specified in more detail. This is useful to distinguish e.g.
aromatic from aliphatic carboxylic acids. In case of aromatic carboxylic acids, the residue must be an aromatic compound,
but it would never be any aliphatic compound like an Alkylgroup. Therefore, residuals (indicated by the question mark)
will be considered as Generic atoms with special properties. These properties can be defined in the atom property dialog
(see below).

Workflow for Designing a Functional Group Molecule
To design a functional group molecule, please follow the instructions below:
1. Open the external structure editor and draw the functional group of interest.
2. Replace any open residual by an R atom.
Example: Carboxylic acid molecular fragment

3. Save or export the drawn molecule file (*.mol or *.sk2).
4. Select the destination functional group node in the tree of the Rule Designer.
5. From the MSWindows explorer, drag the molecule file (*.mol or *.sk2) and drop it onto the molecule section of the
Rule Designer:
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6. Double click with the Left mouse button onto the R atom within the molecule view to edit the Generic atom
properties.
7. An Atom Properties dialog is opened, where generic atom properties according to the SMILES and SMARTS
nomenclature can be adjusted. Please refer to the "Generic Atom Properties" section for details.

8. After modifying the atom properties, close the dialog clicking the
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Generic Atom Properties
Generic atom properties are used to describe unknown residuals attached to a functional group. These residuals are
represented by a generic atom. Its properties describe the chemical environment around a functional group by a number
of parameters as described in the following:

Values set to 0 are ignored!
If any value in the generic atom properties dialog is set to 0, the parameter will be ignored.

Connections
Connections
Gives the total number of neighbouring atoms or groups with respect to the generic atom.
Example:

Number of connections:

4

3

Imagine, the R group attached to the carboxylic acid functional group is replaced by a Methylgroup or an Ethenylgroup.
The double bond in the Ethenylgroup decreases the number of connections by one.
Explicit Connections
Sets the number of neighbouring atoms around the generic atom without consideration of implicit hydrogen atoms.
Example:

No. of explicit connections:

3

2

In case, hydrogen atoms will be explicitly drawn, this will have an effect on the number of explicit connections. Otherwise
they are neglected.
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Valence
The valence specifies the total bond order of the very next atom attached to the functional group. It is meant to be the
highest available bonding.
Single bond = 1
Double bond = 2
Tripple bond = 3

General
This section offers the following settings:
Aliphatic
This flag indicates, whether the residual is aliphatic or not. If the flag is set false, this setting is ignored.
Aromatic
This flag indicates, whether the residual is aromatic or not. If the flag is set false, this setting is ignored.
Atom Pattern
This is meant to be the most important setting in this dialog. Atom patterns or whole residuals can be described here
following the SMILES and SMARTS nomenclature. Please refer to the chapter "SMILES and SMARTS Nomenclature" for
details. A logical expression describing the chemical environment can be entered here. Expressions for whole molecular
fragments can be included here, if required. This Atom pattern description overrides any of the other settings in this
dialog.
Example:
Atom Pattern: *&A; C; !N; !S; !O; !$(C(=O))
*&A means:the residue can be anything aliphatic.
The separator ";" means a logical AND operator.
C means: the very next atom must be an aliphatic Carbon.
!N means: the very next atom must not be an aliphatic Nitrogen.
!O means: the very next atom must not be an aliphatic Oxygen.
!S means: the very next atom must not be an aliphatic Sulfur.
!$(C(=O)) means: the neighbouring group is not a carbonyl group, which means, the following substance types are
excluded:

Charge
Indicates the total positive or negative charge of the generic atom. This is a useful feature to define ions or salts.
Displayed Name
For convenience, chemists prefer particular abbreviations for some residual types as described in the following. This is not
a mandatory setting, but it helps to visualize certain functional groups:
R, R', R'', R''', ... = any kind of Alkylgroup
Ph = any kind of aromatic system e.g. a Phenylgroup
Ar = aromatic residual
G = anything aliphatic or aromatic with no restrictions.

Hydrogens
This section offers the following settings:
Attached Hydrogens
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Sets the number of attached explicit hydrogens of the generic atoms. This number must not be greater than the valence.
Implicit Hydrogens
Sets the number of implicit hydrogens.
Example:
If a Methylenegroup (CH2) needs to be defined as neighbouring generic atom, the implicit hydrogen count is set to
2.

Ring
This section offers the following settings:
Ring Membership
This option is useful for defining bridging atoms of e.g. bicycles. It sets the number of rings the generic atom is a member
of.
Example:
The bridge atoms in Norbornan are members of two 5membered rings.

Smallest Ring Size
This option sets the smallest allowed ring size, if the generic atom is member of a ring. The ring size represents the
number of atoms forming a ring. If the generic atom is member of a greater ring than specified here, it will be considered.
Otherwise it will be ignored.

File Menu
The file menu in the rule designer provides basic commands to maintain several rule databases.
Changing the active rule data base might change analysis results!
Be careful when changing the active rule database! The current rule data base is always applied in actual
analysis. Thus changing the active rule database might have consequences for your future analysis
results.

File Menu Contents

The File menu provides the following commands:
New...
Open...
Save
Saves current changes in the rule database.
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Changes can be undone if the Undo tracking function is enabled!
It is possible to log all changes in the rule database and undo them later on. This will be a good option to
test some improvements and undo them, if the results are not satisfactory.
Please refer to the chapter "Track Rule Changes" for details.

Exit
Closes the rule designer window and returns to the main software. You will be prompted to save or discard any
changes automatically.

Creating a new Rule Data Base
Users might work on a particular fields of research not covered by the default rules delivered with the installation of the
software. Others might want to use the rule data base in a different manner e.g. for substance identification. In all these
cases, users might want to setup their own rule data bases from scratch. A new rule database is developed with the Rule
Designer.
1. Open the Rule Designer.
2. From the File menu, select New...
The current rule data base is closed and a blank new one is shown now. To save the new rule data base, please use the
Save command.

Rules Menu
The rules menu holds various commands for adding, removing, editing and searching chemical classes, subclasses and
functional groups in the rule designer.

Rules Menu Contents
The Rules menu provides the following commands:
New Chemical Class
New Chemical Sub Class
New Functional Group
Rename
Delete...
Copy Functional Group
Paste Functional Group
Find Rule
Find Next Rule
This command repeats the last search action to find a particular interpretation rule.
Find Incomplete Rules
Add Molecule to Functional Group
Track Rule Changes

Find Functional Groups, Chemical Classes and SubClasses
In the large number of items in the rule designer tree view, it is not easy to find a particular functional group you are
looking for. However, if you know the name or at least a part of the name, this option allows full text search on all
functional group names, chemical class names and subclass names in the rule database. This way, the query item can be
found quickly.
1. From the Rules menu, select the Find Rule command to start searching.
Alternatively, press the F3key.
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2. The query text needs to be entered in the following dialog:

The following options are available for searching:
Enter the query text
1. Type any word or multiple words into the text field.
2. Click the OK button to start.
Selecting most recently used Queries
1. From the drop down text field, select one of the most recently used search queries.
2. Click the OK button to start.
Displaying Search Results
The software will jump automatically to the next matching entry in the tree view of the rule designer after clicking the OK
button.

Track Rule Changes
Those users, who develop new rule data bases or modify existing ones in order to improve analysis results, always need
to test their changes before the rule data base can be applied in routine IR interpretation. After some modifications it
would be a difficult approach to keep all recent changes in the rule data base in mind and also concentrate on the IR
interpretation results. The software offers a convenient system which tracks all changes to assist the user during
optimization. Recent changes will be logged and can be undone stepwise up to a certain amount. The system needs to
be activated manually in the software.

Enabling the Change Tracking System
To enable the change tracking system, please follow the steps below:
1. From the Rules menu, select Track Rule Changes.
2. In the dialog, check the Enable Undo Tracking checkbox.
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3. Click the Close button to apply settings.
From now on, all changes in the rule data base will be tracked and logged. Every time the user saves the rule data base,
he might enter a new checkpoint name. Please refer to the chapter saving for details.

Saving a Rule Data Base with Tracking enabled
If the change tracking system is enabled you can set a new checkpoint by saving the rule data base. You will be
prompted to enter a meaningful name for the current checkpoint. This should be a word or hint which summarize the
contents of your recent changes. All operations and changes in the rule data base can be recalled later on under this
checkpoint name.
The saving procedure is described in more detail below:
1. Perform your changes in the rule data base.
2. From the File menu, select Save.
3. Enter a meaningful summary of your changes into the text field of the Rule Data Base Undo Information dialog.

4. Click the OK button.
The rule data base is saved then and you can perform spectrum analyses or validations to test your modifications.

Review recent Changes in the Rule Data Base
To review all recent changes since you started the change tracking system, please follow the steps described below:
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1. From the Rules menu, select Track Rule Changes to open the dialog.

On the left of the dialog you see a list of all checkpoints which have been stored recently. If you click a particular
checkpoint, you can see the changes on the right side of the dialog accordingly. Changes are shown in that way, that the
original condition of the changed item is shown in the upper part. In the lower part, the item is shown with changes.
Example:
In this example, the functional group 'Aliphatic Ether' contained the wrong priority for certain vibrations. The user
corrected the priorities to 'low' as can be in the lower right part of the dialog.

Undo Recent Changes in the Rule Data Base
It is not easy for the analyst to foresee all consequences of changes in the rule data base. After some testing or even
when looking for a completely different issue you might become aware of changes you have made some time ago which
now cause false or unsatisfactory results. To undo these changes, please follow the steps described below:
1. From the Rules menu, select Track Rule Changes to open the dialog.
2. From the list of checkpoints on the left, select the checkpoint to be undone.
3. Click the Undo button to restore the original condition shown in the upper part.
Can I undo multiple changes?
If a checkpoint includes multiple changes, they cannot be undone one by one. It is only possible to undo
all changes of a checkpoint. If this might be required, you need to save intermediate steps more often.

Deleting tracked Changes
If you might have used the change tracking system thoroughly, the list of checkpoints will be rather long after a while.
Many of the checkpoints will become obsolete because changes did real improvements on the rule data base. Such
changes will never be subject of undo anymore and could be deleted without danger in order to reduce the list to
important items.
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Deleting checkpoints means accepting changes forever!

To delete a checkpoint, please follow the steps below:
1. From the Rules menu, select Track Rule Changes to open the dialog.
2. From the list of checkpoints on the left, select the checkpoint to be deleted.
3. Click the Delete button to remove the checkpoint from the list.
Deleting a checkpoint cannot be undone!
Be careful when deleting checkpoints. They will be deleted without further notification and deletion cannot
be undone!

To delete all checkpoints in the list at once, click the Delete All button.

Find Incomplete Functional Groups
This option will help you to find incomplete functional groups in the database quickly. Functional groups are incomplete, if
one of the following conditions is fulfilled:
No molecule is attached to the Functional Group
If the molecule is missing in a functional group, a placeholder is shown instead of the molecule inside the spectrum view
as displayed below. You may add a molecule to complete the Functional Group.
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No interpretation rule is defined.
In this case, the table on bottom right is empty. You may add new interpretation rules to the functional group.

SMILES and SMARTS Nomenclature
SMILES
SMILES is a simple yet comprehensive chemical nomenclature.
The answer to the most commonly asked question about SMILES is: yes, it is an acronym, meaning Simplified Molecular
Input Line Entry Specification. (SMILES originated in the depths of the US government, where humorous names for things
are frowned upon unless they are acronyms.)
SMILES is widely used as a generalpurpose chemical nomenclature and data exchange format. However, SMILES differs
in several fundamental ways from most chemical nomenclatures and other chemical formats. It is useful to review a few
fundamental concepts before digging into the specifics of the SMILES language.

SMARTS
Substructure searching, the process of finding a particular pattern (subgraph) in a molecule (graph), is one of the most
important tasks for computers in chemistry. It is used in virtually every application that employs a digital representation of
a molecule, including depiction (to highlight a particular functional group), drug design (searching a database for similar
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structures and activity), analytical chemistry (looking for previouslycharacterized structures and comparing their data to
that of an unknown), and a host of other problems.
SMARTS is a language that allows you to specify substructures using rules that are straightforward extensions of SMILES.
For example, to search a database for phenolcontaining structures, one would use the SMARTS string "[OH]c1ccccc1",
which should be familiar to those aquainted with SMILES. In fact, almost all SMILES specifications are valid SMARTS
targets (see "SMARTS Exceptions," below). Using SMARTS, flexible and efficient substructuresearch specifications can be
made in terms that are meaningful to chemists.
In the SMILES language, there are two fundamental types of symbols: atoms and bonds. Using these SMILES symbols,
once can specify a molecule's graph (its "nodes" and "edges") and assign "labels" to the components of the graph (that
is, say what type of atom each node represents, and what type of bond each edge represents).
The same is true in SMARTS: One uses atomic and bond symbols to specify a graph. However, in SMARTS the labels for
the graph's nodes and edges (its "atoms" and "bonds") are extended to include "logical operators" and special atomic
and bond symbols; these allow SMARTS atoms and bonds to be more general. For example, the SMARTS atomic symbol
[C,N] is an atom that can be aliphatic C or aliphatic N; the SMARTS bond symbol "~" (tilde) matches any bond.

Atomic Primitives
SMARTS provides a number of primitive symbols describing atomic properties beyond those used in SMILES (atomic
symbol, charge, and isotopic specifications). The following tables list the atomic primitives used in SMARTS (all SMILES
atomic symbols are also legal). In these tables <n> stands for a digit, <c> for chiral class.
SMARTS Atomic Primitives

Symbol

Symbol name

Atomic property requirements

Default

*

wildcard

any atom

(no default)

a

aromatic

aromatic

(no default)

A

aliphatic

aliphatic

(no default)

D<n>

degree

<n> explicit connections

exactly one1

H<n>

totalHcount

<n> attached hydrogens

exactly one1

h<n>

implicitHcount

<n> implicit hydrogens

exactly one1

R<n>

ring membership in <n> SSSR rings

r<n>

ring size

in smallest SSSR ring of size <n> any ring atom

v<n>

valence

total bond order <n>

exactly one1

X<n>

connectivity

<n> total connections

exactly one1

 <n>

negative charge <n> charge

1 charge ( is 2, etc)

+<n>

positive charge

+<n> formal charge

+1 charge (++ is +2, etc)

#n

atomic number

atomic number <n>

(no default)

@

chirality

anticlockwise

anticlockwise, default class

@@

chirality

clockwise

clockwise, default class
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@<c><n>

chirality

chiral class <c> chirality <n>

(nodefault)

@<c><n>? chiral or unspec chirality <c><n> orunspecified

(no default)

<n>

unspecified mass

atomic mass

explicit atomic mass

1 Note that atomic primitive "H" can have two meanings, implying a property or the element itself. [H] means hydrogen
atom. [*H2] means any atom with exactly two hydrogens attached.
Examples:

C

aliphatic carbon atom

c

aromatic carbon atom

a

aromatic atom

[#6]

carbon atom

[Ca]

calcium atom

[++]

atom with a +2 charge

[R]

atom in any ring

[D3]

atom with 3 explicit bonds (implicit H's don't count)

[X3]

atom with 3 total bonds (includes implicit H's)

[v3]

atom with bond orders totaling 3 (includes implicit H's)

C[C@H](F)O

match chirality (HFO anticlockwise viewed from C)

C[C@?H](F)O matches if chirality is as specified or is not specified

Bond Primitives
Various bond symbols are available to match connections between atoms. A missing bond symbol is interpreted as "single
or aromatic".
SMARTS Bond Primitives

Symbol

Atomic property requirements



single bond (aliphatic)

/

directional single bond "up"

\

directional single bond "down"
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/?

directional bond "up or unspecified"

\?

directional bond "down or unspecified"

=

double bond

#

triple bond

:

aromatic bond

~

any bond (wildcard)

@

any ring bond

Examples:

C

any aliphatic carbon

cc any pair of attached aromatic carbons

c:c aromatic carbons joined by an aromatic bond

cc aromatic carbons joined by a single bond (e.g. biphenyl)

Logical Operators
Atom and bond primitive specifications may be combined to form expressions by using logical operators. In the following
table, "e" is an atom or bond SMARTS expression (which may be a primitive). The logical operators are listed in order of
decreasing precedence (high precedence operators are evaluated first).
SMARTS Logical Operators

Symbol

Expression

Meaning

exclamation !e1

not e1

ampersand e1&e2

a1 and e2 (high precedence)

comma

e1,e2

e1 or e2

semicolon

e1;e2

a1 and e2 (low precedence)

All atomic expressions which are not simple primitives must be enclosed in brackets. The default operation is `&' (high
precedence "and"), i.e., two adjacent primitives without an intervening logical operator must both be true for the
expression (or subexpression) to be true.
The ability to form expressions gives the SMARTS user a great deal of power to specify exactly what is desired. The two
forms of the AND operator are used in SMARTS instead of grouping operators.
Examples:
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[CH2]

aliphatic carbon with two hydrogens (methylene carbon)

[!C;R]

( NOT aliphatic carbon ) AND in ring

[!C;!R0]

same as above ("!R0" means not in zero rings)

[n;H1]

Hpyrrole nitrogen

[n&H1]

same as above

[nH1]

same as above

[c,n&H1] any arom carbon OR Hpyrrole nitrogen

[X3&H0]

atom with 3 total bonds and no H's

[c,n;H1]

(arom carbon OR arom nitrogen) and exactly one H

[Cl]

any chlorine atom

[35*]

any atom of mass 35

[35Cl]

chlorine atom of mass 35

[F,Cl,Br,I] the 1st four halogens.

Recursive SMARTS
Any SMARTS expression may be used to define an atomic environment by writing a SMARTS starting with the atom of
interest in this form:
$(SMARTS)
Such definitions may be considered atomic properties. These expressions can be used in same manner as other atomic
primitives (also, they can be nested).
Recursive SMARTS expressions are used

*C

atom connected to methyl (or methylene) carbon

*CC

atom connected to ethyl carbon

[$(*C);$(*CC)] atom in both above environments (matches CCC)

The additional power of such expressions is illustrated by the following example which derives an expression for methyl
carbons which are ortho to oxygen and meta to a nitrogen on an aromatic ring.

CaaO

C ortho to O

CaaaN

C meta to N
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Caa(O)aN

C ortho to O and meta to N (but 2O,3N only)

Ca(aO)aaN

C ortho to O and meta to N (but 2O,5N only)

C[$(aaO);$(aaaN)] C ortho to O and meta to N (all cases)

Componentlevel grouping of SMARTS
SMARTS may contain "zerolevel" parentheses which can be used to group dotdisconnected fragments. This grouping
operator allows SMARTS to express more powerful component queries. In general, a single set of parentheses may
surround any legal SMARTS expression. Two or more of these expressions may be combined into more complex SMARTS:
(SMARTS)
(SMARTS).(SMARTS)
(SMARTS).SMARTS
The semantics of the "zerolevel" parentheses are that all of the atom and bond expressions within a set of zerolevel
parentheses must match within a single component of the target.

SMARTS SMILES

Match behavior

C.C

CCCC

yes, no component level grouping specified

(C.C)

CCCC

yes, both carbons in the query match the same component

(C).(C)

CCCC

no, the query must match carbons in two different components

(C).(C)

CCCC.CCCC yes, the query does match carbons in two different components

(C).C

CCCC

yes, both carbons in the query match the same component

(C).(C).C CCCC.CCCC yes, the first two carbons match different components, the third matches a carbon anywhere

These componentlevel grouping operators were added specifically for reaction processing. Without this construct, it is
impossible to distinguish inter versus intramolecular reaction queries. For example:

Reaction SMARTS expression Match behavior

C(=O)O.OCC>>C(=O)OCC.O

Matches esterifications

(C(=O)O).(OCC)>>C(=O)OCC.O Matches intermolecular esterifications

(C(=O)O.OCC)>>C(=O)OCC.O

Matches intramolecular esterifications (lactonizations)

SMARTS vs. SMILES
All SMILES expressions are also valid SMARTS expressions, but the semantics changes because SMILES describes
molecules whereas SMARTS describes patterns. The molecule represented by a SMILES string is usually, but not always,
matched by the same string when used as a SMARTS.
SMILES is interpreted as a molecule, and it is the resultant molecule (not the SMILES string) which is subject to searching.
Similarly, SMARTS is interpreted as a pattern; it is this pattern (not the SMARTS string) which is matched against
molecules. For instance, the SMILES "C1=CC=CC=C1" (cyclohexatriene) is interpreted as the benzene molecule. This
molecule will be matched by the SMARTS c1ccccc1, which is interpreted as the pattern "6 aromatic carbons in a ring". The
SMARTS "C1=CC=CC=C1" makes a pattern ("six aliphatic carbons in a ring with alternating single and double bonds")
which will not match benzene. It will, however, match the nonaromatic phenylate cation with SMILES C1=CC=CC=[CH+]1.
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When atoms are specified without brackets in SMILES, default values are used; in SMARTS, unspecified properties are not
defined to be part of the pattern. For instance, the SMILES O means an aliphatic oxygen with zero charge and two
hydrogens, i.e. water. In SMARTS, the same expression means any aliphatic oxygen regardless of charge, hydrogen
count, etc, e.g. it will match the oxygen in water, but also those in ethanol, acetone, molecular oxygen, hydroxy and
hydronium ions, etc. Specifying [OH2] limits the pattern to match only water (this is also the fully specified SMILES for
water).
There are a few anachronisms in most SMILES interpreters which can also lead to confusion. Some SMILES interpreters
allow implicit hydrogens to be added as explicit atoms on input as a shortcut. E.g., the SMILES for 1Hpyrrole is "
[nH]1cccc1" which is matched by itself as SMARTS and by "n1cccc1". The current Daylight SMILES interpreter will also
accept "Hn1cccc1" for (not very good) reasons of historical compatability; this generates the same (hydrogen
suppressed) molecule as does "[nH]1cccc1" and is matched by the same SMARTS. However, the SMARTS "Hn1cccc1" does
not match this molecule.
Most SMARTS expressions are not valid SMILES expressions. For instance, the string "cOc" is a valid SMARTS, matching an
aliphatic oxygen connected to two aromatic carbons as part of a larger molecule (e.g. diphenyl ether). However, "cOc"
does not describe a molecule per se, and is therefore not a valid SMILES.

Efficiency Considerations
The Daylight 4.x SMARTS Toolkit provides a function, dt_smarts_opt(), which automatically optimizes a SMARTS by
reordering, expanding, and/or consolidating atom and bond expressions. Programs which use this feature (e.g. the Merlin
program) can be expected to be near optimal in terms of the time used to search typical organic structures.
When this optimization method is not used, there are some things which can be done to facilitate efficient (fast)
searching operations using SMARTS. It is important to recognize that SMARTS target strings are processed in strictly left
toright order. For this reason, substantial gains in speed can be achieved by following these guidelines:
Uncommon atoms or bond arrangements should be placed early in SMARTS targets.
In an "andexpression", the less common atom or bond specifications should be placed early.
In an "orexpression", the less common atom or bond specifications should be placed last.

Examples
cc

any pair of attached aromatic carbons

c:c

aromatic carbons joined by anaromatic bond

cc

aromatic carbons joined by a single bond (e.g.biphenyl).

O

any aliphatic oxygen

[O;H1]

simple hydroxy oxygen

[O;D1]

1connected (hydroxy or hydroxide) oxygen

[O;D2]

2connected (etheric) oxygen

[C,c]

any carbon

F,Cl,Br,I]

the 1st four halogens.

[N;R]

must be aliphatic nitrogen AND in a ring

[!C;R]

( NOTaliphatic carbon ) AND in a ring

[n;H1]

Hpyrrole nitrogen
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[n&H1]

same as above

[c,n&H1]

any arom carbon OR Hpyrrole nitrogen

[c,n;H1]

(arom carbon OR arom nitrogen) and exactly one H

*!@*

two atoms connected by a nonringbond

*@;!:*

two atoms connected by a nonaromatic ringbond

[C,c]=,#[C,c] two carbons connected by a double ortriple bond
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Appendix
This chapter contains following topics:
IR/RAMAN Interpretation Menu
Loading IR/RAMAN Interpretation Rule Database
IR Interpretation Result Layout

IR/RAMAN Interpretation Menu
The IR/RAMAN Interpretation menu contains all available commands for automatic and interactive IR and RAMAN spectrum
interpretation. A general overview and an introduction is given in the "IR/RAMAN Analysis Overview" section.
Why is the IR/RAMAN Interpretation menu missing?
The IR interpretation and RAMAN interpretation are extra modules, which needs a valid license. Maybe your
license does not grant access to this functionality. Please contact your software provider for more information.

IR/RAMAN Interpretation menu commands

The IR/RAMAN Interpretation menu holds the following commands:
The menu name toggles from IR Interpretation to RAMAN Interpretation according to the actual analysis mode.

EN

IR/RAMAN Analysis . 407

Analyze Spectrum
Validate Spectrum and Molecule
Toggle to ... Interpretation
Toggles current interpretation mode either to
IR interpretation
RAMAN interpretation
Browse Functional Groups at specific Wavelength
Show Rule Designer
Show Functional Group Definition
This command opens the actual selected functional group in the rule designer.
Load Rule Database
Preferences...
Remove selected Functional Group
Highlight all assigned Functional Groups
Show Identified Peaks
How to add interpretation results to a project?
After performing any analysis, results can be stored in your project for review later on. Please refer to the
chapter "Add/Remove active Object to a Project" for details.

Loading IR/RAMAN Interpretation Rule Database
Before performing any IR or RAMAN interpretation, a proper set of interpretation rules need to be defined or an existing
rule database needs to be loaded. The default rule database for IR and RAMAN comprise a lot of predefined interpretation
rules, which might be customized by the user on demand. Initially the default rule databases installed together with the
software are loaded by default. Loading a different rule database is performed as follows:
Toggle to the right analysis mode before loading a rule database!
Before loading a rule database, please toggle the analysis mode to the one you want. The rule database
is loaded for the actual analysis mode accordingly!
To toggle the analysis mode, choose the Toggle to ... menu command in the IR/RAMAN Interpretation
Menu.

Loading a Rule Database in the main Application
In the main application a rule data base is loaded as described in the following:
1. From the IR/RAMAN Interpretation menu, select the Load Rule Database command.
2. In the File dialog, navigate to the file location of your rule database and select a *.rules file.
3. Click the Open button to load it.
A default set of Rules is installed together with the software!
Default interpretation rule databases are provided together with the software for IR and RAMAN,
respectively. They will be installed automatically and it is called "IRRules.rules" and "RAMANRules.rules"
accordingly. The files are located in a subdirectory called "Rules" in your software installation directory.

Loading a Rule Database in the Rule Designer
In the rule designer a rule database is loaded as described in the following:
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Why is the Rule Designer missing in my software?
The rule designer is an optional module of the software. You will require a valid license to have this
function available. Please contact your software vendor for detailed information and a quotation.

1. From the File menu, select the Open... command.
2. In the File dialog, navigate to the file location of your rule database and select a *.rules file.
3. Click the Open button to load it.

IR Interpretation Result Layout
Notwithstanding the basic print layout properties and general object properties, some individual properties can be
adjusted for printing IR interpretation result objects.

Printable Objects
The following molecule print layout properties are available:
Print Spectrum View
This flag toggles printing the analyzed spectrum.
Yes
The analyzed spectrum is printed according to its current visible view port in the 2D data view. The size of the
bitmap to be printed, can be adjusted in the Image parameters.
No
The analyzed spectrum is not printed.
Print Matching Functional Groups
This flag toggles printing the table containing matching functional groups.
Yes
The matching functional groups table is printed. If the functional group molecule is printed as well, current selected
functional group is emphasized in the table.
No
The matching functional groups table is not printed.
Print Passed Interpretation Rules
This flag toggles printing the table containing passed interpretation rules.
Yes
The passed interpretation rules table is printed.
No
The passed interpretation rules table is not printed.
Print Failed Interpretation Rules
This flag toggles printing the table containing failed interpretation rules.
Yes
The failed interpretation rules table is printed.
No
The failed interpretation rules table is not printed.

Spectral Image
All basic print settings for the spectral image are applied here too. Additionally, the following settings can be adjusted:
Print Functional Group Molecule
This parameter controls, whether the current visible molecule of the actual selected functional group is printed or not.
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The molecule is only printed, if the spectrum is printed!
Printing the spectrum needs to be enabled to print the molecule.

Yes
The molecule is printed in the spectrum view together with the spectrum.
No
The molecule is not printed.
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MicroLab Expert Instrument Manual
The MicroLab Expert software is designed to run Agilent FTIR spectrometers. The software is easy to use for both
advanced and novice users. The following spectrometers series can be controlled by the software:
Cary 630
4100 series
4200 series
4300 series
4500 series
5500 series

Instrument Menu
The Instrument menu holds various commands to control and drive Agilent spectrometers. It provides commands to
access the instrument panel and instrument controls.

The Instrument menu provides the following commands:
Show Instrument Panel
Opens the instrument panel to let you setup acquisition parameters and review diagnostic information.
Set as Background
The current visible and active spectrum can be set as the new background spectrum without performing a
background measurement. This requires data which has been measured in single beam measurement mode.
PreAlignment Check
This enables and starts the pre sample alignment check .

Methods
Methods define instrument collection parameters and data analysis within the MicroLab Expert software. Methods can be
defined to only collect data, collect and compare collected data to a predefined library or collect data and perform a
quantitative analysis on that data. Predefined methods include data collection, qualitative library searches and
quantitative methods for oil and fuel analysis on the Agilent 4500t/5500t FTIR spectrometers. For questions and
additional information on specifications for predefined methods, contact Agilent.
MicroLab Mobile only allows for selection of predefined methods. Editing of methods must be conducted on a separate
computer operating MicroLab PC, MicroLab Lite or MicroLab Expert software. To be viewable within the Method dialog
box, methods developed with PC, Lite and Expert versions of the software should be transferred to the following
directory on the handheld or embedded controller: @\Program Files\ MicroLab Mobile\Methods. For component methods,
which use Quant (multivariate) calibrations, the Model for the method is required on the handheld as well.
When starting the software the last used method is loaded automatically. While working with the software all parameter
changes in the Instrument Panel will be automatically updated in the current method. This also applies to Agilent library
settings used for searching spectral data in libraries. Current changes remain unsaved as long as the software is running.
Current changes can be actively saved and other methods can be loaded as described in the following.

Load Method
To load a method and apply settings:
In the File menu click the Load Method command
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Navigate to the desired folder and select an a2m method file
Click the OpenButton to load the method
Alternatively, use the general open command:
In the File menu click the Open command
In the file dialog select MicroLab File *.a2m *.a2r *.a2l as file mask
Navigate to the desired folder and select an a2m method file
Click the OpenButton to load the method

Save Method
To save a method follow these steps:
Make sure all parameters in the Instrument Panel are set as desired.
In the File menu click the Save Method as command
In the file dialog navigate to the desired target folder
Update the method file name to the desired new name to create a new method with current settings. Alternatively,
overwrite the existing method to update it
Click the SaveButton to save the method

Method Types
Three types of methods are available in the software:
Data Collect Only
Only collect and display the infrared spectrum. No further analysis is performed on the collected data.
Component
Quantitative prediction methods. An infrared spectrum is collected then a predefined quantitative prediction is
made from that data. Several components can be defined, each with their own quantitative calibration.
Qualitative Library Search
Collect an infrared spectrum and search it against a predefined spectral library. The results of this method will be
the top matches to the spectral library.
The method type can be set in the Types tab of the instrument panel.

Libraries
Libraries are used to save a collection of spectra utilized by qualitative search methods to perform material identification.
New libraries can be created in *.a2l file format or existing libraries can be revised by adding and removing spectra. Have
a look in section How to work with libraries to learn more about it.

Libraries and Methods
When loading or creating a *.a2l library, it will be automatically added to the library explorer but NOT to
current active method. Libraries can only be added to a method in case the method is a qualitative
search method.

Load Library
To load a library do the following:
In the File menu click the Open command
In the file dialog select MicroLab File *.a2m *.a2r *.a2l as file mask
Navigate to the desired folder and select an a2l library file
Click the OpenButton to load the library

Using Libraries in Qualitative Search Method
The current active method needs to be a qualitative search method in order to be used for qualitative analysis with

EN

412 . MicroLab Expert Instrument Manual
MicroLab PC. Proceed as follows to update the current active qualitative search method:
Load a library as described above. The library is automatically displayed in the library explorer.
Click the Right Mousebutton on the library node in the library explorer tree.
Select Add to Method command to add the library to the current method. Do the same to remove it from the
method.
Measure or load a spectrum for testing purposes
In the Library menu click Search Spectrum command
In the Spectrum Search Query dialog setup the search parameters for qualitative data analysis.
Select the appropriate search algorithm
Choose the maximum number of hits to be shown in search result
Choose the minimum match quality to filter results below this threshold
Check the libraries to search in the list
Click the Searchbutton to start searching
Libraries used in Methods
As soon as the search button is clicked, checked libraries are automatically transferred to the current
active method and can be used for qualitative analysis. The method is modified and needs to be saved in
order to keep the changes.
Only Agilent libraries in the *.a2l file format can be used by a qualitative library search method!

Blue libraries in library explorer
All Agilent libraries used by a method for qualitative analysis are shown blue colored in the library
explorer.
Detailed information on parameter settings can be found in the chapter How to search data in a library.

Results
Result files produced with MicroLab PC software can be loaded and reviewed within the software as well. These files have
the file extension *.a2r. Such files might contain spectral data such as background and sample spectra as well as search
results or results of prediction.

Load Result
To load a result do the following:
In the File menu click the Open command
In the file dialog select MicroLab File *.a2m *.a2r *.a2l as file mask
Navigate to the desired folder and select an a2r result file
Click the OpenButton to load the method

Spectra
Spectral data included in the result file is opened and displayed in separate spectrum windows accordingly. All kinds of
additional information is directly attached to the spectra as labels. The following additional information is typically
available:
GPS data showing longitude and latitude of the place where the spectrum has been recorded.
(This is not available for all instrument series data!)
Custom field information entered by the user before measurement.
Prediction results from component analysis (see Univariate or multivariate Prediction Results below)
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The labels can be reviewed in the Labels tab which is located on bottom right corner of the main application work space.

Search Results
In case the result file contains results of a qualitative search method, the search results are displayed as well in a
separate search result window.

Agilent libraries only!
the search result only contains information on results obtained by searching on Agilent libraries (*.a2l)
specified in the underlying method. The result can only be displayed properly in case the corresponding
libraries are in place in the Public Documents/MicroLab PC/Libraries folder! Otherwise an error message is
displayed when trying to open the result.

Univariate or Multivariate Prediction Results
In case the result contains results of a quantitative component method, the component analysis results are added as
labels to the spectrum accordingly.

Instrument Panel
Click the Instrument menu and click Show Instrument Panel command to open or close it.
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The instrument panel is opened on the right side of the application window. If the Show Instrument Panel menu is already
checked, the panel might be folded away. To unfold it, just hover with the mouse over the vertical bar to the right side of
the application window. Then click the pin icon to fix the window to the desktop.

Sample Information
The sample name text field allows quick entering the name for the next spectrum to be acquired. Additional data storage
options and auto naming features can be setup in a separate Sample Information Editor. To open the dialog, click the
Button.

Buttons
The following buttons are available for instrument control:
Connect / Disconnect
The instrument is not automatically connected to the software on startup of the application. Connection needs to
be established actively by clicking the button. In case the instrument is busy or connected to another software or is
unavailable for other reasons, an error message is displayed.
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The software does not automatically connect to the last used/selected instrument!
The application will display the last used instrument in the instrument list but will not connect
automatically to it. The operator always has to manually connect to the instrument by clicking the
Connect button. Alternatively, with an instrument being selected, the operator may just click the
Measure, Live Spectrum or Reference button to directly connect to the instrument and start a
measurement.

Loss of connection or accessory change
Whenever the connection to the instrument is lost, because of disconnecting the USB cable or other
malfunction, the software will refuse to perform measurements and all controls are disabled.
In addition the instrument automatically detects whenever the accessory is changed. While changing
the accessory the controls are disabled as well.

Background
When connected to the instrument, the background can be actively renewed by the operator whenever needed
prior to a sample measurement. In case a new background is required by the background validity settings, the
background is measured automatically prior to the sample measurement.

Is the background always required?
In case the Single beam or Interferogram measurement mode are configured, the background is not
required, since energy data is returned by the spectrometer.

Measure
Starts a sample measurement with the actual parameters listed in the parameters area. A measurement can be
aborted/stopped by clicking on the Abortbutton. The Measure button becomes an Abort button while the
measurement is running. Please refer to the chapter Spectrum Measurement for detailed description of all
measurement options.
Live View
Starts a continuous data acquisition and displays measured spectra immediately in an online monitoring data view.
Since the data is displayed in real time, this is useful for gain adjustment. The live view mode can be stopped by
clicking on the Live Viewbutton again. Measurement details of the current live spectrum acquisition are displayed
in the statusbar of the main application window.

Instrument Tab
The instrument tab inside the instrument panel provides all relevant parameters for data collection setup:
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Acquisition Mode
The following modes are supported:
Interferogram
Returns the interferogram data.
Single Beam
Returns an energy spectrum which might be saved separately. This is the raw spectrum which might be background
corrected later on using a particular background energy spectrum.
Absorbance
Returns a background corrected spectrum having Absorbance units as yaxis units.
Transmittance
Returns a background corrected spectrum having Transmittance units as yaxis units.

Gain
This parameter controls the receiver gain level in order to optimize the signal intensity within the dynamic range of the
detector. If the gain is chosen out of the optimal range, the background of the value field is automatically colored. The
indicators help the operator avoiding detector saturation or too low signal intensities causing higher noise. The following
color codes are available:
No Color
The gain value is within normal acceptance range
Yellow
The gain value is close to the lower or upper limits of the normal acceptance range
Red
The gain value is out of the normal acceptance range
Gain and method gain
The instrument maintains an internal gain value which is used to perform measurements as specified here.
However, this gain value can be overridden by the gain setup for the active method. Please refer to the
Type tab for details.

Spectral Range
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The spectral range to be measured can be manipulated by following options.
Full
The full detector range is used for data acquisition. the range might vary according to the instrument series.
From
This parameter specifies the upper limit of the spectral range in wavenumbers.
To
This parameter specifies the lower limit of the spectral range in wavenumbers.
Instrument Parameter
Sample Scans
This specifies the number of scans to be collected in the sample measurement. As with the background
measurement, additional scans increase the signaltonoise, but also increase the amount of time. The sample
scans should be equal or less than the number of background scans. Typically, the background and sample are
collected with the same number of scans.
Background Scans
This specifies the number of scans to be collected in the background measurement. Additional scans will produce
higher signaltonoise; however, the measurement time increases proportional to the number of scans.
Resolution
This specifies the spectral resolution. For condensed phase samples, most measurements can be made with 8 cm 1
resolution.
Apodization
This specifies the apodization function used for fourier transformation of the interferogram into an energy
spectrum.
Zero Fill Factor
This specifies the zero filling factor used for fourier transformation of the interferogram into an energy spectrum.

Kinetic Measurement Settings
Performing kinetic measurements is very similar to the regular spectrum measurement. A kinetic measurement consists of
a sequence of regular spectrum measurements acquired with a particular delay time between the measurements.
Collected data is automatically saved according to the saving policy. The operator simply has to adjust the additional
acquisition parameters Measurements and Interval
Clean check and background validity
The clean crystal check and the current background are valid throughout the duration of the kinetic
measurement. The background is refreshed before starting the kinetic measurement if required. In this
context the clean check might be performed as well. If the background expires while a kinetic
measurement is ongoing, it will be completed first and it will NOT be interrupted to renew the
background!
Perform Kinetic Measurement
This indicates whether the kinetic measurement mode is enabled or not. If enabled a sequence of spectra
measured according to the timing specified in the following.
Initial Delay
This specifies the delay time between pressing the start button and the first measurement. When monitoring a
reaction or whenever a delay is required for any operations to be completed before the first measurement is
started, this time needs to be adjusted here.
Interval
This parameter specifies the time between two subsequent measurements.

Interval too small
There is no proof for the interval time being valid before starting the kinetic measurement run. If
the time is set too short the next measurement would be started, before the ongoing
measurement is completed. In such event the kinetic measurement is stopped showing an error
message indicating to adjust the interval time to a more appropriate value as shown in the
message.

Number of Measurements
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this parameter specifies the total number of measurements to be performed in this sequence.

Diagnostics Tab
In the diagnostics tab some readonly parameters are shown indicating the actual instrument health and providing
diagnostics information.

Instrument Info
This section gives you more information on the instrument hardware setup you are currently running. Especially the
installed accessory (ATR, transmission cell, etc.) is recognized automatically.
For service and support requests you might need the serial number of the instrument shown in this section as well.

Instrument Status and Temperatures
These two section are giving you an overview on the instrument health. The values are color coded as described above
for the gain value. The instrument is performing under optimal conditions in case all parameters are green.
Battery status
The battery status is only activated for handheld systems. For all other devices the status is green all
the time and the power indicator is disabled.

Energy level and Gain
The Energy level is connected to the gain value. In case the energy level is below or above certain limits
you need to adjust the gain to bring it back to normal (= green) again.

Type Tab
In the types tab the method and workflow settings and shown.
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Method
Name
The method name shows the file name of the current active method. It is also shown in the caption of the main
application window. The method name cannot be modified. It will be changed automatically whenever the active method
is saved under a new file name.
Comment
This field is made available to the user to input any special information concerning the method. The comment is an
optional field.
Developer
This field specifies the user who developed the method.
Type
Three types of methods are available in the software:
Data Collect Only
Only collect and display the infrared spectrum. No further analysis is performed on the collected data.
Component
Quantitative prediction methods. An infrared spectrum is collected then a predefined quantitative prediction is
made from that data. Several components can be defined, each with their own quantitative calibration.
Qualitative Library Search
Collect an infrared spectrum and search it against a predefined spectral library. The results of this method will be
the top matches to the spectral library.
The type parameter shows the selected type in the current active method. Changing the method type will also change
the analysis behavior.

Background
The background mode is controlled by the Collect Mode checkbox:
If unchecked, the user takes care of the background spectrum validity. It might be renewed whenever desired and
it will never expire.
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If checked, the settings below are applied for background validity. Two options exist for collection of the
background:
On every Sample
This requires the collection of a new background spectrum for every sample. This is the recommended option,
as it provides the best correction for water vapor, carbon dioxide and other atmospheric variations.
On valid time limit
If this option is selected, samples can be collected in sequence without measuring a background spectrum in
between samples. The time limit can be set in minutes, hours and days accordingly.
The background validity can be manually reset at any time by clicking the Resetbutton

Clean Crystal
The following options for the clean crystal check are available:
Check
This option enables or disables the system checks of the cleanliness of the ATR crystal or sample cell prior to
collecting a background. This option is recommended but not required.
Scans
This parameter specifies the number of scans to be accumulated to verify the crystal cleanness
Threshold
This parameter specifies the acceptance level for absorbances occurring over the stored reference absorbances.
The clean crystal validity can be manually reset at any time by clicking the Resetbutton

Sample Continuity
This option enables or disables the sample continuity check. This check is typically enabled for handheld devices to make
sure the sample is kept in the focus of the sampling technology during measurement.

PreAlignment
This option enables or disables the presample alignment check.

Method Gain
This option is used to save a particular gain value in the method for routine analysis with MicroLab PC. This is typically
used for specific instrument setups in combination with specific analyses. The gain value set herein overrides the current
instrument gain being setup in the Instrument tab.

Require GPS Data
This option enables or disables GPS data (Global Positioning System) as mandatory information whenever collecting
spectra. GPS data is attached to the measured spectrum as longitude and latitude labels by default if available.
In case the instrument does not support providing GPS data, this option should be disabled. Otherwise data collection is
refused.

Result
Measured spectra are automatically named using one of the following naming policies:
Id + Increment
The sample spectrum is named using a combination of the name entered into the sample ID field on top of the
instrument panel plus an autocounter which is automatically incremented. The counter is reset whenever the
name text is changed in the sample ID field.
Timestamp
The sample spectrum is named using the current date and time in the format specified in the sample information
editor.
Id + Timestamp
The sample spectrum is named using a combination of the name entered into the sample ID field on top of the
instrument panel plus the time stamp in the format specified in the sample information editor.
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Naming of background spectra
Background spectra are using the same naming policy as regular sample spectra. "_BKG" is appended to
the name in order to identify background spectra.

PreSample Alignment Check
The PreSample Alignment Check produces a visual indication of the signal strength from a measured sample in a preview
screen. This allows you to determine if the sample is at the instrument focus or flat against the ATR crystal or reflectance
housing, or that the instrument is aligned to the sample for maximum signal. This procedure details creation of a method
that uses the presample alignment check. In the method, a measurement to be made from the sample will be specified.
Typically this should be a peak height or area that corresponds to the sample of interest.
Before starting a measurement the presample alignment dialog is displayed as follows:

The blue indicator shows the current signal strength. The spectrum view and the indicator are permanently updated while
the operator is positioning the sample. For optimal performance of the instrument, the indicator should reside within the
green range.

Clean Crystal Check
The first step in making a sample measurement is to ensure that the sample mounting interface is clean of any residue
from previous samples or from general use and storage. For specific instructions for cleaning, refer to the appropriate
instrument operation manual supplied with the system.
Is the ATR accessory connected?
The clean crystal check is only performed if the ATR accessory is connected to the instrument.

CAUTION
Do not break the spectrometer seal and attempt to clean interior surfaces. Breaking the seal will void
the warranty.
A brief check of the sample interface (that is, the crystal) will occur when the Clean Crystal option is activated in the Type
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tab of the instrument panel. Following a successful test, the system gathers a ‘background’. Crystal check and
background progress are indicated by a status bar.
The Clean Crystal check will check for absorbance over a stored reference. If any absorbances are found, the software
will instruct you to clean the sample interface and start again.
Is the clean crystal check continuously failing?
If the clean crystal check continually fails, the stored background scan may be corrupted. If this occurs,
the clean background can be reset by clicking the Reset button in the clean crystal settings of the type
tab in the instrument panel. This will clear the stored background.

Background Measurement
The background measurement (with no sample present) provides a baseline profile of the current system conditions and
enables you to factor out any anomalies occurring in both the background and sample spectrum.
Is the accessory clean?
As mentioned above in the chapter Clean Crystal , before collecting a background, ensure that the
sample interface is clean. To clean the sample interface, a suitable solvent such as methanol, acetone or
isopropyl alcohol should be used. See the instrument operation manual for more detailed information.
It is recommended that the system is configured to collect a background before every sample. For details on how to setup
this option please refer to the chapter Types Tab. A brief check of the sample interface (that is, the crystal) will occur.
Following a successful test, the system gathers a ‘background’ whenever needed by the parameter settings. Background
progress is indicated by a status bar.

Refresh Reference Background
Internally the instrument keeps a reference background which is used to verify crystal cleanness. This background can be
actively replace with a new one as follows:
Clean the crystal as described in the chapter Clean Crystal
Click the Backgroundbutton in Instrument Panel
This forces collection of a background measurement. The measured background is automatically saved in the
instrument.

Spectrum Measurement
Data collection is performed according to the parameter settings in the Instrument Tab. To collect a new sample spectrum
do the following:
To begin sample measurement, click the MeasureButton on the Instrument Tab.
In case the method has configured custom fields to be filled, the following dialog is shown with the list of fields to
fill:
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The following field types are available:
Text field
This field supports entering all kinds of texts including numbers. However, numbers are not interpreted as
numeric information.
Number field
This field supports entering a number without decimal digits. In addition the method might specify lower and
upper limits preventing the operator from entering values below or above certain limits.
Decimal field
This field supports entering a number with decimal digits. In addition the method might specify lower and
upper limits preventing the operator from entering values below or above certain limits.
Date field
This field supports entering a date and time value in the specified format. By default the field is field with the
actual date and time. The operator might click on the date picker becoming visible on the right end of the
field when activated. Clicking the date picker opens a calendar for convenience.

Custom fields are mandatory fields
The operator must fill all mandatory fields to continue! It is not allowed to leave fields empty.

Click the OKbutton to continue

Clean crystal, background, presample alignment
The operator is automatically guided through the steps of data collection. Whenever the instrument
is in a state, that a new background is required, the operator is automatically prompted prior to
sample measurement. This is also done for clean crystal check and presample alignment check if
enabled.
As the software instructs (if clean crystal check is enabled),
Adjust the sample focus on the sampling technology while the presample alignment window is shown in
order to maximize the signal intensities (if prealignment check is enabled)
Sample measurement is completed automatically and the collected spectrum is displayed.

Sample Information Editor
The Sample Information Editor offers additional options to configure the date and time format for sample naming. It also
controls the Auto Save options for the measured samples and backgrounds. The editor looks like this:
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Sample Information Editor Contents
The dialog has several areas to control the sample information / auto save options:
Format
This option specifies the date and time format used for the time stamp in result naming. the time stamp is used for
sample and background spectrum naming as specified in the Type tab.
Auto Save Options
The auto save settings are adjusted in this group:
Path
Defines the path where to save the sample file. A path can be entered manually or by clicking on the
button
and using the File Open Dialog. The default path is MicroLab PC folder in the "public documents" folder (which may
differ depending on the operating system, e.g. \Public Documents\Agilent\MicroLab\).
Save Data to File
Checking this option will auto save the measured sample to a data file using the file name entered above and the
file format specified in the dropdown box. The user may choose any of the supported file formats. If this option is
activated, the Save Data to Project option is unavailable. Only one save option may be selected.
Save Data to Project
Checking this option will auto save the measured sample to the selected project and subfolder. A project name can
be entered manually or selected by clicking on the
button and using the File Open Dialog. Non existing projects
will be created automatically. The sample data will be saved to folder inside the project which can be entered here.
If the Save Data to Project option is activated, the Save Data to File option is unavailable. Only one save option
may be selected.

Custom Fields
The method might specify custom fields to be filled during measurement. If such fields are specified, the corresponding
dialog to enter the information is shown automatically when starting a spectrum measurement. For details please refer to
section Spectrum Measurement.
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